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ABOUT FEM-DESIGN 
 
 
FEM-Design offers a powerful, yet easy to use package that can be tailored to suite the exact analysis 
and design needs of the structural engineers using finite element method. 
 
As FEM-Design is a full 64-bit software, all memory of the computer can be utilized. In previous 32-bit 
versions the memory usage was limited to 2 Gigabytes, which could cause out of memory error message 
when displaying results at large models. The analysis core was already 64-bit in earlier versions. 

32-bit operating systems are not supported anymore! 
 
FEM-Design runs on Microsoft Windows ® 8, 7, and Vista operation systems. 
 
Single elements or a complete building, made from any number of materials and structural elements 
can be analyzed with ease related to Eurocode 2, Eurocode 3, Eurocode 5 and Eurocode 7. 
 
 

FEM-Design Modules 
 
The FEM-Design software system is a group of modules developed for different 2 and 3 dimensional 
structural problems, but it provides additional special features such as 2D drawing services and 3D 
solid modeling too. 
The following tables summarize the design and auxiliary modules with their features and functionality.  

  The list of available modules depends on what license you have. 
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Plate 

 
Wall 

 
Plane Strain 

 
3D Frame 

 
3D Structure 

 
PreDesign 

Problem description 

Slabs, slab-
systems or other 

2D elements 
loaded 

perpendicularly 
to their planes 

Plane stress 
problems, shear 
and load bearing 
walls, elements 
loaded in their 

planes 

Structure with 
long extension 
and uniform 

section such as 
retaining walls, 

pipes etc. 

Two and three-
dimensional 
frames and 
trusses with 

arbitrary loads 

3D structures 
include 

combinations of 
shell elements, 

slabs, walls, bars, 
beams, columns 
and foundation 
elements with 
arbitrary loads 

Pre-calculation 
for reactions and 
internal forces of 

load bearing 
walls and 

columns of 3D 
structures. 

      
Analysis 

Linear 
Non-linear 
Dynamic 

Cracked-section 

Linear 
Non-linear 
Dynamic 

Cracked-section 

Linear 
Non-linear 
Dynamic 

Linear 
Non-linear 
Dynamic 

Imperfections 
Second order 

Stability 
Seismic 

Cracked-section 

Linear 
Non-linear 
Dynamic 

Imperfections 
Second order 

Stability 
Seismic 

Cracked-section 

Linear 
Non-linear 

Cracked-section 

Foundation design 

    Isolated 
foundation 

Wall foundation 
Foundation slab 

 

RC Design 

RC slab 
RC beam 
Punching 

RC wall  RC bar RC shell 
RC bar 

Punching 

 

Steel Design 

Steel beam   Steel bar Steel bar 
Steel bar-shell 

 

Timber Design 

Timber slab 
Timber beam 

Timber panel  Timber bar Timber panel 
Timber bar 

 

File format 

.pla .wal .pls .frm .str .prd 
 

Table: The Design Modules 

Starting Program 
 
FEM-Design modules can be started from dialogs appear after choosing one of the following ways: 
 

- Click Start button of Windows status bar and select All Programs > FEM-Design… 

- Double click the short-cut , if it is placed on the Desktop. 
- From FEM Design Center 
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FEM-Design Center helps to reach all the modules, useful links, updates and links to the add-ins in 

one place and much faster.  

 

 

CTRL + Left mouse button will open the last model 

Shift + Left mouse button will open history in a jumplist 

We suggest the User to pin the command center so right clicking the icon on the tray will open a 

jumplist where all the modules available. 

 

 
Starting a design module (or a new project) offers codes for structure design. Code selection influences: 

- the range of available modeling materials, 
- automatic combination of load groups, and 
- the method and result of foundation, reinforcement, steel and timber design. 
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Figure: Design codes 

  The current code of a project can be modified any time during input process (structure and load 
definition) at Settings > All... > Calculation > Code, configuration. Changing a code will modify all 
materials and design parameters according to the selected new code by using an editable 
conversion table. 
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BASIC CONCEPTS 
 

 

User Interface 
 

Each module has a similar user interface and contains the following parts: 

 

- Menu bar 
- Toolbars 
- Tabmenus 
- Status bar 
- Application window 
- Tool palette 

- Dialog 

            

Figure: FEM-Design user interface 

Menu Bar 

 

The Menu bar contains file operations (File), drawing (Draw) and editing commands (Edit), assistant tools 

(Tools), settings (Settings), views (View), window-system (Window) and user-guides (Help). 

Menu commands having icons next to their names can be organized in Toolbars around the Application 

window. Some commands can be executed by hotkey displayed behind the command name. 

  

Toolbars 

Menu bar 

Tabmenus 

Dialog 

Tool palette 

Application 

window 

Status bar 
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Toolbars 

 

The Menu bar commands can be grouped in toolbars with their icons and placed next to Application 

window.  

By default, the Standard and the View toolbars are displayed and the other toolbars are hidden. If you 

right-click anywhere on the menu or on one of the displayed toolbars, a list appears, where toolbars can 

be set visible or hidden. 

 

Figure: Available Toolbars and the Customize tool 

Customize… allows you to edit the command content of the toolbar, on which the right-click is used. 

A toolbar can be moved into new position by dragging it with its “thick vertical line” start. 

Tabmenus 

 

Tabmenus contain the main functionalities and their order displays the recommended structural design 

workflow. 
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Tabmenu Function 

 Tools to define axis and storey system, structural elements, supports and 

connections 

 Tools to define load cases, loads, load combinations and load groups 

 Tools to define finite elements and finite element mesh 

 Tools to run analysis for the current project and to display results 

 Tools to run automatic and manual design for concrete elements and to display 

results 

 Tools to run automatic and manual design for steel bars and to display results 

 Tools to run automatic and manual design for timber elements and to display 

results 

Table: Tabmenu types 

By default, Tabmenus have different Object layer settings to protect their elements from the others. That 

means, for example, structural elements (defined at Structure tab) are protected against load editing 

(Load tab) although they can selected for load definition. Of course, the available layers of tabs can be 

customized (Status bar > Current layer). 

The optional module Documentation can be launched from the Tabmenus bar. 

Status Bar 
 

The Status bar is situated under the Application window and separated into the following parts. 

 

 

Figure: The parts of the Status bar 

- Co-ordinate box 
It shows the exact coordinates of the crosshair cursor in the current co-ordinate system. 

Coordinates can be also given for point/direction definition in a dialog appears after clicking 

on the Co-ordinate box (see Entering Co-ordinates). 

- “Current layer” button 
Clicking the button opens a dialog contains the layer-system of the current project. All layer 

operations like defining new, renaming, color-assignment, showing/hiding and deleting are 

available in the layer-system dialog. The “Current layer” button displays the name of the current 

drawing layer. 

- “Current style” button 

Command 

line 

Co-ordinate 

box 

Layer box 

Point/Direction 

editor 

Object snap 

tools 



10 

 

This button shows the line type currently available for drawing lines, arc, circles, edges etc. 

(Draw menu). Clicking the button opens a dialog, where new line type can be defined or line 

types can be edited. 

- Point/Direction editor 
Editor tools provide reference points and lines by using existing lines and points during element 

definition, drawing and editing. 

- Object snap tools 
Here you can set the snapping distance and turn object snaps on and off. 

- “Current color” button 
Here you can set the drawing color independently from the color of the current drawing layer. 

This color is used for numeric values on result figures too. 

- “OK” and “Cancel” buttons 
These tools approve or reject the current operation. 

- Command line 

Here you can directly communicate with the program for example by typing coordinate values 

in it. In the command line coordinates can be defined in several ways (see Entering Co-

ordinates). Command line also displays additional messages to show the steps of the current 

command. 

Application Window 

 

Two main windows types are available in FEM-Design: 

- Graphical window 
It works as a drawing board and displays the model defined in the current project.  

- Detailed result window 
Analysis and design results with detailed background calculation formulas (code references), 

figures and tables can be displayed by single elements or by design groups in separate 

windows. Quick navigation is powered with zooming details. 

An arbitrary number of windows can be opened (Window menu) to show for example a model in 

different views at the same time. The list of the currently available windows is shown at the bottom of 

the windows (tabs) and in the Window menu. You can swap between the windows by clicking on their 

name tabs or by choosing the requested one in the Window menu. Applied windows can be arranged by 

Window > Arrange. Right-clicking on a window tab, the window’s name can be edited.  

 

Figure: Application windows 

Tool Palette and Dialog 
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In most cases, a command/tool has own palette (Tool palette) that contains its definition and setting 

tools. 

           

Figure: An example for tool palette (Beam command in 3D Structure module) 

The parts of a tool palette are: 

- Toolbar 
It gives the editing modes and their additional tools. The main editing modes are: 

 Define: creates new objects according to its current settings (“Default settings”). 

See more Element Definition. 

 Properties: asks and/or changes the properties of selected object(s). 

See more Object Properties. 

- “Default settings” 
If this button has 3D shape, then you can set all default parameters for the new object. 

Otherwise, it only shows the symbol of the function. 

- Main settings 
The frequently changed parameters of the new object (Define) can be set directly in tool 

palette. 

You can usually use a dialog to modify the settings, the properties of a command; it contains text and 

number fields where you can set parameter values. 

The main difference between dialogs and Tool palettes is that you can work beside an opened tool palette, 

but cannot at a dialog. 

There are three main switch types at a dialog or a tool palette: check boxes, radio and chain buttons. 

In case chain button exists and it is “Active” (pushed in), any changes made to the related edit box will 

be transferred to the next edit box automatically. It gives a quick definition of defining surface elements 

with constant thickness, loads with constant intensities etc. 

  

Default 

settings 

file://///officesrv/strushare/Ricsi/new%20features/Properties%23_
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Figure: Function of chain buttons 

Program Settings 
 

Clicking Settings > All opens a dialog with all available settings of the program and the current project. 

 

Figure: Project and program settings 

The settings are valid for the current project, but they can be extended for later projects by saving them 

as default settings. OK closes the dialog and validates the settings for the current project. Save as default 

set the “selected” project settings available for next projects and new files. 

 “Selected” means that Save as default works only for the branch belongs to the list/folder title 

selected by the cursor. For example, apply Save as default for “Environment” to save the General, 

the Directories and the Cursor settings as default, or select “Settings” and click Save as default to 

store all current settings as default values. 

The range of available settings depends on the currently opened Tabmenu. For example, all 

setting are available at launched “Structure” tabmenu, but the settings are reduced with e.g. finite 

element (Mesh) settings in case of activated “Analysis” tabmenu. 

The program stores project and default settings in the fem.ini file can be found in the “FEMData” 

folder of the installed program. 
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New program release can use the default settings of the previous release, if you keep them after 

the first running of the new release in a warning message dialog. 

Environment 
 

General settings enable the user to adjust the main program settings affect on startup, system, rendering 

and display style. 

- Check for update at start 
By default, the program informs the user if a new official release of the current FEM-Design 

version is available. 

- Check for upgrade at start 
It sends a message if a newer commercial FEM-Design version is released. In this case, the newer 

version can be downloaded, but it can be run only in demo mode till renewing the current 

license agreement (please contact your local distributor). 

- Auto load last drawing 
Checking this box opens the last project at program start-up. 

- Language 
By default, the user interface is displayed in the installation language. Ask your local distributor 

about the available languages in your country. 

- Timesave [min] 
It defines the time period in minute for automatic project saving. Read more at Data safety. 

- Undo steps 

The number of executable undo steps can be set in the field. But do not forget, that there are 

some complex calculation processes (analysis, mesh preparing etc.) Undo does not work on. 

- Graphic engine 
The suitable graphic engine can be set here by choosing “DirectX” or “OpenGL” according to 

the video card. 

The DirectX graphic engine is faster than OpenGL on most of the computers. We recommend 

the User to check which graphic engine performs better on his computer. 



14 

 

 

For more information about the graphic engine read the Remarks. 

 If you have any rendering problem with the default graphic engine, apply the other one. 

In case of further troubles, download the latest driver of your graphic card. 

“Safe mode” is developed to protect the program from possible video drive crashes. If no 

graphic problem is detected with the current driver, uncheck this box to take the full 

advantage of the new powerful graphic engine and to reach the maximum rendering 

speed. 

- Enable Win8/Win7/Vista style 
By default, the user interface is developed in the height of Microsoft Windows 8, 7 and Vista 

fashion. Unchecking the box a simpler interface will be available after restarting the program. 

- Window background 
The color of the drawing background (graphical windows) can be set here. The default and 

suggested color is white. Objects having the same color with the background are always 

displayed in inverse color. 

- Display information pop-up 
If there is no running command, moving the cursor over an element displays an Information pop-

up with the element’s main properties. Depending on the currently used working mode 

(Structure, Loads etc.), pop-up is available for different elements (structural elements, loads etc.) 

only. For example, the pop-up displays the ID, the material, the thickness, the alignment and 

orthotropic features for Plates in Structure mode. 
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Figure: Information pop-up examples 

Directories settings allow the user to specify the location of FEM-Design files. 

- Temporary 
The program stores temporary files during calculations and mesh generations in the given 

folder, which will be automatically removed, if the operations are done successfully. Remained 

temporary files can be erased from the Temporary folder after closing the currently opened 

project. The changes made in Temporary directory will affect after the program is restarted. 

- Working 
The default favorite folder can be set here for the open and save commands. 

The style of cross-hair cursor can be set in Cursor dialog. It can be full-sized in graphical windows or 

custom-sized (Limited) by the scroll tool. 

Drawing 
 

Title dialog allows the user to specify the content of drawing title block (Draw > Title information table) 

and the header title of printing (File > Print). Project, Description, Designer, Signature and Comments 

attributes are autotexts. That means, modifying their content updates all titles used in the current 

project. These five title attributes can be used in documentation and reinforcement list templates with 

the help of Field tool (Draw menu). 



16 

 

 

Figure: Title information table 

Scale has effect in displaying texts, line types and wall hatches in graphic windows. Of course, printing 

scale can be set independently from drawing scale. 

Param settings allow the user to specify the default initial settings for drawing (Draw menu commands) 

in the current or later projects (Save as default). Line type, pen width and drawing color can be edited 

independently from the default values with the Status bar tools “Current style”, “Current layer” and 

“Current color”. 

Text settings enable the user to set the default font style and sizes for general text items. 

 Text setting effect 

Drawing Title block yes 

Structural element ID and label yes 

Design data label yes 

Load label yes 

Mass label yes 

Support ID and label yes 

Default settings of Draw > Text yes 

Default settings of numeric result values yes 

Draw > Dimension no 

Grid axis label (Structure > Axis) no 

Storey label (Structure > Storey) no 

Finite element and node ID 

(Settings > Display > Mesh) 

no 

Table: List of elements on which Text setting has effect or not 
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Dimension, Axis and Storey tools and the finite element display have individual text settings from the 

general Text settings. 

 Script solves the character problems of different languages. For example character “ő” appears as 

“õ” in “Western”, but as correct “ő” in “Central European” script. 

 Size is defined in real values (mm), so text size varies on drawings by modifying its Scale. 

 The Width factor 1.0 refers to the normal character width, so factor smaller/greater than 1.0 results 

a condensed/extended text. 

 For “italic” style use Slant between 10 or 15 degrees. 

Calculation 
Calculation includes settings influence structural behavior, finite element mesh generation, analysis and 

result. 

Code displays the current and available design code for the current project. Code influences: 

- the range of available modeling materials, 
- automatic combination of load groups, and 
- the method and result of reinforcement, steel and timber design. 

Changing the current code erases the materials, the design parameters and the results in the project, so 

these properties have to be redefined to run valid calculations later. 

Read more details from other Calculation settings in the connected topics: 

- “Rigid” values 
The default value of “infinite rigidity” can be set for supports, connections and fictitious bars 

by types. 

- Mesh 

Mesh and peak smoothing settings of automatic finite element mesh generation. 

Perform gives additional features to data safety. 

- Analysis 

In Analysis you can decide the way of Automatic save, in Find identical copies before 
calculation for you can set if the program should check the identical copies of structural 
elements and/or loads and in Warnings it can be checked if the program should warn about 
using non-linear elements in a linear calculation. 

 
- Result 

Options define the calculation sections of bars and affect on detailed results of bars. 

 

Display 

 

The current and default display settings of the drawing elements, numbers, structural objects, loads 

and finite elements/mesh can be set here. 
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Displaying structural and analytical element ID’s is separated in order to avoid duplicate labels on the 

screen. The required ID can be set by Bar and Shell elements in Display settings dialog. 

 

Figure: Display settings (Bar, Shell) 

Window 

 

Co-ordinate systems include the display settings of the Global and the User-defined (UCS) co-ordinate 

system symbols. The symbols are shown in the defined size in working windows, but they can be 

hidden by unchecking the Display co-ordinate systems box. 

Grid defines the distribution settings of the visible Construction grid. The grid can be hidden by 

unchecking the Display grid box. The grid lines can be set to be parallel with the axis directions of the 

Global (Ground) or UCS system. 

All default settings of Object Snap tools are grouped in Snap dialog. 

In different windows different scales can be defined, which is especially useful in documentation 

module. By choosing an appropriate scale factor the displayed labels are easy to read. In another 

window the parameters can be decreased to highlight another result. 

Units setting offers various unit types for modeling (length, angle, force, mass and cross-sectional data) 

and for results. Stress and displacement units can be set independently of the length and force units. 
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Figure: Available units 

Data Safety 
Time saving and protection system ensures more the data safety of working files. 

Time Save 
 

FEM-Design automatically saves copy of the working file by given time period. 

The saving time period can be set in minutes at Settings > All > Environment > General > System > 

Timesave.  

 Working on a project file called e.g. “steel construction.str” in the  3D Structure module with 

a 15-minute time save period, an extra file will be generated and updated by the time period (0, 

15, 30min …) with special extension and in a hidden folder: 

Rules of time save: 

- In case of a program crash, the last saved copy opens automatically in the right module. 
- If you successfully exit from FEM-Design after saving the current project, its time save copy will be 

erased from the recovery folder. 
- The location of time save files cannot be modified for data safety. 

 Additional automatic savings can be set before and after calculations at Settings > Calculation > 

Analysis > Automatic save…, but automatic savings overwrite the original project file. 

Recovery files 

 

Recovery file command in File menu is for managing time-save files which are generated after some 

unexpected events. Its tool-window: 
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Figure: Recovery file dialog 

You can open the desired version and delete the useless ones, and you can also set the sorting criterion, 

by clicking on File / Date / Size. 

Protected Work File 
 

All working files are locked not to be modified, overwritten by another user or process. Starting a 

project, a file having the project name with .lck extension is generated automatically, which guarantees 

the protection till closing the working file. 

Opening a protected file sends the warning message: “The file is locked by another user or process.” You are 

allowed to open and modify the content of a protected file, but changes can be saved only under a new 

name (File > Save as). 

Element Types 
 

Two main types of elements are available in FEM-Design: Drawing elements and (structural) Objects. 

These element types are stored in different Layer-systems and have different kind of property and 

display settings. 
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Drawing Elements 

 

Type Command Property and Display Settings 

Point Draw > Point Settings > Drawing > Param, “Current layer” 

Line Draw > Line Settings > Display > Drawing elements, 

  “Current style”, “Current layer” 

Rectangle Draw > Rectangle Settings > Display > Drawing elements, 

  “Current style”, “Current layer” 

Arc Draw > Arc Settings > Display > Drawing elements, 

  “Current style”, “Current layer” 

Circle Draw > Circle “Current style”, “Current layer” 

Region Draw > Region Settings > Display > Drawing elements, 

  “Current style”, “Current layer” 

Solid Draw > Solid Settings > Display > Drawing elements, 

  “Current style”, “Current layer” 

Text Draw > Text Text tool > Default settings, 

Field Draw > Field Field tool > Default settings 

Dimension Draw > Dimension Dimension tool > Default settings, “Current style” 

Title 

information 

table 

Draw > Title information table 

 

 

Text tool > Default settings, “Current style”,  

Settings > Title, “Current layer” (! Object layer) 

 

 

Table: Drawing elements 
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Objects 

 

Type Command Property and Display Settings 

Axis ,  Axis Axis tool > Default settings, “Current layer” 

Storey ,  Storey Storey tool > Default settings 

Soil ,  Soil 
Settings > Display >Soil and foundation, Soil tool > 

Default  

settings   

Borehole ,  Borehole 

Settings > Display >Soil and foundation, Borehole tool > 

Default  

  settings 

Isolated  

,  Isolated 

foundation 

Settings > Display >Soil and foundation, Isolated 

foundation   

foundation  tool > Default settings 

Wall  ,  Wall foundation Settings > Display >Soil and foundation, Wall foundation   

foundation  tool > Default settings 

Foundation  ,  Foundation slab Settings > Display >Soil and foundation, Foundation slab   

slab  tool > Default settings 

Beam ,  Beam Settings > Display > Drawing elements and Bar 

  

“Current style”, “Current layer”, Beam tool > Default 

settings 

Column ,  Column Settings > Display > Drawing elements and Bar, 

  “Current layer”, Column tool > Default settings 

Intermediate 

,  Intermediate 

section 

Intermediate section tool > Default settings Drawing 

elements  

section              and Bar 

Apex ,  Apex Apex tool > Default settings 
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Corbel , Corbel 

Settings > Display > Drawing elements and Bar 

Corbel tool > Default settings 

Truss 

member ,  Truss member Settings > Display > Drawing elements and Bar, 

  

“Current style”, “Current layer”, Truss member tool > 

Default settings 

Plate ,  Plate Settings > Display > Drawing elements and Shell, 

  “Current layer”, Plate tool > Default settings 

Wall ,  Wall Settings > Display > Drawing elements and Shell, 

  “Current layer”, Wall tool > Default settings 

Profiled panel ,  Profiled panel Settings > Display > Drawing elements and Shell, 

  “Current layer”, Profiled panel tool > Default settings 

Timber panel ,  Timber panel Settings > Display > Drawing elements and Shell, 

  Timber panel tool > Default settings 

Support 

, 

, Settings > Display > Drawing elements and Support, 

 

Supports Settings > FEM > “Rigid” values, Support tools > Default 

settings, “Current layer” 

Connection , , Connections Settings > Display > Drawing elements and Connections, 

 

 Settings > FEM > “Rigid” values, Connection tools > 

Default settings, “Current layer” 

Fictitious bar , , Fictitious bar Settings > Display > Drawing elements, “Current layer” 

 

 Settings > FEM > “Rigid” values, Fictitious bar tool > 

Default settings 

Fictitious 

shell 
, , Fictitious shell 

 

Load , , Settings > Display > Load, “Current layer”, 

 Loads Load tools > Default settings, 

Finite element , Finite element tools Settings > Display > Mesh, “Current layer”, 

  Settings > FEM > Mesh and Calculation 
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RC bar  ,  Settings > Display > Design, “Current layer”, 

 Auto design and Manual design Auto design and Manual design tools > Default settings 

Steel bar , ,  “Current layer” 

stiffener Steel bar stiffener  

Table: Objects 

 

Layers 
 

The FEM-Design layer-system helps you to work in a well-organized way in drawings and in models 

while constructing and documenting. The layers can be considered as transparent papers put on top of 

each other will seem to be one drawing. All layers can be reached in a dialog appears by pressing the 

Current layer button. 

Layer Types 
 

Regarding the element types there are two main layer types: “Drawing” and “Objects”. 

 

 

Figure: “Drawing” and “Objects” layers 

“Drawing” layer contains all drawing elements defined by the Draw menu commands or generated 

from DWG and DXF imports. Drawing layers can be renamed and erased, and their colors and states 

can be edited. Only the default “0” layer cannot be deleted and edited. At the same time only one 

drawing layer called “Current” can be used for drawing. The name of the “Current” layer is appears on 

the Current layer button. The “DIM” layer is a special drawing layer for the dimensions. It is 
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automatically created by using the Dimension command (Draw menu). ”Drawing” Layers can be 

excluded from the Object Snap by checking the „No snap” option 

 

Figure: „No snap” option 

“Objects” layers are built-in layers for objects like plate, wall, column, supports, loads etc. Each object 

type has an own layer (e.g. walls are displayed on the “Wall” object layer). Objects layers are not allowed 

to be deleted and renamed, but their states and the display colors and pen width of objects can be edited. 

”Objects” Layers can also be excluded from the Object Snap by checking the „No snap” option. 

 

Layer Status 
 

Layer Status Symbol Function 

Hidden  The layer content is hidden in graphic windows 

Protected  The layer content is visible, but protected from editing 

Active  The layer content is visible and editable in graphic windows 

Table: Layer status 

 

In Layers dialog changing the layer status is real-time, which means that the selected active (hidden) 

drawing or object layers become hidden (active) without closing the dialog. 

Editing Layers 

 

Tool Function Available for layer type 

Make current Sets selected layer to be the current one Drawing 
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New… Creates new layer in the available layer list Drawing 

Rename… Modifies the name of the selected layer Drawing 

Delete Deletes the selected layer from the layer list 

 Delete function cannot be undone 

All elements will be erased of a deleted layer 

Drawing 

Clear Removes all elements of the selected layer 

 Clear function cannot be undone 

Drawing 

Color… Modifies the current color of the selected layer 

Defines the current drawing color 

Defines the display color of Objects 

 Color can be modified by elements with 

     Edit > Change appearance 

Drawing, Objects 

Drawing 

Objects 

Pen… Sets the pen width assigned to the selected layer 

Defines the current drawing pen width 

Defines the display pen width of Objects 

 Pen width can be modified by elements with 

     Edit > Change appearance 

Drawing, Objects 

Drawing 

Objects 

Select all Quick selection of all layers Objects 

Deselect all Deselecting currently selected layers Objects 

Objects Quick selection structural object layers Objects 

Statical system Quick selection of Supports, Modeling tools and 

finite element/mesh layers 

Objects 

Load cases Quick selection of load (cases) layers Objects 

Table: Editing layers 

 The full content of an Objects layer can be erased with Tools > Delete all. The objects deleted with 

Delete all can be restored with Edit > Undo. Delete all erases the objects of protected layers too! 
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Co-ordinate Systems 
 

Various co-ordinate systems are available in FEM-Design with different function, properties and 

display settings. 

 Global co-ordinate 

system 

User-defined co-ordinate 

System (UCS) 

Local co-ordinate 

System  

Function Definition of co-ordinates 

Definition of directions 

Interpretation of results 

- 

Definition of co-ordinates 

Definition of directions 

- 

- 

- 

Definition of directions 

Interpretation of results 

Definition of profiles 

Type Right-handed Cartesian Right-handed Cartesian Each structural object has got 

Its own right-handed Cartesian 

co-ordinate system 

Axes X, Y, Z X, Y, (Z) x’, y’, z’ 

Symbol 

   

Symbol color Fixed 3 colors, 

X = green 

Y = red 

Z = blue 

Fixed 2 colors, 

X = cyan 

Y = orange 

User-defined 3 colors, 

Settings > All > 

Display > Local systems 

Position Fixed User-defined: 

- View > UCS 

-  moves the origin to the 

   position of the cross-hair cursor 

-  +  moves origin 

   back to the origin of the Global 

   system 

Fixed for an object  

Direction Fixed User-defined: 

- View > UCS 

Changeable: 

Edit > Change direction 
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-  +  resets the 

   directions to the original state 

Show/Hide Settings > All > Window > 

Co-ordinate systems 

Settings > All > Window > 

Co-ordinate systems 

By element types: 

Settings > All > Display 

Symbol size Settings > All > Window > 

Co-ordinate systems 

Settings > All > Window > 

Co-ordinate systems 

By elements types: 

Settings > All > Display 

Table: Co-ordinate systems 

User-defined co-ordinate system (UCS) is developed in order to easily define coordinates and directions in 

a 2D user-defined working plane. 

  



29 

 

Point Definition with Co-ordinates 
 

Points can be defined with their co-ordinates in Descartes or Cylindrical co-ordinate systems. 

 

Figure: Co-ordinate system types for point definition 

 

Point co-ordinates can be defined in various unit types available at Settings > Units (Length and Angle). 

The crosshair cursor position can be displayed on the Status bar in the Descartes or in the Cylindrical co-

ordinate system by clicking the  symbol of the Co-ordinate box. 

Descartes Orthogonal Co-ordinate System 
(Cartesian co-ordinate system) 

The individual co-ordinates represent the distance of the point from the origin of the orthogonal co-

ordinate system (absolute) or from a previously defined point (relative) measured along X, Y and Z 

axes. Cartesian co-ordinate system is available for co-ordinate definition both in the Global co-ordinate and 

the UCS systems. 

Cylindrical Co-ordinate System 

(Polar co-ordinate system) 

Point is defined by three components: an angle (a1) and two distances (d1 and d2). The a1 and d1 co-

ordinates define the point position in the XY plane of the Global co-ordinate and the UCS systems, d2 sets 

the distance from the XY plane. The angle and the distances can be given from the origin of the co-

ordinate systems (absolute) or from a previously defined point (relative). 

Co-ordinate Definition Modes 
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Point co-ordinates can be defined by typing them in the Command line or the Co-ordinate box of the Status 

Bar, or just by mouse-clicking combined with the Object snap tools in the drawing area or in special 

points. 

Absolute co-ordinate definition 
Co-ordinates of a point are defined as distances/positions from a co-ordinate system origin. 

 

 

Figure: Absolute co-ordinates given in Command line and Co-ordinate box 

  

Co-ordinate box 

Command line 
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 Descartes Orthogonal System Cylindrical co-ordinate system 

 Global co-ordinate 

system 

UCS 

system 

Global co-ordinate 

system 

UCS 

system 

 2D 

Command 

line 

- X_Y or X,Y 

 

Example: 

 

- P_a1_d1 

 

Example: 

 

Co-

ordinate 

box 

    

 3D 

Command 

line 

- X_Y_Z or X,Y,Z 

 

Example: 

 

- P_a1_d1_d2 

 

Example: 

 

Co-

ordinate 

box 

    

 

Table: Absolute co-ordinate definition modes 
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Rules of co-ordinate definition: 

- Co-ordinates given in Command line are valid only in UCS. But, if the UCS and Global system are in 
the same position (same origin and same axis directions), the defined point will be in the similar 
position in both two systems. 

- Decimal point has to be defined as “. ” and not “,”. 
- If you do not give Z value in the 3D modules, its value will be automatically zero. 
 

Relative co-ordinate definition 

 

There are three ways to define a point with given distance from another point (called “relative co-

ordinates”). 

Relative coordinates can be defined both in the Descartes and the Cylindrical co-ordinate systems and 

both in the Global and the UCS systems. 

Relative (A): Distance from the last defined point 

Distance from the last point can be defined in the Command line or with the Co-ordinate box. This mode 

is useful while creating line/polyline/polygon/surface with the distance from the start/previous point. 

Steps Command Line Co-ordinate box 

1 Define the start/previous point 

2 2D 

 Type the distance co-ordinates as: 

R_X_Y or @X,Y 

 

 

 

 

Example: 

 

Launch the Co-ordinate box dialog, 

change Origin to Last point, and give the 

distance co-ordinates. 

 

Example: 

 

 3D 

 Type the distance co-ordinates as: 

R_X_Y_Z or @X,Y,Z 

Launch the Co-ordinate box dialog, 

change Origin to Last point, and give the 

distance co-ordinates. 
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Example: 

 

 

Example: 

 

Table: Relative (A) co-ordinate definition modes 

 

 

Figure: Meaning of Relative (A) way in case of beam and plate definition 

Relative (B): Distance from a selected point 

With the help of function key  and the Co-ordinate dialog box, a point can be defined from the point 

on which the cross-hair cursor is left. The steps of definition: 

1 Leave the cursor above the required point found by one of the Object snap tools, which you 
would like to define the distance from. 

2 Click  function key.  
3 Set the distance co-ordinates in the Co-ordinate dialog according to a selected co-ordinate system. 
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Figure: Column definition with the distance from a slab corner or from a beam endpoint (Relative (B) way) 

Relative (C): Point defined on line/edge with the distance from the end point 

With the help of function key  and the Co-ordinate dialog box, a point can be placed accurately on a 

line/edge defined with a given distance from the closer end point of the line/edge. The steps of 

definition: 

1 Leave the cursor above the required line/edge found and next to its end point you would like 

to define the distance from. The  “Nearest” Object snap tool helps you to find the 
line/edge. 

2 Click  function key. 
3 Set the distance (d) from the closer end-point you left the cursor in the appeared dialog box. 

 

 

Figure: Column definition on a beam by using the Relative (C) definition mode 
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Calculator 

If you press  while defining numeric values in a field of a dialog box, the Windows Calculator comes 

up. It is automatically filled with the content of the edit box. When you close the Calculator, the value 

calculated or typed in it will be written into the numeric field. It can be used with both Normal and 

Scientific views of the Calculator. 

 

Figure: Calculator used in numeric fields of dialog boxes 

Working Plane 
 

The default working plane – where the points and coordinates are defined – is the following by different 

FEM-Design modules. 

       

Design modules Section Editor 

Global XY plane Global XY plane Global YZ plane 

Gravity direction  

Global Z direction Global Y direction  

Table: The default working plane by FEM-Design Modules 

As the User-Coordinate system defines the working plane, its custom position can be set by the UCS 

definition tools. The  UCS command (View menu or toolbar) gives different definition ways 

depending on the applied FEM-Design module. 
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UCS definition tools Function Note 

 Axis 
Defines vertical working plane by the 

global Z axis and a selected axis 

Available only in the 3D modules 

 Storey 
Defines horizontal working plane in the 

plane of a selected storey 

Available only in the 3D modules 

 Object plane 
Defines working plane in the 

plane/reference plane of a selected 

drawing/structural region 

Available in all modules, but it has not 

effect on the default working plane in 2D 

modules, where only the position of the 

origin changes 

 3 points 
Defines working plane with 3 given 

points in their common plane  

Available in all modules, but it is useful in 

3D modules, where the working plane can 

be set in arbitrary 3D position with 3 

arbitrary points 

 Global XY plane 
Sets the working plane in the global XY 

plane 

Available in all modules, but it has not 

effect on the default working plane in 2D 

modules, where only the position of the 

origin changes 

 Global XZ plane 
Sets the working plane in the global XZ 

plane 

Available only in the 3D modules 

 Global YZ plane 
Sets the working plane in the global YZ 

plane 

Available only in the 3D modules 

 Origin 
Move the current working plane 

parallel with its original position into a 

given point 

Available in all modules, but it has not 

effect on the default working plane in 2D 

modules, where only the position of the 

origin changes 

Table: UCS – working plane definition tools (in Design modules) 
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Figure: Working plane set into one of the global coordinate planes 

 

 

Figure: Custom-defined working planes 
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 It is very important to set correct position (plane) for the structural model. For example, although 

the default working plane is the Global XY plane in the 3D design modules, place the model of a 

2D frame in a vertical (Global Z) plane with the help of a vertical working plane, because the 

gravity direction is always the Global Z axis direction. 

 

 

 

Figure: Correct model (plane) definition of a 2D frame done in the 3D Frame module 

The program automatically sets the working plane into the reference plane of a planar element (plate, 

wall, surface support, surface load etc.), if you use the Hole tool to cut hole in a structural element or a 

load.  

 

Figure: Hole definition automatically sets the working plane into the plane of the attached object 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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Grid Systems 
 

The program offers a number of aid tools finding specific points and directions while drawing and 

editing. These are the Grid system and the Object snap tools. 

Two grid systems are available in the program: Construction grid and Snap grid. 

Construction grid 
By default, Construction grid is the grid visible in the working plane. Of course, it can be hidden at the 

program settings (Settings > All > Window > Grid). That grid sets the characteristic sizes of your project. 

 

Figure: Construction grid and its settings 

You can snap to the raster points of the Construction grid permanently by activating the  “Raster” 

Object snap tool and temporarily by holding down  function key. By default, the grid directions are 

parallel with the UCS axis directions, so you can rotate the grid together with the UCS. 

Snap grid 

Although Snap grid is an invisible grid, you can join to its raster points permanently (Raster tool) or 

temporarily  as written before at Construction grid. The distribution of the grid can be set at Object 

snap tools or at Settings > All > Window > Snap. The grid distribution can be set as default for the 

project/program in the latter setting dialog. 
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Figure: Snap grid and its settings 

The X and Y directions are always parallel with the UCS axes. 

Settings affect the Snap grid (Raster dialog box): 

- Dot cursor 
If it is active, a small black dot shows the grid points at applied Raster snap. 

- Sensitivity 

It sets the sensitivity area of the raster snap for both the grids and other snapping tools. The 

sensitivity is constant while zooming. 

Object Snap Tools 
 

The Object snap tools finds and joins to special points of drawing elements and objects. The cursor form 

changes to the symbol of the actually used Object snap tool. A snap tool can be activated permanently by 

clicking its icon on the Status bar or checking its box in the Raster dialog box. The dialog shows the 

hotkeys of the snap tools activate the current tool temporarily while holding down the key. 

Object snap tool Function Hotkey Example 

Select closest/ 

Farthest point 

 

 

Two states: finds the closest 

or the farthest point/element 

from the overlapped ones 

- 

 

Raster 
 

Activates the Snap grip and 

finds its points  
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Orthogonal 
 

Defines straight directions 

parallel with the UCS axes 

Available for line-type 

elements 

 

 

End point 
 

Joins to point, corner point 

and endpoint  

 

Middle 
 

Joins to line/edge midpoint 
 

 

Center 
 

Joins to the center of circle/ 

arc/circular surface  

 

Nearest 
 

Finds line/edge with its 

points 

It joins to line/edge with the 

closest point to the cross-hair 

 

 

Perpendicular 
 

Locates the point on an 

element that forms a 

perpendicular line to it from 

the last set point 

 

 

Intersection 
 

Finds the nearest intersection 

point of two elements  

 

Tangent 
 

Locates the point on a 

circular/ curved element that 

forms a tangential line from 

the last set point 

 

 

Table: Object snap tools 
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Settings affect to the Object snap tools (Raster dialog box): 

- Dot cursor 
If it is active, a small black dot shows the points found by the applied Raster tool. 

- Symbol cursor 

If it is active, the symbol of the current Object snap tool when the cursor finds the similar snap 

point. 

- Sensitivity 
It sets the sensitivity area of the raster snap for both the grids and other snapping tools. The 

sensitivity is constant while zooming. Too high Sensitivity value makes more difficult to find a 

point from the neighbors close to it. 

 Snap will not work on objects obscured by other elements (such as surfaces) outside of Wireframe. 

 

User can exclude entire Drawing layers from the snapping on its objects. For more information see „No 

snap” option. 

 

 

Input Devices  
 

The following figure summarizes the main keyboard and mouse functions. Of course, these functions, 

which depend on the current working mode (drawing, editing, selection, documentation or no 

command is running), are mentioned at the related topics of this user manual. 

 

Figure: Keyboard and mouse functions 
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From the above displayed buttons, the following ones have special functionalities during 

drawing/editing: 

…  Activate temporarily the Object snap functions. 

  Defines point on a line or edge by giving distance from the closest end point (Relative 

(C)). 

  Inserts a relative point from the position of the crosshair cursor (Relative (B)). 

  Moves UCS to the position of the crosshair cursor. 

 +  Moves UCS back to the Global co-ordinate system position (original state).  

  Pressing 1st Esc breaks the current command (e.g. placing a structural element). 

For pressing 2nd Esc the active tool palette closes. 

  Opens the properties dialog (Default settings) of the current command. 

  Confirms data input / repeats the last command / finishes multi-selection. 

  Restarts the steps of the current command. 

  Goes back to previous step in a multi-step command. 

Some commands can be accessed by hotkeys. See those commands in the Menu bar or in the 

Toolbars. 

Selections 
Mouse and keyboard selection 

FEM-Design offers various selection modes to select objects for requiring and modifying their properties 

and for editing. If selection is possible, the available selection modes appear in the Command line. 

 

Figure: Selection modes displayed in the Command line 

 Use  to restart selection, if you make mistakes while selecting. 

Box selection 

Rectangular selection box can be defined with two points placed with the  mouse button. Depending 

on the box definition, the box selects elements: 

- that are fully in the defined rectangular area → the end corner of the box is on the 
right from the start one, 

- that are fully or partly (intersected) in the defined area → the end corner of the box is on the 
left from the start one. 
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Figure: Box selection modes 

Object selection 

Use  on an object to select it directly. If you click on a common part of more objects, the first drawn 

one will be selected. 

Holding  pressed and by using  objects can be added to or subtract from the current 

selection. 

Selection of same type elements 

It is a quick selection to select visible elements defined with the same command (e.g. selection of all 

walls created by the Wall command). Just hold down  and select on element (e.g. one wall 

element) with , and all same type elements will be selected (e.g. all walls) independently their 

properties differ or not. 

Select all 

Depending on the current command, all visible elements (e.g. for the Edit > Move command) or all visible 

same type elements (e.g. for the Properties tool) will be selected by using  and  together. 

Multiple-selection 

• ‘+’ sign is drawn if multiply selection is active (by pressing ) 
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• The selection box has different colours depending on the way of the selection: 

a. By ‘left-to-right’ selection (the included objects get selected) the colour of the selection 

box is blue. 

 

b. By ‘right-to-left’ selection (all intersected objects get selected) the colour of the selection 

box is green. 

 

c. By area selection (e.g. to print the selected area) the colour of the selection box is grey. 

 

Multiple selection can be ended by  +  (it has the same effect like pressing ).  

• For pressing  +  in the application window (without any active tool palette) the quick 

menu appears. 

• When a tool palette (e.g. Beam tool palette or Point load tool palette) is active, for pressing  

+  the properties of the items belonging to the active window appear. 
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Filter selection 

Filter is a pop-up window in the workspace, which helps to select the requested objects easily for all 

kind of editing and modifying functions. When clicking on it, the following appears:  

 

With the cursor pointing on Point support group ”+”, “-“ and ”&” buttons appear, enabling the user to 
add or remove point support group elements. If you want to select most, but not all of the point support 
groups, you should click ”+”, and then “Continue” for deselecting the few individual supports not 
needed for the selection.  
The ”&” button works as an “AND” boolean operator: If you want to select the columns on the second 
storey, you have to click ”+” at column and then ”&” at storey 2.  
After closing the Filter palette, it can be switched on again by a right click on any toolbar, or on the 
main menu zone. Another way is available through Settings>All…>Environment>General>View  
where filter palette can switched on and off:  
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User defined filter  in Tools menu is a function for saving some frequently used selections. If you 

define a filter of your own, it will appear at the bottom of the list. When defining, a name has to be given 

and then desired objects have to be selected. A window appears “Filter has been created.”After this, if 

needed, with properties ”?”, the name of the block can be modified; with “+” you can add other 

members, and with “-“, you can remove undesired ones.  

It also can be exploded with :  

 

At first (like in the figure above) “OK” is grey, but after clicking on Explode button “OK” becomes 

active. Don’t forget to validate the explosion with “OK”, before closing this window.  

Point/Direction Editors 
The program offers tools for defining special points and directions while drawing and editing. You 

can reach them from the Status bar. 

Object snap tool Function Example 

Multi steps 
 

Fixes reference points 

defined by the 

following tools 

Define a new point with 

X=Y=1m distances from the 

virtual intersection of two 

predefined lines: 

Launch Point (Draw 

menu), and then activate 

both  and . 

Define the virtual 

intersection of the two 

lines and place the cursor 

close to it. Press  and 

type 1 [m] for X and Y in 

the Co-ordinate dialog box. 
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Pressing  on Status 

bar defines the new point. 

Virtual 

intersections of 

lines 

 
Edits the intersection 

of two lines crossed 

virtually each other 

Start a new line from the 

virtual intersection of two 

predefined lines: 

Launch Line (Draw menu), 

then activate , and 

select the two lines one-

by-one. The new line 

starts from the virtual 

intersection. 

 

 

 

 

Divider point 
 

Edits a point on a 

straight-line with a 

given ratio: 

ratio = the distance of 

the divider and start 

point divided by the 

section length 

Draw a new line from the 

quarter point of another line: 

Launch Line (Draw menu), 

and then activate . 

Define the start and end 

point of the line (section), 

and set the ration to 0.25 

(from the start point). The 

new line starts from the 

quarter point of the 

defined section. 

 

 

Parallel with line 
 

Defines direction 

parallel with a line 

Draw a new line parallel 

with another line starting 

from a point: 

Launch Line (Draw menu), 

and define the start point 

of the new line in the 

point. Activate  and 

select the line. Click the 

point again and finally 

define the end point of the 

new line. 
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Perpendicular 

from line  
Defines direction 

perpendicular from a 

line 

Draw a new line 

perpendicular from a fixed 

point of an arc: 

Launch Line (Draw menu), 

and define the start point 

of the new line in the fixed 

point. Activate  and 

select the arc. Click the 

fixed point again and 

finally define the end 

point of the new line. 

 

Tangent from line 
 

Defines tangent 

direction from an arc 

Draw a new line tangent 

with an arc and starts from 

a fixed point of the arc. 

Launch Line (Draw 

menu), and define the 

start point of the new line 

in the fixed point. 

Activate  and select 

the arc. Click the fixed 

point again and finally 

define the end point of 

the new line. 

 

 

 

Table: Point and direction editors 
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Navigation 
Thanks to the improved video engine, the advantage of all modern displaying technologies such as live 

pan, live rotation, live zoom, special display modes and transparency (see the next chapter) is available 

in FEM-Design. 

 The suitable graphic engine can be set at Settings > All > Environment > General > Graphic 

engine. 

Pan 

Panning view on the drawing area can be done in different ways. “Panning” modifies the current 

view only and not the position of elements. 

 First start Animate pan from the View menu or View toolbar, then press or and drag the 

mouse to pan the current view. If you are in panning mode, you cannot edit the model and the 

currently running command is also paused. Click  to exit panning mode and return to editing 

mode. 

However, while in editing mode, you can temporarily simulate Animate pan by pressing the to pan 

the view. Release the mouse button to stop panning. 

With the command Pan (View menu) the current view can be moved with a displacement vector 

defined by two points. 

Zoom 
Different tools allow you to zoom on the current view. 

Live zoom 

 First start Animate zoom from the View menu or View toolbar, then press or and finally 

move the mouse up to zoom in or move it down to zoom out. If you are in zooming mode, you 

cannot edit the model and the currently running command is also paused. Click  to exit 

zooming mode and return to editing mode. 

However, while in editing mode, you can temporarily simulate Animate zoom by scrolling forward 

to zoom in or backward to zoom out. 

Other zooming tools of View menu 

Zooming tools Function 

Zoom margin 
 

Fits the view to all visible elements and leaves a 5% additional margin around it 

Zoom in 
 

Enlarges the view area defined with a box and fits it to the current window size 

Zoom out 
 

Displays the current view in the defined box area 

Zoom enlarge 
 

Zooms in to the 133% of the actual size 
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Zoom reduce 
 

Zooms out to the 75% of the actual size 

 

Table: Zooming tools 

Orbit 
View rotation can be done in different ways. “Orbit” modifies the current view only and not the 

position of elements. 

 First start Orbit  from the View menu or View toolbar, then press or and drag the 

mouse to turn the model around its center point. If you are in rotation mode, you cannot edit the 

model and the currently running command is also paused. Click  to exit rotation mode and 

return to editing mode. 

However, while in editing mode, you can temporarily simulate Orbit by pressing  together with 

to orbit the model. Release the keys to stop rotating. 

 

Figure: Temporary Orbit 

Alternatively, you can press  together with  to orbit around the closest valid snapping point to 

the cursor; in some cases, this may result in a more predictable orbiting behaviour. Valid snapping 

points include points specified by the Object Snap tool, or outside Wireframe view mode, also the 

closest surface point to the cursor. 

  In Wireframe view mode, surfaces are not 

considered valid snapping points, the 

snapping point will be on the UCS 

In other view modes, like Hidden line, a point 

of a surface can be the orbiting centre. 
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Rotation view can be set in a dialog box too with the command 3D Rotation (View menu). 

             

Figure: Rotation by dialog box 

Views 
Besides of navigation tools, specific built-in 2D and 3D views can be used to set the required project 

view. All views can be stored with given names (user-defined views). 

Built-in views 

Just click one of the following view buttons to set a specific 2D view or a general 3D view: 

User defined views and Home view 

To return frequently to a view of the current project, you can save it as “Home view” (View > Home view 

> Save as). Choose View > Home view > Return to set this view just with one-click. Home view is saved with 

the project. 

Current view can be also saved with names in a dialog appeared by clicking  (View > User defined 

views) or using + . Define a name and click Add to store the view. If you have more than one user 

defined views, Select displays preview of them. To use a stored view as the current one, click Select and 

exit. The list does not contain the Home view. User defined views can be saved with the 2D and 3D View 

commands too. 

 specifies a section view, which contains objects within a given range (Tolerance), while  defines 

a space view perpendicular to a given plane. The section/plane can be defined with the following tools: 

      

Manual definition 

2D Views 

3D Views 

Preview 

Plane view (top view; + ) 

South view (side view; + ) 

East view (side view; + ) 

Space view (general 3D view; + ) 
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Figure: 2D and 3D View commands 

Vertical plane 

Creates a section/view parallel with the global Z axis by selecting two points. 

Horizontal plane 

Creates a section/view perpendicular to the global Z axis by selecting two points. 

 

 

 

Object plane 

The section/view plane is parallel with a selected region (Plate, Wall etc.) plane. The final direction can 

be set by moving the cursor at the selected storey. The view direction is always the opposite of the local 

Z’ direction of the selected surface object. 

3 points 

The section/view plane is defined by adding three points. The first point defines the origin, then the 

second point defines the X direction together with the first one, and finally the third point defines the Y 

directional extension of the plane. The last point also defines the view direction (an arrow shows it). 

User Co-ordinate System 

The section/view plane is set to the X-Y plane of the UCS. The view direction is always the opposite of 

the Z axis of the UCS. 

Dialog 

With this tool, you can define the position of the section/view plane in a dialog box. At 3D View, Dialog 

opens 3D Rotation. 

 

Figure: Section/view plane definitions in dialogs 

Swapping among views 
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Moving one step back from the current view, zoom operations etc., click  (View > Previous view) or 

use + . To go to the next view, click   (View > Next view) or use + . 

Select view 

With this tool, you can select some specific views (Storey view, Axis view and User defined view). 

 

Figure: Example for using Select view command 

 

Figure: List of selectable views 
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After choosing Storey 2 you can see all the elements belonging to the current level, but for example, if 

you have high columns going through the whole building, they will belong only to the level where they 

have been created. You can return to previous view by clicking on the icon  again and then selecting 

“Return to 3D view”.  

You can also obtain cross-sections of the whole building. By choosing axis no. 1. (which is the global X 

axis) in the example above, this is what you can see: 

 

Figure: Cross-section view of the building 

The green dots emphasized with the blue arrows in the figure above indicate the truss elements 

pointing out of the plane determined by the current axis and global Z. 

The name of the selected view is displayed in the upper left corner under the current code. 

 

 

Display Modes 
Thanks to the graphic engine, the following display modes (View menu or View toolbar) are available: 

Wireframe 

or +  displays the model with all edges and lines drawn, but with no surfaces drawn. 

Hidden line 
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or +  displays the model with all edges and lines drawn except those covered by surfaces. 

Shading 

 or +  displays the model with all surfaces shaded according to their assigned layer color. A 

default (non-editable) light source provides illumination for shading. All non-building elements such 

as drawing elements (lines, regions, texts etc.), loads, supports and the grid-system (if not hidden) are 

also displayed in shading mode. 

Shading with edges 

or +  displays the non-occluded edges of the model in addition to Shading mode.  

 

 

Figure: The meanings of the view modes 

Display thickness 

 is a quick tool developed to real-time display or hide 3D solid representation of structural objects 

(Plate, Wall etc.). It’s a switch that can be turned on/off in the View menu/toolbar or by using + . 

 ON OFF 

Beam, Column and Truss member 3D solid Reference line 

Shell 3D solid Reference plane 

Table: The visual effects of “Display thickness” switch status on element types 
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Figure: The statuses of “Display Thickness” 

Hiding Element 

 The hide and show functions are merged in one command called Hide/show objects, which is 

available in the View menu/toolbar or by using + . To hide elements use the Hide tool for 

selecting them. The selected elements are displayed as transparent till closing the command and 

then they disappear on screen. Resuming the command, the transparent objects represent the 

previously hidden objects. Apply the Show tool to display hidden elements again by selecting 

them. Click All (!) to hide or show immediately (without any selection) every project elements 

depending on the Hide or the Show tool is the active. 

 Hide all stories of the building except the first story and the ground floor. 

 

Figure: Hide tool and box selection 

Unhide the second and third stories. 
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Figure: Show tool and box selection 

 

 

Transparency 
 

 Transparency can be set for all element types such as structural objects, drawing elements, loads, 

supports etc. Start the Transparency command from the View menu or View toolbar or with +

. Set the transparency value in the Set transparency dialog and then select elements you would 

like to display as transparent.  

 

 

 

Figure: Example for Transparency 

 To reset transparency settings to opaque for all elements, set the transparency value to 0% and 

click All (!).  
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At solid (Display thickness switch is on) and Hidden line/Shaded representation of 

plates/walls, the finite element mesh can be displayed, if transparency is given for the host 

surface element. 

 

Figure: Display finite elements in solid and shaded view 

 To set the transparency of all walls to 50% in a project, select one wall with + . 

 

Figure: Transparency command combined with “Select type” selection  

Axis 
Axes (Axis objects) have multifunction in FEM-Design. They can be used to find special points and to 

define different kind of planes: 

- Intersections of axes 
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Figure: Intersections may define column base points 

  



61 

 

- Working plane 

 

Figure: Working plane defined on an axis by UCS 

- View planes (2D View and 3D View commands) 

- Project planes (used in the model transfer between the FEM-Design modules) 

 Wall module can open an axis plane defined in the  3D Structure model and imports the walls 

attached to the view. 

New axis or axis-system can be defined with the   Axis command of the  tabmenu. Both 

constant and variable distribution of axes can be defined in the Axis tool palette. 

Definition steps 

1. Set the required horizontal working plane (UCS), where you would like to place axis/axes. 

2. Use the  Define tool. Define the distribution in the Multiple axes description field. If distance is 
not defined, you can place one axis object as a line on the UCS working plane. 
Constant spacing: 

(n-1)xd where n means the numbers of axes, x is the multiplication sign and 

d means the distances between the axes. 

Variable spacing: 

(n1-1)xd1,(n2-1)xd2,... where ni means the numbers of axes per different spacing, x is the 

multiplication sign and di means the different distances. 
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Figure: Axis-system with constant and variable spacing 

3. Label type (Number or Letter), starting character (No/Letter) and Prefix can be defined for the new 
axis/axis-system in the Axis tool palette. 

4. Display settings of axis symbols, colors and label can be set at  Default settings. 
5. An axis or the start axis of a system can be easily defined as a line with 2 points in the working 

plane. The distribution orientation can be changed by clicking  before the definition of the 
axis end point. The program places all axes on the Axes object layer. 

Optional steps: 

6. The numbering of an axis or one direction of an axis-system can be modified with the  
Renumbering tool. Define new (start) numbering value in No/Letter field, and then select the axis 
you would like to renumber. 

7. Display settings of the axis symbols can be modified with the  Properties tool. 

Storey 

Stories (Story objects) have multifunction in the  3D Frame,  3D Structure and  PreDesign 

modules. They can be used to define different kind of planes: 

- Working plane 

 

Figure: Working plane defined on a storey by UCS 

3x5 5,2x3.5,5 
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- Project planes (used in the model transfer between the FEM-Design modules) 

 Plate module can open storey defined in the  3D Structure model and imports the slabs, the 

supports and the loads attached to the loaded storey. 

New storey or storey-system can be defined with the  Storey command of the  tabmenu. 

Both constant and variable distribution of stories can be defined manually in the Storey dialog box. 

  

Figure: Storey dialog box 

Definition steps 

1. Set the Horizontal size of the building. This rectangular size will be the floor plane size of the storey 
object. 

 The horizontal size and the summa height (see later), which define the whole model size, 

effect the automatic wind load calculation. 

2. Set the height of the Ground level and Bottommost level. 

 Ground level also effect to the automatic wind load calculation, because the load values 

depend on the distance from the foundation level. 

Bottommost level 

This is the storey’s origin height, so the storeys are starting from this level. 

3. To define the first storey, set a name for it in the Storey cell of the first row, and then give the 
Height of the storey. Then, define further required stories in the same way. You can also edit the 
level of a storey that automatically updates the story height. 

4. Set the display settings (symbol and label size of the level dimensions) at Properties. 
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5. Clicking OK generates and displays the storey-system in the project. The program places all 
stories on the Stories object layer. 

 

Creating a storey-system automatically generates view planes by stories. Fast navigation among those 

storeys can be done with the keyboard or by using Select view: 

 

 

Figure: Navigation by Storey 

In Settings/Display/Storey dialog you can choose from three options for the appearance of the given 

storey. 

 

All objects are displayed which are in the plane of the storey or crossing the storey above or below 

according to the selected setting. 

Find 
“Find” can be used for finding structural and analytical elements with a given ID (A.1), some finite 

elements  , nodes ,.blocks , user defined filters ., or global unique identifier 

(GUID) . 
You can scroll down all the members of the current type.  

One storey up; +  

One storey down; +  

 

Select view 
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You can scroll down all the members of the current type.  

Reference plane 
Reference plane is an auxiliary object, which allows User to align elements to it. 

Click the Reference plane icon  in Structure tab. 

You can type a Description for the Reference plane in the tool window or in the Default properties. 

 

 

Reference plane can be drawn in any plane. It is displayed by the region contours with the predefined 

description. 
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The Reference plane can be used for align regions to it and also can be used by Correct model tool to fit 

structural objects to. 

 

Reference planes can be exported into/imported from Autodesk Revit via struxml 

format. 
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STRUCTURE DEFINITION 
 

A model consists of structural objects, loads and finite elements. This chapter summarizes the 

definition ways, the properties and the features of the structural objects. 

Depending on the current FEM-Design Module (license you have), the available Object types are 

different. Although the structural objects are real 3 dimensional objects, they are 1D members and 2D 

planar elements (because of the finite element method) having sectional (thickness, profile etc.) and 

material properties. So, they can be defined as lines or regions. Some elements like point supports can 

be defined as points. 

Type Modules 

where 

available 

Definition 

mode 

Position Material Profile Load- 

bearing 

  Soil  Region Horizontal Arbitrary -  Arbitrary 

 Borehole  Point - - - - 

 Isolated 

foundation 
 

Regular 

shape/Solid 
Horizontal Concrete Arbitrary Arbitrary 

 Wall     

foundation 
 Line Horizontal Concrete Arbitrary Arbitrary 

 Foundation       

slab 
 Region Horizontal Concrete Arbitrary Arbitrary 

 Beam  

   

Line 
Horizontal 

Arbitrary 
Arbitrary Arbitrary Arbitrary 

 Column  

   

Point 

Point/Line 
Vertical Arbitrary Arbitrary 

(Support) 

Arbitrary 

 Truss 

         member 
   Line Arbitrary Arbitrary Arbitrary Axial 

Intermediate 

section 
   Point - Arbitrary Arbitrary - 

Apex   Line 
Vertical/ 

Horizontal 
Timber Rectangle Arbitrary 

Column corbel   Point Horizontal Arbitrary Arbitrary Arbitrary 
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Wall corbel   Line Horizontal Arbitrary Arbitrary Arbitrary 

 Plate  

  

Region 
Horizontal 

Arbitrary 
Arbitrary 

Constant/ 

variable 

thickness 

Vertical 

Axial 
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 Wall  

  

  

Line 

Region 

Line 

Vertical Arbitrary 

Constant/ 

variable 

thickness 

(Support) 

Planar 

Arbitrary 

Profiled 

        panel 
 Line/Region 

Vertical/H

orizontal 
Concrete Constant Arbitrary 

 Timber panel 
 Line/Region 

Vertical/H

orizontal 
Timber Constant Arbitrary 

  

 Point support 

 

   

 

Point 
Vertical 

Arbitrary 
- - - 

  

Line  support 

  

   
Line 

Vertical 

Arbitrary 
- - - 

Surface 

   support (group) 

 

  

Region 
Vertical 

Arbitrary 
- - - 

 Point-point 

        connection 

 

   

 

Line 
Horizontal 

Arbitrary 
- - - 

 Line-line 

        connection 

 

   

 

Lines 
Horizontal 

Arbitrary 
- - - 

 Fictitious 

          bar 

 

   

Line 
Horizontal 

Arbitrary 
- - - 

Shell  model 
 Regions Arbitrary Steel 

Constant/ 

variable web 

height 

Arbitrary 

 Fictitious 

         shell 
  Regions Arbitrary - - - 

Table: Structural Objects and their main properties 

The commands for defining structural objects can be started from the  Tabmenu. Each 

command has a Tool palette with the customizable element properties (cross-sections, materials, 

stiffness values etc.) and the definition tools of the element geometry and position (direction). 
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Properties 
Tool palette contains all customizable structural properties. The main properties can be set directly in the 

tool palette and all properties can be set in the dialog opens by clicking on the Default settings button. 

The settings dialog and fields keep the last set property values by element types (beams, columns, plates 

etc.) 

 

Figure: Setting part of Tool palette 

Cross-sections 
FEM-Design offers the possibility to add any cross-section type/shape (Section) to beams, columns and 

truss members. 

  To avoid design failures of concrete, steel and timber bars (section type and material do not fit), 

the program checks the section type - material compatibility while setting the properties. The 

program sends an error message when it finds incompatibility definition at closing the settings 
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dialog. But, the so-called General material (defined by the user) can be added to each section 

types. 

The Section tabpage of the settings dialog contains predefined cross-sections. Unique profiles and shapes 

can be define by their parameters (parametric shapes) in New> Size or with the  FEM-Design Section 

Editor. The following table sums the available cross-section types. 

Type Description Section library Compatible 

material 

Standard steel 

profiles  

Not editable, built-

in steel profiles 

depending on the 

applied national 

code 
 

Steel (or General) 

Often used 

concrete profiles 

Not editable, built-

in square, 

rectangular and 

circular concrete 

profiles  

Concrete (or 

General) 

Often used timber 

profiles 

Not editable, built-

in square timber 

profiles 

 

Timber (or 

General) 

Common 

parametric concrete 

shapes 

Predefined 

concrete shapes to 

create required 

profiles by 

defining the shape 

parameters 

 

Concrete (or 

General) 

Common 

parametric rolled 

steel shapes 

Predefined rolled 

steel shapes to 

create required 

profiles by 

defining the shape 

parameters  

Steel (or General) 

Common 

parametric cold-

formed steel shapes 

Predefined cold-

formed steel 

shapes to create 

required profiles 

by defining the 

shape parameters  

Steel (or General) 

Common 

parametric welded 

steel shapes 

Predefined welded 

steel shapes to 

create required 

profiles by 

defining the shape 

parameters  

Steel (or General) 
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Common 

parametric timber 

shapes 

Predefined timber 

shapes to create 

required profiles 

by defining the 

shape parameters 
 

Timber (or 

General) 

Table: Section types 

Defining a new (e.g. parametric) section in the settings dialog, the program calculates automatically the 

parameters need for later analysis and design. Each bar element has a local coordinate-system which y 

and z axes define the plane of its cross-section.  

Parameter Meaning Example 

A Area 

 

P Perimeter 

A/P Area/Perimeter 

Yg, Zg Center of gravity 

Ys, Zs Shear center position 

Iy, Iz Moment of inertia 

Wy, Wz Section modulus 

ez max, ey max Maximum distance of extreme fiber 

ez min, ey min Minimum distance of extreme fiber 

iy, iz Radius of inertia 

Sy, Sz Maximum statical moment 

It Torsion moment of inertia 

Wt Torsion section modulus 

Igamma Warping parameter 

Iyz Centroidal product of inertia 

z omega Wagner warping parameter 

alpha1, alpha2 Angle of principal direction 

I1, I2 Principal moment of inertia 

W1 min, W2 min Principal minimum section modulus 

W1 max, W2 max Principal maximum section modulus 

e2 max, e1 max Maximum distance of extreme fiber 

e2 min, e1 min Minimum distance of extreme fiber 
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i1, i2 Radius of principal inertia 

S1, S2 Principal maximum statical moment 

So1, So2 Principal statical moment of half area 

c1, c2 Plastic/elastic moment capacity 

Rho 1, Rho 2 Principal shear factor 

z2, z1 Wagner parameter 

Table: Sectional characteristics 

A cross-section is stored in the following tree structure: group > type > size. New library items can be 

defined or previous ones can be edited (renamed, modified or deleted) by the following settings options. 

 

Figure: Section library structure 

Cross-sections used in the project and defined as parametric profiles are grouped in Used sections library, 

but they are available only in the current project. 

 

Figure: “Used sections” library 

  You can Import and Export the Section Library to share the content of the Library. 

Composite sections 

Composite sections can be set for beams, columns and piles. 

The available composite section types: 

 

Click Default settings/Section tab/Composite/New to open the settings of Composite sections. 



74 

 

 

 
For the time being only above listed composite sections can be selected, there is no 

choice to create alternative section. 

 

Materials 

The Material tabpage of the settings dialog contains predefined materials according to the current 

national standard. 

A model may include mixture of elements with different materials, and analysis can be done for the 

complete model, but design can be done for elements having proper materials. 

  

Schematic 

illustration 

Real section 

Composite section library 

Editable values 

Cross-section 

data 
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Material Design 

Concrete RC design 

Steel Steel design 

Timber Timber design 

General - (only for analysis) 

Bar steel RC design 

Table: Available and design materials 

Material library stores the available materials by material type groups. Materials used in the project are 

grouped in Used materials library, but they are available only in the current project. 

 

Table: Material library 

Above the standard materials, user can define concrete, steel, timber and general materials. The new 

materials are also stored in the Material library in the proper material type group. To define a new (e.g. 

concrete) material, select the required material group name (e.g. Concrete), click New and set the required 

material properties starting with the material name first. 

 

Table: Material types 
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Concrete 

For concrete structures, the partial safety factors γc and γS can be calculated automatically from 

Eurocode 2 reductions. Click Safety factor calculator next to the safety factors (Default settings > Material 

> Application data), check the required reduction box and press OK. 

 

Figure: Safety factor calculator 

In Material settings dialog different creep coefficients can be specified for Serviceability Limit State (SLS) 

and Ultimate Limit State (ULS). It has some consequences in load case calculation and results: 

• All load cases are calculated twice (first with the SLS Creep coefficient, than with the ULS Creep 
coefficient. 

• The displayed displacements are the results of the SLS calculation. 

• The displayed internal forces, reactions are the results of the ULS calculation. 

 

Figure: Setting of creep coefficients 

For reinforced concrete structure the user has the possibility to reduce the element stiffness in order to 

model the cracking’s effect in eigenfrequency calculation. 
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Figure: Stiffness reduction for reinforce concrete elements 

In Material settings dialog the stiffness for stability analysis can be decreased. Taking a reduction factor 

into account is needed in those calculations where it is specified by the standards (e.g. at the cracked 

section analysis). 

 

Figure: Reduction for stability analysis  
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Steel 

For steel structures, the γ values (M0, M1 and M2) can be set. 

 

Figure: Setting γ factors 

Timber 

For timber structures, the γM, Service class, the System strength factor and kcr values can be set. 

 

Figure: Timber material settings 

The following table and figures summarize the calculation of Young moduli used in different analysis 

types for concrete, steel and timber materials. 

Analysis type  Concrete Steel Timber 

Load cases, 

Load group, 

1st order load combination 

ULS 
𝐸𝑐𝑚

(1 + 𝜑𝑢)
 

𝐸𝑘  

 

𝐸𝑜,𝑚𝑒𝑎𝑛

(1 + 𝑘𝑑𝑒𝑓)
 

SLS 
𝐸𝑐𝑚

(1 + 𝜑𝑠)
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2nd order load combination, 

Imperfection calculation 

ULS 
𝐸𝑐𝑚

(1 + 𝜑𝑢)
∙

1

𝛾𝑐𝐸

 
𝐸𝑜,𝑚𝑒𝑎𝑛

𝛾𝑀

 

SLS 
𝐸𝑐𝑚

(1 + 𝜑𝑠)
∙

1

𝛾𝑐𝐸

 

Stability analysis  𝑓𝑠𝑡𝑎𝑏 ∙ 𝐸𝑐𝑚  

𝐸𝑜,𝑚𝑒𝑎𝑛

(1 + 𝑘𝑑𝑒𝑓)
 

Eigenfrequency calculation 

Seismic analysis 
 𝑓𝑑𝑖𝑛 ∙ 𝐸𝑐𝑚  𝐸𝑜,𝑚𝑒𝑎𝑛  

Table: Calculation of Young-moduli in different analysis types 

The properties of the current (selected in the list) material can be edited with the Modify tool. 

Customized material database can be shared between projects and users with the Export and Import 

tools. Click Export to save all materials of the current project in a named database file (.fdlmat). To load 

an exported material database to a project, just apply Import and browse for it. 

 

Figure: Material export/import 

 Just one click on Quantity estimation (Tools menu), and a fast process collects all structural 

elements of the current project with their applied materials, material qualities, identifiers, main 

geometric parameters (e.g. profiles), quantities etc. 

  Modifying the national standard for a model the program shows a dialog where you can convert 

the material property of the structural elements and the reinforcing steel, so the materials will 

automatically change after switching the code. 
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Figure: Material conversion dialog 

Information Pop-up 
Moving the cursor over a structural object, an Information pop-up appears with its main properties. For 

example, the pop-up displays the ID, the material, the thickness, the alignment and orthotropic features 

for Plates. 

 

Figure: Information pop-up example 

  Information pop-up appears only for elements on visible layers and if there is not running 

command. 

 Pop-up is enabled by default. To unable it, uncheck the Display information pop-up at Settings > All 

> Environment > General >View. 

“Properties” Tool 

 With the Properties tool of a tool palette, the properties of a selected object or objects can be 

inquired and edited in dialog format (similar to Default settings). 
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Figure: Modifying object properties (e.g. cross-section of a selected beam) 

Modify properties by “Quick menu” 
Alternative way of modifying object properties is to select any object by right click, or more objects of 

the same type by box, then click “Properties ” in the Quick menu to check/modify its/their 

properties. This function works for structural objects, loads or design elements. 

 

 

“Pick properties” and “Copy properties” 
With these functions the properties of an object can be copied to others of the same type, or picked to 

use as default. Both can be found in the Tools menu and in the toolbar as well. 
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To copy properties with the Copy properties ( ) function, first select the source object, then one or 

more objects to which the properties are to be applied. 

 

Pick properties ( ), when used on an object (of the same type as in the active editing dialogue) will 

update the default settings for its type. 

 

 
Pick properties can only be used when Define is selected in an 

editing window, otherwise it is disabled. 

 

 

 

Copy and Pick properties work according to the following rules:  

- Generally, the properties defined by the property dialogue will be picked or copied. 

- They are only available in the 3D Structure and Plate modules. 

- ID will not be copied. 

- Load case of loads will not be copied. 

- Varying shell thickness and surface load value will not be copied. 

  

1. 2. 
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Numbering 

Structural elements with an ‘Identifier (. position number)’ will have an automatically or manually assigned 

position number. 

 

The position number will be 0 upon creating the object and will be automatically set to another value 

in the following cases: 

- before creating a list 

- using the Find tool 

- before calculation 

User can manually set position numbers by Tools/Numbering…  tool. 

 

Use  for Manual position numbering  

1. type required position number into the Position no. textbox  

2. select option for handling position number conflicts 

3. select object(s) to set position number for 

 

 In case more objects are selected, the first one gets the position number typed by the user and for 

the next ones it is increased automatically. 
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To set position number of component objects, like edge connections, corbels, post-tensioned cables, 

punching regions, the Select component (…)  auxiliary option has to be checked. 

Objects with manually set position number can be highlighted by checking the last option of the tool 

window. 

 

 

The position number can be reset to zero by choosing Reset  option then selecting one or more 

objects. 

Automatic numbering  sets position number automatically for all objects in the database except the 

ones with manually set position number. 

The option to Lock numbering can be accessed by clicking its icon  in the same Tool window. 

 

When the numbering of a selected object type is locked, the position number of individual elements 

will remain the same. The maximum position number is saved for all IDs, so position numbers less 

than that will not be used in the future, even if some items are deleted. 

This means all the element types with their numbering locked will retain their original ID, even after 

refreshing the numbering (either manually, or automatically). 
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Display Settings of Structural Elements 
The display properties of the structural elements can be set at the Settings > All… > Display. 

The available options depend on the current FEM-Design module. 

 

Figure: Settings options affect on the appearance of the structural elements 

- Drawing elements 
With the Show end points of line option you can show (or hide) the insertion points of planar 

structural objects, their holes and bar objects (beams, columns etc.). These points are visible in 

Erasing object – effect on structural IDs 

Without locking numbering With numbering locked 
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all display modes, but the Wireframe mode without displaying the elements’ thickness gives 

the clearest appearance of them. 

 

Figure: Insertion points displayed in Wireframe mode 

 By showing the insertion points you can also detect the unnecessary (for example 

accidentally) defined points, which may cause “too refined” finite element mesh in 

planar structural elements. The unnecessary points can be deleted with editing tools 

(Edit menu) which can be applied for region elements (such as plate, wall regions etc.). 

For example, stretch the unnecessary points outside the host region, and then cut the 

stretched region part(s) with the Split tool of the Modify region (Edit menu) or with the 

Hole tool of the structural planar object. 

 

Figure: Unnecessary definition points detected visually 

With the Fill-up with color option the planar objects (plate, wall, drawing regions) can be 

displayed with their reference plane as colored surface or with their contour lines only. 

Applying the fill colors is useful to display holes/openings clearly. The filling color of an 

element is the default color of the Object layer includes the element. It can modified at the layer 
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settings by element types (Plate, Wall etc.) or with the Color option of the Change properties tool 

(Edit > Properties) by elements (independently from their types). 

 

Figure: Planar objects displayed with their colored surface or without it in Wireframe mode 

- Display labels 
Information of structural elements (such as ID, position number, material properties, section 

names etc.) can be displayed on the screen by element types in Wireframe display mode. 
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Figure: Info labels displayed on screen by element types 

- Numbers 
This setting affects on the numeric values of the displayed labels (see the previous option). 

- Display local system 
The local co-ordinate system of the structural elements can be displayed with the Display local 

system option by element types. The size of the local system symbol can be set at the Size option. 

The color of the local system axes can be set at Local systems setting. The default colors are: green 

for the local x’ axis, red for the local y’ axis and blue for the local z’ axis. 

 

Figure: Local co-ordinate system displayed on screen by element types 

- Special display settings of walls 
With the Display wall base line option (3D Structure and Predesign modules only) the bottom end 

of the walls can be displayed as a hatched surface. 

By inactivating the Display wall height option (Plate module only) only the reference support line 

(as hatched surface) can be displayed without showing the height-extension that is out from the 

plates’ calculation 2D plane. 
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Figure: Special display options of walls 
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- Special display settings of bar elements 

The Display section shape option shows the applied section of the bar elements as a colored 

symbol in the middle of the bar reference lines. The size (Scale), the filling (Fill) and contour 

(Border) colors are customizable. Although, section shape symbols are visible in most of the 

different display modes, their “best” display mode is the Wireframe mode without displaying 

the elements’ thickness. 

The Display connections option shows the end connection property (see Beam, Column or 

Fictitious bar connection settings) of the bar elements. Only the free end motion components 

can be displayed as arrows, where a simple arrow shows a motion component by its direction 

and a double-headed arrow shows the axis direction of a rotation component. The fix (rigid) 

end connection components are never displayed. The color of an end motion component equals 

with the color of the proper axis of the host bar element’s local system (see before, Display local 

system). The size of the symbols can be set at the Size option. 

 

Figure: Special display options of bar elements 

- Layer, color and pen width 

All elements are placed (and grouped) on Object layers according to their type. So, for example, 

columns are on the “Columns” layer and the walls are on the “Walls” layer. The default color 

and pen width of elements’ contours/reference lines are represented by their host layers. For 

example, by default, walls are red, if the color of the “Walls” layer is also red. 
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Figure: Layer-system of structural objects 

 The default color of an object can be modified independently from their types with the Color 

option of the Change properties tool (Edit > Properties). 

Color schema 

This feature lets the users to navigate a model easier, by 

allowing them to fully customize element colors. These 

options can be accessed through the Tools  Colors menu 

command, or by clicking on their icon ( ) in the toolbar. 

Mode determines the attribute on which the color coding is 

based. When None is selected, the default colors for object 

types will be used.  
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For each object type, the following attributes are available: 

Beam, column and truss ID, Material, Cross-section 

Plane plate and wall ID, Material, Thickness 

Profiled plate and wall ID, Material, Cross-section 

Timber panel ID, Material 

Edge connection ID, Rigidity type 

The Manage button can be used to save a specified color coding system. These can be selected 

afterwards from the drop-down list to the left from the Manage button. Schema color is saved only for 

a given project. 
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Clicking the Apply button will apply the color code to the model. Enabling the Auto apply checkbox 

will apply any changes automatically. 

When a custom color scheme is in use, a legend window will be 

displayed. With the Position button, the placement of this window 

can be specified; it can even be hidden. By default, the legend is 

displayed in the bottom left corner of the screen. 

 

 

Colors, borders, and their line types (with thickness) can be modified by clicking on the Edit palette 

button. In the dialog box, all parameters can be set for every value of the specified attribute (ID, 

Material or Thickness). It is possible to save these settings separately to be used in another color 

scheme.  

The Settings button will allow you to save your color scheme to a file (*.cpal) or as default, or load 

another schema. 

 

When a color scheme is saved, only the colors and their order will be stored, values need to 

be specified each time. 

 

 

Geometry 
The definition modes and the available shapes of structural elements’ reference line or reference plane 

depend on: 

- the structural type: 1D Member or Planar Object, and 
- the current FEM-Design module. 

The Tool palette of a structural element contains only the available modes. The next table summarizes 

the geometry possibilities by structural elements. 

  

 

Pen (line weight) can use pixels as well as millimeters. A positive number means millimeters, 

while a negative one will give the line width in pixels. A line weight given in millimeters will 

remain the same in the documentation. When pen size is given in pixels, the line weight will 

remain the same on-screen, regardless of zoom level. 
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Type Modules where 

available 

Definition 

mode 

Geometry 

  Soil  Reference region  Rectangular 

 

  

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 Borehole  Reference point - (Insertion point) 

 Isolated foundation  Regular shape  Rectangular 

 

  

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

  Reference solid  Pick existing solid 

 Wall foundation  Line  Straight line 

 

  

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 Foundation  slab  Region  Rectangular 

 

  

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 

 Column 
 

Reference point - (Insertion point) 

 
   

Reference line 
 Line by insertion point 

 Vertical line 

 Select axes 

 Select point 

 Line by selection 

  
Reference line 

 Straight line 
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 Truss member     Line by selection 

 

 Intermediate section 

 

    
Reference point - (Insertion point) 

 

 Apex 

 

  

Reference beams - 

Column corbel  
Reference point 

on a column 

- (Insertion point) 

Wall corbel  
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 Plate 

   
Reference region 

 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 

 Wall 
 

Reference line 
 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 
  

Reference region 
 

 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 

 
  

Reference region 
 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 Profiled plate 
 

Reference region 
   Rectangular 

   Circular 
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   Polygonal 

   Pick lines 

   Pick existing region 

 Profiled wall 
 Reference region 

   Straight line 

   Arc by center, start and end points 

   Arc by 3 points 

   Arc by start, end point and tangent 

   Line by selection 

 

 Timber panel 
 

 

 

Reference region 
 Use as plate: 

   Rectangular 

   Circular 

   Polygonal 

   Pick lines 

   Pick existing region 

 
 

Reference region 
 Use as wall: 

   Straight line 

   Arc by center, start and end points 

   Arc by 3 points 

   Arc by start, end point and tangent 

   Line by selection 

 

 Point support 
     

 

Reference point - (Insertion point) 

 

  Line support 

 

     

 

Reference line 
 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 Surface support 
   

Reference region 
 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 

Point-point 

connection 

     

 

Reference points - (Insertion points) 
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 Line-line 

connection 

     

 

Reference lines 
 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 

 Fictitious bar 

    
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 Cover 

 Wall type 

 
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 

 Cover 

 Slab or roof type 

 
Reference region 

 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 

 Building cover 
 

Reference plane 

shape 

- 

Table: Structural Objects and their geometry definition 

  



98 

 

  Straight line 

The steps of a straight line definition: 

1. Define the start point of the line by giving coordinates or mouse-clicking. 
2. Define the end point of the line by giving coordinates or mouse-clicking. 

 

Figure: Some examples for defining structural objects with Straight line 

Although Walls are planar objects with reference line, they are vertical and defined by their base 

reference line only in the  FEM-Design Plate and  3D Structure Modules. The final geometry of 

the reference region is set by the wall height. The next figure shows the differences of height measuring 

between the Plate and 3D Structure Modules. Of course, the height defines the position of reference 

region of curved Walls too. 
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Figure: Height direction of Walls in Plate and 3D Structure Modules 

 

 In 3D Structure Module, the rectangle shape of the wall can be edited by the Modify region > 

Split region tool and other editing tools (Edit menu). Also the Hole tool of Wall tool palette can 

be used to edit the reference regions. 

 

Figure: Some examples for additional editing of Wall region 
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 Arc by center, start and end points 

The steps of an arc definition with its center, start and end points: 

1. Define the center point of the arc by giving coordinates or  mouse-clicking. 

2. Define the start point of the arc by giving coordinates or  mouse-clicking. 

3. Set the drawing direction (clockwise or counterclockwise) with  mouse-clicking. Define 

the end point of the arc by giving coordinates or  mouse-clicking, or set the central angle 
(4.) by giving its value. Circle can be defined by angle 360°. 

 
Figure: Some examples for defining structural objects with Arc by center, start and end points 

 

Figure: Drawing direction and angle definition 
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 Arc by 3 points 

The steps of an arc definition with its three points: 

1. Define the start point of the arc by giving coordinates or  mouse-clicking. 

2. Define the end point of the arc by giving coordinates or  mouse-clicking. 

3. Define the third, peripheral point of the arc by giving coordinates or  mouse-clicking. 
 

 

Figure: Some examples for defining structural objects with Arc by 3 points 

 Arc by start, end point and tangent 

The steps of an arc definition with its start, end point and tangent: 

1. Define the start point of the arc by giving coordinates or  mouse-clicking. 

2. Define the end point of the arc by giving coordinates or  mouse-clicking. 

3. Set the tangent side with  mouse-clicking. Define the tangent direction from the start 
point with a third point (e.g. a point on a tangentially connected line) by giving coordinates or 

 mouse-clicking. 



102 

 

 
Figure: Some examples for defining structural objects with Arc by 3 points 

 

 

Figure: Although same definition points are defined, the tangent side is different 

 Line by selection 

The step of a reference line (straight or arc) definition by selecting a previously defined line: 
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Select lines or region (drawing or structural object) edges define the requested shape of the reference 

line with one of the selection modes. 

 

Figure: An example for defining Wall by selecting all lines 

 

 

Figure: Defining Beams and Walls on Plate edges (1.) and Line supports on Wall edges (2.) 

  For Columns in FEM-Design 3D Modules, only vertical lines or edges can be selected. 
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Figure: Column definitions by selecting vertical lines/edges 

 Line by insertion point and height 

As a simple definition of Columns in  3D Structure,  3D Frame and  PreDesign modules 

define the position of the Column with its insertion point and height. The positive or negative value of 

the Height sets the measuring direction of the height. 

 

Figure: Column definition with one-click in 3D modules 
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 Select axes 

This definition mode is for defining Columns in the intersections of selected axes. 

Select axes with one of the selection modes. 

 

Figure: An example for defining columns with selecting axes 

 Vertical line 

This is a special tool for defining Column with two points. FEM-Design Columns can be only vertical, 

so the second point is not needed to be on the column axis, because its vertical distance from the start 

(first) point defines the height of the column. This Column definition tool is useful, when you do not 

know the height value of the new column, but points and lines defines the column’s vertical extension 

(height) can be easily found. Use Object Snap tools to find point defines indirectly the column’s end 

point. 

 

Figure: Examples for defining vertical columns with two points 
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 Rectangular 

The steps of a rectangular region definition: 

I. Rectangle’s edges parallel with the UCS: 

1. Define the point of the first corner by giving coordinates or mouse-clicking. 
2. Define the point of the end corner by giving coordinates or mouse-clicking. 

 

Figure: Defining rectangular Plate and Surface support 

II. Rectangle’s edges not parallel with UCS: 

1. Click   one or two times to define the rectangle’s first edge’s direction 

a. If you click  one time, the direction is can be defined from the global 
coordinate system’s origin, 

b. If you click  one times, the direction is defined in an arbitrary direction. 

2. Define the arbitrary direction of the rectangle’s one line. 

3. Define the point of the first corner by giving coordinates or mouse-clicking. 
4. Define the point of the end corner by giving coordinates or mouse-clicking. 
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Figure: Defining rectangular plate  

 The geometry of rectangular regions as well as other (later mentioned) region shapes can be 

edited by the Modify region > Split region tool and other editing tools (Edit menu). Also the 

Hole tool of planar objects’ definition command can be used to edit the reference regions. 

 

Figure: An edited rectangular Plate region  
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 Circular 

The steps of a circular region definition: 

1. Define the center point by giving coordinates or mouse-clicking. 
2. Define the radius by giving its value or a point on the circle (with coordinates or mouse-

clicking). 

 

Figure: Defining circular Plate and Surface supports 

 Polygonal 

The steps of a polygonal region definition: 

1. Define the points of the polygon vertexes by giving coordinates or  mouse-clicking. 

2. Close the polygon with  mouse-clicking or  key. 

 

Figure: Defining polygonal Plate and Surface support 
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Pick lines 

With this method, previously defined or imported (DWG/DXF) drawing elements can be used as 

sketches of structural region shapes. The step of definition: 

Select a closed line defines the requested shape of the reference region with mouse-clicking. 

 

Figure: Defining Plate and Surface support by using close contours 

In case of line junctions, more than one line has to be selected to make clear the continuity of the 

requested closed contour. 

 

Figure: Selection of more lines to define the right path for the closed shape 

Pick existing region 

The step of a reference region definition by selecting a previously defined object or drawing region: 

select the region(s) defines the requested shape of the reference region(s) with one of the selection 

modes. 
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Figure: An example for placing Surface support under a Plate by selecting its region 

 With Pick existing region, shell (Plate) elements can be easily place on the entire surface or some 

surface components of a Solid body (Draw > Solid). 

 

Figure: Defining shell (Plate) regions by picking the surface regions of a Solid body 

Hole 

 Holes, openings and cuttings can be added to reference regions (Plate, Wall and Surface support) 

with the Hole tool. The following geometries can be used for holes: 

The steps of a hole definition: 

1. Select the host region with mouse-clicking. Clicking a region places the UCS into the region 
plane, so giving hole coordinates needs only X and Y values from the UCS origin. 

2. Define the geometry of the hole with one of the following geometry modes: 

 Rectangular 

 Circular 
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 Polygonal 

 Pick lines 

 

Figure: Examples for holes 

 

Figure: Hole tool can be used to edit region geometries as cuttings 

Holes can be easily copy inside a region or among regions with same reference plane position with the 

Copy command (Edit menu). It is recommended to display only the regions’ reference plane (inactive 

Display thickness option) to easily select the contour of the hole you would like to copy. To set the 

distances/new positions, the UCS has to be in the plane of the host region(s). 
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Figure: Copying holes in a Wall 

Direction 
Numerous objects need direction settings for their positioning (bar elements) or their components 

definition (supports). The next table summarizes the direction possibilities by structural elements. 

Type Modules where 

available 

Direction for Direction Modes 

  Soil  
- - 

 Borehole  
- - 

 Isolated 

foundation 
 

Solid position: 

Direction of local x’ 

axis 

 Predefined 

direction 

 Local system 

 Wall foundation  
- - 

 Foundation  slab  
- - 

 Beam    
Cross-section position: 

Direction of local y’ 

axis 

 Predefined 

direction 

 Parallel with line 

 Perpendicular to 

plane 

 Column     
Cross-section position: 

Direction of local y’ 

axis 

 Predefined 

direction 

 Parallel with line 

 Perpendicular to 

plane 
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 Truss member    
Cross-section position: 

Direction of local y’ 

axis 

 Predefined 

direction 

 Parallel with line 

 Perpendicular to 

plane 

Column corbel  
Horizontal axis 

position: 

Angle between the 

horizontal axis of the 

corbel and the local y’ 

axis of the column 

 

Alpha[°] 

 Point support   
Rotation direction 

 Predefined 

direction 

 
  

Motion component 

direction 
 Parallel with line 

 
   

Component direction 
 Perpendicular to 

plane 

 Point support 

group 

   
Component direction - (Predefined direction) 

 
   

 

Component direction 

(reference system) 

 Predefined 

direction 

 Local system 

 Line support   
Rotation direction 

 Predefined 

direction 

 
  

Motion component 

direction 
 Parallel with line 

 
   

Component direction 
 Perpendicular to 

plane 

 Line support 

group 

   
Component direction - (Predefined direction) 

 
   

 

Component direction 

(reference system) 

 Predefined 

direction 

 Parallel with line 

 Perpendicular to 

plane 
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 Point-point 

         connection 

     

 

Component direction 
 Predefined 

direction 

 Local system 

 Line-line 

connection 

     

 

 

Component direction 
 Predefined 

direction 

 Local system 

Table: Structural Objects and their direction settings 

 Predefined direction 

With this option an axis/a plane of the Global or the User-defined (UCS) co-ordinate system can be set 

for the required direction (e.g. the local y’ axis of a beam profile). The direction can be chosen from the 

drop-down list attached to the Predefined direction option. The available directions depend on the applied 

FEM-Design Module (e.g. Plate, 3D Structure etc.). 

 

         

Symbol Meaning of direction System 

 

 

Parallel with XY plane Global 

 

 

Parallel with YZ plane Global 

 

 

Parallel with XZ plane Global 

 

 

Parallel with UCS (XY plane) UCS 

 

 

Perpendicular to UCS (XY plane) UCS 

 

 

Parallel with global X axis Global 

 

 

Parallel with global Y axis Global 
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Parallel with global Z axis Global 

 

 

Parallel with X axis of UCS UCS 

 

 

Parallel with Y axis of UCS UCS 

 
Parallel with Z axis of UCS UCS 

Table: The available axis directions to set the new direction 

 

Figure: Examples for Beam profile positions 

At supports, additional direction setting can be chosen from the definition tool palette: 

 “Positive direction”: The orientation is the same with the selected axis orientation; 

 “Negative direction”: The orientation is the opposite of the selected axis orientation. 

 

Figure: Examples of Point support position 
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 For some support and connection types, only the reference system can be selected as “predefined 

direction”. That means the direction of the components (x’, y’ and z’) are valid in the selected co-

ordinate system (Global or UCS). 

 

Figure: Support components in different co-ordinate systems 

 Parallel with line 

With this option, the required direction (e.g. the local y’ axis of a column profile) can be defined 

manually with its start and end points. The new direction is set for all objects till  stops the 

repetition of object insertion and restarts with another direction definition. 

 

Figure: The local y’ axis of column profiles is parallel with the defined direction 

 Perpendicular to plane/line 

With this option, the required direction (e.g. the local y’ axis of a beam/column profile) will be 

perpendicular to a defined plane/line. The plane can be given with three points and the line with two 
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points (start and end points). In case of the perpendicular plane, the third point defines the final 

orthogonal direction, which the new direction will be parallel with. The new direction is set for all 

objects till  stops the repetition of object insertion and restarts with another direction definition. 

 

 

Figure: The local y’ axis of beam profiles is perpendicular to the defined plane 

 

Figure: The local y’ axis of column profiles is perpendicular to the defined line 

 Local system 

When the Global or User-defined (UCS) co-ordinate system is not enough as a predefined system for 

component directions (Point support, Point-point connection and Line-line connection), a custom 

local system can be defined. Tree points declare the system and the 4th point places the new object: 

1st point: system origin, 

2nd point: defines the x’ axis direction, 
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3rd point: defines the y’ axis direction. 

 

The z’ axis of the system always perpendicular to the x’y’ plane. 

The new system directions are set for all objects till  stops the repetition of object insertion and 

restarts with another system definition. 

 

 

Figure: Point support group set by a special local system 

 

Figure: Typical example for special direction (Point support group) 

Change Direction 

Any previously set direction can be modified by the editing commands (Edit menu): Change direction 

and Rotate. 
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Change direction uses the Predefined direction, Parallel with line and Perpendicular to plane direction 

definition tools. 

 

 

Figure: Beam position (local y’ axis) is modified with Change direction 

Rotate edits a selected direction or the main direction of a selected system with giving new direction 

points or the rotation angle. Rotation works around a given point or an axis. 

 

Figure: Rotate modifies the main direction (x’) of the Point support group 
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1D Members 
This chapter summarizes all features and properties of a 1D member such as Borehole, Isolated 

foundation, Wall foundation, Beam, Column, Truss member, Fictitious bar and Corbel. 

Borehole 

 Borehole property Description 

Modules where available     

Geometry Straight 

Table: Borehole properties 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. In the 3D design modules, respect that the gravity direction is always the Global 
Z axis direction. 

2. Start  Borehole command from  tabmenu and choose  Define. 
3. Place a borehole. There are two way to place a borehole: 

• If “Use closest bore hole data” is checked, the borehole properties will be the same as 
the nearest borehole. 

 

• If “Use closest bore hole data” is unchecked properties of the new Borehole can be set at 

 Default settings: 
 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Groung Water Level (Ground water) 
Water level has effect to the design calculations. Soil and foundations which are under the 

water level, FD calculates with modified density. 
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- Strata 
Optional steps: 

1. Modify the borehole properties with the  Properties tool of the Borehole tool palette. 
2. Set the display settings of beams at Settings > All > Display > Soil and Foundation. 

     

3. The boreholes are stored on “Soil” Object layers. At layer settings, the default color and 
pen width can be set for all beams. 

With boreholes the user can define inclined level strata by setting the strata levels. 
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Pile 

 Pile Description 

Modules where available     

Geometry Straight, placed in any arbitrary angle but 90° to vertical 

Cross-section Arbitrary concrete, steel, timber, and certain types of composite profiles 

Material Concrete, steel, timber, composite 

End condition Rigid and hinged, or custom defined by Point-point connection 

Soil springs Support springs, Negative shaft friction 

Load direction Arbitrary in    

Load type 
Point/line load (force and moment), Line support motion 

Available analysis results Displacement, stresses, stability and vibration shape in    

Available design - 

Table: Pile properties 

Definition steps 

1. You need to define the soil first. 

2. Start  Pile command from  /Foundation tabmenu and choose  Define. 

3. Set the properties of the new Pile in  Default settings: 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID) 

number can be displayed in model view (Display settings). 

- Rotation (General) 

You can set the direction of the local y axis. 
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- Cross-section (Section) 

The section of the pile can be selected from the Section library or you can set a Composite 

one for it. (Cross-sections) 

   

The available composite sections for simple pile are the followings: 

 
 

- Material 
Concrete, steel, timber or composites can be set as material for pile Analysis. 

- End conditions 

On the End conditions tab User can set the top release of the pile, which can be useful in case 
piles are connected to a foundation slab. The connection can be either fixed or hinged. 
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- Support springs (Soil springs) 

In the Soil springs tab you can overwrite the automatically calculated values of any support, 
such as Lateral/ Vertical line motion springs, Vertical pile tip springs or Vertical plastic limit forces.  

References: 

- Bogumił Wrana (2015) Pile load capacity – calculation methods. Studia Geotechnica et 

Mechanica, Vol. 37, No. 4, pp. 83-93 

- NAVFAC DM 7.2 (1984): Foundation and Earth Structures, U.S. Department of the Navy 

- Skempton A.W. (1959), Cast-in-situ bored piles in London clay, Geotechnique, Vol. 9, No. 4, pp. 

153–173 

- Qian-qing Zhang, Shu-cai Li, Fa-yun Liang, Min Yang, Qian Zhang (2014) Simplified method 

for settlement prediction of single pile and pile group using a hyperbolic model. International 

Journal of Civil Engineering Vol. 12, No. 2, Transaction B: Geotechnical Engineering, pp. 146-

159 

- Vesic, A.B. (1963) Beams on Elastic Subgrade and the Winkler’s Hypothesis. Proceedings of the 

5th International Conference of Soil Mechanics, pp. 845-850 
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- Negative shaft friction (Soil springs) 

βneg is the factor for negative shaft friction for drained soils (default value is also assumed to 
1.0). This load is applied as a linearly variable line load along the pile, and its value can be 
changed by the modification of the αneg and βneg values (each stratum has one value) together 
with neutral level: 
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4. Click Option to open Pile option dialog. Here you can declare the Type of pile or the Surface 
surcharge (affecting the vertical stresses in case of drained soils), the division length of line 
supports and can decide the method of the Section perimeter’s calculation. 

 

 
The feature has some important limitations! 

- Pile model is used only for analysis purpose (displacements, internal forces), 

geotechnical design calculations are not implemented yet. 

- During the calculations soil must not be modelled as soil element. 

 
- Negative shaft friction is considered in a load combination only if it includes 

“Neg. shaft friction” load case, which is generated automatically when a pile is 

created in the model with non-zero neutral level. 

 

 
 

 
 

! 
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Isolated foundation 

 Isolated foundation 

property Description 

Modules where available     

Geometry Regular shape, Solid 

End connection Rigid and hinged, or custom defined by Point-point connection 

Material Concrete 

Load direction Arbitrary in    

Load type 
Point load (force and moment), Point support motion 

Available analysis results Displacement, stresses, stability and vibration shape in    

Available design Foundation design 

Table: Isolated foundation properties 

 

Definition steps 

1. If needed, set a proper position for the working plane.  

2. Start  Isolated foundation command from  tabmenu and choose  Define. 

3. Set the properties of the new Isolated foundation at  Default settings: 
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- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID) 

number can be displayed in model view (Display settings). 

 

- Analytical system (General) 

Here the user can choose how to model the Isolated foundation depends on if “Calculate soil 
as a solid element” is chose or not. If “Calculate soil as a solid element” is not chosen in “Code, 
Configuration” dialog, user can choose if he/she wants to model the Isolated foundation by 
line support group or by surface support group. In this case bedding modulus can be set 
in Default settings / General dialog.  
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- Insulation (General) 
User can apply insulations attached to the bottom of the isolated foundation. If Calculate 

soil as a solid element is activated, Insulations are calculated as part of the Foundation 

object with the user-specified parameters. Otherwise, they are ignored. 

- Material 
Only concrete material can be set for isolated foundation Analysis. 

4. Choose a geometry definition method. 
5. Define the Wall foundation in the model view based on the chosen geometry method. 

Optional steps: 

6. Modify the isolated foundation properties with the  Properties tool of the Isoltated 
foundation tool palette. 

7. Set the display settings of isolated foundations at Settings > All > Display > Beam, Column 
and Truss. 

 

8. The Isolated foundations are stored on “Foundation” and if they modeled with Surface 
support group their supports will be stored at the “Support” Object layers. The color 
and pen width settings by selected beam elements can be modified by Edit > Properties 
> Change appearance. 

Wall foundation 

 Wall foundation 

property Description 

Modules where available     

Axis position Arbitrary (horizontal, vertical and skew) 

Geometry Straight and curved 

Cross-section Arbitrary profile 

Eccentricity Available 

End connection Rigid and hinged, or custom defined by Point-point connection 

Material Concrete 
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Load direction Arbitrary in    

Load type Point load (force and moment), Line load (force and moment), Line temperature 

variation load, Line stress load, Line support motion  

Available analysis results Displacement, stresses, stability and vibration shape in    

Available design Foundation design 

Table: Wall foundation properties 
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Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for 
the working plane.  

2. Start  Wall foundation command from  tabmenu and choose  Define. 

3. Set the properties of the new Wall foundation at  Default settings: 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID) 

number can be displayed in model view (Display settings). 

- Analytical system (General) 

Here the user can choose how to model the Wall foundation depends on if “Calculate soil as 
a solid element” is chose or not. If “Calculate soil as a solid element” is not chosen in “Code, 
Configuration” dialog, user can choose if he/she wants to model the Wall foundation by 
line support group or by surface support group. In this case bedding modulus can be set 
in Default settings / General dialog.  
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- Insulation (General) 
User can apply insulations attached to the bottom of the wall foundation. If Calculate 

soil as a solid element is activated, Insulations are calculated as part of the Foundation 

object with the user-specified parameters. Otherwise, they are ignored. 

 

- Section 
Choose a profile from the Section library or define a new cross-section by parameters. The 

applied section name can be displayed in model view (Display settings). 

- End conditions 
The end connections can be set under the End conditions tab similarly to Beams. Only the 

released motion (arrow) and rotation (two-headed arrow) components are displayed in the 

model view (Display settings). Rigid connections can be customized to hinged or semi-

rigid (spring) with additional Point-point connection. 

The end connections (in the beam start and end) with joined objects can be set to rigid or 

hinged by motion and rotation components. The component directions are valid in the 

beam’s local co-ordinate system. 

Inactive component means a fixed motion/rotation, while a checked component behaves 

as free motion/rotation in the assigned direction. 
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Only the released motion (arrow) and rotation (two-headed arrow) components are 

displayed in the model view (Display settings). 

- Eccentricity 
Eccentricity has effect in calculation and it can be turn on/off with Consider eccentricity in 

calculation option. The default position (center of gravity) of the beam axis (local x’ axis) 

can be set in the aspect of analysis/design calculation or accurate display. 

The axis position (symbolized with yellow point in the section) can be set with its 

coordinates in the local y’z’ plane, or can be placed into special section points (e.g. plate 

corners) by dragging the yellow point into the requested position. 

 

Two type of eccentricity option can be chosen: 

First type (“End releases applied at the ends of the theoretical axis”) is typically used for 

modeling RC bars which work together with concrete slabs (slab normal forces transfers to 

the bar). 

The second type (“End releases applied at the ends of the gravity (physical axis)”) is for 

modeling single plate and bars which are not working together. 
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- Material 
Only concrete material can be set for isolated foundation Analysis and Design. 

4. Choose a geometry definition method for the wall foundation reference line (axis). 
5. Define the Wall foundation in the model view based on the chosen geometry method. 

Optional steps: 

6. Modify the geometry with the Edit menu commands valid for line elements. 

7. Modify the bar properties with the  Properties tool of the Wall foundation tool palette. 
8. Set the display settings of beams at Settings > All > Display > Soil and Foundation. 

 

9. The Wall foundations are stored on “Foundation” and if they modeled with Surface 
support group their supports will be stored at the “Support” Object layers. The color 
and pen width settings by selected beam elements can be modified by Edit > Properties 
> Change appearance. 

Beam 

 Beam property Description 

Modules where available     

Axis position Horizontal in  

 Arbitrary (horizontal, vertical and skew) in    

Geometry Straight and curved 

Cross-section Arbitrary profile 

Eccentricity Available 

End connection Arbitrary 

Material Steel, concrete, timber and general 

Load direction Vertical in  

 Arbitrary in    
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Load type All point and line load 

Available analysis results 

Displacement, internal forces, stresses, stability and vibration shape in   

 

Available design Steel design in    

 RC design in    

 Timber design in    

Alternative Steel beam can be modeled/designed as the set of shells (Shell model) 

Table: Beam properties 

 Typical 2D and 3D frame structures build by beams (only) can be fast defined with the so-called 

Wizard tool. Fast means, that in a dialog you can set the beam sizes and positions by parameters. 

Besides the geometry, Wizard adds loads and supports to the beam-system. 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for 
the working plane. In the 3D design modules, respect that the gravity direction is 
always the Global Z axis direction. 

2. Start  Beam command from  tabmenu and choose  Define. 

 

3. Set the properties of the new beam at  Default settings: 
 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Camber simulation by prestressing (General) 
To simulate camber of the elements check the box next to Camber simulation by prestressing 
in the General tab.  
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To calculate camber a camber-type load case needs to be defined. The effect is calculated as a 
kinematic load. 

 
Camber calculation gives statically correct result only for non-eccentric, hinged beams 

and shells. This only corrects the displacement result and no internal forces will rise in 

the model. 

- Section 
Choose a beam profile from the Section library or define a new cross-section by parameters. 

The applied section name can be displayed in model view (Display settings). 

- End conditions 
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In , the end connections are fully rigid. 

In 3D modules, the end connections can be set under the End conditions tab. Only the 

released motion (arrow) and rotation (two-headed arrow) components are displayed in the 

model view (Display settings). End connections can be fully customised for bar ends by 

setting the rigidity of the displacement components. 

The component directions are valid in the beam’s local co-ordinate system. 

Inactive component means a fixed motion/rotation, while a checked component behaves 

according to the user-specified rigidity value. 

 

With the „Rigid” and the „Hinged” buttons pre-defined end condition values can be 

applyed to the bar ends. 

The local x’ axis always points the beam end, so the start and end point position can be 

followed from the beam’s local co-ordinate system. 

 

Only the released motion (arrow) and rotation (two-headed arrow) components are 

displayed in the model view (Display settings). 

The connection settings is not available in , the end connections are always fully rigid. 

Eccentricity in analytical model (End conditions) 
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Eccentricity has effect in calculation. The default position (center of gravity) of the beam 

axis (local x’ axis) can be set in the aspect of analysis/design calculation. 

The axis position (symbolized with yellow point in the section) can be set with its 

coordinates in the local y’z’ plane, or can be placed into special section points (e.g. plate 

corners) by dragging the yellow point into the requested position. 

 

Two type of eccentricity option can be chosen: 

First type (“End releases applied at the ends of the theoretical axis”) is typically used for 

modeling RC bars which work together with concrete slabs (slab normal forces transfers to 

the bar). 

 

                         Figure: Modeling of a “ribbed concrete slab” 

 

The second type (“End releases applied at the ends of the gravity (physical axis)”) is for 

modeling single plate and bars which are not working together. 
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                            Figure: Modeling of a steel beam under slab in 3D Structure module 

Physical model 

Eccentricity of the physical model can be set in the Physical model tab, in a similar way as 

the Eccentricity of analytical model. It has no effect on the calculation. 

- Material 
Any type of materials can be set for beam Analysis, but design can be run for concrete, steel 

and timber beams only. The applied material name can be displayed in model view 

(Display settings). 

4. Define the direction of the cross-section y’ axis (only in 3D modules). 

The y’ axis cannot be modified in the  module, so it is always parallel with the Global X-Y 

(working). 

5. Choose a geometry definition method for the beam reference line (axis). 
6. Define the beam in the model view based on the chosen geometry method. 

Optional steps: 

7. Modify the geometry with the Edit menu commands valid for line elements. 

8. Modify the bar properties with the  Properties tool of the Beam tool palette. 
9. Set the display settings of beams at Settings > All > Display > Beam, Column and Truss. 
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10. The beams are stored on “Beams” Object layers. At layer settings, the default color and 
pen width can be set for all beams. The color and pen width settings by selected beam 
elements can be modified by Edit > Properties > Change appearance. 
 

 

Column 

 Column property Description 

Modules where available     

Function Point support in  

 Column in    

Position Always vertical 

Geometry Straight 

Cross-section Arbitrary profile 

Eccentricity Available 

End connection Arbitrary  

Material Steel, concrete, timber and general 

Load direction Arbitrary in    

Load type All point and line load in    

Available analysis results Reaction forces in  

 Displacement, internal forces, stresses, stability and vibration shape in    

Available design Steel design in   

 RC design in   (Column punching is available in ) 
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 Timber design in   

Alternative Steel column can be modeled/designed as the set of shells (Shell model) 

Table: Column properties 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. 

2. Start  Column command from  tabmenu and choose  Define. 

 

3. Set the properties of the new column at  Default settings: 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Allow uplift (General) 

Available in  only. “Uplift” behavior can be modeled by activating this option. It works 

in case of tensional reaction force. 

 In 3D modules, “uplift” can be modeled with non-linear Point support settings. 

- Section 
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Choose a column profile from the Section library or define a new cross-section by 

parameters. The applied section name can be displayed in model view (Display settings). 
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- End conditions 

In , the support conditions (General) of the top and bottom ends can be set to fully rigid 

or fully hinged. Because Columns are point supports further point support is not needed to 

define at Column end. 

In 3D modules, the end connections can be set under the End conditions tab. Only the 
released motion (arrow) and rotation (two-headed arrow) components are displayed in the 
model view (Display settings). End connections can be fully customised for bar ends by 
setting the rigidity of the displacement components. 

The component directions are valid in the beam’s local co-ordinate system. 

Inactive component means a fixed motion/rotation, while a checked component behaves 
according to the user-specified rigidity value. 

-  

With the „Rigid” and the „Hinged” buttons pre-defined end condition values can be 
applyed to the bar ends. 

Eccentricity of analytical model (End conditions) 
 

In 3D modules, eccentricity of the analytical model can be set in the End conditions tab 

similarly to Beams. The default position (center of gravity) of the column axis (local x’ axis) 

can be set in the aspect of analysis/design calculation. 

- Physical model 

Eccentricity of the physical model can be set in the Physical model tab, in a similar way as 

the Eccentricity of analytical model for Beams. It has no effect on the calculation. 

- Material 
Any type of materials can be set for column Analysis, but design can be run for concrete, 

steel and timber columns only. The applied material name can be displayed in model view 

(Display settings). 

4. Define the direction of the cross-section y’ axis. 
5. Choose a method for insertion point definition (geometry). 
6. Place the column in the model view based on the chosen geometry method. 
Optional steps: 

7. Modify the bar properties with the  Properties tool of the Column tool palette. 
8. Set the display settings of columns at Settings > All > Display > Beam, Column and Truss similarly 

to Beams. 
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9. The columns are stored on “Columns” Object layers. At layer settings, the default color and 
pen width can be set for all columns. The color and pen width settings by selected column 
elements can be modified by Edit > Properties > Change appearance. 

10. In  Plate module, the  Info tool displays the support stiffness (motion and rotation) values 
of the column ends valid in the column local co-ordinate system. 

 

Figure: Support stiffness of Columns in Plate module 

11. To simulate camber of the elements check the box next to Camber simulation by prestressing in the 
Default setting/General tab. 
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Truss Member 

 Truss member property Description 

Modules where available    

Function It models bars with limited compression and tension-only bars like cables, pull rods, 

diagonal braces etc. 

Axis position Arbitrary (horizontal, vertical and skew) 

Geometry Straight 

Cross-section Arbitrary profile 

Connection - Always hinged (cannot be modified) 
- It can be connected to other elements only at its ends 
- It does not intersect other elements cross it visually 

Material Steel, concrete, timber and general 

Load direction Axial 

Load type - Dead load (will be distributed to the end nodes) 
- Uniform line temperature variation 
- Shrinkage 
- Line stress load 
- Point mass (will be distributed to the end nodes) 

Analysis Displacement, normal force and stress 
 

Available design Steel design in   

 RC design in   

 Timber design in   

Alternative Steel truss member can be modeled/designed as the set of shells 

(Shell model) 

Table: Truss member properties 
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Figure: Modeling a truss 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. In the 3D design modules, respect that the gravity direction is always the Global 
Z axis direction. 

2. Start  Truss member command from  tabmenu and choose  Define. 

 

3. Set the properties of the new truss element at  Default settings: 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Non-linear behaviour (General) 
Limited capacity and Brittle/Plastic can be set for both compression and tension. These 

options are considered only for load combinations calculated as non-linear elastic. Plastic 

behaviour is only considered for load combinations calculated as non-linear elastic + 

plastic. 

- Section 
Choose a profile from the Section library or define a new cross-section by parameters. The 

applied section name can be displayed in model view (Display settings). 

- Material 
Any type of materials can be set for beam Analysis, but design can be run for concrete, steel 

and timber elements only. The applied material name can be displayed in model view 

(Display settings). 

4. Define the direction of the cross-section y’ axis. 
5. Choose a geometry definition method for the truss element reference line (axis). 
6. Define the element in the model view based on the chosen geometry method. 
Optional steps: 

7. Modify the bar properties with the  Properties tool of the Truss member tool palette. 
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8. Set the display settings of truss elements at Settings > All > Display > Beam, Column and Truss 
similarly to Beams. 

9. The truss elements are stored on “Truss members” Object layers. At layer settings, the default 
color and pen width can be set for all truss elements. The color and pen width settings by 
selected truss elements can be modified by Edit > Properties > Change appearance. 

Fictitious Bar 

 Fictitious bar property Description 

Modules where available     

Function Bar elements with given stiffness values 

Axis position Horizontal in  

 Arbitrary (horizontal, vertical and skew) in    

Geometry Straight and curved 

End connection Rigid and hinged, or custom defined by Point-point connection 

Stiffness Editable (but, material and cross-section definition is not available) 

Load direction Vertical in  

 Arbitrary in    

Load type All point and line load 

Available analysis results Displacement and internal forces 

Table: Fictitious bar properties 

 

Figure: Fictitious bars connect plate elements 
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 The program automatically generates “rigid” fictitious bars in the end points of “bars” modeled 

as a shell model (end edges of shell regions; see Shell model). 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. 

2. Start  Fictitious bar command from  Tabmenu and choose  Define. 

  

 

3. Set the properties of the new bar at  Default settings: 
 

 

- Stiffness (General) 
EA, GIt, EI1 and EI2 stiffness values can be assigned to bars. No definition of material and 

cross-section is needed. The local y’ axis represents the 1st principal axis, and the local z’ 

axis defines the 2nd principal axis. 

The value of rigid stiffness (“infinite” rigidity) can be defined and set as project default at 

Settings > Calculation> “Rigid” values > Fictitious bar. 

- Connections 

In , the end connections are fully rigid. 

In 3D modules, the end connections can be set under the Connections tab similarly to 

Beams. Only the released motion (arrow) and rotation (two-headed arrow) components 

are displayed in the model view (Display settings).  

4. Define the direction of the cross-section 1st principal axis (local y’ axis; only in 3D modules). 

The y’ axis cannot be modified in the  module, so it is always parallel with the Global X-Y 

(working). 

5. Choose a geometry definition method for the bar reference line (axis). 
6. Define the bar in the model view based on the chosen geometry method. 
Optional steps: 

7. Modify the geometry with the Edit menu commands valid for line elements. 
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8. Modify the bar properties with the  Properties tool of the Fictitious bar tool palette. 
9. The fictitious bars are stored on “Modeling tools” Object layers. At layer settings, the default 

color and pen width can be set for all fictitious bars. 

Planar Objects 
This chapter summarizes all features and properties of planar objects: Foundation slab, Plate, Wall, 

Shell model elements, Fictitious shell, Timber panel and Profiled plate/wall. 

Foundation slab 

 Foundation slab 

property Description 

Modules where available    

Reference plane position Horizontal 

Geometry Any shape 

Thickness Constant or variable 

Hole Available 

Eccentricity Available for display and calculation 

Edge connection Rigid elastic (spring) linear or non-linear 

Material Concrete 

Orthotropic feature Available 

Load direction Vertical 

Load type 

Point load (force and moment), Line load (force and moment), Surface load, Surface 

temperature variation load, Surface stress load, Surface support motion  

 

Available analysis results Displacement, internal forces, stresses, stability and vibration shape 

Available design Foundation design 

Table: Foundation slab properties 

Definition steps 

1. If needed, set a proper position for the working plane. 

2. Start  Foundation slab command from  tabmenu and choose  Define. 

 

3. Set the properties of the new plate at  Default settings: 
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- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID) 

number can be displayed in model view (Display settings). 

- Bedding (General) 
The horizontal one can be specified by the User. These three values define the motion 

spring stiffness of the automatically created surface support group under the foundation 

slab. By default, the horizontal values are the half of the vertical one. 

- Insulation (General) 
User can apply insulations attached to the bottom of the foundation slab. If Calculate 

soil as a solid element is activated, Insulations are calculated as part of the Foundation 

object with the user-specified parameters. Otherwise, they are ignored. 

- Geometry (General) 
Variable thicknes can be set for the foundation slab with the same method as for the Plate 
objects. 

- Eccentricity (General) 
Eccentricity (e) adds “virtual” distance between the reference plane and the calculation 

(middle!) plane if“Consider eccentricity in calculation” option is unchecked, otherwise the 

eccentricity has effects in the calculation. This option is useful for displaying regions with 

different thickness values. 

 Eccentricity have no effect in calculations if “Consider eccentricity in calculation is 

checked off. They are only to display plate “solid” with its defined position.  

Eccentricity value can be displayed in model view (Display settings). 

The “Consider eccentricity caused by cracking in cracked section analysis” option is for 

Reinforced concrete slabs. With this option modeling the eccentricity changes after 

cracking is available. The following figure shows the eccentricity changes. 

             
Uncracked 

analysis 

Cracked 

analysis 
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Figure: Explaining cracked and uncracked analysis  

 

- Orthotropy (General) 
The ratio between the E1 and E2 elasticity modules in the main directions can be set here. 

So, if the value is 1, the new plate will be isotropic, otherwise it is orthotropic. The 

orthotropy direction can be set with the angle between E1 direction and the plate’s local x’ 

axis (Alpha). 

- Material 
Only concrete material can be set for Analysis and Design.  

4. Define the plate region in the model view based on the chosen geometry method. 
 

Optional steps: 

5. Modify the default edge connections with . Just select the plane and then its edge(s) to set 
connection conditions, and finally set the requested motion and rotation settings. 
Motion-Rotation / Compression-Tension 

The x’, y’ and z’ are valid in the connection’s local system displayed in the preview and as a 

symbol in the middle of the edges in the model view. Choose “Rigid” or “Free” from the drop-

down lists, or type stiffness values (spring connection). 

 Active  link button assigns the stiffness value typed in the Compression field to the 

Tension field. Inactive icon  lets to define stiffness values separately. 

Predefined types 

Click  to set all motion and rotation components to “rigid”. The result will be a “totally 

rigid” connection. 

Click  to set all motion components to “rigid” and all rotation components to free (allow 

rotation around all directions). The result will be a hinged connection. 

Click  to set all components to free. This tool gives the possibility to virtually connect 

independently moving elements. 

Behavior 
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Click  to assign the stiffness value defined in the Compression field to the Tension field by 

components. 

Click  not to allow tension for all connection components. 

Click  not to allow compression for all connection components. 

Setup “Rigid” 

With this option the value of “infinite” rigidity can be defined by motion and/or rotation for 

selected connections. 

For all edge connections, the value of “infinite” rigidity can be defined and set as project default 

at Settings > Calculation> “Rigid” values > Connections. 

6. Add hole with  tool. 
7. Modify the reference plane geometry with the Edit menu commands valid for region elements. 

8. Modify the Foundation slab properties with the  Properties tool of the Foundation slab tool 
palette. 

9. Set the display settings of plates at Settings > Display > Soil and Foundation. 
10. The Foundation slabs are stored on “Foundation” and if they modeled with Surface support 

group their supports will be stored at the “Support” Object layers. The color and pen width 
settings by selected plate elements can be modified by Edit > Properties > Change appearance. 

Plane plate 

 Plane plate property Description 

Modules where available    

Reference plane position Horizontal in  

 Arbitrary (horizontal, vertical and skew) in   

Geometry Any shape 

Thickness Constant or variable 

Hole Available 

Eccentricity Only for display 

Edge connection Rigid, hinged, elastic (spring) linear or non-linear 

Material Steel, concrete, timber and general 

Orthotropic feature Available 

Load direction Vertical in  

 Arbitrary in   

Load type All point, line and surface load 

file://///officesrv/strushare/Ricsi/new%20features/Infinite%23_
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Available analysis results Displacement, internal forces, stresses, stability and vibration shape in   

Available design RC design in   

 Timber design in  

Table: Plate properties 

Definition steps 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. 

2. Start  Plane plate command from  tabmenu and choose  Define. 
 

 

3. Set the properties of the new plate at  Default settings: 
 

 

- Identifier (General) 
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The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Alignment and Eccentricity (General) 
With alignment the position of the reference (definition) plane can be set to top, center or 

bottom. 

Eccentricity (e) adds “virtual” distance between the reference plane and the calculation 

(middle!) plane if “Consider eccentricity in calculation” option is unchecked, otherwise the 

eccentricity has effects in the calculation. This option is useful for displaying regions with 

different thickness values. 

 Alignment and eccentricity have no effect in calculations if “Consider eccentricity in 

calculation is checked off. They are only to display plate “solid” with its defined 

position.  

Eccentricity value can be displayed in model view (Display settings). 

The “Consider eccentricity caused by cracking in cracked section analysis” option is for 

Reinforced concrete slabs. With this option modeling the eccentricity changes after 

cracking is available. The following figure shows the eccentricity changes. 

             

 

 

Figure: Explaining cracked and uncracked analysis  

- Thickness (General) 
By default, only plate with constant thickness (t1=t2=t3) can be set at Default settings. Use 

the Variable thickness tool to define different t values that declare the top/bottom surface 

as a linearly variable plane. 

- Orthotropic features (General) 
The ratio between the E1 and E2 elasticity modules in the main directions can be set here. 

So, if the value is 1, the new plate will be isotropic, otherwise it is orthotropic. The 

orthotropy direction can be set with the angle between E1 direction and the plate’s local x’ 

axis (Alpha). 

 In  Plate module the local x’ axis is always parallel with the global X axis. 

- Material 
Any type of materials can be set for plate Analysis, but design can be run for concrete only. 

The applied material name can be displayed in model view (Display settings). 

Uncracked 

analysis 

Cracked 

analysis 



155 

 

4. Set the default connections for all plate edges to rigid or hinged with the tool palette’s Edges 
option. 

 

Figure: Default edge connections 

 Use the Edge connection tool to modify the default connections by the selected edges 

of a predefined plate. Hinged, rigid, semi-rigid (spring), free connections can be set 

with linear and non-linear behavior. 

The edge connections can be calculated as plastic behavior, which shows the figure below. 

The values can be customized. 

 

 

5. Choose a geometry definition method for the plate reference plane (set by Alignment and 
Eccentricity). 

6. Define the plate region in the model view based on the chosen geometry method. In  module 
the slab plane can be horizontal only, while in 3D modules any skew position can be set. All 
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region definition points have to be in the same plane. UCS may help to find the requested 
position of the new plate region. 

 

Figure: Different working planes for plate definition 

 

Optional steps: 

7. Modify default thickness (Variable thickness) 

Constant slab thickness can be fast modified with the  Properties tool. Just select the plate(s) 

and set a new value under General Tab. 

Constant thickness can be changed to variable, or reverse, with the  Variable thickness tool. 

Steps of defining plate with variable thickness: 

i. Inactivate the  link buttons to allow giving different values in the t fields. 
ii. Type the t1, t2 and t3 according to the current length unit. 

 

 

iii. Select the plate you would like to modify. 
iv. Define three points in the plane of the selected plate’s reference plane, where t1, t2 and t3 

will be measured. The measurement of the thickness values depends on the position of the 
reference plane (Alignment and Eccentricity). 
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Figure: Align the thickness of the middle slab to its neighbors 

 

 

Figure: Align circular slab thickness to a variable height wall 

 

 The measurement of the thickness values depends on the position of the reference 

plane (Alignment and Eccentricity). 

 

 You are allowed to place the measuring points outside the region, too. 

 

Figure: Edit thickness by using other objects’ height 
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8. Modify the default edge connections with . Just select the plane and then its edge(s) to set 
connection conditions, and finally set the requested motion and rotation settings. 

 

 

Figure: Modification of two slab edges 

Motion-Rotation / Compression-Tension 

The x’, y’ and z’ are valid in the connection’s local system displayed in the preview and as a 

symbol in the middle of the edges in the model view. Choose “Rigid” or “Free” from the drop-

down lists, or type stiffness values (spring connection). 

 Active  link button assigns the stiffness value typed in the Compression field to the 

Tension field. Inactive icon  lets to define stiffness values separately. 

Predefined types 

Click  to set all motion and rotation components to “rigid”. The result will be a “totally 

rigid” connection. 

Click  to set all motion components to “rigid” and all rotation components to free (allow 

rotation around all directions). The result will be a hinged connection. 

Click  to set all components to free. This tool gives the possibility to virtually connect 

independently moving elements. 
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Figure: Edge connection types and their displacement effect 

Behavior 

Click  to assign the stiffness value defined in the Compression field to the Tension field by 

components. 

Click  not to allow tension for all connection components. 

Click  not to allow compression for all connection components. 

Setup “Rigid” 

With this option the value of “infinite” rigidity can be defined by motion and/or rotation for 

selected connections. 

For all edge connections, the value of “infinite” rigidity can be defined and set as project default 

at Settings > Calculation> “Rigid” values > Connections. 

 As a real example, Edge connection gives the possibility to model prefab concrete 

elements too. Define the objects with the Plate/3D plate commands, set the thickness 

value of the regions to substitute the real cross-section with the holes, and finally add 

“hinged” edge connection (Cx = 0) to one of the region at the common edge with the 

other one (see the next figure). 

file://///officesrv/strushare/Ricsi/new%20features/Infinite%23_
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Figure: Modeling slab elements connected to each other (hollow-core prefab slabs) 

9. Add hole with  tool. 
In 3D modules, select a plate region and define hole in it or cut it by using a geometry mode. 

Selecting a plate displays the UCS in the reference plane of the plate. 

 

Figure: Hole and cuttings 

In  Plate module, just define hole or cutting by using a geometry mode in the required plate 

reference plane. Selection of the host plate is needed, if the hole region intersects more than one 

regions. 

10. Modify the reference plane geometry with the Edit menu commands valid for region elements. 

11. Modify the plate properties with the  Properties tool of the Plate tool palette. 
12. Information (the volume of the plate solid and the position of its centre of gravity) about a 

selected plate can be inquired with the  Info tool. A drawing point can be placed in the plate’s 
centre of gravity, if needed. 

13. Set the display settings of plates at Settings > All > Display > Shell. 
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14. The plates are stored on “Plates” Object layers. At layer settings, the default color and pen 
width can be set for all plate regions. The color and pen width settings by selected plate 
elements can be modified by Edit > Properties > Change appearance. 

Plane wall 

 Plane wall property Description 

Modules where available       

Function Line support in  

 Shear or load-bearing wall region  

 Unit section of long-extensional object (tunnels, dams, retaining walls et.)  

 Structural wall in   

Reference plane position Vertical in    

 Global X-Y plane    

Geometry Any shape 

Thickness Constant or variable 

Hole Available 

Eccentricity Only for display 

Edge connection Rigid, hinged, elastic (spring) linear or non-linear 

Material Steel, concrete, timber and general 

Orthotropic feature Available in     
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Load direction Arbitrary in   

 Planar, global X-Y plane    

Load type All point, line load and surface load in     

Available analysis results Reaction forces in  

 Displacement, internal forces and stresses  

 Displacement, internal forces, stresses, stability and vibration shape in    

Available design RC design in   

 Timber design in  

Table: Wall properties 

 

 

Figure: Wall function by FEM-Design modules 

 

Definition steps 

The wall definition depends on what module is used for modeling: 

 Wall is a line support, so its base line has to be defined with a given height and 

constant/variable thickness as a straight or curved line. 
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 The only modeling object is the Wall, which is a region with constant or variable 

thickness, so its reference plane has to be defined as a rectangle, circular, polygonal 

or arbitrary shaped region. Holes can be added to it. 

 The only modeling object is the Wall, which is a region with unit (=1) thickness, so its 

reference plane has to be defined as a rectangle, circular, polygonal or arbitrary 

shaped region. Holes can be added to it. 

  Wall is a region in vertical position, so the base line has to be defined with given 

height and constant/variable thickness as a straight or curved line. Holes can be 

added to it. 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. 

2. Start  Wall command from  tabmenu and choose  Define. 

 

3. Set the properties of the new wall at  Default settings: 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Height (h) (General) 

In  the height can be set in the dialog, but in 3D modules only in the Wall command’s 

tool palette. 

 - In 3D modules, the sign (positive or negative) of the Height value defines the 

location of the Wall (Straight line). 
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 - In , the position of the wall support can be set according to slab position: 

“Above slab” or “Under slab”. It also defines the location of the base line. 

- Alignment and Eccentricity (General) 
With alignment the position of the reference base line or the reference region can be set to 

left/front, center or right/back. 

Eccentricity (e) is handled the same was as in 3D Plate . 

Eccentricity value can be displayed in model view (Display settings). 

 While modeling, think about the reference plane/reference line connections with 

each other. Connecting edged “perfectly” results correct and “nice” finite element 

mesh. If they intersect each other with small distances, the outcome of mesh 

generation may be very small finite elements or unexpected mesh regions. The next 

figure shows an example for possible (recommended or not) wall connection to slab 

edge.  

 

Figure: Recommended modeling of plate-wall edge connection (no calculation differences in case 1. and 2.) 

- Thickness (General) 

In   , the thickness values (t1 in the start point and t2 in the end point) can be set 

directly in the settings dialog. The measurement of the thickness depends on the 

Alignment and Eccentricity settings. 
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Figure: Variable thickness and eccentricity 

In , the thickness value is fixed. It is always 1m, so only region(s) with unit thickness 

(section) can be defined. 

In , the thickness value can be constant or variable like plate regions. Because walls are 

regions in the Wall module like plates in  Plate module, the definition way of constant 

and variable thickness is the same. In the dialog, only constant thickness (t1=t2=t3) can be 

set, but with Variable thickness tool (same with Plate’s Variable thickness tool) t values 

can be modified separately to define wall regions with variable thickness. 

- Orthotropic features (General) 

This option is available in     modules. The ratio between the E1 and E2 

elasticity modules in the main directions can be set here. So, if the value is 1, the new wall 

will be isotropic, otherwise it is orthotropic. The orthotropy direction can be set with the 

angle between E1 direction and the wall’s local x’ axis (Alpha). 

 In    modules the local x’ axis is always parallel with the global X axis. 

- Statical System (Connections) (General) 

In , the support conditions (General) of the top and bottom wall ends can be set to fully 

rigid or fully hinged. Because, Walls are line supports further line/point support is not 

needed to define at Wall end. 

- Allow uplift (General) 

Available in  only. “Uplift” behavior can be modeled by activating this option. It works 

in case of tensional reaction force. 

 In 3D modules, “uplift” can be modeled with non-linear Line support settings. 
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- Material 
Any type of materials can be set for wall Analysis, but design can be run for concrete and 

timber walls only depending on the current FEM-Design module. The applied material 

name can be displayed in model view (Display settings). 

3. In   modules, the default connections for all wall edges can be set to rigid, hinged or “No 
shear” with the tool palette’s Edges option. 

 

Figure: Default edge connections 

 Use the Edge connection tool to modify the default connections by the selected edges 

of a predefined wall. Hinged, rigid, semi-rigid (spring), free connections can be set with 

linear and non-linear behavior. 

“No shear” macro defines edge connection with predefined “No shear” rigidity type on the 

defined wall’s bottom edge. 

 

It is the recommended wall definition method to create a non-bracing system element.  
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“No shear” rigidity type settings with free local x’ motion rigidity: 

 

 

 If a wall connect to slab at a common edge and you would like to define hinged 

connection between them, only one edge connection (for plate or wall) has to be defined 

hinged and the other has to be kept as rigid. So, applying hinged edge connection for 

both plate and wall at their linked edge is not allowed to avoid instability in finite 

element modeling. The figure shows the possibilities to model the same hinged 

connection in two ways. 

 

Figure: Modeling the same hinged wall-plate edge connection in two ways 

 The previous rule is also true for wall support in  module: if, you would like to 

model hinged wall support at a plate edge, define hinged statical connection for wall 

(top or bottom depending on the wall position) and set the plate edge connection to 

rigid, or, define rigid wall support and hinged edge for plate. 

4. Choose a geometry definition method for the wall’s reference line/plane (set by Alignment and 
Eccentricity) and create the wall with co-ordinates or by picking points in the drawing area. 
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In   modules, the walls are regions in the Global XY working plane. 

 In these wall modules the dead-load is orientated in Global Y direction, although the 

dead-load is orientation in Global Z direction in all other modules. 

 

 

Figure: Wall region with holes, loads and supports in Wall and Plane Strain modules 

In  module, wall is a line support, so it has to be defined with its base/reference line. 

Although walls are planar objects in   modules, they can be defined with their reference 

lines, because of the fixed vertical position. The lines can be straight or “curved”. The “curved” 

means real arc and circle in  module, while it means the combination of straight lines (wall 

sections) in the 3D modules. In the second case the “curved walls” are built up by planar region 

members (curved finite elements are not available in FEM-Design), and the resolution of the 

curve approximation can be set by the peripheral angle of the sections (Alpha). 
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Figure: “Curved” wall definition in 3D modules 

 In the 3D modules, if you would like to connect a plate to “curved” walls at the edges, 

define polygonal slab instead of curved-edge slab. In case of curved plate, small regions 

are cut by the connected wall, and that results finite elements with very small angle. 

 

Figure: “Curved” wall definition in 3D modules 

Optional steps: 

5. Modify default thickness (Variable thickness) 
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Constant wall thickness can be fast modified with the  Properties tool. Just select the wall(s) 

and set a new value under General Tab. In   modules, you can define variable thickness 

with t1 and t2 values too. 

In   modules, constant thickness can be changed to variable (linear distribution), or 

reverse, with the  Variable thickness tool. 

Defining wall with variable thickness is similar as done in case of a Plate. 

6. Modify the default edge connections with . Just select the wall and then its edge(s) to set 
connection conditions (rigid, hinged, free or semi-rigid (spring)), and finally set the requested 
motion and rotation settings. See the definition steps and possibilities at Plate. 

7. Add hole with  tool (see hole definition in plates). 

Except of  module where wall is support, holes and cuttings can be defined in walls. 

In 3D modules, select a wall region and define hole in it or cut it by using a geometry mode. 

Selecting a wall displays the UCS in the reference plane of the wall. 

In    modules, just define hole or cutting by using a geometry mode in the required wall 

reference plane. Selection of the host wall is needed, if the hole region intersects more than one 

regions.  

8. Modify the reference line/plane geometry with the Edit menu commands valid for lines/region 
elements. 

9. Modify the wall properties with the  Properties tool of the Wall tool palette. 

10. In  Plate module, the  Info tool displays the support stiffness (motion and rotation) values 
of the wall ends (start and end point) valid in the wall local co-ordinate system. 
In the other design modules, information (the volume of the wall solid and the position of its 

centre of gravity) about a selected wall can be inquired with the  Info tool. A drawing point 

can be placed in the wall’s centre of gravity, if needed. 

11. Set the display settings of walls at Settings > All > Display > Shell (see Plate display settings). 
12. The walls are stored on “Walls” Object layers. At layer settings, the default color and pen width 

can be set for all plate regions. The color and pen width settings by selected plate elements can 
be modified by Edit > Properties > Change appearance. 

Shell Model 

In  3D Structure module, straight and arc bars (Beams and Columns) can be modeled more 

accurately for stability, utilization check (against flexural, torsional, lateral torsional and local buckling) 

and design according to their EC by modeling them with planar shell members.  

Definition steps 

1. Press Analytical model / Shell model option of Beam or Column toolwindow and choose the bar. By 
default, selecting a bar element generates a complex 3D model built by a group of steel plates 
derived from the geometry of the selected bar’s profile. All converted plates inherit the original 
bar element’s steel material. 

file:///D:/meló/FEM-Design/FEM-Design_2012/manual/user_manual/11/user%20manual.docx%23_Co-ordinate_Systems
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Figure: Straight bars with constant cross-section 

 After converting a bar to shell model, the program automatically defines “rigid” Fictitious 

bar objects at the ends of the shell model to guarantee continuous connection to other objects 

line 1D members, point supports and point loads. The stiffness of these fictive elements can 

be modified with the  Properties tool of Fictitious bar command. Alternatively, this function 

can be turned off by clicking  after selecting Analytical model in the Beam or Column 

toolwindow. 

 

 

 Depending on, Beam, Column or Truss member was converted to shell model, the model can be 

hidden together with the Beam, Column or Truss member object layer. 

Fictitious shell 

In  3D Structure module a fictitious shell can be defined by clicking on . Fictitious shell is ideal 

to model a section with composite material, where the designer may calculate appropriate stiffness and 
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fill the D, K and H stiffness values. Fictitious shell is also a powerful tool by the calculation of a section 

with complex geometry where the parameters are specified by the manufacturer of the structural 

element. 
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Definition steps 

1. If needed, set a proper position for the working plane. 

2. Start  Fictitious shell command from  tabmenu and choose  Define. In the tool-
window the type of the edges (Rigid or Hinged) can be chosen. 

 

3. Set the properties of the new plate at  Default settings. The User can define the stiffness 
matrices (Membrane stiffness matrix, Flexural stiffness matrix and Shear stiffness matrix) and 
physical properties (Unit mass, distances of the planes where thermal load acts from the center 
plane, coefficient of thermal expansion). 

 

Stiffness of orthotropic shell element for fictitious shell can be calculated as follow: 
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These matrices belong to an orthotropic, homogenous, constant thickness shells according to 

Mindlin theory. 

The H matrix is calculated as ρ*G*h (see in Profiled plate), where the ρ is the shear modification 

factor, the G is the shear modulus and the h is the thickness of the fictitious shell. For constant 

thickness the shear modification value is 5/6 = 1/1.2, this gives the equivalency of the energy of 

the shear forces and shear stresses. 

 

As it is mentioned above, if the D, K and H stiffness values are calculated and filled in, then it is possible 

to model the sections with complex geometry and composite materials with new fictitious shell object. 

A few sections are shown below which can be handled by the help of fictitious shell. 

Corrugated steel + Concrete floor 
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Corrugated steel + Timber floor 

 

Timber Panel 

Quick tool to model timber slabs and wall panels is optionally available for later analysis in  3D 

Structure and  PreDesign modules and timber design in . 

Definition steps 

1. If needed, set a proper position for the working plane. 

2. Choose  or  according to the panel function to define a new timber panel:  Use as 

plate or  Use as wall. 

3. Set the panel settings under  (plate) or  (wall) Default settings. 

 

Figure: Timber command and settings 

- Group identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 
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- Panel type identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Width (General) 
The width of the elements can be set if Prefabricated physical model is chosen. 

- Gap between panels (General) 
The gap between panels can be set if Prefabricated physical model is chosen. 

- Alignment and Eccentricity (General) 
With Alignment the position of the reference (definition) plane can be set to Top/Left, Center 

or Bottom/Right. 

Eccentricity adds “virtual” distance between the reference plane and the calculation 

(middle!) plane. This option is useful for displaying regions with different thickness 

values. 

Eccentricity (e) is handled the same was as in 3D Plate . 

Eccentricity value can be displayed in model view (Display settings). 

- Type (Material) 
Predefined panel types are available, but it can be expanded manually (Edit library) with 

new laminated, fiber boards, plywood etc. Design factors, stiffness and strength values can 

be edited for predefined and new panel types. Panel types can be imported or exported 

between users like the FEM-Design materials. 

- Physical model and Analytical model (General) 
In Timber plate/wall dialog there is opportunity to select the physical model (in-situ or 

prefabricated), then analytical system of shell, if applicable. The analytical system can be 

Continuous or Panel by panel. This option is available in profiled plate and profiled wall. 
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Figure: Physical model and Analytical system of a timber panel 

Choosing continuous analytical system can be useful when modelling the whole 

structure e.g. in the preliminary design phase. The memory usage of calculation with 

continuous analytical system is less than panel by panel system due to the reduced 

number of edge connections. 

The use of panel by panel analytical system is reasonable in the phase of detailed 

design. In this case the results of the calculation are more accurate. 

 In case of continuous analytical system, effect of the connections between the panels 

can be considered by the transverse flexural stiffness factor. 

4. Set the width (w) of the selected panel type on the tool palette. 
5. Set the default edge connection to hinged or rigid at Edges of the tool palette. 
6. Define the timber plate/wall based on the geometry of the reference plane/base line. 

For plate panels, the stiff direction has to be defined first. (For walls, the stiff direction is always 

perpendicular to the wall base line.) The distribution of panels is described with an anchor 

point. 
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Figure: Timber plate definition 

Optional steps: 

7. The panel type of selected timber panels can be modified subsequently with the  Properties 
tool. 

8. Modify the default edge connections of the unique panel or panel group with . Just select 
the plate/wall panel and then its edge(s) to set connection conditions at Border (DOF of the 
panel group) or Panel tab (rigid, hinged, free or semi-rigid (spring)), and finally set the 
requested motion and rotation settings. See the definition steps and possibilities at Plate. 
 

 

Figure: Panel edge connections 

9. Openings and cuttings can be added to timber panel elements with Edit > Region operations > 
Split regions. 

10. Set the display settings of timber panels at Settings > All > Display > Shell (see Plate display 

settings). 
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11. The panels are stored on “Plates” Object layers. At layer settings, the default color and pen 
width can be set for all panel regions. The color and pen width settings by selected panel 
elements can be modified by Edit > Properties > Change appearance. 

Profiled plate/wall 

Quick tool to model prefabricated slabs and wall panels is optionally available for later analysis in  

3D Structure module and the designing in . 

Definition steps 

1. If needed, set a proper position for the working plane. 

2. Choose  or  according to the panel function to define a new profiled panel:  Use as 

plate or  Use as wall. 

3. Set the panel settings under  (plate) or  (wall) Default settings. 
- Identifier (General) 

The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Alignment and Eccentricity (General) 
With Alignment the position of the reference (definition) plane can be set to Top/Left, Center 

or Bottom/Right. 

Eccentricity (e) is handled the same was as in 3D Plate . 

Eccentricity value can be displayed in model view (Display settings). 

- Section (Section) 
Predefined panel types are available in Section library in Hollow Core. Cross-section types 

can be imported or exported between users like the FEM-Design materials. 

- Physical and analytical model (General) 
In Profiled plate/wall dialog there is opportunity to select the physical model (in-situ or 

prefabricated), then analytical system of shell, if applicable. The analytical system can be 

Continuous or Panel by panel. This option is available in profiled plate and profiled wall. 

- Camber simulation by prestressing (General) 
See details at Beam. 
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Figure: Physical model and Analytical system of a prefabricated panel 

Choosing continuous analytical system can be useful when modelling the whole 

structure e.g. in the preliminary design phase. The memory usage of calculation with 

continuous analytical system is less than panel by panel system due to the reduced 

number of edge connections. 

The use of panel by panel analytical system is reasonable in the phase of detailed 

design. In this case the results of the calculation are more accurate. 

 In case of continuous analytical system, effect of the connections between the panels 

can be considered by the transverse flexural stiffness factor. 

 

4. Set the panel group’s edge connection in Border tab. 
 

5. Set the unique panel’s edge connection in Panel tab. The following figure shows the difference 
between the continuous and the panel border. 

 

Panel group border 

line 

Single panel border line 
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6. Define the profiled plate/wall based on the geometry of the reference plane/base line. 
For plate panels, the stiff direction has to be defined first. (For walls, the stiff direction is always 

perpendicular to the wall base line.) The distribution of panels is described with an anchor 

point. Defining is similar to Timber panel definition. 

Optional steps: 

7. The panel type of selected profiled panels can be modified subsequently with the  Properties 
tool. 

8. Modify the default edge connections of the unique panel or panel group with . Just select 
the plate/wall panel and then its edge(s) to set connection conditions at Border (DOF of the 
panel group) or Panel tab (rigid, hinged, free or semi-rigid (spring)), and finally set the 
requested motion and rotation settings. See the definition steps and possibilities at Plate. 

9. Openings and cuttings can be added to timber panel elements with Edit > Region operations > 
Split regions. 

10. Set the display settings of timber panels at Settings > All > Display > Shell (see Plate display 

settings). 
11. The panels are stored on “Plates” Object layers. At layer settings, the default color and pen 

width can be set for all panel regions. The color and pen width settings by selected panel 
elements can be modified by Edit > Properties > Change appearance. 

12. Modifying the anchor point it’s possible with Base line command: 

 

13. With  Swap panel two panel placement can be change which one panel is a truncated panel. 

 

 

14.  

15.  

16.  

 

 

Select the panels 
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14. Cut panel will change the placement of the truncated panel. 

 

 

 

 

 

 

 

 

15. To simulate camber of the elements check the box next to Camber simulation by prestressing in the 
Default setting/General tab. 

 

 

Calculation of Profiled shell 

Profiled shells are calculated as Fictitious shells (the stiffness matrices are calculated automatically, 

according to the tables below). 

1. Select the truncated 

panel 
2. Define the cut placement New cutted panel 
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Section data: 

hx, hy : equivalent thickness in x and y direction 

Ix, Iy: equivalent inertias in x and y direction 

ρx, ρy: equivalent shear factor in x and y direction 

x direction: strong axis of the panel cross-section 

y direction: is perpendicular to the x direction in the plane of the panel 

Material data: 

E: Young modulus 

G: Shear modulus 

ν: Poisson’s ratio 

Panel data: 

q: transverse flexural stiffness factor (applicable only in Continuous analytical system) 
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Modifying any above mentioned data will affect the stiffness of shell. The stiffness of shell is 

calculated automatically. The value of the stiffness (derived from properties of the shell) can 

be checked by clicking on the “Display stiffness” button. 

 

Different types of Young moduli (except for steel material) can be set in different types of 

calculations. It has a direct effect  on the values of stiffness matrices in different types of 

calculations. The stiffness values can be easily checked in “Display stiffness” dialog. 

 

This feature gives the possibility to automatically calculate stiffness of concrete shell having 

complex geometry. Some typical examples are shown below (sections are made in section-

editor). 
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Components 
This chapter introduces the component objects which can not exist bz themselves only as part of an 

other object (bar, shell) 

Intermediate section 

 Intermediate section   Description 

         property  

Modules where available      

Axis position Horizontal in  

 Arbitrary (horizontal, vertical and skew) in   

Cross-section Arbitary 

Eccentricity Available 
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Material Steel, concrete, timber and general 

Available analysis results Displacement, internal forces, stresses, stability and vibration shape in    

Definition steps  

1. If needed (and available in the current FEM-Design module), set a proper position for working 

plane. In all modules, respect that the gravity direction is always the Global Z axis direction. 

2. Start  Intermediate section from  tabmenu and choose  Define. 

 

3. Set the properties of the new Intermediate section at   Default setting: 

 

- Section 

Choose a beam profile from the Section library or define a new cross-section by parameters. 
The applied section name can be displayed in model view (Display settings). 

 Intermediate section can be used with the same section shape and fabrication 
technology. 

- Insertion point 

The axis default position is on the gravity center (symbolized with yellow point in the section), 
but it can be set with its coordinate in the local y’z’ plane, or can be placed into special section 
points (e.g. plate corners) by clicking the yellow point into the requested position. 
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You can manage the physical and analytical eccentricity separately for intermediate sections: 

 

4. Define the direction of the cross-section y’ axis (only in 3D modules). 

The y’ axis cannot be modified in the  module, so it is always parallel with the Global X-Y 
(working) plane. 

5. Define the Intermediate section placement. 
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Figure: Defining an Intermediate section 

Optional steps: 

6. Modify the Intermediate section with the  Properties. 

7. The Intermediate section is part of the bar element so its layer and setting can be found like in 
Beam, Column or Truss. 

Apex 

 Apex property  Description 

Modules where available    

Axis position Arbitrary (horizontal, vertical and skew) in   

Cross-section Rectangular 

Eccentricity Disable 

Material Steel, concrete, timber and general 

Load direction Arbitrary in   

Load type All point and line load 

Available analysis results Displacement, internal forces, stresses, stability and vibration shape in    

Available design Timber design in   

Definition steps  

- If needed (and available in the current FEM-Design module), set a proper position for working 

plane. In all modules, respect that the gravity direction is always the Global Z axis direction. 

- Start  Intermediate section from  tabmenu and choose  Define. 
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- Set the properties of the new Intermediate section at   Default setting: 

 

 

- Rounding radius (r) 

The rounding radius can be invidually set. The default value is 1.00 m and rounding the inner 
edge. For rounding the outer edge check the Round outer edge option on. The following figure 
shows the difference between rounding the inner or both edges. 

 

Figure: Rounding inner and both edge  

 

- Select the neighboring bar element. 

 Defining the correct way an apex, the following criteria has to meet: 

- The neighboring bars cross-section has to be Rectangular 

- Their Y axes are parallel and point into the same direction 
- Their material has to be the same 
 

- Apex zones with their connected bars are only one physical element but it has more analytical 
element. 
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Figure: Describing analytical and physical elements 
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Column corbel 

 

 Column corbel property Description 

Modules where available     

Function It models corbels attached to columns. 

Position Horizontal, perpendicular to the local y’ or z’ axis of the column it is attached to. 

Geometry Straight 

Cross-section Arbitrary profile 

End connection - Always rigid at the column it is attached to (Start). 
- Arbitrary at the end point, set by the object attached to the corbel. 

Material Concrete, steel, timber 

Load direction Arbitrary in   

Load type All point and line load in    

Available analysis results Displacement, internal forces, stresses, stability and vibration shape in    

Alternative 

Can be considered as eccentricity of the load acces point on the column, or can be 

modelled as a short beam with the suitable end conditions and eccentricity. 

 

 

Definition steps 

1. Start  Column corbel command from  Bar component menu in  tab 

2. Set the direction of the Column corbel. A Column corbel is always perpendicular to the 
local x’ axis and parallel with the local y’ or z’ axis of the column. 
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3. Set the properties of the new column corbel at  Default settings 

 

- Identifier (General) 
The program automatically generates it, but User can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Geometry (General) 

User can specify the followings: 

• direction of the Corbel  

• relative position of the Corbel compared to the column (d, e) 

• length of the Corbel (l) 

• position of the load application point (x, e), marked with red dot in the figure 
below 

• whether to calculate the “d” value automatically in accordance with the Section 
of the column or not 

 

 

- Section 
User can set a profile from the Section library or define a new cross-section by parameters. 

The applied section name can be displayed in model view (Display settings). 

- End conditions 
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In 3D modules, the end connections can be set under the End conditions tab. Only the 

released motion (arrow) and rotation (two-headed arrow) components are displayed in the 

model view (Display settings). End connections can be fully customised for bar ends by 

setting the rigidity of the displacement components. 

The component directions are valid in the beam’s local co-ordinate system. 

Inactive component means a fixed motion/rotation, while a checked component behaves 

according to the user-specified rigidity value. 

 

With the „Rigid” and the „Hinged” buttons pre-defined end condition values can be 

applyed to the bar ends. 

The local x’ axis always points the vertical fictitious bar end, so the start and end point 

position can be followed from the bar’s local co-ordinate system. 

 

Only the released motion (arrow) and rotation (two-headed arrow) components are 

displayed in the model view (Display settings). 

- Material 
Any type of materials can be set for corbel Analysis. The applied material name can be 

displayed in model view (Display settings). 

4. Place the corbel along a column by left-clicking. 

 

End point where the user can set the 

end connections 



194 

 

Optional steps: 

5. Modify the Corbel properties with the  Properties tool of the Corbel tool palette. 

6. Set the display settings of Corbel at Settings > All > Display > Bar similarly to Beams. 

7. Corbels are stored on “Columns” Object layers. At layer settings, the default color and 
pen width can be set for all columns and corbels. 

 

Wall corbel 

 

 Column corbel property Description 

Modules where available     

Function It models corbels attached to plane walls. 

Position Horizontal, attached to wall. 

Geometry Straight 

Connection - Always rigid at the wall it is attached to. 
- User-defined at the point where other object is attached to it. 

Material Concrete 

Load direction Arbitrary in   

Load type All point and line load in    

Available analysis results Displacement, internal forces, stresses, stability and vibration shape in    

 

 

Definition steps 

1. Start  Wall corbel command from  Shell component menu in  tab 

2. Set the direction of the Wall corbel, whether the corbel should be adjusted to the 
positive or negative side of the wall according to its local coordinate-system. 
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3. Set the properties of the new wall corbel at  Default settings 

 

- Identifier (General) 
The program automatically generates it, but User can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Geometry (General) 

User can specify the followings: 

• the side of the wall 

• relative position of the Corbel compared to the wall (l, x) 

• length of the Corbel (l) 

• position of the load application (x), marked with red arrow in the figure below 

• the heights of the corbel at the wall and at the end of corbel 

 

 

- Connection 

In Connection tab the Motion springs, Rotation springs, Plastic limit forces and Plastic limit 

moments can be managed. 

With the „Rigid” and the „Hinged” buttons pre-defined end condition values can be 

applied to the corbel edge. 
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- Material 
Only concrete material can be set for wall corbel.  

4. Place the corbel along a wall by drawing a line. 

 
Optional steps: 

5. Modify the Corbel properties with the  Properties tool of the Wall corbel tool palette. 

6. Set the display settings of Wall corbel at Settings > All > Display > Bar similarly to Beams. 

7. Wall corbels are stored on “Walls” Object layers. At layer settings, the default color 
and pen width can be set for all walls and wall corbels. 

Post-tensioned cable (PTC) 

 Post-tensioned cable 

property Description 

Modules where available   

Function It is a structural component, modelled by equivalent load system. 

Axis position Arbitrary (horizontal, vertical and skew) 

Geometry Straight 

Shape Wavy with Base points and Inflection places 

Result - Radius of curvature 
- Angular deviation 
- Stress function with friction losses 
- Stress function with anchorage set slip losses 
- Stress function with elastic shortening losses 
- Stress function with all time dependent losses 
- Equivalent force for 1 strand 
- Equivalent force for PTC 
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Manufacturing the Manufacture drawing can be set with proper x’ and z’ shift 

Table: Post-tensioned cable properties 

Definition steps 

1. Start  Post-tensioned cable for bars/Post-tensioned cable for shells command from  
tabmenu and pick the parent object (a bar or a shell), then define the line of the PTC. 

The two Tool window work in slightly different ways: for shells, the user can define more 
cables by using Line by selection option, but for bars only one cable can be defined. 

  

  

It is strongly recommended to use Axes: all aid functions (Macros, Shape wizard, Layout 

wizard) highly rely on them. It could greatly speed up the definition process. 

2. Click  Default settings and set the properties of the PTC. 

 

- Identifier (General) 
The program automatically generates it, but you can define custom value. Identifier (ID 

and Position) number can be displayed in model view (Display settings). 

- Strands (General) 
User can set the type from the strand library and the number of the strands by typing. 
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- Jacking (General) 
User can select the Jacking side in the drop-down menu next to Jacking side. Jacking side 

options: Start, End, Start then End, End then Start. The last two are Both-sided jacking with 

same stress, but it was necessary to distinct, because the effect of draw-in could result in 

different stress functions using shorter cables. 

Jacking stress is calculated as 0.8 ∗ 𝑓𝑝𝑘by default after the Strand type selection. 

- Short term losses (General) 

▪ friction: It is estimated by EN 1992-1-1 5.10.5.2 (1) (formula 5.45) using the 

Wobble (k) and Curvature coefficients (µ):  

▪ ∆𝑃𝜇(𝑥) = 𝑃𝑚𝑎𝑥(1 − 𝑒−𝜇(𝜃+𝑘𝑥)) 

▪ anchorage set slip 

▪ elastic shortening 

 

- Long term losses (General) 

▪ shrinkage of structure 

▪ creep of structure 

▪ relaxation of post-tensioned cable 

 

- Shape 
There are settings related to the geometry of the cable (Display settings) here. The Shape 

table can contain Base points and Inflection places: these determine whether linear or 

parabolic shape is applied.  

The Top and Bottom values mean the distance between the axis of the cable and the edge of 

the element. 
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Using Shape wizard (Shape wizard… button) parabolic shapes can be easily created. This tool 

highly relies on previously defined axes. 

- Results 
There are several results -listed in the order of calculation - which can be chosen from Result 

tab/Result drop-down menu. 

 

- Manufacturing 
On this tab the Manufacture drawing can be set with proper x’ and z’ shift. 

 

Optional steps: 

3. Modify the PTC properties with the  Properties tool of the Post-tensioned cable bar/shell tool 
palette. 

4. Set the display settings of PTC elements at Settings > All > Display > Post-tensioned cables. 
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5. The PTCs are stored on “Post-tensioned cable” Object layers. At layer settings, the default color 
and pen width can be set for all PTC elements. The color and pen width settings by selected 
PTC elements can be modified by Edit > Properties > Change appearance. 

 

- Layout wizard 
It is a tool to create a set of PTCs in a specific layout. It can be launched from Structure/Shell 

component/Post-tensioned cable/Layout wizard. 

 

The Layout wizard searches for the closest solution to the Unequal loading settings from the PTC layout 

variations which fulfilled the following conditions: 

- difference between the sum of the PTC’s forces acting in local z+ direction and the 

product of Considered load and Balance ratio is less than the Maximal deviation 

- geometrical requirements 

The Layout calculation process shows the currently calculated layout parameters and a few indicator 

values. After the calculation it shows the parameters of the best found solution. 

Select 
plate 
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The function uses Axes to divide the selected structural element to stripes (Mid span and Column 

span) assuming columns in the axes cross points. 

  

The algorythm can handle the holes of the plate regions. 

 

At least two Axes crossing the plate are needed to use this tool. 

 

Checking Shape wizard using height [mm] instead of physical model option can highly 

reduce the runtime if the selected plate’s thickness is constant. 

 

Supports and Connections 
This chapter summarizes the possibilities and properties of the available supports and connections. 

The connection with the ground (model space) can be modeled with Supports, while the link among 

structural elements can be defined with Connections. All support/connection components can be set to: 

- “infinite” rigid: blocked motion/rotation, 
- “free”: released motion/rotation, or 
- semi-rigid: given stiffness value (spring) against motion/rotation. 

Non-linear behaviors, independent compression and tension, elastic and plastic behaviour settings are 

also available for all motion and rotation components. 
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 Edge connection is a special tool of structural object definitions. Although it was described at 

planar objects (like Plate), the following connection settings and functions are also valid for Edge 

connections. 

 Support motion loads have to be assigned to supports, so supports are requested input 

parameters for motion-type loads. 

 Always try to create stable structural model by defining correct support and connection 

conditions. From unstable (kinematically indeterminate) structure equilibrium error can be 

resulted. In that case the program sends a warning message at the end of the calculations, and 

you can determine the location of the problems by checking the equilibrium (Analysis > 

Equilibrium), the displacement/buckling and/vibration shape results of the structure. It may 

also happen that the model is so incorrect that calculations stops with error messages and without 

results. 

“Infinite” Rigidity 

The value of “infinite” rigidity can be defined and set as project default by support/connection types 

and components at Settings > All > FEM. Go through the Motion and Rotation components by support 

and connections types and set the requested stiffness value that model blocked absolute/relative 

displacement. 

 The “rigid” values can be set to default for further projects, if select “Rigid” values in the Settings 

tree and click Save as default. 
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Figure: “Rigid” values 

 The “rigid” value can be set by support/connection/fictitious bar element inside its settings 

dialog (Setup “Rigid”) independently of the project default. 
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Figure: “Rigid” value set by support objects 
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Properties (Non-Linear Behaviors) 

Compression, tension, elastic and plastic behavior of supports and connections can be set separately 

and by components. 

  

Figure: The parts of typical support/connection settings dialogs 

- Stiffness fields by compression and tension 
“Rigid” or Free can be chosen from the pop-ups, or stiffness value (spring support/connection) can 

be typed in the fields. 

 Active  icon assigns the stiffness value typed in the Compression field to the Tension field. 

Inactive icon  lets to define the stiffness values separately. 
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- Predefined types 

Click  to set all motion and rotation components to “rigid”. The result will be a totally rigid 

support/connection. 

Click  to set all rotation components to “free” (allow rotation around all directions). The result 

will be a hinged support/connection. 

Click  to set all components to free. This tool gives the possibility to virtually connect 

independently moving elements. 

 “Uplift” can be modeled both in 2D and 3D design modules by defining compression-only support 

/ connection (tension = 0 (free)) and by checking the Consider non-linear behavior of supports, 

trusses and connections box at Calculate> Analysis. 

 

Figure: Allow uplift in Plate and 3D Structure modules 

- Using “Detach” option 
The nonlinear behavior of supports and connections (Point support, Point support group, Line support, 

Line support group, Surface support, 3D Plates and Walls Edge connection, border and panel connection of 

Timber panels and Profiled panels) can be controlled by one signed component. It means, if the force in 

the connection / support happen to act in this selected direction, all spring constants will be set to 0, 

so called it is detached. This option can be set in the dialog, where the spring coefficients are set. If in 

the Detach list anything is selected (e.g. z’ tension) the corresponding spring constant will be 

automatically set to 0.  
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If in Calculations dialog the ”Consider non-linear behavior of supports, trusses and connections” 

option is checked the calculation method is the following: If in the connection where the detach 

behavior is defined (e.g. z’ tension) the connection force is tension in the given direction (z’) in an 

iteration step all of the other spring constant will be set to 0. If in any later iteration step the connection 

force will be compression, the spring constants will be set to the previously defined values.  

 

There is a big difference between setting any of the components to zero or selecting a detach 

behavior. If the user sets manually a component to zero, in the analysis the connection or support will 

not have rigidity in that direction. 
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Supports 
Support types 

The following table summarizes the available support types and their main features in the different 

FEM-Design Modules. 

 Column and Plane wall are developed to model single point and line support in  Plate 

module. These types of support are not mentioned in the Support chapter. 

 Point support property Description 

Modules where available      

Motion component direction Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 Arbitrary direction in   

Rotation component direction Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in   

Geometry - (insertion point) 

Available analysis results Reaction forces and moments 

Load can be assigned Point support motion load  

 Point support group property  

Modules where available       

Motion component direction Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 Arbitrary direction in    

Rotation component direction Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in    

Geometry - (insertion point) 

Available analysis results Reaction forces and moments 
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Load can be assigned Point support motion load  

 Line support property  

Modules where available     

Motion component direction Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 Arbitrary direction in  

Rotation component direction Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in  

Geometry Straight or curved reference line 

Available analysis results Reaction forces and moments 

Load can be assigned Line support motion load  

 Line support group property  

Modules where available      

Motion component Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 

Arbitrary direction in   

 

 

Rotation component Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in   

Geometry Straight or curved reference line 

Available analysis results Reaction forces and moments 

Load can be assigned Line support motion load  

 Surface support group property  



210 

 

Modules where available    

Motion component direction Parallel with Global Z axis in  

 Arbitrary direction in   

Rotation component direction Not available     

Geometry Arbitrary region shape; holes can be placed into it 

Available analysis results Reaction forces 

Load can be assigned Surface support motion load  

Table: Properties by Support types 

Single Support versus Support group 

Single Support defines only one component in one step, whilst Support group places a group of more 

components in one step. Although single Supports can be combined and work as a group support, it is 

recommended to define multi-support conditions with Support group, because all support components 

can be set or modified later (with the  Properties tool) inside one settings dialog.  

 

 

Figure: A fully rigid support modeled by six single Support components or one Support group 
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Special color-system differentiates single Supports from the Support group components. Whilst a single 

Support uses the color of the “Supports” Object layer, the components of a Support group are displayed 

in the colors equivalent with the support’s Local system (Settings > All > Display > Support and Local 

systems). 

 

 

Figure: Color settings of support types 

Definition steps 

 While support definition, keep in mind not to create unstable situation! For example in 3D 

modules, model a hinged support under a wall with hinged line support added to a wall at its 

rigid edge or with rigid line support added to a wall at its hinged wall. In case of unstable 

situation the program sends a warning message during calculation. 

 

Figure: Modeling same wall support condition in two ways 

1. If needed (and available in the current FEM-Design module), set a proper position for the 
working plane. 

2. Start the required support command from  tabmenu and choose  Define. 
3. In case of single Support, choose the displacement type you would like to be define: 
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-  Motion  

-  Rotation 
 

4. Set the support properties as mentioned before in the applied support’s Default settings dialog. 
See the settings possibilities and options at Properties (Non-Linear Behaviors). 
In the settings dialog of a curved line support, the support direction has to set fixed or variable 

along the support’s reference line. 

 

 

Figure: Possible support directions in case of curved reference line 

5. Define the required support component direction for the single Support or set the reference 
system for the Support group. 

6. Choose a geometry definition method for the support’s reference point/line/region. 
7. Define the support in the model view based on the chosen geometry method. 
Optional steps: 

8. Modify the geometry with the Edit menu commands valid for line/region elements. 

9. Modify the support properties with the  Properties tool of the support’s tool palette. 
10. Set the display settings of supports at Settings > All > Display > Support. 

 

 “Label” represents the supports’ ID number generated by analysis/design calculation or 

by clicking Refresh numbering (Tools menu). 

Rotation support is displayed with symbol strongly different from motion representation. 
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Figure: Typical symbols by support types 

 Support groups can also be separated from the single Supports by displaying their Local 

system. 

 

Figure: Local system separates a one-component Support group from a same directional single Support 

11. The supports are stored on “Supports” Object layers. At layer settings, the default color of the 
single Supports and pen width of all support types can be set. The color and the symbol line type 
(e.g. dotted) of selected supports can be modified by Edit > Properties > Change appearance. 

 

 
Connection Objects 
Connection types 

The following table summarizes the available “connection model objects” and their main features in the 

different FEM-Design Modules. 
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 Edge connection is not a “connection object”. It is a definition tool for boundary connection 

conditions, which is available for Plate/Wall, Profiled panel and Timber Panel elements. But, 

the non-linear behavior and component settings are valid for edge connections introduced for 

the supports and below mentioned connection elements. See the definition modes and 

possibilities of an Edge connection at Plate. 

The end connection property of the bar elements are also not “connection objects”. You can read 

more about them at the Beam, Column and Fictitious bar connection settings. 

 Point-point connection property Description 

Modules where available       

Motion component direction Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 Arbitrary direction in    

Rotation component direction Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in    

Geometry - (insertion points) 

Available analysis results Connection forces and moments 

 Line-line connection property  

Modules where available       

Motion component Parallel with Global Z axis in  

 Arbitrary direction in Global XY plane in   

 Arbitrary direction in    

Rotation component Arbitrary direction in Global XY plane in  

 Not available in   

 Arbitrary direction in    

Geometry Straight or curved reference lines 

Available analysis results Connection forces and moments 

Table: Properties by Connection types 
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For the end points of the edge connections two options are available: 

• Separate end points from environment, 

• Connect end point to environment. 

In all Shell Toolwindows this setting is available by choosing ‘Edge connection’ then clicking on 

‘End point behaviour’  button. The end point can be chosen in three steps by selecting the Plate or 

Wall, then the edge and finally the end point.  

 

Using this function can solve problems like the one on the picture below: 

On the right side structure all edge connection end points are connected to the environment which 

cases difference between the shear force on the wall and the sum of shear forces on the plate panels, 

which should be in balance according to common sense and this is exactly the case on the left side 

structure where edge connection end points are separated from the environment. 
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Plastic calculation 

The plastic data can be set in the Default settings/Data tab of each above mentioned options. The figure 
shows where the feature is placed in the dialog. 

 

 
 

Point-point connection 

With Point-point connection, different connections can be defined between crossed or connected bars. It 

is very useful in 3D modules. Some typical examples: 

- Bracing (called St Andrew’s cross) 
A hinged connection between two channels intersecting each other: free rotation around the 

axis perpendicular to the plane defined by the two channels. (It is not necessary to define the 

eccentricity; the next figure is schematic.) 
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- Independent bars 

Defining two bars crossed each other with their structural lines but having no connection in real 

state is a typical problem of modeling. Now, it can be solved easily by creating point-point 

connection in the bars' intersection with all components set to “free”. 

 

 

- Semi-rigid connection between members 
At the Connections settings of members (Bar > Default settings) only fully rigid or different type 

of hinged end connections can be defined. But, Point-point connection command gives the 

possibility to model any other connection types like semi-rigid connection with given stiffness 

values for rotation. The stiffness values can be set according to the applied standard 

instructions. 

 

 

- “Real state” modeling 
Real eccentric position (e.g. bars connected with their web plates) without eccentricity settings 

can be also modeled with Point-point connection. 
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Definition steps 

1. Start  Point-point connection command from  tabmenu and choose  Define. 

  

2. Set the properties of the new connection at  Default settings. See the settings possibilities and 
options at Properties (Non-Linear Behaviors). 

  

 Applying a connection different from rigid state, the Interface position (r) is very 

important. 

 ( 0 r 1   .) 

r = distance between connection position and start point of definition / 

distance between start and end points of connection 

The next figure introduces the meaning of the interface position (r) (it has no effect if the 

connection points are in the same position!): 
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3. Set the system for the direction of the connection components. 
4. Select the first object you would like to connect. 
5. Define the point of the first object you would like to start the connection. 
6. Define the point of the second object you would like to end the connection. If the connection 

points between the two objects (crossed each other) are in the same position, just click  to 
define the connection end point. 

Optional steps: 

7. Modify the connection properties with the  Properties tool of the tool palette. 

8. Add members to a selected connection or remove members from it with  Edit connected 
objects. 

 The next figure shows the steps of adding a new member (beam) to a predefined point-

point connection. First, select the connection you would like to modify and then choose 

the new object you would like to add to the selected connection. To remove a member of 

a connection, do the same steps with . 

 

The next figure shows you the difference between the static-systems of the initial and modified 

states at all rigid bar end connections and defined hinged point-point connection. 
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9. Set the display settings of connections at Settings > All > Display > Connections. 

 

 “Label” represents the connections’ ID number generated by analysis/design calculation 

or by clicking Refresh numbering (Tools menu). 

10. The connections are stored on “Modeling tools” Object layers. At layer settings, the default 
color defines the connection label color. 
Each connection element has its own local system. The connection symbol (darker colors, 

thicker lines etc.) shows the objects having one of the associated above mentioned connection 

types. 

The following figure shows an example how the program makes different symbols depending 

on what object was selected during the selection of the connected points. But note, that although 

the definition ways are differ at the column-plate connections, if the properties (directions, 

components and stiffness values) are the same at both point-point connections (here in the 

example, hinged connection = all rotation components are free), the static-systems are also the 

same. 
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Line-line connection 

With the Line-line connection command, different connections can be defined between two regions 

having different positions in 3D (so not having common parts in the geometry model). Some typical 

examples: 

- Hinged connection between regions having a gap 

 

- Slabs on different level 
Instead of connecting two slabs with a Wall element, the connection can be modeled with the 

Line-line connection tool (if the internal stress and other results are not required in the wall). 



222 

 

 

Definition steps 

1. Start  Line-line connection command from  tabmenu and choose  Define. 

  

2. Set the properties of the new connection at  Default settings. See the settings possibilities and 
options at Properties (Non-Linear Behaviors). 

  

 Applying a connection different from rigid state, the Interface position (r) is very important. 

( 0 r 1   .). 

r = distance between connection position and start point of definition / 

distance between start and end points of connection 
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 The figure shows two different interface positions at hinged line-line connection between 

two plate regions: in the first example, the hinged line (the place of the interface) is on the 

edge of the left plate (rs=re=0), and in the second example the interface position is in the 

middle (rs=re=0.5). In both examples, the left plate is supported rigidly and the right one 

has simple support against to Z-directional motion. The Mx moment diagrams show zero 

moments where the interface positions are placed. 

 

In the settings dialog of a curved line support, the support direction has to set fixed or variable 

along the support’s reference line. 

 

3. Set the system for the direction of the connection components. 
4. Choose a geometry definition method for the first connection object’s reference line (axis). 
5. Select the first object you would like to connect. 
6. Define the first connection line object in the model view based on the chosen geometry method. 
7. Choose a geometry definition method for the second connection object’s reference line (axis). 
8. Define the second connection line object in the model view based on the chosen geometry 

method. 
Optional steps: 

9. Modify the connection properties with the  Properties tool of the tool palette. 
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10. Add members to a selected connection or remove members from it with  Edit connected 

objects. 
11. Set the display settings of connections at Settings > All > Display > Connections. See the 

possibilities at Point-point connection. 
12. The connections are stored on “Modeling tools” Object layers. At layer settings, the default 

color defines the connection label color. 
Rigidity type 
This option is used by Point support group, Line support group, Surface support group, Edge 

connection in 3D Plate and Wall structural objects, Point-point connection, Line-line connection, border 

and panel connection of Timber and Profiled panels. With rigidity type the user can define and load 

specific predefined spring constants. 

If the rigidity type is Custom the user can define the spring constants as in previous versions. To define 

a type the user has to choose the Edit library… option. 

 

After defining rigidity types, the defined spring constants will be registered in the Library and it can be 

loaded in the future. 

 

There are some objects that use the same rigidity type library: 

- Line – line connection, Edge connection (3D Plate, Wall), border and panel connection of Timber panels 
and Profiled panels 
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Cover 
Cover 

 Cover property Description 

Modules where available       

Geometry Any shape 

Load direction Arbitrary in   

Load type Surface load 

Available analysis results - 

Table: Cover properties 

Definition steps 

1. If needed, set a proper position for the working plane. 

2. Start  Cover command from  tabmenu and choose  Define. 

 

 
Figure: Cover toolwindow 

3. Set the cover type if it is slab/roof type  or wall type  

 

Figure: Cover types 

4. Choose a geometry definition method for the cover’s plane. 
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Note: In case of arc geometry in wall covers, you must set the maximum angle between 

neighboring covers at , since arced walls are replaced with straight sections. 

5. Set the load bearing directions with  . 

 

Figure: Setting the load direction (monodirection) 

6. Defining the supporting structures with  . 

After defining the supporting structures, the equidistant lines will appear with the load 
distribution zones. 

 
Figure: Defining cover’s supporting structures 

Activating the Auto supports checkbox will automatically determine the supporting structures for 

the cover. These can be modified later. 

When using Auto supports, the following objects or elements will be recognized as supports if they are 

located in the cover’s plane: 

- Beams and columns (including fictitious ones) 

- Line supports and line support groups 
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- All inner and outer edges of slabs and walls (also working with fictitious ones) 

- all point elements (such as point supports) 

The Supporting structures and the Load bearing direction commands can be used to alter the 

automatically determined specifications. 

 

Building cover 

With this command frequently required shapes such as flat roof, ridge roof, or inclined roof can be very 

quickly defined. 

 

 

 
Figure: Starting Building cover command 

Flat roof:  and its height parameters:   

No negative value is accepted for either h or h’.  

Lean-to:    and its height parameters:     

No negative value is accepted for either h or h’.  

Ridge-roof:  and its height parameters:  

Negative values is accepted for h’. 

Keep in mind that in EC, the total height is signed by h which is h+h’ in the program’s notation. 

This is important in wind calculation according to EC which requires the reference height. 
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After setting the height parameters you can create the layout rectangle. In the picture below you can see 

the three types with their assumed stiff direction. 

 

All building covers are monodirectional by default except the upper surface of flat-roof. (They 

can be changed one by one after definition.) 

By clicking on  (Properties) you can change the ID and the height parameters of the building cover: 

 

You can explode the building cover with , and then edit the covers one-by one. 

The Auto supports function is available for building covers as well. 
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3D Members 
This chapter summarizes all features and properties of a 3D member such as Soil !!! (Link).  

Soil 

 Soil property Description 

Modules where available     

Geometry Regular shape, Solid 

End connection - 

Material Soil 

Load direction Arbitrary in    

Load type 
Point load, Line load, Surface load. Only forces! 

 

 

Soil’s ground level, water level, and strata top level can be different in each Boreholes belonging to the 

soil. Boreholes are created in the corners of the soil region by default, but User can create more if 

necessary. Soil’s limit depth is constant. 
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The soil details can be set in Default Settings: 

 

- Identifier (General) 
The program automatically generates it, but User can define custom value. Identifier (ID and 

Position) number can be displayed in model view (Display settings). 

- Limit deph level (General) 
The level of the bottom boundary plane of the soil 

- Average element size (General) 
If Calculate soil as a solid element is activated, Fem Design tryes to define the solid elements 
of the soil according to the given value 

The soil material details can be set individually: 
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- Name 
The name of the soil material 

- Behaviour 
Wether the analysis is processed with drained or undrained soil conditions. If “Design 

according to combined behaviour” is active, both conditions are considered 

User can choose if he/she wishes to calculate soil as solid elements in analysis or just wants to 

consider it in foundation design calculation. In the Settings/Calculation/Code, Configuration dialog 

this option can be set. 

 

The soil can be loaded only with Point load, Line load, Surface load (not with moments). 

Concentrated mass cannot be defined in the soil.  
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SECTION EDITOR 
 

FEM-Design Section Editor gives the possibility to define, edit and store profiles for the bar elements 

(beam, column and truss element). 

The functions of the Section Editor: 

- drawing new sections, 

- definition of new sections by parameters, 

- definition of complex sections by mixing drawing and standard profiles, 

- editing cross-sections, 

- calculation of sectional data, and 

- profile registration and organizing. 

Section editor can be started directly from design modules that work with bar elements from the Tools 

menu. 

 

Figure: Section Editor as a built-in tool of design modules 

Section Editor can be started as an independent FEM-Design application by clicking the  Section Editor 

icon in the “FEM-Design tools” folder of 

- Start > All Programs > FEM-Design…, 

- Windows Taskbar > FEM-Design System Tray  (if installed), 

- short-cut  of Desktop (if installed). 

Section Editor module has only one tabmenu called  that contains all the section definition tools, 

but the FEM-Design drawing, editing, displaying etc. commands are also available on the Section Editor 

user-interface. 
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Figure: Section Editor user-interface 

Sections are two-dimensional region elements defined in the Y-Z plane of the Global (and UCS) 

coordinate-system. Section Editor uses the Y-Z system for defining and calculating profiles, because the 

sections are perpendicular to the x’ axis (parallel with the y’-z’ plane) of the local coordinate system of bar 

elements. 

Cross-Section Definition 
New cross-section can be defined by drawing section regions with arbitrary geometry, or by giving 

parameter values of a parametric section available in the built-in Section library, or by combining the two 

methods to build complex sections. 

Drawing a Section 

To draw a section use the  Draw section tool and apply  Define for the required region definition 

(geometry) mode  Rectangular,  Circular or  Polygonal. 

 

Figure: Section defined as polygon 

 

With  Pick lines tool, section can be generated by one-clicking drawing lines and arcs that define 
closed region. Drawing elements can be defined previously with the Draw menu commands or they can 
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be imported from DWG/DXF files. With  Pick existing region tool, section can be generated by one-
clicking drawing region defined by the Region command of the Draw menu. 

 

Figure: Section created by selecting closed contour 

With the  Hole tool, openings and cuttings can be inserted to section regions with any shape defined 

by the previously listed region definition modes. 

 

Figure: Section edited by Hole 

 You can read about the definition steps and functions of different region and hole geometries 

at the similar tools (“blue color-linked”) of Structure definition. 

Section region shapes, corner points and side lines can be modified with the Modify menu tools.  
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Figure: Section modified with Edit tools 

Parametric Section 

Although, quick definition of parametric profiles available in the settings dialogs (Cross-sections) of 

Column, Beam and Truss member, parametric sections can be inserted for editing and using them to create 

complex sections. 

Use  Insert section into drawing command to browse from parametric sections as well as standard 

and user-defined profiles, and to insert one or more of the required section with chosen geometry and 

sizes into the drawing area. 

  Although, you may choose for example a timber profile for editing and register as another 

fabrication type (for example steel, concrete etc.), we suggest you to choose profile type that will 

suit for later design. But, always you decide the available design type of the section defined by 

Section Editor when registering it with its Fabrication technology into Section library. 

Definition steps 

1. Choose a parametric section shape in Section library or select a predefined (standard or 
registered user-defined) profile from New >/Size… option. 
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Figure: Dialog for defining parametric sections or for choosing predefined sections 

2. In case of parametric profiles, set the required geometric parameters. Each shape has a 
preview with the meaning of the parameters. 

3. Set the insertion point at Insertion point tab, where the placement can be defined. Default 
setting for placement is the center of gravity, but it can be changed by clicking on the 
specific points (green points) or set by y’ and z’ coordinates.  

4. Click OK to start inserting the defined or selected profile into the drawing area. 

 

Figure: Definition of insertion point position 

5. Place the section with its insertion point on the drawing area. Click  or  to 
insert the section in the origin of the global Y-Z system. 

6. Further rotation can be set with the direction of the section’s z axis. Accurate angle can 

be typed in the Command line or click  or  to use the direction set in the 
Reference point… dialog. 

Complex Section 

 Only homogenic complex profiles can be defined in the Section Editor, because one material can 

be assigned to it later in the design modules when defining beams, columns and bars. 

At complex sections, intersecting or overlapping among section regions are not allowed. If there 

is any problem, the program stops the sectional data calculation with an error message. 
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As read in the previous chapter, quick definition of complex profile can be done by the repetition of 

section insertion with different positions and directions. 

 

Figure: Complex profile built by parametric profiles 

Of course, combining the section drawing and insertion modes various complex cross-sections can be 

defined. 

 

Figure: Mixture of definition modes 

Cross-Sectional Data 
Before calculating the data of the defined section, it is recommended to place the section’s centre of 

gravity to the global system origin. With the Query command of Tool menu, you can easily find the 

center of gravity point of the defined section region and insert a drawing point. 
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Figure: Section moved into Origin with its center of gravity 

 Query finds the center of gravity point of complex sections, if you merge the connected region 

parts with the Union tool of the Modify region command (Modify menu). 

 

Figure: One complex region after merging region parts 

The following settings (Settings menu) effect on sectional data calculation: 
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Figure: Calculation settings 

- Display result 

Set data types you want to display after calculation in the Sectional data window. The data list 

contains all available data on which multiply-selection such as  and . (See the 
meanings of the sectional data at Sections.) All data can be selected by the Select all button. 

- Calculation options 

The Link the touching regions automatically at the next calculation option handles the connected 
regions as one complex region in calculations. The option influences the value of the following 
parameters: perimeter (P), area/perimeter (A/P), shearing center (Ys, Zs), shearing factors (Rho 
y, Rho z, Rho yz, Rho 1, Rho 2), torsion moment of inertia (It), torsion section modulus (Wt), 
warping parameter (Igamma) and Wagner parameters (z1, z2, z gamma). 

To calculate the sectional data set at Monitored data click  Calculate on the  tabmenu. The 

results are automatically displayed in the Sectional data window. 

 

Figure: Calculated sectional data 
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If you make modifications on the section geometry, you have to rerun the sectional data calculation with 

 Calculate. 

As a modeling feature, a calculated cross-sectional data can be manually modified/overwritten 

manually with arbitrary given value. With this possibility the user can create virtual cross-section with 

known data. Double clicking on a data, custom value can be set for it in the Modify sectional data dialog. 

Modified data is signed with “:” instead of “=” in the Sectional data window. The original value can be 

reset for the current data with the dialog’s Calculate option, or you can reset all data with the Overwrite 

the user modified sectional data at the next calculation option (Settings > Calculation options). 

 

Figure: Customizable sectional data 

Documentation of Cross-Section 

With the  Insert report command, the table of the calculated sectional data can be placed on the 

drawing area based on the Display result setting. 

 

Figure: Sectional data inserted to drawing area 



241 

 

If you make modifications on the section geometry, you have to rerun the sectional data calculation with 

 Calculate and the content of the table refreshes automatically. 

The table is stored on the Sectional data object layer. The color of the table can be modified together with 

the layer’s color. More display changes such as the modification of the text and border style can be done 

with the Properties > Change properties tool (Edit menu). 

The defined section is lying on the Cross-section object layer, so the default blue color of section regions 

can be modified together with the layer’s color. 

Insert section into library – Section Library 

To add a new section having valid calculations to the Section library, click  Register and set the 

required settings such as the name of the storing folder (Library name) and the Type and Size IDs. Also 

set the fabrication technology effect on the later available design calculations. To store the section press 

OK. 

 Before registering the current section click Calculate. 

 

Figure: New section registered to Section library 

Fabrication technology Design 

Rolled steel Steel bar design 

Cold-formed steel Steel bar design 

Weld steel Steel bar design 

Concrete RC bar design 

Timber Timber bar design 

Generic - (only for analysis) 

Table: Fabrication technology and the assigned design type 
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The program automatically detects the shape type of the sections and shows it as a symbol. It is 

important for the later design calculations. 

The content of the Section library can be edited (renaming, deleting etc.) with the  Edit library 

command. 

 

Figure: Library and content editing 

A registered section can be added to beam and column elements by choosing it in the Section tabpage 

of the element settings dialog (Default settings). 

 

Figure: User-defined section used for bar elements (beams) 
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LOADS 
 

After defining the structure and support elements, the next step is adding loads to the statical system. 

This chapter sums all load possibilities, load definition (directions and geometry) and combination 

modes. Mass definition required for dynamic calculation is also introduced in this chapter. Let’s click 

on  tabmenu to reach all load definition commands. 

Load Types 
Depending on the current FEM-Design Module (license you have), the available type of load 

commands is different. Loads can be defined with their insertion point, action line or action region. 

Type Modules where 

available 

Definition 

mode 

Direction Intensity 

    Structural dead load 
      

   

(Automatic) 

Global Z-axis 

 

- 

    Soil dead load 
    

  

(Automatic) 

Global Z-axis 

 

- 

 Point load 

       (force and/or moment) 

 

    

 

Point 

Horizontal 

Arbitrary 

Constant 

 Line load 

       (force and/or moment) 

 

    

 

Line 

Horizontal 

Arbitrary 

Constant/Variable 

 Surface load 

       (force) 

 

    

Region 

Horizontal 

Arbitrary 

Constant/Variable 

 Line temperature 

       variation load 

 

  

Line 

Fixed 

Arbitrary 

Constant/Linearly variable 

Constant/Variable 

 Surface temperature 

       variation load 

 

  

 

Region 

Fixed 

Arbitrary 

Arbitrary 

Constant/Linearly variable 

Constant/Linearly variable 

Constant/Variable 

 Line stress load  

  

Line 

Fixed 

Arbitrary 

Constant/Variable 
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 Surface stress load  

  

 

Region 

Fixed 

Arbitrary 

Arbitrary 

Constant/Variable 

 Point support motion 

       (motion and/or rotation) 

 

    

Point Support direction Constant 

 Line support motion 

       (motion and/or rotation) 

 

  

Line Support direction 

Constant 

Constant/Variable 

 Surface support motion 

       (motion) 

 

 

Region 

Horizontal 

Support direction 

Constant/Variable 

       Shrinkage 
    (Automatic) - - 

       Seismic load 
  (Automatic) - - 

 Wind  (Automatic) Horizontal Constant 

 Snow  (Automatic) Vertical Constant 

 Deviation  (Automatic) Horizontal Constant 

Moving Load  Special Arbitrary Special 

Table: Load types and their main properties 

Load Direction 
Most of the load objects need direction settings. The next table summarizes only the editable direction 

possibilities by load types. Other load types have fixed direction (for example in  Plate module, Force 

direction is always perpendicular to the calculation plane, so it is parallel with the global Z direction). 

Type Modules where 

available 

Direction for Direction Modes 

 Point load   
Moment direction 

 Predefined direction 

 
  

Force direction 
 Parallel with line 

 
   

Force/Moment direction 
 Perpendicular to plane 

 Line load   
Moment direction 

Predefined direction 

 
  

Force direction 
Parallel with line 
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Force/Moment direction 
Perpendicular to plane 

   
 Object’s local system 

 Surface load     
Force direction 

Predefined direction 

   
Parallel with line 

   
Perpendicular to plane 

   
Object’s local system 

 Line temperature   
Direction 

Predefined direction 

        variation load   
Parallel with line 

   
Perpendicular to plane 

   
Object’s local system 

 Line stress load   
Direction 

Predefined direction 

   
Parallel with line 

   
Perpendicular to plane 

   
Object’s local system 

 Surface stress load     
Direction 

Predefined direction 

   
Parallel with line 

   
Perpendicular to plane 

   
Object’s local system 

 Point support   
Rotation direction 

Predefined direction 

        motion load 
  

Motion direction 
Parallel with line 

 
  

Motion/Rotation direction 
Perpendicular to plane 

   
Object’s local system 

 Line support   
Rotation direction 

Predefined direction 

        motion load 
  

Motion direction 
Parallel with line 
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Motion/Rotation direction 
Perpendicular to plane 

   
Object’s local system 

 Surface support  
Motion direction 

Predefined direction 

        motion load   
Parallel with line 

   
Perpendicular to plane 

   
Object’s local system 

Table: Load types and their directions 

 Predefined direction 

With this option an axis/a plane of the Global or the User-defined (UCS) co-ordinate system can be set 

for the required load direction. The direction can be chosen from the drop-down list attached to the 

Predefined direction option. The available directions depend on the applied FEM-Design Module (e.g. 

Plate, 3D Structure etc.). 

 

 

 

 

Symbol Meaning of 

direction 

System 

  

Parallel with XY 

plane 

Global 

  

Parallel with YZ 

plane 

Global 

  

Parallel with XZ 

plane 

Global 

  

Parallel with UCS 

(XY plane) 

UCS 

  

Perpendicular to 

UCS (XY plane) 

UCS 

  

Parallel with 

global X axis 

Global 

  

Parallel with 

global Y axis 

Global 

 

Parallel with 

global Z axis 

Global 

  

Parallel with X 

axis of UCS 

UCS 

  

Parallel with Y 

axis of UCS 

UCS 
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Parallel with Z 

axis of UCS 

UCS 

Table: The available directions to set the new load direction 

 

Figure: Examples of temperature loads placed on bar elements 

In some cases, additional direction setting can be chosen from the definition tool palette: 

 “Positive direction”: The orientation is the same with the selected axis orientation; 

 “Negative direction”: The orientation is the opposite of the selected axis orientation. 

 

Figure: Examples of Point load direction 

 Parallel with line 

With this option, the required load direction can be defined manually with its start and end points. 
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Figure: The load direction is parallel with the defined direction 

 Perpendicular to plane/line 

With this option, the required load direction will be perpendicular to a defined plane/line. The plane 

can be given with three points and the line with two points (start and end points). In case of the 

perpendicular plane, the third point defines the final orthogonal direction, which the new direction will 

be parallel with. 

 

Figure: The line load direction is perpendicular to the defined plane 

 Object’s local system 

If the load direction has to be set in the local co-ordinate system of the “assigned” structural object 

(beam, column, plate, wall and support), the fastest definition of load direction is to use the Objects' local 
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system option. This feature is available for Line, Surface, Line temperature variation, Line stress, Surface 

stress, Point support motion, Line support motion and Surface support motion load in the 3D modules. 

Using Object’s local system, the geometry definition of the line or surface load is skipped, because one 

click on the assigned structural object is enough after setting the requested local system axis direction. 

 In case of surface loads, only load with constant intensity can be defined with the tool Select objects 

to load in local system. But, you can change intensity values (linear distribution) with the Variable 

intensity tool of the applied load command as a next step. 

 One-click definition of constant surface loads perpendicular (e.g. wind) to planar objects (e.g. 

shells). 

 

Figure: Fast definition of surface load by using object’s local system 

 One-click definition of line load (constant or variable) perpendicular (e.g. wind load) to a beam 

reference line. 
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Figure: Fast definition of line load by using object’s local system 

 One-click definition of point support motion parallel with a component direction of a point 

support. 

 

Figure: Support motion added to a point support component 

 Only the same type support can be selected for a support motion: 

 

Support motion load type Support type 
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Table: Support motion load types and their proper support types 

Change Direction 

Any previously set direction can be modified by the modifying commands (Modify menu): Change 

direction and Rotate. 

Change direction uses the Predefined direction, Parallel with line and Perpendicular to plane direction 

definition tools. 

Rotate edits a selected direction or the main direction of a selected system with giving new direction 

points or the rotation angle. Rotation works around a given point or an axis. 

 Naturally, you cannot modify fix directions. For example in the  Plate module the point, line 

and surface forces are always vertical (perpendicular to the calculation plane of the plates). 

Load Geometry 
The definition modes and the available shape of the loads’ action line/plane depend on: 

- the load type: point, linear and surface load, and 
- the current FEM-Design module. 

The Tool palette of a load command contains only the available modes. The next table summarizes the 

geometry possibilities by the load types. 

Type Modules where 

available 

Definition 

mode 

Geometry 

 Point load      

 

Reference point 
 Edit point (give an insertion point) 

 Select point 

 Line load      

 

Reference line 

 

 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 Surface load      
Reference region 

 Rectangular 

 Circular 

 Point support motion load  Point support 

 Line support motion load   Line  support 

 Surface support motion load  Surface support 
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 Polygonal 

 Pick lines 

 Pick existing region 

 Line temperature 

       variation load 

   
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 Surface temperature 

       variation load 

    
Reference region 

 Rectangular 

 Circular 

Polygonal 

Pick lines 

 Pick existing region 

 Line stress load    
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 Surface stress load     
Reference region 

 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

 Point support 

        motion load 

     
Reference point 

 Edit point (give an insertion point) 

 Select point 
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 Line support 

        motion load 

   
Reference line 

 Straight line 

 Arc by center, start and end points 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Line by selection 

 Surface support 

        motion load 

  
Reference region 

 Rectangular 

 Circular 

 Polygonal 

 Pick lines 

 Pick existing region 

Table: Loads and their geometry definition 

 If you define a load that does not acting on a structural element, a warning message appears 

during the calculation. Continuing the calculation does not take the “unconnected” load into 

consideration. 

 It follows from the previous fact, that if the documentation does not need “perfect geometry” for 

loads in some cases, you can spare time with neglecting some editing steps.  

 

 

Table: Uncut, but unnecessary load parts 

 The units of the loads can be set at the Settings > Units. 
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 Straight line 

The steps of a straight line definition: 

3. Define the start point of the line by giving coordinates or mouse-clicking. 
4. Define the end point of the line by giving coordinates or mouse-clicking. 

 

Figure: Some examples for defining line-type loads with Straight line 

 In 3D modules, the “curved” walls are modeled as planar shells instead of curved ones, so their 

base lines are straight segments and not real arcs. So, if you would like to place line loads on the 

reference contour of 3D walls, use the Straight or the Line by selection tool instead of one of the 

arc definition tools (see later). Otherwise, the misplaced load will not be taken into consideration 

in calculations. 

 

Figure: Incorrect and correct ways to define line-type loads on “curved” wall edges in the 3D modules 
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Arc by center, start and end points 

The steps of an arc definition with its center, start and end points: 

4. Define the center point of the arc by giving coordinates or  mouse-clicking. 

 Use the  Center Object Snap tool, if you would like to define the center point of the 

line load in another center point of an arc. (See the next figure, where the (1*) step means 

that the center point of the curved slab edge is selected for the load’s center point.) 

5. Define the start point of the arc by giving coordinates or  mouse-clicking. 

6. Set the drawing direction (clockwise or counterclockwise) with  mouse-clicking. Define 

the end point of the arc by giving coordinates or  mouse-clicking, or set the central angle 
(4.) by giving its value. Circle can be defined by angle 360°. 

 

Figure: An example for defining line-type loads with Arc by center, start and end points 
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Figure: Drawing direction and angle definition 

Arc by 3 points 

The steps of an arc definition with its three points: 

4. Define the start point of the arc by giving coordinates or  mouse-clicking. 

5. Define the end point of the arc by giving coordinates or  mouse-clicking. 

6. Define the third, peripheral point of the arc by giving coordinates or  mouse-clicking. 

 

Figure: Some examples for defining curved line load with Arc by 3 points 



257 

 

 Arc by start, end point and tangent 

The steps of an arc definition with its start, end point and tangent: 

4. Define the start point of the arc by giving coordinates or  mouse-clicking. 

5. Define the end point of the arc by giving coordinates or  mouse-clicking. 

6. Set the tangent side with  mouse-clicking. Define the tangent direction from the start point 

with a third point (e.g. a point on a tangentially connected line) by giving coordinates or  
clicking. 

 

Figure: Definition of a curved line load tangent to a beam 
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Figure: Although same definition points are defined, the tangent side is different 

Select point / Line by selection / Pick existing region 

By selecting previously defined points, lines and regions, loads can be inserted very fast, in one step: 

- Point-type loads: select drawing points or point supports (in case of Point support motion load) 
with one of the selection modes. 

- Line-type loads: select drawing lines, reference line of 1D member structural elements, region 
(drawing or structural object) edges or line supports (in case of Line support motion load) with 
one of the selection modes. The length of the loads’ action lines will be equal to the selected 
line elements. 

- Surface-type loads: select drawing regions, drawing solid surfaces, Planar objects or surface 
supports (in case of Surface support motion load) with one of the selection modes. The size of the 
loads’ action surface will be equal to the selected region elements. 

 Because only the loads/load parts located on structural elements will be considered in 

calculations, these “definition by selection” modes are the easiest technique to define loads with 

perfect accuracy.  

 

Figure: Examples for defining line-type loads by selecting beams 
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Figure: Adding line loads to the members (beams) of a frame structure 

 

 

Figure: Defining line loads on structural element edges 

 In 3D modules, the “curved” walls are modeled as planar shells instead of curved ones, so their 

base lines are straight segments and not real arcs. So, if you would like to place line loads on the 

reference contour of 3D walls, use the Line by selection or the Straight tool instead of one of the 

arc definition tools. Otherwise, the misplaced load will not be taken into consideration in 

calculations. 
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Figure: Defining line loads on structural element edges 

 With Pick existing region, surface loads can be easily place on 3D shell elements (plates and walls) 

or drawing solid surfaces (defined by the Draw > Solid command). 

 Point/Line/Surface support motion loads will be considered in the calculations, if they are placed 

into supports, so it is recommended to select the reference point/line/surface of previously 

defined supports in case of motion load definition. 

 

Figure: Defining motion loads in supports 
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Rectangular 

The steps of defining a rectangular surface load: 

5. Define the point of the first corner by giving coordinates or mouse-clicking. 
6. Define the point of the end corner by giving coordinates or mouse-clicking. 

 

Figure: Defining a rectangular surface-type load 

 The geometry of rectangular regions as well as other (later mentioned) region shapes can be 

edited by the Modify region > Split region tool and other editing tools (Edit menu). Also the 

Hole tool of surface loads’ definition command can be used to edit the reference regions. 

 Circular 

The steps of a circular region definition: 

1. Define the center point by giving coordinates or mouse-clicking. 
2. Define the radius by giving its value or a point on the circle (with coordinates or mouse-

clicking). 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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Figure: Defining circular surface loads on a plate above columns and terrace part 

 Polygonal 

The steps of a polygonal region definition: 

3. Define the points of the polygon vertexes by giving coordinates or  mouse-clicking. 

4. Close the polygon with  mouse-clicking or  key. 

 

Figure: Defining polygonal surface load 

 Pick lines 

With this method, surface-type loads can be placed on closed contours defined by 

- previously defined drawing lines, 
- the edges of a previous defined drawing region, a plate, a wall (only in 3D modules) or surface 

support, or 



263 

 

- imported (DWG/DXF) drawing lines that can be used as sketches of surface load shapes. 
It is a one-click definition mode: select a closed contour defines the requested shape of the surface load 

with mouse-clicking. 

 

Figure: Defining surface loads by using close contours 

In case of line junctions, more than one line/edge has to be selected to make clear the continuity of the 

requested closed contour. 

 

 

Figure: Selection of more lines to define the right path for the closed shape 

“Holes” in Surface Loads 

 Holes and cuttings can be added to surface loads with the Hole tool. The following geometries 

can be used for holes: 

The steps of a hole definition: 

3. Select the surface load with mouse-clicking. Clicking a region places the UCS into the region 
plane, so giving hole coordinates needs only X and Y values from the UCS origin. 

4. Define the geometry of the hole or cutting with one of the following geometry modes: 
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 Rectangular 

 Circular 

Polygonal 

Pick lines 

 

Figure: Editing a surface load (previously defined by Pick existing region) with the Hole tools 

Holes can be easily copy inside a surface load with the Copy command (Modify menu). To set the 

distances/new positions, the UCS has to be in the plane of the host region(s). 

Load Cases 
Loads in FEM-Design are represented with Load cases. A Load case has a name and physically contains 

one or more load objects. 

Special loads (invisible loads) like dead load, shrinkage and seismic effect can only defined with Load 

cases. For timber elements duration classes can be set with the Load cases command. 

Although a Load case can be assigned later to loads, the first recommended step of load definition is the 

load case classification (load case list). 
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Definition steps 

1. Start  Load cases command from  tabmenu. 
2. Define Load case name in the Name column. 
3. Set the Type of the new load case: 

 

Type Modules where 

available 

Ordinary 
      

+Dead load 
      

+Shrinkage 
    

+Seismic… 
  

  

Table: Load case types by FEM-Design modules 

- “Ordinary” means that no additional effect will be assigned to the load case 
- “+Structural Dead load” means that the weight of all structural elements, “+Soil Dead load” 

means the weight of soil, which is calculated automatically, will be assigned to the load case 
as an invisible load. So, a “Dead load”-type load case contains automatic dead-load and can 
contain further manually defined loads (e.g. “dead load” of the non-load-bearing (non-core) 
parts of a composite slab). 

 Because “+ Structural Dead load” and “+Soil Dead load” type includes the dead load 

(calculated from the geometry and material) of all structural elements, define only 

one dead load type load case in one project. If you define more than one “+ 

Structural Dead load” and “+Soil Dead load” type load cases never group them in 

the same Load combination! 

 In all modules automatic dead load works in the global Z direction, except for the 

 Wall and  Plane Strain modules, where the dead load direction is parallel with 

the global Y. 

- “+Shrinkage” means that free shrinkage strain behavior will be considered as a load effect 
in concrete design. The shrinkage strain value can be set at the material properties of 
concrete structural elements. 
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-  “+Seismic…” means that sway and torsional effect components calculated from Seismic 

calculations will be considered as a load effect in analysis and design calculations. 
4. In case of Timber design only, set a load-duration class for a load case according to the regulations 

of Eurocode 5 (EN 1995-1-1:2004). The load-duration classes are characterized by the effect of 
constant load acting for a certain period of time in the life of the structure. For a variable action 
the appropriate class shall be determined on the basis of an estimate of the typical variation of 
the load with time. 
Actions shall be assigned to one of the load-duration classes given for strength and stiffness 

calculations. 

 

Table: Load-duration classes and examples of load-duration assignment (EN 1995-1-1:2004) 

 Since climatic loads (snow, wind) vary between countries, the assignment of load-

duration classes may be specified in the National annex. 

Optional steps: 

5. New load case can be inserted to the Load case list in the required row position with Insert load 
case. Just click in the Name field you would like to insert the new load case and press the Insert 
load case button. In the pop-up dialog, set the name, the type and the duration class of the new 
load case. 

6. Load cases can be removed from the Load case list with Delete load case. Just click a field of the 
load case you would like to delete and press the Delete load case button. 

7. The load case list can be set as default for next project by clicking the Save as default button. 
After finishing the load case definition, a load case can be assigned to a load in two modes: by choosing 

a case directly from the  tabmenu (drop-down list) or in the Default settings dialog of the current 

load command. 

 

Figure: Load case selection for load objects 

Load-duration class Order of accumulated duration 

of characteristic load 

Examples of loading 

Permanent More than 10 years Dead load 

Long-term 6 months – 10 years Storage 

Medium-term 1 week – 6 months Imposed floor load, snow 

Short-term less than one week Snow, wind 

Instantaneous  Wind, accidental load 
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A color is assigned to a load case after its definition. That color represents the color appearance of the 

loads included in a load case. The default load case color is red, but you can set different colors by load 

cases at the layer settings.  

 

Figure: The color-system of Load cases represents the load appearance 

Moving load cases 

With defining a Moving load special load cases are created, which are displayed with blue text and can 

not be deleted in the Load cases dialog.  

 

Figure: Moving load cases 
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Load Definition by Types 
The commands for defining loads can be started from the  Tabmenu. 

To show the mostly used load commands and to hide the rarely used ones; you can organize the icons 

in expanded or compact form. 

 

In compact mode, you see the icon of the last used command. If you click on the command's symbol, 

the program opens its tool palette. You can reach the other same type load by clicking on the  symbol. 

Each command has a Tool palette with the customizable load properties (load value/intensity, host 

load case etc.) and the definition tools of the load geometry and position (direction). 

Structural dead load 
The weight of the load-bearing structural elements are calculated automatically by the program and is 

considered in the calculations, if “+Structural dead load” type load case is defined and it is added to 

the load combinations or load groups. So, the so-called “auto dead-load” is calculated from the 

geometry and material-dependant density value. 

The direction of the dead-load is vertical, but the vertical direction differs in the different FEM-Design 

modules. 

      

Structural Dead-load (gravity) direction 

Global Z direction Global Y direction 

Table: The structural dead-load direction by FEM-Design Modules 

Definition steps 

1. Start the  Load case command, and define a “+Structural dead load” type load-case with a 
name (such as “Dead load”). So, the “auto dead-load” is allowed on load-case level. 

2. Define loads (Point-, Line- and Surface loads) under the load-case defined in the previous, 1st 
step, if additional dead-loads coming from invisible not-load-bearing parts (non-load-bearing 
layers of composite structures) are requested. 

3. Add the load case defined in the 1st step to load combinations/groups depending on the later 
design. 

The auto dead-load is always invisible. Only the additional, manually defined dead-loads can be 

displayed (as point/line/surface load) by activating the layer of the host load-case. 

Soil dead load 

The weight of the soil is calculated automatically by the program and is considered in the calculations, 

if it is added to a “+Soil dead load” type load case and then load combinations or load groups. So, the 

so-called “auto dead-load” is calculated from the geometry and material-dependant density value. 

The direction of the dead-load is vertical, but the vertical direction differs in the different FEM-Design 

modules. 
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Dead-load (gravity) 

direction 

Global Z direction 

Table: The soil dead-load direction by FEM-Design Modules 

Definition steps 

1. Start the  Load case command, and define a “+Soil dead load” type load-case with a name 
(such as “Dead load”). So, the “auto dead-load” is allowed on load-case level. 

2. Define loads under the load-case defined in the previous, 1st step. 

The soil can be loaded only with Point load, Line load, Surface load (not with 
moments). 

3. Add the load case defined in the 1st step to load combinations/groups depending on the later 
design. 

The auto dead-load is always invisible. Only the additional, manually defined dead-loads can be 

displayed (as point/line/surface load) by activating the layer of the host load-case. 

Shrinkage Strain 
Free shrinkage strain behavior can be modeled as a load effect in reinforced concrete design and check.  

Shrinkage effect is calculated as a specific rotation. The following formulas give the example of 

calculation for reinforced concrete slabs: 

 

 The specific normal force causing the given shrinkage value (εcs [‰]) in the 

concrete zone of the section is (here in X direction). 

 The position change of centre of gravity considering reinforcement bars (here 

X-direction; see dashed line), where  and Ss is the statical moment of 

(here) X-directional bars around the Y axis of the calculation plane. 

 The moment around the Y axis of the calculation plane from Nx because of 

the position change of centre of gravity. 
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 The specific rotation (curvature) from My for 1 meter wide section, where 
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Definition steps 

1. Set the shrinkage strain (εcs) value at the material properties of concrete structural elements. 

  

Figure: Shrinkage value of concrete materials 

  Shrinkage effect is taken into consideration in RC design and check of concrete 

elements, which have applied reinforcement. 

2. Start the  Load case command, and define one “+Shrinkage” type load-case with a name 
(such as “Shrinkage effect”). That means, the automatically calculated shrinkage effect is 
allowed on load-case level. 

 

Figure: Shrinkage effect added to a load case 

3. Add the load case defined in the 2nd step to load combinations/groups depending on the later 
RC design. 
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Point Load 

Depending on the current FEM-Design module, point force and/or moment can be defined easily by 

giving just the load insertion point and direction. The load properties and definition tools are available 

on the tool palette of the  Point load. 

  

Figure: Tool palette of Point load 

Definition steps 

1. Select the load case from the load case drop-down list from  tabmenu, which you would 
like to add the new point load(s) to. 

If you have not defined a load case yet, you can also define and set it in the  Default settings 

dialog by giving a load case name. Here you can type any comment, which will be displayed 

next to the force. 

 

Figure: Load case definition 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Choose the load type:  Force or  Moment (FEM-Design module dependent). 
3. Set the load value according to the current unit (that can be set at Settings > Units) in the tool 

palette or at  Default settings. 
4. Define the direction of the force or moment axis (FEM-Design module dependent). 
5. Choose a method for the insertion point definition (geometry). 
6. Place the point load in the model view based on the chosen geometry method (5th step). 
Optional steps: 

7. Modify the load properties (the host load case, load value) with the  Properties tool of the 
Point load tool palette. 

8. Modify the load direction with the editing tools (Editing Loads). 
9. Set the display settings of the load (Load Display Settings). 

Deviation load (Automatic) 

Deviation load (as point loads) can be placed automatically in the centre of gravity points of plates 

located on stories. 
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 Automatic deviation load generation needs storey-system in the project! 

Definition steps 

1. Entering to “Load” mode, the program displays the so-called “main directions” of the current 
project. These main X’ and Y’ load directions are used by the automatic deviation and wind 

load definition. By default, the main X and Y load directions are parallel with the Global X and 
Y axis directions. Set the required load directions for the deviation (and wind) loads with the 
Change direction command (Modify menu). 

 The symbol of the main load directions are stored on “Main directions” Object layers. 

2. Start the  Deviation load command from Loads tabmenu. 

 The generated point loads will be inserted into load cases called “Deviation X (Generated 

by [Factor x Load case1] + [Factor x Load case2])” and “Deviation Y (Generated by [Factor x 

Load case1] + [Factor x Load case2])”. If there are no load cases with the same name in the 

project, the program automatically defines them for the automatic deviation load 

components. 

3. Select the story you would like to add deviation load to. Choose the required direction X and/or 
Y and positive and/or negative based on the main directions set in the 1st step. Define the 
required alpha h and m parameters according to the current standard. The program calculates 
the point deviation load value in the selected storey from the selected load cases, the storey 
height and the number of vertical members contributing to the horizontal force. Clicking 
Generate creates deviation load in the centre of gravity of the selected storey slab with the given 
load direction. Checking the Surface load generation instead of point force option generates surface 
load instead of point force. 

4. Repeat the previous step to generate deviation load in the other storey slabs. Click Close to exit 
from the dialog box after finishing the load definitions. 

For faster and more comfortable load definition deviation loads can be generated 
simultaneously for X and Y direction. Furthermore, with the “Generate All” button it is 
possible to create deviation loads for all storeys. 
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Generate buttons re-defines all existing Deviation load with the default properties. That may 

delete previously defined Deviation Load cases. 

 
Notional load 
Notional load function generates horizontal load from non-horizontal loads using a conversion factor. 

 Notional load generation needs user-defined Load Cases in the project! 

Definition steps 

1. Start the  Notional load command from Loads/Macro tabmenu. 
2. In the top of the dialog there is a textbox containing an automatically generated name for the 

notional load case, which can be changed arbitrarily. 
3. Click EC seismic notional load button, it indicates that Load case factor will be set according to 

parameters of Load groups the Load case belongs to. It uses EN 1990-1-1 A1.3.2 DK NA: 𝐴𝑑 =

1.5%(∑ 𝐺𝑘,𝑗" + " ∑ 𝜓2,𝑖𝑄𝑗,𝑖𝑖≥1 ) 

4. Click Generate to create as many Notional Load cases, as many directions are chosen above the 
Generate button. 

Buttons can be active at 

the same time 

2. Generate Surface load if 

it’s needed 

3
2

1. Select load cases and 

specify their factors 

1

3. Generate deviation load on all 

stories or only the selected one 
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The generated Notional Load Cases appear in the Load Cases dialog and they can be selected from Loads 

tab/Current load case drop-down list. 

 

1. 

2. 

3. 
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Line Load 

Depending on the current FEM-Design module, constant or variable line force/moment can be defined 

easily by giving the load shape, direction and position. The load properties and definition tools are 

available on the tool palette of the  Line load. 

 

Figure: Tool palette of Line load 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new line load(s) to. 
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If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. Here you can type any comment, which will be displayed next to the 

force. 

 

 

Figure: Load case definition 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Choose the load type:  Force or  Moment (FEM-Design module dependent). 
3. Set the intensity values in the start (q1) and end point (q2) of the new load according to the 

current unit (that can be set at Settings > Units) in the tool palette or at  Default settings. If you 

inactivate the arrow (  ) next to the q1 field, you can type intensity value in q2 different from 
q1. 

4. Define the direction of the force or moment axis (FEM-Design module dependent). 
5. Choose a method for the action line definition (geometry). 
6. Set the “intensity mode”, that means the connection between applied intensity and the action 

line at  Default settings, if the new load will be in skew position (not vertical or horizontal): 
- “Intensity meant along action line” 

The intensity will be meant along the action line, so the resultant will be calculated from 

the intensity and the length of the action line. Apply this option for dead load-type loads. 

- “Intensity meant perpendicular to direction of load” 

The intensity will be meant perpendicular to the load direction, so the resultant will be 

calculated from the intensity and the length of the horizontal projection of the action line. 

Apply this option for example to model snow load.  
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Figure: Intensity difference at skew bars 

7. Set the “direction mode”, that means the connection between applied load direction and the 

action line at  Default settings, if the new load will be a curved line load: 
- “Direction is constant along action line” 

The load direction set in the 4th step will be constant along the action line. 

- “Direction varies along action line” 
The load direction will vary along the action line, so the characteristic direction set in the 

4th step will be taken into consideration in the middle point of the curved action line. 

 

Figure: Intensity difference at skew bars 

8. Place the line load in the model view based on the chosen geometry method (5th step). 

With the special tool called Object’s local system ( ) you can add line load directly to a selected 

bar element in a direction set parallel with the one of the local system axis of the bar element. 

So, with this tool, you can merge 4th, 5th and 8th steps to one step, if the required load direction 

is equal to the direction of the assigned bar element’s local axis. 

Optional steps: 

9. Modify the load properties (the host load case, intensity values, “intensity” and “direction 

mode”) with the  Properties tool of the Line load tool palette. 
10. Modify the load direction with the editing tools (Editing Loads). 
11. Set the display settings of the load (Load Display Settings). 
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Wind Load (Automatic) – Regular building 

Two types of wind load can be generate in FEM-Design, Regular building and Generic building wind 

load. 

 Regular building wind load generation needs storey-system in the project! 

Definition steps 

1. Entering to “Load” mode, the program displays the so-called “main directions” of the current 
project. These main X’ and Y’ load directions are used by the automatic wind and deviation 

load definition. By default, the main X and Y load directions are parallel with the Global X and 
Y axis directions. Set the required load directions for the wind (and deviation) loads with the 
Change direction command (Modify menu). 

 The symbol of the main load directions are stored on “Main directions” Object layers. 

2. Start the  Wind load command from Loads tabmenu. 

 The generated wind line loads will be inserted in a load cases called “Wind load X” and 

“Wind load Y”. If there are no same named load cases in the project, the program 

automatically defines them for the automatic wind load components. 

3. Set the wind speed and terrain type in the settings dialog according to the building environment. 
The program calculates the applied wind load values by the levels of the current project’s 
storey-system from the given parameters and the model size set at the Storey command 
(horizontal building size and story level heights). The calculated intensity values are displayed 
in table format (right part of the dialog). 

4. Set the wind load X and Y directions same (+) or converse (–) with/to the main X and Y 

direction system. 
5. Clicking OK generates line loads in the external edges of plates that are located on stories 

surfaces/region parts. 
 

 

While generating Wind Loads all existing Wind Loads are redefined! That may delete previously 

defined Wind Load cases. 
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Surface Load 

In all FEM-Design module constant or variable  Surface load (force) can be defined  in the 

oridinary way by giving the load region, direction and load intensity positions, if necessary. In the 3D 

modules, there is an additional option to define  Soil/hydrostatic pressure-like load by giving the 

load region, direction, the soil/water level, the intensity at the soil/water level and the increment of 

the intensity.  

The load properties and definition tools are available on the tool palette of the   Surface load. 

 

Figure: Tool palette of Surface load 

Ordinary, Constant Surface Load 

 

 

Figure: Constant surface load on a slab and on a wall 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new surface load(s) to. 

If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. Here you can type any comment, which will be displayed next to the 

force. 
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Figure: Load case definition 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Set the intensity value in the q1 field according to the current unit (that can be set at Settings > 

Units) in the tool palette or at  Default settings. You may also choose intensity from the 

predefined load values from the list appears after clicking on the  button. 
3. Define the load direction (FEM-Design module dependent). 
4. Choose a method for the action surface definition (geometry). 
5. In the 3D modules only, you can set the “intensity mode”, that means the connection between 

applied intensity and the action plane  at  Default settings, if the new load will be in skew 
position (not vertical or horizontal): 
- “Intensity meant along action plane” 

The intensity will be meant along the action plane, so the resultant will be calculated from 

the intensity and the area of the action surface. Apply this option for dead load-type loads. 

- “Intensity meant perpendicular to direction of load” 
The intensity will be meant perpendicular to the load direction, so the resultant will be 

calculated from the intensity and the area of the horizontal projection of the action surface. 

Apply this option for example to model snow load.  
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Figure: Intensity difference at skew bars 

6. Place the surface load in the model view based on the chosen geometry method (4th step). 

With the special tool called Object’s local system ( ) you can add surface load directly to a 

selected planar object in a direction set parallel with the one of the local system axis of the planar 

object. So, with this tool, you can merge 3rd, 4th and 6th steps to one step, if the required load 

direction is equal to the direction of the assigned planar object’s local axis. 

Ordinary, Variable Surface Load 

Linearly variable surface loads can be defined with Surface load command. Three intensity values define 

the linearly variable load as a “skew plane”. 

 

Figure: Variable surface loads 
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Definition steps 

1. Define first a constant surface load with the required direction and geometry as written at 
Constant Surface Load. 

2. Use the  Variable intensity tool of the Surface load command. 

3. Set the new intensity values (q1, q2 and q3). If you inactivate the arrows (  ) next to the value 
fields, you can type different values by the q fields. 

4. Select the constant surface load that you would like to modify being variable. 
5. Give the position of the intensity values. You may click outside the surface load’s action plane 

too. 
Optional steps for constant/variable surface loads 

1. Place a hole/opening in a surface load. Use the  Hole tool of the Surface load. 

2. Modify the load properties (the host load case, intensity values, “intensity mode”) with the  
Properties tool of the Surface load tool palette. 

3. Modify the load direction with the editing tools (Editing Loads). 
4. Information (the resultant force value and the position of its action point) about a selected 

surface load can be inquired with the  Info tool. A drawing point can be placed in the 
resultant’s action point, if needed. 

 

Figure: The resultant force value and position calculated by Info tool 

5. Set the display settings of the load (Load Display Settings). 
 

Soil/hydrostatic pressure 
 

Soil/Hydrostatic pressure-like load can be defined in a convenient way by choosing “Soil/Hydrostatic 

pressure” option. 

 

The load intensities are automatically calculated based on three user-defined values: 

• z0: the surface level of soil/water (on the global Z axis) 

• q0: the intensity of load at the surface level 

• qh: the increment of load intensity (along the global Z axis) 

The intensity of the load at a certain point of an element is calculated with the formula below: 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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 𝑞 = 𝑞0 + (𝑧0 − 𝑧) ∙ 𝑞ℎ (2.1.) 

q: the intensity of the load at the particular point 

 z: the Z coordinate of the point 
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The direction of the soil/hydrostatic pressure load can be determined either in the same way as in 

case of the ordinary surface load. 

For the fastest and easiest load definition it is recommended to use the Object’s local system 

option with the “Direction is parallel with the local z’ axis” mode. 

 

 
Wind load (Automatic) – Generic building 
Generic building’s wind load (as surface loads) can be placed automatically on covers. 

1. Set the type of the cover according to EC: External wall , Flat roof , Lean-to  or 

Ridge-roof : 

 

Figure: Generic building wind load dialog 
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In all four cases a green arrow plays a crucial role in correct load generation. In Lean-to and Ridge-

roof the arrows are generated automatically by FD, but for flat roof and external wall, the user has to 

define it. Details can be found in the sections below. 

The importance of the green arrows can be understood at the bottom-left figure in the four settings 

windows of the four cover type, showing the wind direction terminolgy of EC. In the standard, if the 

deviation of wind speed is in the range of +45 and -45, it is taken as 0. In the range of 45-135, it’s 

taken to be 90, between 135-225, to be 180, and in the last interval to be 270. By this assumption, no 

other direction can be imagined as the four cases in the window below, which shows the Default Settings 

(the button shown in the figure above) for external wall first, and the others next. 

 External wall 

After having chosen , this is what you get in Default settings: 

 
Figure: External wall dialog 

The figure at bottom-left shows the direction terminology. For 0, you can scroll down the typical cases 

mentioned by EC: 



287 

 

and for 180  

Figure: External wall – setting multiplication factor for predefined wall positions 

By choosing the one valid for the current cover, the multiplication factor will be adjusted to the right 

value. For more sophisticated cases you have the possibility to define the multiplication factor manually.  

If the wind direction is in the plane of the wall, some more highly loaded zones (A and B, see EC 1-4 for 

details) are applied by EC at the leading edge of the wall for taking the effect of turbulence into account. 

Followed by zone C, a less loaded domain. If no turbulence can be imagined at the leading edge, you 

can cancel out the creation of zone A and B (The legend in bottom left helps in understanding the 

directions.): 

 

 

Figure: Wind load direction terminology 

EC allows the division of the load domain into horizontal stripes, so you may take into account the 

height dependence of wind velocity by the application of several horizontal stripes: 

 
Figure: Wind load vertical distribution 
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In case of external wall, you have to select the cover by clicking on it, and than select a point at the 

external side of the building. The green label, and also the arrow will appear, but the arrow will be 

perpendicular to the plane of the cover. If you have a composed building like in the case below, you can 

unify several wall covers by pushing Ctrl, and selecting the members: 

 
Figure: Selecting External wall 

If you have selected one element, you can immediately define the green arrow by picking an external 

point, in case of more elements you have to end the selection by ’Enter’, and then point an external point 

outside the walls: 
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Figure: Defining wall’s external point 

The wind load generated according to EC will consider the unified green rectangle as one surface. 

After classified all the walls, verify all arrows’ pointing out from the building in order to obtain 

well directed wind loads on the walls. 

Flat roof 

In case of Flat roof , the following appears: 
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Figure: Flat roof dialog 

In the bottom left, the figure shows the notation of the directions with respect to the green arrow. The 

user can switch on or off the creation of the turbulence zones like in the case of External wall, and also 

can change the multiplication factors manually. 

If an attic wall is at the edge of the cover, the height is required, as it has influence on the values of the 

load. 

After choosing the settings, you have to click on the cover, and then, you have to give the main direction 

for wind generation: 
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Figure: Defining the main direction for wind generation 

After the definition of the direction a green label will appear with an arrow in the middle of the cover. 

If possible, you should choose a main direction of the building that coincides with axis X, for obtaining 

the correct distribution in the different wind load cases.  

An incorrectly defined direction can lead to false wind load distribution.  

You can modify its direction in Modify>Change direction.  (If the label or the arrow is missing after 

creation, try another graphic engine in Settings>All>Environment>General>Graphic Engine) 

Lean-to 

In case of Lean-to , the dialog window is as follows: 
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Figure: Lean-to dialog 

Likely to former cases, the notation of EC appears at bottom-left corner. If you have a cover that is not 

parallel with the load coordinate-system, the wind load directions will fit the cover’s direction.  The 

different factors can be set eiter by scrolling down the  symbol: 

and  
Figure: Lean-to – setting multiplication factor for predefined wall positions 

 

or, by setting them manually. 

If required, turbulence zones can be switched off: 
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Figure: Turbulence zone application 

 

Ridge roof 

The pop up window in case of Ridge roof: 

 
Figure: Ridge roof dialog 

Likely to former cases, the notation of EC appears at bottom-left corner. If you have a cover that is not 

parallel with the load coordinate-system, the wind load directions will fit the cover’s direction.  The 

different factors can be set eiter by srcolling down the  symbol: 
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and  
Figure: Ridge roof – setting multiplication factor for predefined wall positions 

or, by setting them manually. 

If required, turbulence zones can be switched off. 

 

Figure: Turbulence zone application 

2. Generate the wind load 

When clicking on the symbol , the wind generation tool window appears: 
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Figure: Wind load generation dialog 

In this window you have to classify the building according to EC, and give  the basic wind velocity  for 
load generation. 

After clicking OK, the wind loads are generated in 16 different load cases: 

 
Figure: Automatically generated wind load (WL,Y-,1) 

(For proportional displaying of loads click: Settings>All>Display>Load>Display proportionally) In the 
example above, WL Y-, 1. is active which corresponds to a wind marked by the orange arrow. 

It is parallel with the loaded wall, and as it is in the range of 45-135, according to the load’s coordinate 
system, it is stored in WL, Y-, 1. For each (four) directions, generally 4 different cases can be imagined 
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in EC (because of variation of suction and pressure), but they not necessarily vary: in the case above, all 
four versions of WL, Y-, are the same for the loaded external wall.  

According to EC, protuding parts of roofs should be loaded at underside with the pressure 
applied on the wall below. This is not taken into account by the wind loading module of FD 11.0. 

If the building have a frequently used shape, the program generates the different load domains and the 
values will be applied on them automatically.  

Snow Load (Automatic) 
Snow load (as surface loads) can be placed automatically on the open, external plates and plate parts. 

Definition steps 

1. Start the  Snow load command from Loads tabmenu. 

 The generated snow surface loads will be inserted in a load case called “Snow load”. If 

there is no “Snow load”-named load case in the project, the program automatically 

defines it for the automatic snow load. 

 

2. Set the characteristic snow load value in the settings dialog according to the current code rules. 
The program calculates the applied snow load value (intensity) from the characteristic value 
and the built-in form, exponation and thermal factors of the Eurocode. 
 

3. Clicking OK generates surface loads on the open plate surfaces/region parts. 
Thermal Load 
Depending on the current FEM-Design module, uniform or non-uniform temperature variation can be 

added to the structural elements as loads. 

 

Table: Temperature load types by FEM-Design modules 

FEM-Design 

Module 

Temperature Variation Load Command 

 
Non-uniform temperature in Beams 

 Line temperature variation 

 Non-uniform temperature in Plates 
 Surface temperature 

variation 

  
Uniform temperature in Walls 

 Surface temperature 

variation 

 
Uniform/Non-uniform temperature in bar 

elements 
 Line temperature variation 

 Uniform/Non-uniform temperature in planar 

elements 
 Surface temperature 

variation 

 
Uniform/Non-uniform temperature in bar 

elements 
 Line temperature variation 
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Line Temperature variation 

- Non-Uniform Temperature Variation in Beams 

In  Plate module, non-uniform temperature variation can be defined along beam action line 

or a part of it. The absolute value of the temperature has to be the same in the top and bottom 

cords: 

|dttop| = |dtbottom| 

So the meaning of the temperature variation is the following: 

|dt| = ±|dttop-dtbottom| = ±2 x |dttop| 

 

The temperature variation can be linearly variable along the action line, so it can be different in 

the start and end point of the action line. 

- Uniform/Non-Uniform Temperature Variation in Bar Elements 

In  3D Structure and  3D Frame modules, uniform or non-uniform temperature variation 

can be defined along beam and column action lines or a part of them. The temperature values 

can be different in the top (t) and bottom (t’) cords. 

 

 

The temperature variation can be linearly variable along the action line, so it can be different in 

the start and end point of the action line. 

Depending on the current FEM-Design module, temperature load can be easily added to bar elements. 

The load properties and definition tools are available on the tool palette of the  Line temperature 

variation load. 
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Figure: Tool palettes of Line temperature variation load 

Definition steps 

1. Select the load case from the load case drop-down list from  tabmenu, which you would 
like to add the new load(s) to. 

If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Set the temperature values at the start and end point of the “load” action line to the current 

temperature unit (that can be set at Settings > Units) in the tool palette or at  Default settings. 

If you inactivate the arrow (  ) next to the temperature fields, you can type different 
temperature values in the “1” and “2” fields. 

 

Figure: Settings dialogs (the meaning of the “t” values) 

3. Define the direction of the plane you would like to place the thermal load (only in 3D modules). 

4. Add the thermal to its belonging bar element by selecting it with . 
Or, choose a method for the action line definition (geometry) and define the thermal load. Use 

this method, if you would like to place the load on a part of the bar element. 

With the special tool called Object’s local system ( , only in 3D modules) you can set the load’s 

plane direction directly to a selected axis of the bar element’s local system in the tool palette 

and by the clicking on the bar element. So, with this tool, you can merge 3rd and 4th steps to one 

step, if the direction of the thermal load plane is equal to a required axis direction of the assigned 

bar element’s local system. 
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Figure: Different ways of thermal load definition 

Optional steps: 

5. Modify the load properties (the host load case and temperature values with the  Properties 
tool of the Line temperature variation load tool palette. 

6. Modify the direction of the thermal load plane with the editing tools (Editing Loads). 
7. Set the display settings of the thermal load (Load Display Settings). 

Surface Temperature variation 

- Non-Uniform Temperature Variation in Plates 

In  Plate module, non-uniform temperature variation can be defined in plate region or a part 

of it. The absolute value of the temperature has to be the same in the top and bottom cords: 

|dttop| = |dtbottom| 

So the meaning of the temperature variation is the following: 

|dt| = ±|dttop-dtbottom| = ±2 x |dttop| 

 

The temperature variation can be linearly variable along the action plane. Temperature value in 

3 region points defines the linearly variable temperature in a plate object. 

- Uniform Temperature Variation in Walls 

In  Wall module and  Plane Strain modules, uniform temperature load can be defined in 

wall region or a part of it: 

tsi= ttop = tbottom 
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The temperature variation can be linearly variable along the action plane. Temperature value in 

3 region points defines the linearly variable temperature in a wall object. 

- Uniform/Non-Uniform Temperature Variation in Planar Elements 

In  3D Structure module, uniform or non-uniform temperature variation can be defined in 

plate, wall and shell regions or a part of them. The temperature values can be different in the top 

(t’) and bottom (t) cords. 

 

The temperature variation can be linearly variable along the action plane. Temperature value in 

3 region points defines the linearly variable temperature in a plate, wall or shell object. 

Depending on the current FEM-Design module, temperature load can be easily added to planar objects. 

The load properties and definition tools are available on the tool palette of the  Surface support motion 

load. 

 

Figure: Tool palettes of Surface temperature variation load 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new load(s) to. 

If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. 
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The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. First, define temperature variation constant along the load action plane. Set the motion value in 
the “t1” fields according to the current temperature unit (that can be set at Settings > Units) in 

the tool palette or at  Default settings. 

 The local z’ axis of the surface element (plate, wall) points to the “top” surface temperature 

(t’) in  3D Structure module. 

 

Figure: Settings dialogs (the meaning of the “t” values) 

3. Add the thermal load to its belonging surface element by selecting it with . 
Or, choose a method for the action surface definition (geometry) and define the surface thermal 

load. Use this method, if you would like to place the load on a part of the surface element. In 

this case set the working plane into the element’s plane. 

 

Figure: Different ways of surface thermal load definition 
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Optional steps: 

4. Use the  Variable intensity tool, if you would like to define variable surface thermal load. Set 
the new temperature values (dt1/t1/ts1, dt2/t2/ts2 and dt3/t3/ts3). If you inactivate the arrows 

(  ) next to the value fields, you can type different values by the t fields. Select the constant 
surface temperature load that you would like to modify being variable. Give the position of the 
three temperature values. You may click outside the surface load’s action plane too. 

5. Place a hole/opening in a surface thermal load. Use the  Hole tool of the Surface temperature 
variation load. 

6. Modify the load properties (the host load case and temperature values with the  Properties 
tool of the Surface support motion load tool palette. 

7. Set the display settings of the thermal load (Load Display Settings). 
Initial Internal Load 

Post-stress can be added to bars (  Initial internal line load) and structural regions (  Initial internal 

surface load) as load. Constant moment and normal force values in a given direction (e.g. only in one 

direction) may be defined by points of line and planar structural objects. 

The initial internal load commands are useful for defining post-tensioning loads in concrete bars and 

slabs. Post-stress is also good for steel bars at welded connections. The definition steps are the same as 

introduced at Line or Surface temperature variation load commands. 

 

Figure: Initial internal force (compression) in a stiffener truss member 

 

 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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Support Motion 

Predefined displacement (motion and/or rotation depending on the current FEM-Design module) can 

be assigned to point, line and surface supports. 

Only the same type support motion can be assigned to a support. 

 

Table: Support motion load types and their proper support types 

 If a support motion load is not belonging to a support, the program sends you a warning message 

during calculation, that that load will be ignored in the calculations. 

In  Plate module the Column and Wall elements are supports, so  Point support motion load 

can be assigned to Columns and  Line support motion load to Walls. 

Point Support Motion 

Depending on the current FEM-Design module, predefined point motion/rotation can be easily added 

to point supports by giving displacement direction and position. The load properties and definition 

tools are available on the tool palette of the  Point support motion load. 

  

Figure: Tool palette of Point support motion load 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new load(s) to. 

If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Choose the motion type:  Motion or  Rotation (FEM-Design module dependent). 
3. Set the displacement values in the e or phi of the new load according to the current unit (that 

can be set at Settings > Units) in the tool palette or at  Default settings. 
4. Define the direction of the motion or the rotation axis (FEM-Design module dependent). 
5. Add the point motion to its belonging point support by clicking the support’s insertion point (

) or by selecting the point support ( ). 

Support motion load type Support type 

 Point support motion load  Point support 

 Line support motion load   Line  support 

 Surface support motion load  Surface support 
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Optional steps: 

6. Modify the load properties (the host load case and displacement values with the  Properties 
tool of the Point support motion load tool palette. 

7. Modify the displacement direction with the editing tools (Editing Loads). 
8. Set the display settings of the load (Load Display Settings). 

Line Support Motion 

Depending on the current FEM-Design module, predefined motion/rotation can be easily added to line 

supports by giving displacement direction and position. The load properties and definition tools are 

available on the tool palette of the  Line support motion load. 

 

 

Figure: Tool palette of Line support motion load 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new load(s) to. 

If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. Choose the motion type:  Motion or  Rotation (FEM-Design module dependent). 
3. Set the displacement values at the start and end point of the “load” action line: e1 and e2 or phi1 

and phi2 according to the current unit (that can be set at Settings > Units) in the tool palette or 

at  Default settings. If you inactivate the arrow (  ) next to the e1 or phi1 field, you can type 
intensity value in e2 or phi2 different from e1 or phi1. 

4. Define the direction of the motion or the rotation axis (FEM-Design module dependent). 
5. Set the “direction mode”, that means the connection between applied load direction and the 

action line at  Default settings, if the new load will be a curved line load: 
- “Direction is constant along action line” 

The load direction set in the 4th step will be constant along the action line. 

- “Direction varies along action line” 

The load direction will vary along the action line, so the characteristic direction set in the 

4th step will be taken into consideration in the middle point of the curved action line. 

6. Add the motion to its belonging line support by selecting the line support ( ). 
Or, choose a method for the action line definition (geometry) and define the line load. Use this 

method, if you would like to place the load on a part of the support’s action line. 
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With the special tool called Object’s local system ( ) you can add motion load directly to a 

selected component of a support/more supports just by setting the required component 

direction (an axis of the support’s local coordination system) in the tool palette and by the 

clicking on the support(s). So, with this tool, you can merge 4th and 6th steps to one step, if the 

required displacement direction is equal to the direction of the assigned support component. 

 

Figure: Different ways of line support motion load definition 

Optional steps: 

7. Modify the load properties (the host load case and displacement values with the  Properties 
tool of the Point support motion load tool palette. 

8. Modify the displacement direction with the editing tools (Editing Loads). 
9. Set the display settings of the load (Load Display Settings). 

Surface Support Motion 

Depending on the current FEM-Design module, predefined motion can easily be added to surface 

support by giving displacement direction and position. The load properties and definition tools are 

available on the tool palette of the  Surface support motion load. 

  

Figure: Tool palette of Surface support motion load 

Definition steps 

1. Select the load case from the load case drop-down list from Loads tabmenu, which you would 
like to add the new load(s) to. 
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If you have not defined a load case yet, you can also define and set at the  Default settings by 

giving a load case name. 

The load will be displayed on the layer assigned to the selected load case and in the layer’s 

color. 

2. First, define a constant predefined displacement. Set the motion value in the e1 field according 

to the current unit (that can be set at Settings > Units) in the tool palette or at  Default settings. 
3. Define the direction of the motion (FEM-Design module dependent). 

4. Add the motion to its belonging surface support by selecting the surface support ( ). 
Or, choose a method for the action surface definition (geometry) and define the surface load. 

Use this method, if you would like to place the load on a part of the support’s action surface. 

With the special tool called Object’s local system ( ) you can add motion load directly to a 

selected component of a support/more supports just by setting the required component 

direction (an axis of the support’s local coordination system) in the tool palette and by the 

clicking on the support(s). So, with this tool, you can merge 3rd and 4th steps to one step, if the 

required displacement direction is equal to the direction of the assigned support component. 

 

Figure: Different ways of surface support motion load definition 

Optional steps: 

5. Use the  Variable intensity tool, if you would like to define variable surface motion assign to 
a surface support or a part of it. Set the new displacement values (e1, e2 and e3). If you inactivate 

the arrows (  ) next to the value fields, you can type different values by the e fields. Select the 
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constant surface load that you would like to modify being variable. Give the position of the 
three motion values. You may click outside the surface load’s action plane too. 

 

Figure: Variable surface support motion 

6. Place a hole/opening in a surface load. Use the  Hole tool of the Surface support motion load. 

7. Modify the load properties (the host load case and displacement values with the  Properties 
tool of the Surface support motion load tool palette. 

8. Modify the displacement direction with the editing tools (Editing Loads). 
9. Set the display settings of the load (Load Display Settings). 

Mass 
For dynamic, vibration shape and seismic effect calculations (especially for frame structures), masses 

can be defined optionally as point loads or automatic conversion of load cases to mass. 

 Masses are not participants of load cases, load combinations and load groups. 

Concentrated Mass 

Definition steps 

1. Start the  Mass command from  tabmenu. 
2. Set the mass value according to the current unit (that can be set at Settings > Units). 
3. Place the mass just by clicking in the required point. 

The mass will be displayed on the Masses object layer assigned in green color by default. 

Optional steps: 

4. Modify the mass value with the  Properties tool of the Mass tool palette. 
5. Set the display settings of masses (Load Display Settings). 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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Figure: Definition of concentrated mass 

Load Case-Mass Conversion 

With the  Load case-mass conversion command of Loads tabmenu, you may convert load cases to 

masses by assigning factor values to them. All conversions are done just before dynamic calculation. 

Typing 1 into the Factor field means that the loads (of the load case) with their original value will be 

converted to mass. Typing 0 value removes predefined conversion of a load case (as a result you will 

get the "--" symbol again). 

 

Figure: Mass definition by conversion of loads (load cases) 

The following point, line and surface force types can be converted to masses: 

 Plate module: force with global -Z direction: mz = -Fz/g 

 Wall  and  Plain Strain modules: force with global -Y direction: mx = my = -Fy/g 

 3D Frame and  3D Structure modules: force with global -Z direction: mx = my = mz = -Fz/g 
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 Moments, support motions, thermal loads cannot be converted to masses. 

Seismic Load 

Seismic loads are taken into account according to the Response Spectrum Analysis method of 

Eurocode 8 or Turkish seismic code. 

Only the response spectrum and some additional parameters have to be defined as Seismic load. 

Required spectrums can be defined with the  Seismic load by using standard spectra (automatic) or 

by manual definition (unique). 

 The applied/defined spectra and its properties can be added to documentation as figures and 

tables by clicking on Add to documentation. 

Automatic Design Spectrum Definition (“Standard”) 

Clicking on Standard generates the horizontal and vertical spectra based on settings and parameters 

required by Eurocode 8. 

 The horizontal spectrum is always necessary. The vertical spectrum is necessary when the 

vertical affect taken into account. 

- Structure information 
Eurocode code: 

Structure type: 

- Building structure 

- Non-building structure 

ksi: is the viscous damping ratio (generally 5%), which is used in Modal analysis when 

the summation of the effect of the same direction vibration shapes is carried out by 

the CQC (Complete Quadratic Combination). 

qd: behavior factor. The displacements from seismic analysis is increased with this 

factor. 

Turkish seismic code: 

Structure type: 

- New building 

- Existing building (Limited, Medium or Comprehensive Information level): 
The Information level affects the cross-sectional resistances in Performance Based 
Design calculations. 

- Non-building structure. 

Beta: This coefficient is for checking if the ratio of base shear force calculated with Mode 

superposition method and Equivalent seismic load is greater than this value. 
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 Storeys definition is necessary if the user selects the Structure information as building (in Turkish 

seismic code New or Existing Building) 

For Non-building structures the following result are calculated after Seismic analysis: 

- Equivalent loads 

- Displacements 

- Reactions 

- Connection forces 

- Bar / Shell internal forces 

 For building structures additional result are calculated which can be listed after Seismic analysis: 

- Second order effect (P-Delta) coefficients 

- Horizontal spectra 

 

Figure: Parameters and automatic generation of horizontal spectra 

Data of horizontal design spectra (based on Eurocode 8): 

- Type (of spectra: 1 and 2) and Ground type (A, B, C, D and E) specify the values of S, TB, TC 
and TD; 

- ag is the design ground acceleration; 
- S is the soil factor; 
- q is the behavior factor that depends on material and type of the structure; 
- beta is the lower bound factor for the horizontal design spectrum. 

 

Data of horizontal design spectra (based on Turkish seismic code): 

- Seismic zone (1, 2, 3 or 4), Local site class (Z1, Z2, Z3 or Z4), Building importance factor and 
Probability to exceed in 50 years specify the values of S, TA, TB; 

- Ductility level: 

- Behaviour factor: depends on material and type of the structure; 
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Vertical spectra 

 

  

Figure: Parameters and automatic generation of vertical spectra 

The vertical design spectrum is derived from the horizontal spectrum using the agv (vertical 

design ground acceleration)/ ag multiplicator based on Eurocode 8. 

 The vertical spectra is available only in Eurocode and not available in Turkish seismic code. 

Custom Design Spectrum Definition (“Unique”) 

User can define custom horizontal and vertical spectra in table format or by editing spectra graphically. 

Switch to Unique mode, and then add T and Sd values to the table cells or place points in the Sd-T(s) 

curve by clicking in the required points of the figure. 

 

Figure: Custom spectra definition 
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Unique spectra can be stored in files and exported with Save. Spectra can be imported with Load. 

Moving load 

 

The Moving load macro applies a pre-defined set of loads (Vehicle) along a user-specified path. Its 

working method is the following: 

1. User specifies the path and the preferences of the Moving load. 
2. The macro defines Vehicle positions along the path according to the preferences. 
3. The pre-defined Vehicle is added to each Vehicle position, producing singular Load cases. 
4. A Load group is created, containing the Load cases of the Moving load. 
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Defining a Moving load 

The following figure shows the definition method of a Moving load: 

 

The options on the General tab are described below. 

Default division: the method how the path of the Moving load is divided into segments. The Vehicle 

positions will be defined in the points of division and at the start and the end point. The division can 

be defined 

 

• By division number: the number of parts, that the macro divides the Path into, will be equal with 
the given value. Accordingly, the result is one more Vehicle position than the user-specified 
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value. The distance between the points of division (and therefore between the Vehicle 
positions) are equal. 

 

• By distance: the software defines as many segments from the start of the Path, with length equal 
to the specified value, as possible. The last segment may be shorter than the others. 

Loading options: the preferences of the way the macro defines the individual load cases along the 

path. 

•  Return: if checked, two load cases are defined in each Vehicle position. The first one 
has the same X axis direction as the Local coordinate system of the path element its Vehicle 
position is located on. The second one has the opposite X axis direction. 

 

•  Lock direction of vertical load: if checked, the vertical loads of the selected Vehicle are 
forced to be parallel with the global Z axis. Otherwise, they are parallel with the Z axis of the 
Local coordinate system of the path element which they are located on. 
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• Cut load to path extent: if checked, every load case of the Moving load gets analysed. If it 
extends over the path, then the software trims off the overhanging part. 

 

User can select the set of loads to apply in the Vehicle tab.

 

The functions of the buttons at the bottom of the dialog: 

• : Rename selected Vehicle 

• : Delete selected Vehicle 

• : Import Vehicle library from existing (*.vehicle) file 

• : Export Vehicle library to file 
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Defining Vehicles 

The steps of Vehicle definition: 
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Summary of Moving load functions 

 

 Define: the regular Define tool. It has two options: 

•  Draw path: selecting it allows User to define Path by its corner point. 

•  Select path: when selected, path can be defined from existing linear objects, such 
as drawing lines, bars, edges of plates or walls.  

 Properties: the regular Properties tool. 

The size of the local co-ordinate system symbol can be adjusted on the Display/Load tab in the 

Settings window. 

file:///C:/Munka/Properties%23_
file:///C:/Munka/Properties%23_
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 Vehicle: User can define Vehicles with it. This tool has the option: 

•  Delete original load: if activated, loads used for the definition of Vehicle will be deleted 

 Vehicle position: allows the modification of Vehicle positions.  

•  Add: defines a Vehicle position in a selected point along the path 

•  Delete: removes the selected Vehicle position 

•  Move: changes the position of the selected Vehicle position along the path 

•  Reset: redefines all Vehicle positions on the selected path according to the Preferences of 
the Moving load. It removes all former modification of Vehicle positions. 

 Animate motion: Plays an animation that shows each load case of the Moving load, one after the 

other. The speed of the animation can be set with the slider. 

 

Predefined Load Values 

You can browse from predefined intensity values when clicking on the  button of the Surface load 

command’s tool palette. Just select a value from the drop-down list and it will be added in the proper q 

field. 

 

 

Figure: Predefined intensity value added to q field (Surface load) 
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Load Display Settings 
The display properties of the loads can be set at the Settings > All… > Display > Load. 

The available options depend on the current FEM-Design module. 

  

Figure: Settings options affect on the appearance of the loads 

 

- Display label 
The load values can be displayed on the screen in Wireframe display mode. The default font 

size and style can be set at Settings > Text settings. 
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Figure: Load labels displayed according to Text settings 

 The position of the load labels can be modified with Edit > Move. 

- Display proportionally 
By default, this option is inactive. That means all loads are displayed according the Size [m] set 

by load types. So, for example, point loads having different force values are displayed with 

same size arrow symbols with the height set by Size. 

Activating the Display proportionally option the loads will be displayed with their values 

multiplied with the Scale value set by load types. So, if the Scale value is 1.0 for all load types, 

the loads are displayed with their real values converted to meter units. For example, 5kN point 

force is displayed 5m-height symbol in case of 1.0 Scale value; but modifying the Scale value to 

2.0 displays the 5kN force with 10m-height symbol. 

 

Figure: Examples for different Size/Scale values and Display proportionally option 

- Hatch distance 
Hatch distance sets the density of the hatches of the surface loads’ action plane. 

Layer, color and pen width 

All loads are placed (and grouped) on Object layers according to their host load case. Color and pen 

width are assigned to each load case. After defining a load case the program automatically set red color 

for it by default. The default color together with the pen width of the load symbol contours can be 

modified with the Color and Pen tools. 

By default, the layer of the current load case is active and the others are hidden. Of course, you can 

activate, hide or protect load case layers as you want. 
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Figure: Layer-system of loads (load cases) 

Editing Loads 
Copying Loads 

The Copy load case command (Loads menu) gives an easy way to copy all defined loads of a load case 

(Source) into another load case (Destination). With the Multiplication factor the values of copied loads can 

be increased or decreased proportionately. 

 

Figure: Copying loads of a load case to another one 

Loads can be copied inside a load case with the Copy command (Modify menu). 

Modifying Load Values 

Load properties (such as the load values) can be easily modified with the  Properties tool of the proper 

load definition command. 

With the  Multiply load command, you can modify values of selected loads with a given multiple 

factor. 

Modifying Load Directions 

Depending on the current FEM-Design module, the direction of predefined loads can be modified with 

the Change direction, Mirror and Rotate command of the Edit menu. 

Modifying Load Positions 

The position of Loads can be modified with the Move command (Modify menu). 

Modifying the Geometries of Action Lines and Surfaces 
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The editing tools valid for region elements can be used to modify the geometry of surface loads’ action 

plane. These Edit menu commands are for example Modify region, Stretch, Curve, Elbow, Scale, 

Chamfer, Fillet etc. The  Hole tool of surface load commands can also be used to cut parts from a 

surface load. 

The editing tools valid for lines and arcs can be used to modify the geometry of line loads’ action line. 

These Edit menu commands are for example Stretch, Curve, Elbow, Split, Trim, Extend, Break etc. 

Combination of Loads/Load cases 
Load cases (and so their load contents) can be combined manually with given load factor multipliers 

(Load Combination) or the program finds the most unfavorable combinations of the load cases grouped 

in different types (permanent, temporary, accidental etc.). 

Load Group 

 Load cases can be grouped (Load groups command) by their action type (permanent, temporary, 

accidental etc.). The program calculates (if required) the critical values of analysis and design 

results from the most unfavorable combinations of “grouped” load cases. 

 Non-linear calculations such as 2nd order analysis, stability and cracked-section analysis cannot 

be done for load groups. 

There is an option for temporary load groups to choose predefined ψ0, ψ1 and ψ2 values. 

file://///officesrv/strushare/Ricsi/new%20features/Holes%23_
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Figure: Load group definition 

Temporary load groups has an option to ignore in SLS combinations in Load group maximum results 

and in Generating load combinations by load groups.  

 

 

In Load groups dialog the User has the opportunity to choose one of the combination methods offered 

by Eurocode 0. Two methods of determining the combination of actions are allowed for the STR 

Ultimate Limit States. 
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The first approach is to use expression 6.10. 

 ∑ 𝜸𝑮,𝒋𝑮𝒌,𝒋𝒋≥𝟏 " + "𝜸𝒑𝑷" + "𝜸𝑸,𝟏𝑸𝒌,𝟏" + " ∑ 𝜸𝑸,𝒊𝝍𝟎,𝒊𝑸𝒌,𝒊𝒊≥𝟏  (6.10.) 

The second approach is to use the more onerous of expressions 6.10.a and 6.10.b. 

 ∑ 𝜸𝑮,𝒋𝑮𝒌,𝒋𝒋≥𝟏 " + "𝜸𝒑𝑷" + "𝜸𝑸,𝟏𝝍𝟎,𝟏𝑸𝒌,𝟏" + " ∑ 𝜸𝑸,𝒊𝝍𝟎,𝒊𝑸𝒌,𝒊𝒊≥𝟏  (6.10.a) 

 ∑ 𝝃𝒋𝜸𝑮,𝒋𝑮𝒌,𝒋𝒋≥𝟏 " + "𝜸𝒑𝑷" + "𝜸𝑸,𝟏𝑸𝒌,𝟏" + " ∑ 𝜸𝑸,𝒊𝝍𝟎,𝒊𝑸𝒌,𝒊𝒊≥𝟏  (6.10.b) 

The subtle attraction of this pair of expression derives from two important changes from 6.10.: 

The application of the ψ0 factor to the leading variable action in expression 6.10.a (not applied in 6.10.) 

The introduction of a reduction factor ξ applied to the permanent actions in expression 6.10.b (not 

applied in 6.10.) 

It is possible to deactivate the Potentially leading load cases check box for a Temporary load group. This way 

the number of generated load combinations can be reduced. 

The whole expressions appear on the screen as the cursor is moved on the name of the combination 

method. 

Load group and Load case definition functions are shown on the right side of the Load groups dialog 

box. 
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Figure: Load group definition functions 

Under Load group group, there are three functions: 

- Insert 

With this function the user can add a new Load group. After clicking on Insert button, the 

parameters can be set in the dialog. 

- Delete 

This function deletes a Load group. 

- Delete all 

This function deletes all defined load groups. 

Under Load case group, there are three functions: 

- Insert 

An existing load case can be inserted to a load group. 

- New 

The user has the opportunity to define load cases in Load groups dialog. After defining a load 

case in this dialog, the new load case will be added to Load case list (the user can see it in Load 

cases dialog). 
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Figure: Load case definition in Load groups dialog 

- Remove 

This function removes the selected load case from the current load group. 

Definition steps of new load groups 

1. Click on an empty Load group cell. Define the name of the new load group and set its type. Set 
the required factors of the group according to the selected type and the applied standard. 

2. Add a load case to the group by selecting it from the Included load cases drop-down list. To add 
more than one cases to a group, use the Insert case(s) option. 

 “Permanent”-type load groups defined will be present in all load combinations. 

 If more than one load cases are assigned to a load group, they will never be 

simultaneously present!  So, it is recommended to set permanent-type load cases (e.g. 

automatic dead-load, roof weight etc.) in own “Permanent”-type groups to avoid the 

loss one of them. 

3. Define the next load group by repeating the previous steps. 
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Optional steps 

4. A load group can be edited by double clicking on its Load group cell. 
5. The load group list can be set as the default group set for the next and later projects by clicking 

on Save as default option. 

 Let’s see an example, how partial loading of slab can be modeled with load groups. Just place 

the load cases represented the loading statuses into one “Temporary”-type load group. 

 

Figure: Partial loading of a slab 

Load Combination 

 Load combination lets you combine load cases by multiplying them with given load factors. 

Two main types of load combinations can be defined: load combinations for ultimate (U) and for 

serviceability (S) limit state. Although Analysis calculations can be done for both types, the 

recommended functions of the types are the followings: 

- Ultimate limit state-type load combination (U) 
Define U-type load combinations for strength and stability calculations. All design calculations 

(except for crack width of RC Design) are done only for U combinations. 

 -   Ultimate limit state-type (accidental) load combination (Ua) 

     This type of load combination is like Ultimate limit state, but the difference is in the safety factors. 

-    Ultimate limit state-type (seismic) load combination (Us) 

This type of load combination is like Ultimate limit state, but the difference is in the safety factors. 

- Serviceability limit state-type load combination, characteristic (Sc) 
Define Sc-type load combinations to calculate displacement. 

- Serviceability limit state-type load combination, frequent (Sf) 
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This type of load combination is like Serviceability (characteristic) limit state, but the difference is in 

the safety factors. 

- Serviceability limit state-type load combination, quasi permanent (Sq) 
Define Sq-type load combinations to calculate RC bars and slab crack width calculation. 

For the different design calculations different SLS load combinations are used: 

- Deflection check: user selectable 

- Foundation settlement: user selectable 

- Crack width: Quasi-permanent (Sq) 

  

Figure: Load combination definition 

Definition steps of new load combinations 

1. Type the name of the new combination in the Name cell. 
2. Set the load combination type by choosing Ultimate (U, Ua, Us) or Serviceability (Sc, Sq, Sf) 

from the Type drop-down list. 
3. Select a load case that you would like to add to the combination from the Included load cases 

drop-down list, which contains all load cases predefined in the current project. 
4. Type a load factor for the load case chosen in the previous step in the Factor cell. 
5. Repeat the 3rd and 4th step in the following rows, if you would like to add more than one load 

cases to the combination. 

 If you would like to add more than one load cases to the current load combination with 

the same factor in one step, use the Insert option of the Load combinations group. 

6. Define the next load combination by repeating the previous steps. 

 If you would like to define a load combination with a similar content (load cases with 

factors) of another one, apply the Copy comb. option for the source load combination 

and define the destination combination by defining a new load combination. Copy comb. 

option can also add a load combination content to another predefined one. 

Optional steps 

7. Load combination can be renamed by typing a new name in its proper Name cell. 
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8. Load combinations can automatically be generated from the Load cases assigned to the Load 
groups, according to Eurocode 1990-Chapter 6.4.3. 

- In Load combination dialog click Generate button. 

 

- Select load cases from the Load groups. 

- Select Load combination type to generate and their properties (if there is any). 

 The selected Load combinations will be generated if there is at least one load group 

of that type. E.g. if the user wants to generate Accidental load combination, but there is no 

Accidental Load group, or in that Load group there is no Load case, the program will not 

create any accidental Load combination.  

- Set the General options parameters. 

9. Another way to manage Load combination(s) and their Load case(s) are listed below: 

Load combinations: 

- Insert 
With this function the user can add a new Load combination. After clicking on Insert 

button, the parameters can be set in the dialog. 

- Copy 

With this function the user can copy an existing combination with load cases and factors. 

- Delete 
The user can delete a selected load combination. 

- Delete all 
All the load cases can be deleted with Delete all function. 

Load cases: 

- Insert: 
An existing load case can be inserted to a load group with Insert function. 

- New: 
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The user has the opportunity to define load cases in Load combinations dialog. After 

defining a load case in this dialog, the new load case will be added to Load case list (the 

user can see in Load cases dialog). 

- Remove: 
This function removes the selected load case from the current load group. 

Load Export/Import via clipboard 
Load Export and Import via clipboard lets the user easily and quickly modify loads. 

 

In order to export loads, User has to click to Export to send the load information to the clipboard. Then 

User can paste to Excel or any editor program and modify them. 

 
Only comments and the load intensities can be modified. We suggest NOT to edit other 

columns to avoid errors in Importing. 

 

 

After changing attributes, User can choose whether to import some. or all of the loads by selecting the 

desired rows and copying them to clipboard, then in FEM-Design clicking on Import. 

 
If the User exported constant surface load, only changing the first intensity value will 

have effect on the surface load. 

 

 

Export Import 

Editable columns 
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MODEL AND DATA CONNECTIONS 
 

There are numerous ways to get draft and initial model geometry for later design in FEM-Design. 

With the so-called Wizard tool, typical frame and roof structures can be modeled quickly by giving the 

parameters of the required geometry, support and load, and the program automatically generates the 

real 3D model. 

Models can be shared between the 2D and the 3D modeling of FEM-Design modules. For example, a slab 

of a multi-storey building (modeled in 3D Structure module) can be design separately from the other 

slabs in the Plate module. 

FEM-Design supports the major CAD drawing exchange formats (DWG/DXF), so imported drawings 

can be used as referenced draft for building up the structural models. 

FEM-Design is able to import 3D models from other structural and architectural programs in two ways: 

- FEM-Design supports the import of the most popular 3D model exchange data format called 
IFC (Industry Foundation Classes). The model-based data import gives the possibility to use the 
models designed by other disciplines (such as architectural) as an initial model or to show them 
as a reference. 

- StruSoft develops direct 3D model exchange links with ArchiCAD (architectural discipline) and 
the major structural applications: Tekla Structures and Revit Structure. Add-ons build in these 
applications export native FEM-Design elements generated from 3D models. 

Frame Wizard 

Wizard helps you to model typical frame and roof structures with beam elements, point supports and line 
loads. With geometry parameters, you can define one frame/roof stand (planar model) or a multi-
frame/roof system with 3D extension. Line loads such as automatic and additional dead-loads, snow, 
wind and live load can be added to the beam components. 

 Wizard is available in the  3D Structure and the  3D Frame modules. 

Definition steps 

1. Start the Wizard command from the Tool menu. 

 

Figure: Typical frame and roof structures as the range of Wizard 
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2. Choose the required frame/root type in the Wizards dialog box. 
3. According to the selected structure type, set the geometry parameters. Click Preview to check 

the defined geometry. 

 

Figure: Settings dialogs 

 Meanings of some main parameters: 

Number: Number of the frame standings 

c/c: Distance between the frame standings 

4. If load definition is available for the selected type, define the additional dead load (roof weight), 
snow, wind and live load based on the figure shows the meaning and position of line loads 
(intensity). 

 Save option (of Wizard) lets you save all parameters of the current wizard template. The 

exported wizard settings can be imported for later project with the Wizard’s Load tool. 

 Defining “Dead load” (additional, roof weight) line load generates the automatic dead 

load too as a separate load case. 

5. Clicking OK finishes the Wizard and generates the 3D model with loads and supports 
(depending on the selected type). 
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Figure: Roof structure example 

6. The generated beams have no profiles and materials. So, Wizard generates only beam axes 

without properties. Add properties to beams with the Beam command’s  Properties tool. 
7. Wizard sets up hinged and rigid supports (as displayed by wizard settings) from single support 

components. So, for example a fully rigid point support is modeled by 3 motion-type and 3 

rotation-type single point supports. You can modify the support conditions by the  Point 

support command’s  Properties tool. 

 

Figure: Complex (rigid) support modeled by single Point supports 

Optional steps: 

8. Add more structural elements (plate, wall, beam, column etc.) with the commands of the 

 tabmenu. 

9. Edit the generated loads or add new ones with the commands of the  tabmenu. 

Model Exchange between FEM-Design Modules 
Different FEM-Design modules are able to share models between each other. The next table shows the 

possible connections between modules. 
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 Source Module (.file extension) 

2D models 3D models 

 (.pla)  
(.wal) 

 (.frm)  (.str)  (.prd) 
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 (2)  (2) 

 

  

  (4) 

 

  (3.1)  (3.2)  (5)  

 

  (3.1)  (3.2)  (5)   

Table: Model connections between FEM-Design modules 

The main featured connections from the above possibilities: 

- Slab-system imported from 3D Structure/PreDesign to Plate module (1) 

Slabs or slab-system of a building (created by 3D Structure or PreDesign) storey together with 

connected walls, columns, beams and loads can be imported into Plate module. 

 Only the loads directly placed on the slab elements can be imported to Plate. The loads 

arrive from other stories or connected elements have to be added manually to the slab 

regions as Point/Line/Surface loads. 

Steps of import: 

1. Click Open (File menu) in the .Plate module. Select the .str (3D Structure) or .prd 
(PreDesign) which contents you would like to import to Plate. 

2. Select the Storey, which slabs (plates) you would like to load as a new project. 

 The import requires storey-system from the file selected by Open. 

3. Allow or forbid the import of columns and walls connected above/below the slabs of the 
selected storey. Beams and loads connected to related slabs will be automatically imported. 

4. Set the end conditions (fixed or hinged) of the walls (=wall supports) which you would like 
to import. 

5. Click OK to start the import. 
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Figure: Import of slabs with connected elements into a Plate project 

- Wall-system imported from 3D Structure/PreDesign to Wall module (2) 

Wall regions situate on a vertical plane defined by an axis of a building (created by 3D Structure 
or PreDesign) can be imported into Wall module together with connected supports and loads. 

 Only the loads directly placed on the wall elements can be imported to Wall. The loads 

arrive from other connected elements have to be added manually to the wall regions as 

Point/Line loads. 

Steps of import: 

1. Click Open (File menu) in the  Wall module. Select the .str (3D Structure) or .prd 
(PreDesign) which contents you would like to import to Wall. 

2. Select the Axis, which wall regions you would like to load as a new project. 

 The import requires axis-system from the file selected by Open. 

3. Click OK to start the import. 
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Figure: Import of walls with connected elements into a Wall project 

- Single plate/wall import to 3D Structure (3.1 and 3.2) 

Slabs/Walls with their supports and loads created and designed in the  Plate /  Wall 

module can be imported into the  3D Structure module. Multi-storey building can be defined 

by copying the opened elements, and run global stability analysis and design for the final 

model. 

Steps of import: 

1. Click Open (File menu) in the  3D Structure module. Select the .pla (Plate) or .wal (Wall) 
which contents you would like to import to Plate. 

2. In case of curved walls, set their conversion to planar wall regions. Curved wall element is 
not available in the 3D structure modules. The value of the approximation can be set in the 
tmax field. If the “originally curved” walls are connected to curved plate edges, the program 
also modifies the curved plate edges to polyline. 

3. Click OK to start the import. 

Optional steps: 

4. Copy (Modify > Copy) plate regions with their wall/column supports and loads, if required. 
5. Only one Plate/Wall file can be imported (with Open) in a 3D project. But, you can open 

different files in separate 3D projects, and later you can merge their contents into one with 
the Copy and Paste commands and set their real position with the Move command (Edit 
menu). 

6. In Plate module, the Wall and Column elements are supports. So, do not forget to add 
supports to the bottom end of the columns and walls of the lowest storey. 
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Figure: Import of a slab (system) into a 3D structure project 

- Frame part exported from 3D Structure to 3D Frame (4) 

Frame parts (beams, columns and truss members) of a multi-storey building (created in  3D 

Structure) can be imported into the  3D Frame module by filtering out the shell, plate, wall 

elements and their related surface supports and loads. The import process is very simple: just 

apply Open (File menu) for the .str (3D Structure) files in 3D Frame. 

 

Figure: Import of frame parts into the 3D Frame module 
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- Frame import to 3D Structure (5) 

Initial analysis and design can be done for only the load-bearing frame parts in the  3D Frame 

module, then the bar elements can be imported into the  3D Structure modules to complete 
them with planar element such as plates, walls and their supports and loads. The import process 
is very simple: just apply Open (File menu) for the .frm (3D Frame) files in PreDesign or 3D 
Structure. 

Opening PreDesign model in 3D Structure and 3D Frame is not allowed since version 12.0, as 

PreDesigh has totally different database and not possible to keep compatibility with other 3D 

modules. 

CAD Drawing Import/Export 
A DWG or DXF file generally contains drawing objects (points, lines, dimensions, texts etc.), so it can 

be used as a reference draft displaying a floor plan, a section or an elevation. Each FEM-Design module 

is able to import (and also export) DWG and DXF. 

All elements, so both structural model and drawing elements, can be converted and exported to 

DWG/DXF format. The objects are automatically converted to lines with their 3D position and placed 

onto separate layers by object types. Also, the symbols and info labels are broken to text and line parts. 

Import 

The steps of opening a DWG/DXF file: 

1. Open the DWG/DXF file with File > Open. 
2. Set the import settings in the upcoming dialog: 

 

Figure: DWG import settings 

- Unit: Set the same drawing length unit with the unit-system saved in the file by the 
exporting application. Most of the DWG-compatible applications use “mm” while defining 
and exporting drawings. 

- Scale: Set the drawing scale of the opened file by typing the required value. Scale affects the 
display of texts, line types and hatches. 

- Ignore points: Check this box to filter out drawing points, so not to allow their import. 
- Set to 2D: Check this box, if you would like to merge all drawing elements (independently 

their level position) in the XY plane of the Global co-ordinate system. It is recommended only, 
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if the points of the imported drawing place in the same or near the same (small geometry 
inaccuracy in Z direction) plane. 

- Ignore empty layers: Check this box not to import empty layers that do not contain drawing 
elements. Unchecked box merges all layers stored in the DWG/DXF file. 

 The imported layers will be converted to Drawing layers. 

- Merge points: Checking this box corrects the inaccuracies of the imported drawing in the 
given merging distance and deletes the point duplications. 

3. Hide the unnecessary drawing layers to make clear the points and lines you would like to use 
for later model definition. 

 

Figure: Active imported drawing layers 

 With Modify > Change appearance you can query the host drawing layer of a selected 

element. 

4. Create the structural model based on the referenced (opened) drawing. 

 Apply the proper Object Snap Tools to find the required main points, endpoints, 

intersections, lines etc. for the input (reference points and lines) of the model elements. 

Set the size of the elements according to the drawing elements after inquiring/measuring 

positions, directions and sizes with Tools > Query, if it is needed. 

Pay attention to pick proper/correct lines when defining reference lines and insertion 

points for the structural objects. For example, think on the wall position while connecting 

it to a plate edge. Not always following the real state (defined by the DWG drawing) is 

the optimized way to model elements. 
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Figure: Reference line (and finite element mesh) definition based on the drawing 

Rotate the position of the drawing, if it is needed. For example set a section/elevation 

drawing to the Global XZ or YZ plane in 3D modules. 

 

Figure: Rotation of a drawing (definition of an elevation) 

In most cases the drawing elements of the merged DWG/DXF file are placed far from 

the origin of the global co-ordinate system, so click View > Zoom margin to show the entire 

drawing after opening it. 

 Only one DWG/DXF file can be opened at a time. But, you can merge more than one drawing 

(e.g. floor plans of different stories) into a project as the following hint: 

1. Open the first drawing as a new FEM-Design project. 
2. Open the second/other drawing as a separate FEM-Design project. (More than one copies of 

a FEM-Design module can run in the same time. 
3. Apply Edit > Copy for the required elements of the second/other drawing to send them to 

Clipboard. 
4. Use Edit > Paste to merge the drawing elements (from the Clipboard) into the first project. 

Set the real position of the drawing insertion (point), so for example, place the 2nd floor 
elements in the correct 2nd level position. 

Export 
The steps of saving a DWG/DXF file: 

1. Click File > Save as, and choose the proper DWG/DXF file. 
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2. Set the export settings in the upcoming dialog: 
 

  

 

Figure: DWG export settings 

- Unit: Set the drawing length unit of the exported elements to the type required by the other 
application which wants to open the DWG/DXF file. 

- Arc resolution: Curved elements, arcs and circles will be exported as connected straight lines 
(polyline). The accuracy of the line-conversion approximation can be set here. Arc 
resolution is equal the angle closed by the tangent of the connected lines. This setting effects 
the number of the generated lines too. 

- Convert text: The option converts the special Unicode characters (such as ő, ű etc.) to 
readable ANSI-compatible characters (such as o, u etc.). So, this option is recommended to 
be used in case of text, labels etc. Non-used option may cause unreadable symbols in the 
application opens the exported DWG/DXF file. 

All elements (beams, columns… supports, loads, drawing elements, labels, etc.) will be generated to 

lines and texts, and they will be placed onto separate drawing layers by their types. All DWG/DXF-

compatible applications are able to filter elements by layers during or after the import process. 



342 

 

 

Figure: Exported DWG in 2D and 3D views 

Strusoft XML 
Models can be imported or exported between structural engineering programs (e.g. Tekla, Revit) in a 

special Strusoft XML format (struxml). Exporting from and importing to FEM-Design 3D Structure 

module by struxml format can be done by Save as or Open commands respectively. 

Only basic structural elements and loads can be exported from and imported to FEM-Design in 

struxml format. 
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IFC Import 
FEM-Design gives the possibility to import 3D models saved in IFC files from other architectural and 

structural programs. Some of the most important features of the FEM-Design’s IFC import: 

- Compatible import formats: IFC2x version 2 and 3 

- Material conversion table and style 

- Object-filtering 

- Connections of misplaced objects (point-point and line-line connection) 

An IFC model contains elements according to the mapping rule of model elements to IFC element types. 

For example, a column is represented as IfcColumn in the IFC scheme by default. Not only the geometry, 

but numerous properties like material, profiles etc. are assigned to one element. 

Opening an IFC file generates native FEM-Design elements based on the model structure or solid body 

model (“reference model”) depending on the chosen import method: 

- Architectural View 
 The static system is converted from the architectural/structural model elements (IFC 

architectural representation), so FEM-Design creates native structural objects such as Plates, 

Walls, Beams and Columns. 

 

Figure: Generation of real FEM-Design objects 

- Reference Geometry View 
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A solid body model is generated from the IFC model as a reference. Elements are not supported 

by the current FEM-Design can be also display because of the solid representation. For example, 

solids generated from slabs and walls can be shown as reference in the  3D Frame module, 

although only bar elements can be defined in it. 

After the import, FEM-Design can find and select points, edges and surfaces of the solid body 

model elements, so the user can define Plates, Walls, Beams, Columnsand Truss members manually 

according to the referenced model. For example, to define a wall object in FEM-Design 3D 

modules, just pick on the requested vertical solid surface. 

 

Figure: Generation of 3D solid bodies (drawing) 

- Structural Analysis View 
Some structural application (e.g. Tekla Structures) is able to create analysis model and export it 

via IFC. Opening an analysis type IFC model, which contains region and line representation of 

structural elements generates native FEM-Design elements very fast. 

 

Figure: Generation of real FEM-Design objects from an imported analysis model 

Of course, the result of element import depends on the FEM-Design module where the process is done: 

Module Architectural View Reference Geometry View Structural Analysis View 

 Plate 

 

One storey only: 

- Plates and Beams 

- Walls and Columns as 

supports 

Entire model and all building 

elements as Solid objects 

 

- 

 

 

 3D Frame Beams and Columns only 
Entire model and all building 

elements as Solid objects 
Beams and Columns only 
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 3D Structure 

 PreDesign 

Plates, Walls, Beams and 

Columns 

Entire model and all building 

elements as Solid objects 

Plates, Walls, Beams and 

Columns 

Table: Imported IFC elements by “views” and FEM-Design modules 

The steps of opening an IFC file: 

1. Load the IFC file with File> Open. 
2. Choose the required import method: Architectural View, Reference Geometry View or Structural 

Analysis View. The first two methods are always available, but the last one depends on the 
received IFC model type (“Analysis-type”). 

 

Figure: Selection of import mode (view) 

3. A tree lists the IFC model content by buildings and their storeys. In the Architectural and 
Reference Geometry views, objects can be selected for the import. 
In Architectural View mode, “Irregular” label represents the element types/geometries, which 

cannot be converted to FEM-Design structural elements. However these elements can be 

displayed in the Reference Geometry View. 

  Plate module only imports plates situate on the same storey together with supports 

under them. Most of the architectural software places the “support elements” (like walls, 

columns etc.) on one storey below the plates’ host storey, so the requested elements can 

be selected from separate storeys. In case of  3D Structure models, the entire model 

can be imported independently from the storey system. 

 

Figure: Differences between modules used for the model import 
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4. Set the main properties of the selected elements (only in Architectural and Structural Analysis 
views). 

 

Figure: Main properties of elements 

- General properties: it displays the ID name of the elements and the IFC global unique 
identifier (GUID). Description may contain the profile name of the elements depending on 
the exporter application. 

- Material mapping: it displays the material of the selected element (IFC material) and the 
default FEM-Design material (available in the current standard) assigned to the imported 
IFC material. Of course, you can modify and set the required material that will model the 
imported one. Material can be set with Select material by elements or based on the material 

Mapping table. Of course, the material can be modified later with the element’s  Properties 
tool. 

 The conversion can be done on different model levels, so for the entire structure, by storeys 

(e.g. 1st floor), by object type (e.g. all slabs), and for the type (e.g. slabs) of the selected objects. 

- Select material 

A dialog appears with the built-in (available in the current standard) and user-

defined concrete, steel and timber materials of FEM-Design. New concrete, steel and 

general materials can be created in the dialog too. 

- Mapping table 

You can associate standard materials (as the applied code) to one or more materials 

of the imported model (= “FC Material”) in dialogue format. It works for the 

complete model, so there is no difference that you select an object or a storey or a 

building. There are two independent conversion maps, one for the architectural and 

one for the structural model. 

Select one (or more) material in the “IFC Material” column, then press Assign 

material and finally choose proper FEM-Design material available in the current 

code. Here, new materials can also be created (New). Clicking OK returns to the 

material conversion table that shows the selected conversion: the selected material 

appears in the “FEM-Design Material” column. Material mapping table can be saved 

and exported for others with the Export option, or previously saved conversion rules 

can be loaded with Import. 

- Layer filter: the core of the composite layered materials can be set here. 

- Statical system: in  Plate module, the end connections (fixed or hinged) of selected 
columns and walls (supports) can be set as a default value. Of course, the end connections 

can be modified later with the element’s  Properties tool. 
5. Clicking OK loads the IFC model. The loading process may take a long time depending on the 

complexity and the size of the imported model. 
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If you open an IFC model in Architectural view mode with the 3D modules, the program generates rigid 

connection objects (Point-point and/or Line-line connection) between the misplaced elements, which solid 

surfaces are touching each other, but the generated calculation planes are not. The method depends on 

the types of the “connected” objects: 

- If a bar element connects to an object, the program applies Point-point connection. 

- If only planar elements connect to each other, Line-line connections are assigned to them. 

 

Figure: Line-line connection generated between the plate and the touching wall elements 

 You can modify the connection stiffness with the  Properties tool of the Point-point and Line-

line connection commands. 

Direct Data Links 
StruSoft develops direct links with the architectural software ArchiCAD and the structural applications 

Tekla Structures and Revit Structure. So, thanks to external tools, ArchiCAD can exports the entire 

architectural or a simplified structural model or its part, and the two structural management/editor 

applications can export the analysis model generated from the structural model. 

Direct link means that add-ons embedded in the previous applications generates automatically FEM-

Design Plate, Wall, Column and Beam elements from their native 3D elements, so further conversion is 

not needed inside FEM-Design while opening the model files. 

 

 The external StruSoft applications together with their user manuals are available on the 

www.fem-design.com (Downloads menu) by the versions of ArchiCAD, Tekla Structures and 

Revit Structure. 

The ArchiCAD Add-On exports .fdx files compatible with the FEM-Design  3D Structure or 

 Plate. 

The Revit Structure Add-In exports .r2f files compatible with the FEM-Design  3D Structure. 

Tekla Structures sends analysis model (Analysis > Analysis & Design Models) directly to FEM-

Design  3D Structure, so both FEM-Design and Tekla Structures licenses can be installed on 

the same computer. 

http://www.fem-design.com/
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The next table summarizes the FEM-Design elements matched to the elements of the related 

applications by the external tools in the special exchange file formats. 

FEM-Design ArchiCAD Revit Structure Tekla Structures 

 Beam 
Beam - Beam 

- Truss 

- Brace 

- Beam System 

- Concrete Beam 

- Concrete Polybeam 

- Steel Beam 

- Steel Polybeam 

- Steel Curved Beam 

 Column 
Column Structural Column 

(straight only) 

- Concrete Column 

- Steel Column 

 Plate 
- Slab 

- Roof 

- Structural Floor 

- Isolated Foundation 

- Wall Foundation 

- Foundation Slab 

- Concrete Slab 

- Steel Contour Plate 

 Wall 
Wall 

(Straight, Curved, Trapezoid) 

Structural Wall 

(straight only) 

Concrete Panel 

Table: Elements by applications can be imported as FEM-Design elements 

Material and profile mapping is recommended at all direct link connection: 

- In case of Revit Structure, the Add-In gives the possibility to map the Revit Structure profiles 
and materials with the FEM-Design ones. 

- In case of Tekla Structures, the material and profile mappings can be done in editable (e.g. with 
Notepad) text files. The factory default templates can be found in the FEM-Design’s 
“FORMATS” library: “TeklaFEM-DesignMaterialMapping.cnv” and “TeklaFEM-
DesignProfileMapping.cnv”. 

- In case of ArchiCAD, opening the .fdx file in the  3D Structure or  Plate module, a setting 
dialog comes up with the following settings: 
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Storey (  Plate module) 

In ArchiCAD, users work by storeys. The Plate module’s “Selected item” lists all available 

storeys. Choose the required one, and the program will import the plates and its connected 

objects like beams and column/wall supports. In case of  3D Structure, storeys can be not 

selected, the module opens the entire model. 

Composites 

“Composites/Fills” lists the materials (ArchiCAD Cut Fills) together with the multi-layered 

composite structures defined in ArchiCAD. For composites, the core part (that thickness will be 

considered in FEM-Design) can be set in this dialog tab. 

Defaults 

- Here you can set the “Material” mapping by element types. 
- Minimum size/thickness value gives the limit of the columns/walls can be imported. For 

example, giving 0.1m min. thickness for walls means that the partition walls with smaller 
thickness (e.g. 9cm) will be not loaded while import. 

- Fixed and hinged end “Connections” for columns and walls (Plate module only) can be set 
with the radio buttons. 

- Unchecked “Arrange beam to reference line” option will be place beams in their original 
position as defined in ArchiCAD; but the calculation line will be their (middle) axis. The 
checked state derives same position of the beam’s calculation line with its reference line in 
ArchiCAD. 

- “Create support from ArchiCAD's reference line” has the same function with the previous 
beam setting, but it effects on walls. 

- “Accuracy of arc wall” generates straight wall segments from a curved ArchiCAD wall in 
the 3D Structure module (because curved wall can be defined in 3D modules). The 
maximum deviation (a) from the arc can be set in meter unit. 
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FINITE ELEMENT MESH 
Finite Element Method is used in calculation engine as it is also visible in the name of program (Finite 

Element Method = FEM). This chapter introduces the main concepts, features and functions of the built-

in finite element method. 

Element Types 

Depending on the applied FEM-Design module, the engine uses the following line and 2D (rectangular 
and triangular) finite elements. 

 Finite Elements 

Line element 2D element 3D element 

“Standard” “Accurate” “Standard” “Accurate” “Standard” “Accurate” 
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4-NODE    3-

NODE 

9-NODE    6-

NODE 

 

    

 

 

4-, 6-, 8 - nodes 

 

 

 

10-, 17-, 27 nodes 

Table: Finite element types by FEM-Design modules 

In the 3D modules, you can choose between “standard” and “accurate” 2D element types. With 
standard elements you can run 4-times faster but less accurate analysis than with the fine elements. In 
case of bar elements, the program assigns 2-node line elements to each beam and column element by 
default: 

 1 piece when choosing “standard” elements, and 

 2 pieces when choosing “accurate” mode. 

 The program divides curved beam objects by several line elements in number depends on the 
central angle of the arc. 

The element type “standard” or “accurate” can be set in the calculation dialog (Analysis > Calculate > 
Analysis > Finite element types). 
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Figure: Finite element types by FEM-Design modules 

 Modification on the geometry of a structural object causes the deletion of its finite elements. 

Mesh Generation 
FEM-Design offers a fully automatic finite element mesh generation by using optimized (factory 

default) or custom mesh settings. Of course, the generated mesh can be modified with special easy-to-

use edit and modify functions. 

Fully automatism means that the program generates the mesh with elements having average element 

size optimized for the structure and its environment (supports and loads). The process can contain 

automatic element refinement and peak smoothing algorithm according to the settings. 

Automatic mesh generation can be done according to the mesh settings: 

- Before calculations 

Click  Prepare in the  tabmenu. You can see and check the finite element 
suggested. The mesh will be visible by activating the Surface elements layer automatically. If you 
do not edit the mesh and modify the structural model, the later calculations will use the mesh 
generated by Prepare, so no further mesh generation will be done. 

- As the result of calculations 

If the program does not find previously generated finite element mesh, running calculations 

(analysis or design) by  Calculate generates it automatically. The mesh can be displayed by 
activating the Surface elements layer in the current structural or result view mode or just by 

returning to  mode. 
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Figure: Automatic finite element mesh generation 

Mesh Settings 

The settings of the automatic mesh generation are available only in  mode and at Settings> 

All...> FEM > Mesh and Calculation. 

 

Figure: Settings affect automatic mesh generation (Prepare) 

“General” settings 

 

- Merge objects 

The program merges fixed points, fixed lines, supports, beams, columns and walls (only in 

the Plate module) to plate and/or wall regions (the border of the regions). It is decided 

randomly which objects will be let in their place or removed. The objects shorter than a merging 
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distance will be deleted. The objects being at the same place (covering) and having same 

properties will be deleted except one. 

The program also merges columns and/or beams together. It is decided randomly which line 

elements will be let in their place or removed. The bars shorter than the merging distance will 

be deleted. After that, the supports fit to the bars. The objects being at the same place (covering) 

and having same properties will be deleted except one. 

The program merges the loads to the geometry created in the first step. Those loads that have 

not been merged by the previous way will be merged together. It is decided randomly which 

ones will be let in their place or removed. Line loads shorter than the merging distance will be 

deleted. If the Avoid load multiplication option (see later) is active, the loads having the same 

position and same properties will be deleted except one. 

 The merge process may modify the original shape of the objects to a simpler geometry; 

but a simple figure cannot be changed for a more complicated one. For example the 

program does not fit a line load having straight action line to a curved edge although 

merging distance requires that. 

This version of object merge cannot merge the plate or wall regions to themselves or to 

each other. The user has to pay attention to the correctness of these objects. 

Using Auto merge objects (recommended) corrects structural object misplacements. If the option 

is inactive, geometric anomalies cause too long mesh generation process or generation failure. 

Using Inform about volume of merged objects option together with object merge sends information 

about the quantity of corrections. 

Distance sets the maximal investigation zone between elements, so if the objects are closer than 

the defined distance, they will be merged. The suggested distance value is 3 to 5cm for 

engineering problems. 

 

Figure: Correction of misplaced elements (Object merge) 

Activating Merge peak smoothing region and Merge load allows the object merge to work for peak 

smoothing regions and loads. 

Using Avoid load multiplication deletes the loads having the same position, geometry and 

properties (load case host and value) by keeping only one copy. 

- Load handling 



355 

 

By default, load positions are independent from the finite element mesh; so for example, it is 

not necessary to place point loads into finite element nodes and vice versa. Although it is 

recommended to place loads (especially the concentrated loads with high value) into nodes, it 

is not necessary. Adjust mesh to load positions automatically places finite element nodes in the 

action points, on the action line and region border of the loads depending on their types (point, 

line and surface load), so the mesh follows the load position and geometry. 

 

Figure: Load handling in mesh generation 

- Auto peak smoothing region around... 

To solve the result singularity problems above supports and other critical points, the program 

may run peak smoothing algorithm around the listed elements. Activating an element in the 

list, the program automatically creates peak smoothing region around it. 

“Elements” settings 

 

- Calculated average element size 

By default, the program automatically calculates the optimal average size of the 2D finite 

elements considering the size, the geometry, the environment etc. of the structural elements. So, 

you do not need to give an initial value for it. The automatic calculation and the element size 

depend on the following settings options. 

 Element sizes can be set manually for all model regions or by regions with the Average 

element size command. If you modify the default “Automatic” value for a planar 

structural element (wall or plate) to a given value, the automatic element size calculation 

will be skipped for that region, and the given size will be used for that. 
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Figure: The Average element size command and the “Automatic” option 

Using Region by region, the program optimizes the element size by model regions. In this case, 

the regions will contain meshes generated by different average element sizes. This option is 

recommended to use in case regions (e.g. having openings and holes) need to be refined (more 

dense mesh). 

Using Consider all regions together, the one optimal average element size will be determined for 

all model regions having “Automatic” size setting. This option is suggested for structural 

models contain regions with nearly same geometry and size parameters. 

 

Figure: Calculation modes of average size of 2D elements 

In the Scale figure, the optimal average element size can be reduced or increased with a given 

ratio set by the scroll button. The grey mesh shows the recommended optimal size, whilst the 

blue one shows the modified custom size. Double clicking the Scale figure resets the element 

size to the optimal average element size (1:1 ratio). 

 

Figure: The average element size will be four times bigger than the optimal size 

The Correct according to the minimum division numbers option modifies the average element size 

of the 2D elements, if the minimum division number (automatic or custom) of the boundary 

lines and edges requires that. This option is recommended for generating uniform finite element 

meshes. Skipping this option causes dense mesh near edges where the minimum division 

numbers are predefined. 

Using the According to the peak smoothing regions option considers the peak smoothing settings 

of model elements in the calculation of the average element size. 
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- Line element parameters 

The default minimum number of the line elements can be set here for the bar elements. The 

meaning of the default division number depends on the applied element type: standard or 

accurate. For example n=2 value sets (minimum) 2 finite elements for a whole bar (if 

neighboring elements connect to it only in its endpoints) or a continuous part of it (in case of 

joined or intersected neighbors) in case standard element type and 4 elements at accurate element 

type. 

 

Figure: Meaning of Division number in case of Standard and Accurate element types 

At curved beams, alpha parameter sets the minimum division number: 

 minimum division number = central angle of the curved beam / alpha . 

 Division number can be set manually for all bar elements or by line elements with the 

Division number command. 

 For imperfection (of steel bars), stability and dynamic calculations, it is suggested to set 

the default n value to more than 1; 4-5 division number is the recommended minimum 

for n. 
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“Functions” settings 

 

- Automatic refinement in surface mesh (Generate surface mesh) 

The Refine locally where needed option – as an iteration process - eliminates distorted elements, 

which may normally be derived from accidental geometric errors (if object merge is not used). 

So, the option makes the finite element mesh denser at the locations where needed. 

(Deactivation of this option can be used in case of searching geometric errors.) The Max. step 

(recommended value is 6) defines the number of the iteration step of refining. The iteration will 

end when generated elements have the required side-ratio or the steps of the iteration reach 

their maximal value. If Max. step is not enough for the optimal refining, a warning message 

informs you the number of iteration steps is not enough and there are critical geometry errors 

(if the Warn about reaching max. step option is active).  

The automatic refinement may cause too dense mesh at special geometries (e.g. at highly 

depressed regions), so in that case, it would be more practical to reduce the average element 

size with the Reduce average element size if necessary option. 

- Smooth surface mesh 

Smooth procedure calculates the optimal coordinates of the corner nodes of elements. It is 

recommended after splitting or merging elements. The best mesh can be achieved with the 

iterative use of the Rebuild and the Smooth commands. Smoothing of a mesh is executed with 

iteration technique: the procedure places the nodes of the triangle elements in such a way, that 

the area of the triangles will be balanced. The number of the smoothing steps can be set in the 

Steps field. 

- Check surface mesh 

The Check surface mesh option lets the program to check the geometry of the mesh after automatic 

mesh generation. The mesh can be controlled with respect to unsuitable geometry, overlaps and 

topology. This means that mesh errors, produced by an automatic or manual mesh generation 

can be easily found. If the program finds defective geometric elements in the model, it sends a 

warning message (error list) and displays the position of the mesh errors. 

The Geometry tool checks the geometry of finite elements, such as the angles of the elements and 

the ratio of the largest and smallest sides (Max. side ratio). 

The Overlap & cut tool checks overlapping and intersecting finite elements, which can be caused 

for example by copying or moving regions together with their finite element meshes. 

The Topology & gap tool checks the topology of the finite elements and finds possible gaps. A 

typical topological error, when for example a corner node of an element lies on a side edge of 
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another element. This problem can easily arise manually by using the Split command 

incorrectly. 

 

Figure: Topologic errors (unconnected nodes) 

 Topological errors can be easily solved by the Rebuild and Smooth commands and 

quick algorithms. 

“Prepare” settings 

 

- Regenerate surface mesh automatically on the changed regions 

Using this option, the program will regenerate the mesh at any geometrical changes of region 

elements and will generate mesh on the regions having no mesh. 

If you switch off the Regenerate surface mesh automatically... option, the program will not generate 

mesh on the regions modified geometrically and will send an error message. In this case you 

cannot start calculation until you generate mesh on those regions. And, if you would like to 

generate mesh manually with the edit functions, also inactivate this option. 

From the element list, you can choose element types for automatic mesh refinement around 

them. 

The Optimal rebuild surface mesh after refine option rebuilds the mesh automatically after refine. 

It is recommended to use this option, because elements having non-optimal side-ratio (after 

refining) will be removed. This procedure will also create more optimal quadrates from the 

triangles. 
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If you have objects to refine, the Smooth surface mesh after refine option will smooth the mesh 

after generation, refine and rebuild procedures. 

- Check the surface mesh 

If this option is activated, the program will automatically check the mesh on regions having 

valid mesh and are not necessary to be regenerated. The mesh of a region is valid, if the 

geometry of the region has not been modified since the last generation. 

Peak Smoothing 
Singularity problem 

As an effect of the mesh refinement the calculated results are converging to the theoretical solution. The 

problem is that at certain places we get infinite inner forces according to the theory, so the inner forces 

increase each time by refining the mesh. These places could be: point supports, end points of edge 

supports, 

vertices of surface supports, end points of beams and columns, end points of intersection lines of 

adjoining surfaces, point loads, end points of line loads, vertices of surface loads etc. 

In practice, usually, the singularity problem occurs at supports because they heavily influence the inner 

forces (e.g. negative moments) in ratio. 

Possible solutions 

There are three known possibilities to solve the above-mentioned problem: 

- Choosing optimal finite element size at singularity places 

FEM-Design aids that with several built-in tools such as automatic element size adjustment, 

automations in mesh generation, automatic local densification etc. It is evident, that choosing 

optimal element size cannot be perfect, because we should have to know the appropriate values 

to which we adjust the average element size in advance. The functions used today for automatic 

element size calculation and generation are providing values with adequate precision in most 

cases, but it is obvious that they cannot guarantee that in any case. 

- More realistic and precise model definition 

Point and line loads/supports with action surface (only action points and lines) do not exist in 

real life. So, if you model all point/line loads and supports as surface loads/supports, then you 

can cease the problem derived from the singularity. This opportunity is available in FEM-

Design, because the user can apply surface supports and loads with any directions and any 

geometry of action surface. 

- Peak smoothing 

Singularities always cause only local disturbance in the inner forces, they do not influence the 

inner forces at adequately short distance from the location of singularities. The “adequately 

short distance” is defined by the national standards. In the zones causing substantial changes 

three solutions can occur according to the codes: the peak can be cut (1), or it can be approached 

with a linear function (2), or a constant value may be set above the substantial area (3). In the 

last solution, the capacity of the inner force figure above the area may become equal with the 

capacity of the original figure. The last solution is the safest one, so it is accepted by every 

standard. 
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The peak smoothing algorithm is available (for internal forces and stresses in planar elements) 

in every FEM-Design modules work with planar objects. 

Peak smoothing region 

The program defines peak smoothing regions to solve the possible singularity problems. Basically, these 

regions are the active zones in the environment of the singularity, where the inner forces change 

substantially as a result of mesh refinement. 

Peak smoothing regions can be generated automatically by the mesh generator or calculation processes. 

Automatic generation always results circular peak smoothing regions with centre points placed in the 

location of the singularity. The radius of a circular smoothing region depends on the geometry of 

singularity locations. 

 Peak smoothing regions with any arbitrary shape can be defined manually with the Peak 

smoothing region command. That command is able to edit predefined (automatically or 

manually) peak smoothing regions. 

Automatic generation of peak smoothing regions can be set and controlled at the General settings of 

mesh generation (Settings> All…> FEM> Mesh> General). At Peak smoothing region around... option you 

can set the places (depending on the current module) where you want the program to create circular 

peak smoothing regions. The radius of the circular regions is calculated from the following formula: 

 

Figure: Settings of automatic peak smoothing generation 

r = t / 2 + f * v, 

where: 

t is the characteristic geometric parameter of the object that causes singularity: 

- 0 value in case of supports (point, line and surface), 

- the diameter of circle circumscribed of a cross-section, if bar elements connect to planar 
elements, 
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- the thickness of the plate or wall, if the peak smoothing region generated in plate/wall 
connection; 

v is the thickness of the planar element (plate, wall) in the considered place; 

f is a factor can be set manually. The default value is 0.5, which means 45 degrees angle of projection 

starts from the connection (singularity cause) and ends in the calculation plane of the related planar 

element (see the figure before). 

 

 

Figure: Examples for peak smoothing regions by different element-plate connection 

Peak smoothing algorithm 

The steps of the peak smoothing algorithm are the followings during calculations (inner forces): 

1. The program creates peak smoothing regions and/or checks the predefined active zones. 

 

Figure: Generation of peak smoothing region at column-plate/wall connections 
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2. Allow peak smoothing algorithm for internal force and stress calculations. It is not enough to 
generate peak smoothing regions, so you have to confirm the smoothing process in the Calculate 
dialog before starting any analysis (and design) calculations. 

 

Figure: Peak smoothing algorithm set for analysis calculations 

3. The program calculates a constant value for cutting the peaks according to volume calculations 
of inner diagrams above the peak smoothing regions. That means, the volume at the final 
constant result value (Volume (smooth)) is equal with the volume derived from the peak 
(singularity) value (Volume (peak)) above the same peak smoothing region. Let’s see the next 
figure. 

 

 

Figure: Peak smoothing algorithm (modified inner force diagram) 
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Figure: Internal force “graph” and “section” diagrams after using peak smoothing algorithm 

 Although peak smoothing is available for internal and stress calculations of planar elements, 

you can solve the singularity peak problem of line reactions and line connection forces. The 

program calculates the average value of the reaction and connection forces by finite element. 

That means, line reactions and connection forces can be displayed with constant (average) value 

by element (Distribution > Constant by element). In this case, you can easily place numeric 

values onto the steps of a figure (Numeric value> Find all local maximum/minimum). 

 

Figure: Singularity of line reaction force solved by simple display technique 

Edit Functions 
There are numerous tools in the  tabmenu allow you to edit the finite element mesh 

generated automatically. 

A short summary of the edit functions: 

- adding additional nodes to the mesh (Fixed point), 

- fixing lines inside the mesh (Fixed line), 
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- editing peak smoothing regions or definition of new ones (Peak smoothing region), 

- fixing the node numbers on fixed lines (Division number), 

- modifying the element number on bar elements (Division number), 

- modifying the average element size of 2D finite elements (Average element size), 

- refining mesh manually (Refine), 

- splitting elements to modify finite element geometries (Split), 

- modifying node positions (Move node), 

- deletion of mesh regions (Delete). 

After editing finite element mesh, you can do automatic mesh object merge, rebuild, smooth, check 

etc. processes with special tools of the  tabmenu. Mesh generation can be done by planar 

regions with the Generate tool. 

Adding nodes to mesh 

With  Fixed point, nodes can be manually added to a predefined mesh in given points. 

Click  Prepare to update the mesh according to the new nodes. Depending on mesh settings, the 

program automatically does refine, smooth and check processes to create an optimal mesh, if it is 

possible. 

 

Figure: Adding nodes to a mesh 

Fixed points defined in the model can be displayed with the Geometrical system object layer. 

Fixing lines of mesh 

With  Fixed line, lines (straight and curved) can be fixed in a mesh to generate nodes on it. 

Click  Prepare to update the mesh according to the new nodes. The program defines nodes in the 

line endpoints and some points on the lines. Depending on mesh settings, the program automatically 

does refine, smooth and check processes to create an optimal mesh, if it is possible. Further node 

distribution of the fixed line element can be influenced by the Division number command. 
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Figure: Adding lines to a mesh 

Fixed points defined in the model can be displayed with the Geometrical system object layer. In brackets, 

the number of line elements can be seen defined by the Division number command. If “-“ is displayed, 

there is no restriction on the element number. 

 Fixed lines display the intersection lines of structural regions (e.g. intersections of slabs and walls) 

too. This is very useful for defining holes/openings that connect accurately to finite element 

meshes (see the next figure). 

 

Figure: Fixed lines used for editing regions 

Editing peak smoothing regions 

With  Peak smoothing region, the predefined peak smoothing regions can be edited (status, shape and 

size modification), or new ones can be defined manually. 
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The following functions can be done with the Peak smoothing region command: 

- Modifying the geometry of predefined peak smoothing region 

Automatic generation of peak smoothing region always results circular geometry of regions. If 

you would like to create regions with custom shape, draw a new one with the  Define tool 
and the different shape tools. If the new region covers an automatic one (and it is active, see 
later), the program will use the new region instead of the automatic one for solving the 
singularity. 

 

 

Figure: Manually drawn peak smoothing regions with custom shape 

Sometimes, you need to correct the geometry of automatic regions to avoid the creation of 

incorrect or too dense finite element mesh (nodes are generated in the intersections and on the 

edges of peak smoothing regions). 

 

Figure: Geometry modification effect on finite element mesh generation 

- Creation of new peak smoothing regions manually 

With the  Define tool, totally new peak smoothing regions can be drawn with custom shapes, 
too. 
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- Modifying the status of a predefined peak smoothing region 

Apply the  Properties tool and the  Inactive option for peak smoothing regions to modify 
their status from active to inactive. Inactive region will not be considered in mesh generations 
and in calculations too. To reset an inactive status of a region to an active one, apply the 

Properties tool together with the  Active option for the region. 

 

 

Figure: Difference between active and inactive peak smoothing regions 

Peak smoothing regions defined in the model are stored in the Peak smoothing regions object layer. 

Click  Prepare to update the mesh according to the new and modified peak smoothing regions. 

Depending on mesh settings, the program automatically does refine, smooth and check processes to 

create an optimal mesh, if it is possible. 

 It is not enough to generate/define peak smoothing regions, so you have to confirm the 

smoothing process in the Calculate dialog before starting any analysis (and design) calculations. 

Division number 

Division number sets: 

- the number of line finite elements of bar elements (columns and beams), 

- the number of 2D element-edges on fixed lines and structural region edges. 

In case of bar elements, the  Division number command can modify their default element number 
(value in brackets) set at “Elements” setting. 

 In 3D modules, the meaning of division number depends on the element type sets at calculations. 

For example division number 2 sets 2 line elements for standard element type and 4 line elements 

for accurate element type. The line elements together with their node numbers can only be 

displayed after analysis (or design) calculations (see display settings). 
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Figure: The meaning of division number for bar elements 

In case of fixed lines and structural region edges, the  Division number command can fix the 

minimum number of 2D elements (sides) will be connected to the lines/edges by the mesh generator. 

“-” label in brackets shows no number-restriction for lines/edges.  
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Figure: The meaning of division number for fixed lines and edges 

Defined division numbers together with fixed lines, edges and structural lines of bar elements are 

displayed with the Geometrical system object layer (red by default). 

Modifying average element size 

The  Average element size command modifies the optimized element size(s) of 2D elements 

calculated by the program according to mesh settings. 

Applying the command for a structural region (wall, plate etc.), a dialog shows with “Automatic” label, 

that the optimal element size calculation is the active by default for the region. Typing an arbitrary 

element size (in a field) overwrites the usage of the optimal size. Of course, the final average element 

size generates by the mixture of the value set by Average element size and the effect of mesh settings. 

Inactivating all mesh generation automatism (refine, smooth and check processes together with 

“Elements” settings), the a value will be the average element size for the related structural regions. 

Clicking Calculate automatically button shows the optimized average element size used when 

“Automatic” is set for the related object region(s). 
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Figure: “Automatic” and custom average element size 

Click  Prepare or  Generate (for the region only) to update the mesh according to the average 

element size setting. 

Refine mesh manually 

A predefined finite element mesh can be refined manually. Apply the  Refine command to refine 

mesh parts by picking structural objects connect to the meshed region or by clicking directly finite 

elements. 

- Refine mesh around objects 

Activate first the  Mark element mode. Pick the checkbox of object types (e.g. Region border), 

which you would like to allow refining the mesh around. Select objects (e.g. Walls) assigned to 

allowed object types on the drawing area with  Pick object, or click  Mark elements around 

all objects to refine mesh around all objects belongs to the checked object types. Click  to 

start the refine process. 
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Figure: Refined finite element mesh around columns 

- Refine 2D elements 

Activate first the  Mark element mode. Select elements of a mesh on the drawing area with 

 Pick element, or click  Mark all elements to refine all finite elements of the project. Click 

 to start the refine process. 

 

 

Figure: Refined finite elements (element-selection) 

To deselect previously selected elements (before clicking  to start refine), switch to  Unmark 

element mode and do the same steps mentioned for selection. 

Splitting elements 

2D finite elements can be refined according to splitting patterns, too. Start the  Split command, then 

chose a cut pattern, and finally select an element which you would like to apply the selected cut mode. 

Each pattern has a short description about its usage for rectangular and triangular 2D finite elements. 
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At some splitting patterns, red “+” shows the click position in an element to get the requested splitting 

shapes. 

 

Figure: Element refinement manually with Split 

Modifying node positions 

The position of mesh nodes can be modified with the  Move node command. Select node(s) you 

would like to move, and define the displacement vector with a start- and endpoint. The program sends 

an error message, if it finds nodes being out of legal moving range. 

 

Figure: Modifying node positions 

Deletion of mesh regions 

With the  Delete command, predefined mesh of selected planar object (regions) can be deleted. Just 

select the required region(s) and the program erases the mesh. 

 If you modify the geometry of an object region (e.g. by inserting a hole, by stretching one of 

region corners etc.), mesh assigned to it will be automatically deleted. 
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Object merge 

The object merge process can be run any time you want by clicking the  Object merge command 

button. 

Rebuild 

After using manual tools (mentioned before) to edit the mesh generated automatically before, it is 

recommended to rebuild the mesh. The process rebuilds the current mesh of selected object regions 

according to the global optimum without the movement of mesh nodes. 

The steps of the rebuild process are: 

1. The program builds a mesh from triangular elements using the principles of Delaunay 
triangular technique. 

2. It converts these triangles to quadrates corresponding to the global optimum of the mesh. 

If the  Rebuild command results drastic changes in the mesh, smoothing algorithm is also 

recommended. The best, the most optimal finite element meshes can be achieved with the iterative 

usage of the two commands. 

Smooth 

Smooth process calculates the optimal coordinates of the corner element nodes. Smoothing the mesh is 

highly recommended after splitting or merging elements. If the mesh is modified drastically after 

rebuild, use smoothing for the model. The best, the most optimal finite element meshes can be achieved 

with the iterative use of the rebuild and the smoothing. 

Just apply the  Smooth command for selected mesh regions. Mesh smoothing is executed with 

iteration technique: the procedure places the nodes of the triangular elements in such a way, that the 

area of the triangles will be balanced. The number of the smoothing iteration steps can be set at 

“Functions > Smooth surface mesh” settings. 

 Undo cannot restore the mesh state before using Smooth. 

Check 

After using manual tools (mentioned before) to edit the mesh generated automatically before, it is 

recommended to check the mesh. It can be done according to “Functions > Check surface mesh” 

settings any time you want by clicking the  Check command button. 
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Figure: Topological errors found by Check 

Generate (vs. Prepare) 

Automatic mesh generation can be done by planar object region with the  Generate command. 

(Prepare runs automatic mesh generation for the entire structural model.) Generate takes into 

consideration the manual editing functions (such as Fixed point, Fixed line, Peak smoothing, Division 

number and Average element size) and the Mesh settings excluding the Check, the Smooth and the 

Prepare settings. Generate is also recommended to find defective geometric finite elements by checking 

(generating mesh) regions by regions. 

 

Figure: Mesh generation by regions (Generate) 
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Mesh generation is an iteration process, of which goal is to generate optimal and eurhythmic mesh by 

the given or automatically calculated average element size. The main and general steps of the generation 

process are the following: 

1. Defining the node positions of elements. 

2. Creating triangle elements by nodes. 

3. Converting triangle elements to mixed quadrate mesh where it is possible. 

4. Optimization of node coordinates (e.g. smoothing the mesh). 

5. Definition of middle points on element sides. 

Renumbering and Display Settings 
Renumbering 

Mesh generator automatically add numbers for finite elements and nodes. If you edit the mesh (e.g. 

adding new nodes and elements, mesh refinement etc.), you can rerun the renumbering process with 

the Refresh numbering command of the Tools menu. 

Display settings 

The display style of node symbols and peak smoothing regions, the numbering of nodes and finite 

elements can be set at Settings > All... > Display > Mesh. 

  

Figure: Display settings of mesh items 

- 2D finite elements 

Although 2D finite elements are displayed automatically after mesh generation (if the Surface 

elements object layer is active), the element numbers (Number) can be displayed only after 

analysis or design calculations. The nodes can be displayed with circle or cross symbols any 

time, but with numbers (Number) after analysis and design calculations. 
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Figure: Finite elements displayed with numbers and nodes 

- Line finite elements 

Line finite elements together with their numbers (Number) can be displayed only after analysis 

or design calculations, if the Line elements object layer is active. The nodes can be displayed with 

circle, cross symbols or with numbers (Number). 

The color of the elements, nodes and peak smoothing regions depends on the color of their own object 

layer.  

Error Handling 
Warning and error messages assist you when problems appear in mesh creation functions, during 

analysis or design calculations. But, how you can find the position of these cautions to solve them later? 

The program points the geometrical and mesh errors, the load misplacements and any other problems 

in the model, and it collects their coordinates (in the Global coordinate-system) in an error/warning dialog. 

 

Figure: Geometrical errors detected by the average element size calculation 
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ANALYSIS 
 

Depending on the current FEM-Design module you can do different calculations: displacement, internal 

forces, stresses, stability, imperfections, stability analysis, eigenfrequencies and/or seismic analysis. 

Some extra settings such as cracked-section analysis, non-linear behaviour etc. are also available for 

certain modules. 

 

Table: Analysis features by FEM-Design Modules 

Analysis can be done independently from any design calculations by entering to  tabmenu and 

clicking  Calculate command, or together with designs (RC, Steel or Timber) with the same 

command. 

 

Analysis type/settings 

      

Analysis for load cases

       

Analysis for load combinations

       

Analysis for maximum of  load groups

       

Imperfections

 

   
  

 

Second order analysis    
  

 

Stability analysis

 

   
  

 

Eigenfrequencies

      
 

Seismic analysis

 

   
  

 

Non-linear behavior

       

Cracked-section analysis

       

Peak-smoothing algorithm
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Figure: Analysis calculations 

Analysis settings contain general and calculation-dependent settings. This chapter summarizes these 

settings and their effect on the result. Clicking OK runs Analysis according to the settings and selected 

calculation types. Other chapters introduce the display of results and their documentation (such as 

listing results in tables). 

General Analysis Settings 
Finite Element Types 
In the 3D modules, you can choose between “standard” and “accurate” 2D element types. With 

standard elements you can run 4-times faster but less accurate analysis than with the fine elements. 

Peak Smoothing 
To solve singularity problem in analysis results (internal forces), it is not enough to create peak 

smoothing regions in the finite element mesh. The use of the peak smoothing algorithm in the 

calculations have to be allowed. Without that permission, peak smoothing regions cause only mesh 

refinements (densifications) around objects. 

 

Figure: Peak smoothing algorithm for Analysis 
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Setup calculation by load combinations 

The calculation of the load combinations can be run with different options. They can be set in 

Calculations dialog by selecting the Load combination items and clicking  on Setup by load 

combinations. 

 

The User has the opportunity to choose 

• Non-linear elastic calculation (NLE), 

• Plastic analysis (PL), 

• Non-linear soil (NLS), 

• Cracked-section analysis (Cr.), 

• Second order analysis (2nd), 

• Imperfection calculation (Im., the selected shape will be taken into account in Second order 
analysis) 

for each Load combinations. 

For example, in practice it can be useful to set 2nd order analysis only for the ULS and Cracked-

section analysis only for the SLS combinations. 

The above mentioned calculation types are described in details below. 
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Non-Linear Behavior 

Non-linear behavior of supports (e.g. uplift), connections and truss members (e.g. tension-only) can be 

considered in analysis calculations (for load-combinations, imperfections and stability) by ticking NL 

checkbox at Calculations > Analysis > Load combinations > Setup load combinations. 

 “Uplift” can be modeled both in 2D and 3D design modules by defining compression-only 

support/connection (tension = 0 (free)) and by selecting non-linear calculation for a load 

combination. 

There is a possibility for the user to set the maximum iteration number of nonlinear calculation in Non-

linear calculations tab in Setup load combination calculation dialog. 

 

Plastic Analysis  

In FEM-Design 3D Structure there is a plastic calculation option by the setup of load combinations. 

Plastic calculation is available for trusses, supports and connections and edge connections of all shell 

elements (Plane plate and wall, Profiled plate and wall, Timber plate and wall, Fictitious shell). 
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The options above are considered only for load combinations calculated as non-linear elastic. Plastic 

behaviour is considered for load combinations calculated as non-linear elastic + plastic. See more 

details in the next chapter. 

For further information check the documentation. 

Cracked-Section Analysis 

Cracked-section analysis means that the displacement of RC plates, walls, columns and beams can be 

calculated based on their cracked state and designed reinforcement. 

 

Figure: Iteration steps of cracked-section analysis 

Cracked section analysis for load combinations is available by ticking the Cr. checkbox at Analysis > 

Calculations > Load combinations > Setup load combinations > By load combinations 

The iteration process settings available at Analysis > Calculations > Load combinations > Non-linear 

calculations: 

  

http://download.strusoft.com/FEM-Design/inst170x/documents/diaphragm_and_plastic_theory.pdf
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- One load step in % of the total load (= number of load steps): 
For example, 20% means 5 load steps (= 100/20[%]). Less percentage generates more steps and 

more running time. 

- Maximum iteration number: 

The value must be in range 1 and 100. 

- Allowed displacement error [%]: 
Iteration ends, when the relative displacement error becomes less than the allowed value. 

Second Order Analysis 

In the  and  modules, 2nd order theory can be applied for load combination calculations of 3D 

structures. The 2nd order analysis considers the placement of the loads that changes together with the 

displacement, so it results additional moments derived from the new load positions. 

To allow the 2nd order analysis for load combinations, just tick the 2ND checkbox at Calculations > 

Analysis > Load combinations > Setup load combinations > By load combinations 

 The 2nd order analysis is recommended to be done together with imperfection calculation. In Setup 

load combinations dialog, choose load combinations which you would like to apply the 2nd order 

theory for, and give the number of imperfection shape (simultaneous or previous calculation for 

imperfection is needed) you would like to consider for the 2nd order analysis. 

  

 If the loads are too large when using second order analysis, the program stops the calculations 

with an error message. 

Diaphragm calculation 
If at least onw diaphragm is defined int he stucture, User can choose one of the following diaphragm 

calculation options: 

- None 

- Rigid membrane 

- Fully rigid  

The difference between them is demonstrated by the following pictures. See details in the 

documentation.  

http://download.strusoft.com/FEM-Design/inst170x/documents/diaphragm_and_plastic_theory.pdf
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Analysis for Load Cases and Combinations 

Analysis calculations can be done by load case and/or load combination. The next table summarizes 
the results available for load cases and load combinations by FEM-Design modules. 

 

Figure: Starting analysis for load cases and/or load combinations 

Analysis result 

      

Translational 

displacements (Plate/Beam) (Wall) (Wall)   (Wall/Column) 

Rotational 

displacements (Plate/Beam) (Wall) (Wall)   (Wall/Column) 
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Table: Basic analysis results by FEM-Design Modules 

Displacements 

Depending on the current FEM-Design module, the program calculates and displays the model 

displacement from linear or non-linear (for RC elements: cracked-section analysis) analysis. There are 

two types of displacement results: translational or rotational. For bar elements, the motion and rotation 

components can be displayed separately (Detailed result) by direction (local axis). 

 In  Plate, the displacements are calculated for the plate regions and beam elements, and the 

motion is parallel with the global Z direction, so perpendicular to the plate regions. Only 

reactions can be asked for columns (point reaction) and walls (line reaction). 

In  Wall and  Plane Strain, the motion is parallel with the calculation plane of the wall 

regions. 

In  PreDesign, although the 3D model contains all types of elements, displacements are 

calculated for the vertical elements such as columns and walls. 

 Displacement results are recommended to be asked for serviceability load combinations. 

Reactions 

Depending on the support types, the program calculates the reaction forces and/or moments in the 
supports by direction component, their resultants and the resultant at the support’s center of gravity of 
line and surface supports. 

 The  Plate module calculates reactions in columns and walls too above the point/line and 

surface supports. 

The available result components: 

 Fx’ / Fy’ / Fz’  - reaction force in the local x’/y’/z’ axis of the support (group); 

 Fr     - resultant of the reaction force components (support 

group); 

Reactions 

      

Connection forces 

      

Bar internal forces 

(Beam) 

  

  (Column) 

Shell internal forces 

(Plate) (Wall) (Wall)   (Wall) 

Bar stresses 

(Beam) 

  

  (Column) 

Shell stresses 

(Plate) (Wall) (Wall)   (Wall) 
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 F      - reaction force of the single support; 

 Mx’ / My’ / Mz’ - reaction moment around the local x’/y’/z’ axis of the support (group); 

 Mr     - resultant of the reaction moment components (support 

group); 

 M     - reaction moment of the single support. 

Connection Forces 

Similarly to reactions, the program calculates the forces and/or moments in the connection objects 

(Edge connection, Point-point connection and/or Line-line connection) by direction component and 

their resultants. 

The available result components: 

 Fx’ / Fy’ / Fz’  - connection force in the local x’/y’/z’ axis of the connection; 

 F      - resultant of the connection force components; 

 Mx’ / My’ / Mz’ - connection moment around the local x’/y’/z’ axis of the connection; 

 M     - resultant of the connection moment components. 

 The figure shows an example for displaying connection forces at the three connection types. The 

Fy' is displayed at the line (line-line and edge) connections, and the Fx' and Fz' for the point-

point connection. (The color of a result component (e.g. Fy') is the same with the color of the local 

axis (e.g. y') associated to the component direction) . On the next figure shows the resultants. 

 

Figure: Connection forces by connection type 
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Figure: The resultants (force and moment) for edge connection and line-line connection forces 

Local stability results 
After calculating the load combinations the Local stability results (Overturning of walls and Sliding) are 

available in Display results dialog.  

 

Figure: Display local stability results 

- Overturning of walls 

Only those walls can be calculated which have at least one horizontal edge in the bottom and edge 

connection is defined for it. The result is expressed as a percentage: 

• 0% belongs to the case when the vertical force acts at the centre of bottom edges, 

• 100% belongs to the case when the vertical force acts at one of the corners, 

• 1000% belongs to the case when the resultant is outside the wall edge.  
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Figure: Overturning of walls 

 Overturning of walls results are informative. Without accurate modelling it may lead to incorrect 

results! 

- Sliding of edge connections 

The result is the ratio of the design force and the friction capacity. The friction factor can be set in the 

edge connection dialog. 

 

Figure: Sliding of a wall 
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Numerical example below will illustrate the Local Stability. 

Geometry and Loads 

 

Properties of edge connections 

 

Non-linear calculation (which allows uplift) is recommended to get correct result for local stability. 

 

 

Displacement graph (as well as connection force) is the easiest way to check the uplift. 
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Overturning of wall 

With the help of resultants of edge connections, wall’s overturning can be examined as below. 

 

𝐹 = ∑ 𝐹𝑖

𝑛

𝑖=1

=  −190 − 110 =  −300 𝑘𝑁 

𝑀(𝐶) = ∑ 𝑀𝑖 + 𝐹𝑖 ∗  𝑣𝑖

𝑛

𝑖=1

=  −429 + 190 ∗ 2 − 53 − 110 ∗ 4 =  −542 𝑘𝑁𝑚 

𝑒 =  
𝑀(𝐶)

𝐹
=

−542

−300
= 1.81 𝑚 

𝑈𝑡𝑖𝑙𝑖𝑧𝑎𝑡𝑖𝑜𝑛 =  
𝑒

𝑑
∗ 100 % =

1.81

5.00
∗ 100 = 36%   
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Sliding of edge connections 

Edge connection’s sliding is calculated in each edge connection separately by comparing the x’ 

component of the connection force as design force, and the limit  force calculated by the y’ components 

of the connection forces and the friction coefficient of the edge connection. 

 

𝐹𝑙𝑖𝑚 = 𝜇 ∗ ∑ 𝑓𝑖 ∗ 𝑑𝑥𝑖 =  0.3 ∗ (15 ∗ 0.4 + 50 ∗ 0.4 + 83 ∗ 0.4 + 126 ∗ 0.4) =  32.9 𝑘𝑁

𝑛

𝑖=1

 

𝑈𝑡𝑖𝑙𝑖𝑧𝑎𝑡𝑖𝑜𝑛 =  
𝐹

𝐹𝑙𝑖𝑚

∗ 100 % =
51.6

32.9
∗ 100 = 157.1% 

Bar Internal Forces 

The program calculates internal forces and/or moments in the bar elements depending on the applied 
FEM-Design module. 

The available result components: 

 N     - normal (axial) force (local x’ axis of the bar element); 

 Ty’ / Tz’    - shear force in the local y’/z’ axis direction of the bar 

element); 

 Mt     - torsion moment (around the local x’ axis of the bar 

element); 

 My’ / Mz’   - bending moment around the local y’/z’ axis of the bar 

element. 

 Truss members bear only normal forces (N). 

 The  Plate module calculates internal forces only for beams. Columns are point supports. 

In  PreDesign, although the 3D model contains all types of elements, internal forces are 
calculated in columns. 
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Shell Internal Forces 

Depending on the current FEM-Design module, the program calculates internal forces and/or moments 
in the planar structural elements 

The  Plate module calculates internal forces in the plate regions and in the Global coordinate system: 

Mx’/ My’ - bending moment around the global Y / X axis; 

Mx’y’ - torsion moment; 

Tx’ / Ty’ - shear force for the global X / Y normal and in the Z direction; 

M1 / M2 - principal moments; 

M1/M2 - principal moment directions. 

 Although Analysis calculations give results for the global Descartes system, internal forces can 

be asked and displayed in arbitrary (reinforcement) directions by checking design forces in case 

of RC design. 

The  Wall module calculates internal forces in the wall regions and in the Global coordinate system: 

Nx’ / Ny’ - normal force in the global X / Y direction; 

Nx’y’ - shear force in the global X-Y plane; 

N1 / N2 - principal normal forces; 

N1/N2 - principal normal directions. 

The  Plane Strain module calculates only the shear stresses in the wall regions and in the Global 

coordinate system. 

The  3D Structure module calculates internal forces and moments in the planar object regions (plate 
and wall) in their local coordinate system: 

Mx’ / My’ - bending moment around the local y’ / x’ axis of the region element; 

Mx’y’ - torsion moment; 

Nx’ / Ny’ - normal force in the local x’ / y’ axis of the region element; 

Nx’y’ - membrane shear force; 

Vx’ / Vy’ - shear force for the local x’ / y’ normal and in z’ direction; 

M1 / M2 - principal moments; 

M1/M2 - principal moment directions; 

N1 / N2 - principal normal force; 

N1/N2 - principal normal directions. 

The  PreDesign module calculates the previous internal forces and moments but only walls. 

Bar Stresses 

FEM-Design calculates the normal stress in bar elements (beams, columns and/or truss members) with 
the following meaning: 

Sigma x‘(max) - maximal normal stress (tension); 
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Sigma x’(min) - minimal normal stress (compression). 

 The  Plate module calculates stresses only in beams. Columns are point supports. 

In  PreDesign, although the 3D model contains all types of elements, stresses are calculated in 
columns. 

Shell Stresses 

The program calculates stresses in the top, bottom and middle (so called “membrane”) planes of the 

planar elements. The meaning of top and bottom side depends on the position (  Plate module) or the 

local coordinate system (3D modules) of a region element. 

 

Figure: The meaning of planes depending on region position 

So, depending on the current FEM-Design module, we get results from the following: 

Sigma x’, top / membrane / bottom - normal stress from Nx’ in top/membrane/bottom 

plane; 

Sigma y’, top / membrane / bottom - normal stress from Ny’ in top/membrane/bottom 

plane; 

Tau x’y’, top / membrane / bottom - shear stress from Nx’y’ in top/membrane/bottom 

plane; 

Tau x’z’ - shear stress (x’ normal and z’ direction); 

Tau y’z’ - shear stress (y’ normal and z’ direction); 

Sigma vm, top / membrane / bottom - von Mises stress in top/membrane/bottom plane; 

Sigma 1/Sigma 2, top / membrane / bottom - principal stresses and directions in 

top/membrane/ bottom plane. 

 The x’, y’ and z’ directions are valid in the global coordinate system at  Plate and in the local 

coordinate system of planar elements in the 3D modules. 

In  PreDesign, although the 3D model contains all types of elements, stresses are calculated in 
walls. 

In  Wall and  Plane Strain, stresses are calculated only in the membrane plane. 
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Equilibrium Check 

The program automatically checks the equilibrium of the analysis calculations. Statical equation is 

written to the origin [0; 0; 0] of the Global Coordinate System. It compares the sum of the reactions and 

the sum of applied loads. Equilibriums can be asked by load case and load combination. 

Just click the  Equilibrium icon (in Analysis or Design mode), choose a load case or load combination 

to see the equilibrium check results. 

 

 

Figure: Equilibrium check of Analysis calculations 

If equilibrium error derives from an analysis calculation, the error will be appeared in percentage in the 

Error column by equation types (force (F) and moment (M)) and directions (x, y and z directions of the 

global coordinate system). “Error” shows the differences between the resultants of the queried loads 

and the calculated reactions. 

Analysis for Maximum of Load Combinations and Groups 
Choosing Load combinations for Analysis automatically generates results for the maximum of load 

combinations too. 

If you define Load groups and choose Maximum of load groups for Analysis, FEM-Design calculates 

maximum/minimum results (in all finite element nodes) from the most unfavorable combinations of 

the load groups according to the applied code. 

So, maximum and simultaneous results of displacements, reactions, connection forces, internal forces 

(bar and/or shell) and stresses (bar and/or shell) can be calculated for maximum of load combinations 

and groups. 

The symbol “+” and “–“ sign the direction of the maximal value in the valid systems: local or global 

coordinate systems (depend on the current FEM-Design module). Some examples for the meaning of 

“+” and “-“: 
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Displacement: 

ez’(+) - maximal uplift in global z’ direction in  Plate, 

 - maximum motion in the positive direction of element’s local system in 3D 

modules; 

ez’(-) - maximal depression in global z’ direction in  Plate, 

 - maximum motion in the negative direction of element’s local system in 3D 

modules; 

 

Internal forces: 

Mx’(+) - maximal bending moment around the y’ axis (global/local) in positive direction 

(= same direction with the axis direction). 

Mx’ (-) - maximal bending moment around the y’ axis (global/local) in negative 

direction (= opposite direction to the axis direction). 

The next figure shows the meaning of simultaneous results. 

  Maximal Mx’ Nx’ belongs to maximal Mx’ 

 

 

Figure: The meaning of simultaneous results belong to a maximal value 

Combination of Load cases that gives the maximum analysis results in Maximum of load groups can be 

listed in tables. Just use the  List command (Tools menu) for the Maximum of load groups result data. 
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Figure: Combination of load cases for maximum of load groups results 

Deflection check for RC, steel and timber bars 
A new checking criteria is available for reinforced concrete, steel and timber bars. Deflection 

utilization is calculated for load combinations, Maximum of load combinations and Maximum of load groups 

according to the user defined serviceability limit states. 

This new result type is based on the displacement of the bars and the deflection limitation settings 

which can be defined by the so-called deflection lengths. 

 

In the  Deflection configuration dialog, we can specify the types of load combinations/groups for 

which the deflection check is performed. 
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Deflection lengths are used to define those bar segments, where the deflection checking 

criteria/limitations are coincide. The “Simply supported” deflection lines are denoted with blue arcs 

below the bar, the ”Cantilever and column” types are orange and the “not relevant” types are black. 

Relative and/or absolute limit can be set for each length individually. If both are requested the 

dominant one will be calculated and displayed.  

The first option we can set here is the behaviour of the lengths which affects the calculation method of 

the deflection. If we choose not relevant for a specific length, it will be excluded from the checking 

process.  

For the better understanding of the next two options, namely the Simply supported and Cantilever mode 

let us consider the following example, a cantilever frame structure. 

 

In the midspan we should use the Simply supported option, where we eliminate the rigid body 

motions in such a way that we connect the endpoints of the length, and measure the deflections of the 

middle sections from this imaginary line (red skew line on the picture above). 

 

As a consequence of this method, the deflections of the endpoints are zero, the 

dominant section is usually at the middle of the length. 

On the cantilever, we would like to use the cantilever mode, where the dominant value of deflection 

on this length will be the difference between the maximum and minimum absolute deflection (in this 

example the largest distance from the red horizontal line). For columns the same calculation method is 

used, the only difference is that the deflection is measured in the horizontal plane (from the green 

lines). 
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For columns only this (“Cantilever and column”) option is available.  

 

 

 

 

As deflection lengths correspond to only specific bar segments, they are independent on the bars in 

such a way that they can be longer or shorter than the bar itself. But why is this differentiation so 

important? The answer can be demonstrated with the following two examples. On the left of the 

picture below, only one beam is drawn, thus if the Relative limit would be calculated directly from the 

length of this beam, the results would be misleading.  

In other words, in the L/? formula, instead of the length of the midspan or the cantilever, the whole 

length of the beam would be substituted. Therefore, we need two Deflection lengths to differentiate 

the L in the Relative limit formulae on the midspan and on the cantilever. In addition, the limit value 

also can differ for the two types of structure according to the National Annexes.  

In the second case (to the right on picture below) imagine that our aim is to design a beam splice and 

check deflections. Two beams need to be drawn for the steel design, but of course during the 

deflection check we want to use the summed length of the two beams for the calculation of the relative 

limit value. For this purpose, we define one Deflection length over the two bars - this way we make 

correct calculations in both cases without any additional modification on the structure. 

 

Deflection lengths 
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It is worth to note that in the second case we had two beams, but in contrary to the buckling lengths, 

definition and editing of deflection lengths can be performed on such set of beams, which are both 

parallel and continuous.  

By default, deflection lengths are generated automatically. This procedure first search all the 

previously mentioned parallel and continuous beams sets, then intersect them with the edges/axes of 

the structural elements (beams, columns, trusses, plates, walls, line and surface supports) and point 

supports. In the majority of the cases deflection lengths obtained by this way are reasonable from 

engineering point of view, but in some cases we may want to modify them. A good example can be a 

structure consisting of two beams with a horizontal support, which should not be considered in the 

deflection checking process. The following flow diagram illustrates the modification of the two beams 

step by step. By default, as we can see in the upper picture, the automatically generated deflection 

lengths coincide with the beams because they are intersected with the horizontal point support. If we 

would like to have one deflection length over the two beams, we can draw it between the support 

groups using the Define tool, similarly to the buckling lengths. By this way, the new length substitutes 

the original ones! 

 

 

 

Deflection length has its own layer.  
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Deflection check button becomes active if Load combinations and/or Load groups are already 

calculated. The utilization results can be displayed from the New result dialog.  

 

The Deflection checking process considers only the straight beams and columns. For 

beams the deflection is measured along their own local z’ axis, for columns it is 

measured in the global horizontal x-y plane. 

Results requested for a Load combination can be displayed both on the deformed and undeformed 

shape.  

  

Due to the fact that the limit values of the calculation are controlled by the Deflection lengths, the 

result is constant along them. In other words we have one (dominant) utilization value for each 

Deflection length. Results for Maximum of load combinations and Maximum of load groups are only 

displayed on the undeformed shape of the structure. 
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Imperfections 
Imperfection calculation is run only for steel bar elements of the structure. Users can add imperfections 

to a structure in two ways: 

- Imperfection modeled by defining loads (manual) 

Place for example horizontal point and line loads on a multi-storey building to model 

imperfection manually. 

- Imperfection calculation according to the formula EC3: 1-1 (automatic) 

For load combinations, the program can calculates the probable imperfect shapes in real 

dimensions from the mode shapes (get from stability analysis) according to Eurocode. Second 

order analysis must be run by using imperfection. To do automatic imperfection calculations, 

activate Imperfections and set the required number of the imperfect shapes (Rqd. cell) for the load 

combination which you would like to run imperfection for. 

 

Figure: Imperfection calculation by load combination 
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For the automatic imperfection calculation you got the buckling shape of the structure with real 

size in real dimension. Critical parameter assigned to a buckling shape is also available with the 

following meaning: 

critical parameter = critical buckling force/actual load 

or in other words: 

if the critical parameter is bigger than 1, the structure or a part of it is sufficient to perform the 

stability analysis; if it is smaller it is not. 

If the critical parameters differ a lot between the buckling lengths, the first buckling shape is 

the critical. If the critical parameter values are close to each other, it is your decision what 

structural part you check by its shape. 

 The factor defines the real imperfect shape, so: 

imperfect shape in real dimension = factor * buckling shape 

 

Figure: Automatic imperfect shape calculation 

 Before imperfection calculation, it is recommended to set minimum 4-5 division numbers (finite 

elements) for bars. 

Stability Analysis 
In 3D modules, global stability of the structure can be analyzed automatically if it is requested. Similarly 

to Imperfections, the program calculates buckling shapes together with their critical parameters for 

selected load combinations. 

To do stability analysis, activate Stability analysis and set the required number of the buckling shapes 

(Rqd. cell) for the load combination which you would ask stability results for. 
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Figure: Stability analysis by load combination 

As result, you got the buckling shape(s) of the structure with unit dimension. The greatest displacement 

value of the buckling shape is 1 and the others are the ratio of that. 

Critical parameter assigned to a buckling shape is also available with the following meaning: 

critical parameter = critical buckling force/actual load 

or in other words: 

if the critical parameter is bigger than 1, the structure or a part of it is sufficient to perform the stability 

analysis; if it is smaller it is not. 

  

Figure: Buckling shape calculation 
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The last three columns shows the probability of the buckling shapes are global or local, where eH meant 

for horizontal displacement, eV for vertical displacement (global Z direction) and rZ for rotaion around 

global Z axis. 

 In the example below, the eH value of the first shape is 89%, which means it is probably a global 

buckling shape with horizontal displacement. 

Displaying the result (see the leftmost inset above) and examining the buckling shape shows that this 

is indeed a case of global buckling with the horizontal displacement of the frame’s top. 

The same structure’s second shape possesses a very high rZ value (99%), meaning this almost 

certainly is a global torsional buckling shape (shown in the middle inset). 

The fourth shape’s eH, eV and rZ values are significantly lower, which implies it is a local buckling 

shape. As the rightmost inset shows, the assumption was correct (local buckling of both columns). 

 

 
Higher probability values shows high probability that the shape is global. If there are not 

enough shapes calculated, none might be global. 

 

 

1st shape 
Global in horizontal direction 

3rd shape 
Global in rotational direction 

4th shape 
Local in rotational direction 
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 Before stability analysis, it is recommended to set minimum 4-5 division numbers (finite 

elements) for bars. 

Eigenfrequencies 
Mass/Vibration shape 

FEM-Design can do dynamic analysis by calculating vibration shapes of the structural model and the 

belonging eigenfrequencies and free vibration time values (periodic time). 

To do dynamic calculation, activate Eigenfrequencies and just set the required number of the vibration 

shapes (Number of shapes cell), the active masses in X, Y or Z direction and the Top of substructure. 

 

  

Figure: Dynamic calculation 

 Dynamic calculation requires masses to be predefined. 

Seismic analysis needs the eigenfrequencies calculations. 

In Calculation / Eigenfrequencies dialog the user can set the level of top of the substructure. The 

masses will be neglected at and under this level. 
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In the mass centre of the masses the total mass is displayed with red circle. 

To get the whole structure’s mass centre position set the level of the Top of the substructure a bit 

under the structure. 

This function is useful to neglect the foundation mass in the eigenfrequency calculation so the 

total mass contribution in Modal analysis can reach >=90%. 

Results of Eigienfrequencies calculation: 

Masses - mass matrix of point masses and/or masses calculated from load cases 

converted into finite element nodes; 

Vibration shape - vibration shape and associated eigeinfrequency (Frequency) and periodic time 

(Period). 

 

Figure: Results of dynamic calculations 

 Before dynamic analysis, it is recommended to set minimum 4-5 division numbers (finite 

elements) for bars. 

Shear center result 
FEM-Design can calculate Shear centers for each storey of a building. The figures below show a shear 

center result of an Eigenfrequency calculation. 

 

 
Each displayed shear center represents the result of a calculation based on the storeys 

below that storey. For example, the calculation of the center displayed on “Storey 2” 

takes also “Storey 1” and “Foundation” into account. 

 

 
For displaying shear center, diaphragms are 

needed for every storey. 
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Shear center results can be listed in List tables dialog/Analysis/Eigenfrequencies/Shear center. 

 

  

 

Values in the Tooltip: 

- alpha: the angle between the X axis of 

the global coordinate system and 

stiffness directions, 

- EI1, EI2: stiffnesses in principal 

directions of strains, 

- x, y, z: the global coordinates of the 

shear center. 
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Seismic Analysis 
Methods 

In the  and  modules, seismic calculation offers the following methods to the users according to 

Eurocode 8. 

- Modal response spectrum analysis (“Modal analysis”) 

- Lateral force method / Equivalent static load method 

This method can be used to calculate the seismic effect in horizontal plan, x’ and/or y’ direction. 

The main point is to calculate “base shear force” taking into account the base vibration period and 

design spectrum in x’ or y’ direction, which is distributed into those nodes of the structure where 

there are nodal masses. The “base shear force” formula is taken from EC-8 4.3.3.2.2(1)P. The “base 

shear force” is nothing else than the total seismic force of inertia that acts between the ground and 

the structure, and it can be distributed in two ways: 

• Linear shape method (Static, linear shape) 

The distribution of the “base shear force” happens according to a simplified fundamental mode 

shape, which is approximated by horizontal displacements that increased linearly along the 

height. 

• Mode shape method (Static, mode shape) 

See the detailed description and the applied theory of all calculation methods in the Theory book. This 

guide introduces only the user interface and the steps of seismic analysis. 

Steps of Seismic Calculation 
The suggested steps of seismic calculation are the followings: 

1. Mass definition 

To calculate the seismic effect, it is necessary to know the vibration shapes and corresponding 

periods (except the Static, linear shape method). To perform dynamic calculations, it is necessary to 

define mass distribution which can be defined as concentrated mass or load case-mass conversion.  

2. Design spectrum definition 

The program contains predefined design spectra according to EC8, but you can also define your 

own spectra. Use the command Seismic load (Loads menu). 

3. Dynamic calculation 

Dynamic calculation should be done before performing seismic calculation, which gives sufficient 

vibration shapes of the structure. Although setup for the seismic calculation can be done at any 

time, but the seismic calculation could be performed only after Eigenfrequency calculation. Run 

dynamic calculation under Analysis by setting the required number of vibration shapes. 

 It is suggested to set the finite element number bigger than 1 at bars (Finite elements/ Division 

number). 

4. Settings of seismic calculation 

A national code always provides which seismic calculation method has to be performed for 

different structure, where and when it should be performed and what other effects to be considered 
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(e.g. torsional effect, P-∆ effect). FEM-Design provides three types of calculation methods 

(depending on the applied code): 

 

Figure: Settings of seismic analysis 

- Static, linear shape 

As a matter of fact, eigenfrequency calculation is not necessary for this method, because giving 

the base period time in x’ and y’ directions (Tx’ and Ty’) is enough for the calculation. 

Practically, eigenfrequency calculation performs before setting this data, but these data can be 

defined using experimental formulas as well. Investigation can be done in x’ or y’ direction, or 

both together. 

You may set the calculation direction to be performed by 

selecting the desired direction. To set the desired x’-y’ 

direction, you should give Alfa (  is the angle between 

the global X and x’; see Direction of the horizontal 

effect).  =0.0 means x’-y’ directions coincide with global 

X-Y directions. 

 This method is unusable, if the whole foundation is not in same plane or the horizontal 

foundation is elastic. In these cases, Static, mode shape or Modal analysis should be used. 

- Static, mode shape 

In this method the distribution of “base shear force” happens according to fundamental mode 

shapes (base vibration shapes). 

The table shows how to select the base 

vibration shapes. It contains all mode shapes 

(No), the vibration time (T(s)) and effective 

masses of the mode shapes in x’ and y’ 

directions (mx’(%) and my’(%)). The effective 

masses are given in a relative form to the 

total or reduced mass of the structure. The 

reduced mass means the total mass above the 

foundation or above the rigid basement. The 
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value of the effective mass refers to how the 

mode shape responds to a ground motion 

direction, so the effective mass shows the 

participation weight of the mode shape. 

Select (or double-click on it) one mode shape in x' or/and y' direction(s) (mx’ /my’). (Yellow 

field color shows the activation.) 

 It is recommended to select that mode shape which gives the largest effective mass as 

the fundamental mode shape. 

 The calculation of “base shear force” is performed according to the total mass of the 

structure and not to the effective mass. 

- Modal analysis 

The essence of the method is the 

calculation of the structural response 

for different ground motions by the 

sufficient summation of more 

vibration shapes. Method gives 

possibility to take into account full x', 

y' and z (=global Z) direction 

investigation. 

In the table, more vibration mode 

shape could be selected in x’, y’ and z 

directions if necessary. The last row 

(orange cells) of the table shows that 

how large is the sum of the 

considered effective masses 

compared to the total or reduced mass of the structure in a given ground motion 

direction. 

 According to EC8, sum of the effective mass of the choosen mode shapes (at least in 

horizontal direction) should reach 90% of total mass. Additionally every mode shape 

has to be taken into account where effective mass is larger than 5%. 

 If the sum of the effective mass is much smaller than 90%, eigenfrequency calculation 

should be done for more shapes in order to reach 90%. 

Lots of mode shapes should be ensured to reach the 90% of total mass in vertical 

direction. It is highly recommended to check the national code, whether it is necessary 

to examine the vertical effect or it is not. 

The mode shapes which have small effective mass may be neglected, because their 

effect in result is very small, but calculation time increases. 
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Summation rule by directions 

According to the EC8, the summation rule in the individual directions can be selected. In all 

other codes always the SRSS rule is used for summation (there is no choice). Read more about 

SRSS and CQC summation rules in Theory book. If the Automatic is selected, the rule selection 

procedure is as follow: 

- Always three directions are investigated (if 

more than one mode shape is selected in a 

column), where all mode shape is independent 

from each other or not. 

- If at least one dependent situation exists in a 

direction, the program automatically uses the 

CQC rule for all mode shape in that direction, 

otherwise SRSS rule is used. 

Direction of the horizontal effect 

Codes generally speak about seismic calculation in X-Y directions. These directions give the 

maximum effect, if the mass and elastic properties of the structure ensure that the calculated 

mode shapes lay in X-Z or Y-Z plane. But it is not always achieved in practice. 

To achieve the unfavorable direction, where the results of ground motion are maximum, the 

program gives the possibility to set x'-y' direction for the seismic horizontal effect (Alpha). The 

program suggests the Alfa value, if you click on Auto button. It finds the most unfavorable 

direction, where any of the mx’ and my’ is zero and the other is maximum in the same row (same 

shape). But, there is a rule: the direction can be ensured only for one mode shape, so the program 

selects the row where the effective mass is the maximum. If manually definition is chosen, give 

an angle for Alfa and press the button Set. 

 On the left hand side figure you can see a badly adjusted x’-y’ direction (Alpha = 0). 

Appling Auto button, the program arranges the direction for the 58.5% effective mass 

my’ and correct it to 78%. 

 

Figure: Settings of Alpha 

Effective mass 

The modal effective masses can be compared to the total mass or reduced mass at Eff. mass: 
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In FEM-Design “Reduced mass” means the difference between the total mass 

of the structure and the basement mass. The basement mass is the sum of all 

masses which lay on the foundation level (set at Seismic load/ Others). 

 EC8 defines the total mass without basement (Reduced mass). The effective masses are 

generally compared to the Reduced mass, but this is not valid for the massive basement 

with elastic foundation. If the above mentioned situation is the case, it might happen 

that the sum of the effective masses of a column is larger than the 100%. 

It is uninterested in the calculation point of view, that effective masses are compared to 

the total or the reduced mass, because these values are given in percentage and only 

gives information, that which mode shape is the fundamental or which shapes are 

dominant in a given direction. 

At Options, more calculation properties can be set: 

 

Combination rule 

The combination rule of effects in the x', y' and maybe z 

directions can be set here. You can choose from two 

possibilities. 

Consider torsional effect / Consider second order effect 

Additional effects can be taken into consideration during 

seismic calculation. See the detailed description of these effects 

in Theory book. 

 The calculation of both effects needs the definition of storeys. 

5. Seismic calculation 

After choosing a calculation method and setting its properties, activate first Seismic analysis under 

Analysis and then press OK. 

The Results 
Besides displacements, reactions, connection forces and internal forces, the program calculates the 

Equivalent loads and the “Base shear force”. Results can be displayed by vibration shape (selected at 

calculation settings), from torsional effect, from sums by direction and from the total sum (Seismic max). 

If equivalent loads are displayed, also the “base shear force” appears on screen (in grey color). Torsional 

moment effect on the whole structure can also be displayed, if torsional effect was taken into 

consideration during calculation. 
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Figure: Results of Seismic analysis 

 Because of the square combination rule, the results summed by direction (Sum, x’, Sum, y’, Sum, 

z) and the total sum (Seismic max) give only positive values, so absolute maximums. Also, 

because of combination rule, the displacement components and the internal forces in one point 

are not simultaneous results. 

Summary of Static and Seismic Effects 

Seismic effect can be combined with static loads in two ways: 

- By defining new load cases contain equivalent seismic loads to take them into consideration at 

analysis or design calculations as real static loads, 

- By adding the maximum seismic effect to load combinations or load groups. 

Seismic loads as load cases 

The x' and y' directional loads (also torsional moments) equivalent to the horizontal ground motion can 

be converted to load cases. “Seismic,...”-type load cases behave as static loads: they can be combined, 

they can be added to groups, and they can be taken into consideration at stability, imperfection and 

design calculations. As you see in the list of load case types, the seismic effects can be considered with 

positive and/or negative sign. 
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Figure: Seismic effect added as load case 

Maximum seismic effect in load combinations 

The total, the maximum seismic effect (see Seismic max at Equivalent loads) can be added to load 

combinations. Start the command Load combinations (Loads menu). Apply Insert case(s) on a predefined 

or new load combination, choose “(Seismic max)”, define a load factor and press OK. 

 

Figure: Maximum seismic effect added to load combination 

Maximum seismic effect as load group 

The maximum seismic effect (Seismic max) can also be added to groups in all codes. Define a group as 

“Seismic”. The program automatically takes the “(Seismic max)” into consideration with +/- values in 

the generation of the most unfavorable results. 
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Figure: Maximum seismic effect defined as load group 

Investigate 
If a warning message appears during calculation (e.g. Load mismatch or Finite element mesh problem) 

there is a possibility to check and fix the error by navigating in the model with Investigate. 

The following pictures show a badly defined load and how can the user check and fix the error with 

Investigate function. 
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DESIGN 
 

Depending on the current FEM-Design module you can do different design calculations for concrete, 

steel and timber model elements. This chapter summarizes the design possibilities and results by design 

type. 

Design Load 
All design calculation works with load combinations and load groups. 

 

Figure: Design calculation settings 

 Although analysis can be run for load combinations and load groups in the same time, design 

calculation results exist only either for the load combinations or the maximum of load groups. 

 The Shell design can be done only for load combination, because it based on stability results. 

 Serviceability load combination is considered only in RC bar and shell design, other design is 

done just for ultimate load combinations. 

Buckling Length Factors 
Buckling length is claimed input data of all bar element design (RC/steel/timber columns, beams). The 

buckling length is determined from the bar length and a factor depends on bar end connections. For 

typical end conditions (hinged, fixed, cantilever etc.), proposed beta factors are available for flexural 

buckling. 
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Figure: Proposed beta factors for flexural buckling 

 Buckling length of a Truss member element is equal to its length, so buckling length of trusses 

cannot be modified. 

 The default beta factor is 1.0 for both flexural and torsional buckling. 

 The defined buckling length fundamentally influences the design results. 

Design Groups 
Elements having certain common properties can be assigned to a design group, and the members in one 

group will be designed in the same way. For example, uniform reinforcement (longitudinal bars and 

stirrups) will be calculated for RC bars assigned to one design group, or the same profile will be 

designed for each steel bar of a design group, etc. 

General terms to be a design group member: 

- Same design element type (beam, column, truss member, plate, wall or timber panel) 
- Same material 
- Same geometry (sizes, profiles etc.) 
- Same design parameters (e.g. base reinforcement) 

 Depending on specific cases/element types, additional conditions have to be materialized: 

- Same support conditions 
- Same end/edge connections 
- Same load, etc. 

In design mode, click  to group elements under a name and color. 

  

Figure: Design group tools 
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Design group tool provides the following group operations: 

-  creates a new group, 

-  edits the properties (name and color) of a selected group, 

-  adds selected elements to the current group, 

-  removes selected element from the group, 

-  is available only in Surface and Punching reinforcement design. A group member has to be 
set as the “Master” that carries visually the representative applied reinforcement designed 
uniformly for the group. Only the “Master’s” applied reinforcement is editable; symbolic 
reinforcement is displayed for the other group members. 

-  explodes/deletes a selected group. 

 The next figures give examples of grouping same type steel bars, concrete slabs and beams. 

 

Figure: Some design groups of a steel frame 
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Figure: Design groups of concrete slabs and beams 

From Auto Design till Final Design 
FEM-Design covers the whole RC, steel and timber design process by starting with automatic predesign 

(so-called “Auto design”) for the entire structure and/or by elements/design groups, then by continuing 

with detailed manual design of the domain structural components and by ending with the final design 

(so-called “Check”) of the entire structure. 

 

Figure: From predesign of components till final global design 

 Although analysis can be done in one step for the entire structure independently of the element 

types (concrete, steel and timber), design calculations (and so the design modules) can be run 

separately by the element types (e.g. one after the other). 

 Apply design changes and recalculate: one-click validation of design changes in the current entire 

model together with analysis and design recalculation according to the new states. But, leaving 

Design mode, the design changes are always updated in the current model. 



422 

 

 Delete all applied quantity: restores the model state previous to the applied design according to 

following settings dialog: 

 

Auto Design 
Based on internal forces, utilization check and initial design settings, FEM-Design finds quickly and 

automatically the most suitable applied quantity depending on the design category and element type. 

The so-called “Auto design” makes a proposal for reinforcement distribution, for the applied profile, for 

the panel type, etc. 

Auto design can be done for the whole project with the Calculate > Design calculations > Auto design 

all structural elements. The fast algorithm uses the default calculation and design parameters of the 

elements and search for the most suitable applied quantity according to the utilization. Auto 

design automatically runs Analysis calculations (for Load combinations or Load groups), for Stability 

etc. depending on the design type: e.g. Steel bar design or Shell design. 

Auto design can be applied for single elements and/or design groups only (without running 

design for the complete model). 

The next table summarizes the initial design parameters and the results of Auto design by design 

categories and element types. 

Category Element type Design parameter Auto design 

RC design Bar reinforcement Steel quality, bar diameter 

and profile, concrete cover 

Bar and stirrup distribution 

(numbers of bars, spacing) 

 Surface reinforcement Steel quality, bar spacing, 

shape settings of the 

reinforcement regions, 

possible bar diameters 

Bar distribution, applied 

reinforcement regions and 

area, and bar diameter 

 Punching reinforcement Steel quality, range of 

diameters, distribution 

shape (bended bar, circular 

stirrup, open stirrup) 

Bar and stirrup sizes and 

distribution 

Steel design Steel bar Range of cross-sections Suitable cross-section 
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 Shell model Range of plate thicknesses Suitable plate thickness 

Timber design Timber bar Range of cross-sections Suitable cross-section 

 Timber panel Range of panel types Suitable panel type  

Table: Input parameters and the results of element-based Auto design 

Auto design gives summary tables, which display both the initial design parameters and the 

recommended (applied) quantities optimized to maximum utilization. All utilization details done by 

the Eurocode 2, 3 or 5 regulations can be also displayed. 

Fast redesign can be started from the table by modifying the design parameters. 

 

Figure: Summary table of Auto design (Bar reinforcement) 

If the program is not able to find suitable parameters from the given/available design parameter range, 

it sends a warning message and marks the problematic elements/groups. 

 Leaving Design mode applies all design changes by updating the current model in order to be 

considered in a next recalculation. It also invalidates previous analysis results. 

In RC modules, Auto design results applied reinforcement that is considered in case of cracked-

section analysis. 

Manual Design 
Following Auto design, “on-the-fly” fine tuning of applied quantities can be done by elements and 

design groups. In RC design, Manual design completes the applied reinforcement editing task for 

both concrete surface and bar elements. 

The manual design can be done without calculated analysis results in the following categories: 

- RC design 

- Steel design 

- Timber design 

This function is useful especially at the analysis of an existing building. 
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Category Element type Possible initial data  Manual design 

RC design Bar reinforcement Reinforcement come 

from Auto design 

Applied reinforcement 

(longitudinal bars and 

stirrups) 

 Surface reinforcement Reinforcement come 

from Auto design 

Applied reinforcement 

(top/bottom/middle RC) 

 Punching reinforcement Reinforcement come 

from Auto design 

Applied reinforcement 

(bended bar, circular stirrup, 

open stirrup) 

Steel design Steel bar  Applied cross-section 

 Shell model  Applied plate thickness 

Timber 

design 

Timber bar  Applied cross-section 

 Timber panel  Applied panel type 

Table: Input parameters and the results of Manual design 

 The next figure gives an example for the reinforcement design of a concrete beam from starting 

with Auto design and finishing with detailing (Manual design). 
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Figure: Combined RC design 

 Leaving Design mode applies all design changes by updating the current model in order to be 

considered in a next recalculation. It also invalidates previous analysis results. 

In RC modules, Manual design results applied reinforcement that is considered in case of cracked-

section analysis. 

Detailed Result 
Utilization results with detailed background calculation formulas (together with Eurocode 

references), figures and tables can be displayed by single elements or by design groups. Quick 

navigation is powered with zooming details. 
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Figure: Detailed result 

 Of course, Detailed result is also available for the analysis (displacement, internal forces, and 

stresses) of bar elements. 
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RC DESIGN 
 

Following the analysis calculation, the applied reinforcement (longitudinal bars, stirrups etc.) can be 

designed automatically and refined manually for concrete beams, columns, truss members, slabs, walls 

and shell elements. The applied reinforcement can be considered in cracked-section analysis. 

The table summarizes the available RC design features and its analysis-related effect (cracked-section 

analysis) by FEM-Design module. 

 

Table: RC design features by FEM-Design module 

Global Auto (RC) design (Calculate > Design calculations > Auto design all structural elements) gives applied 

reinforcement for all concrete elements based on their initial design calculation parameters, Auto design 

> Parameters and optimized to their internal forces and detailed utilization calculations. With Manual 

design you can fine-tune the reinforcement by elements and/or design groups. You can do quick Auto 

design by elements and design groups only instead of global design. Of course, any number of design 

cycles is executable, so the global Auto design can be combined with both previous and additional 

element-based Auto designs. 

  

Design element type Design feature 

    

 

Bar reinforcement

 

Auto design 
 

 
  

 Manual design 
 

 
  

 Cracked-section analysis 
 

 
  

 

 Surface reinforcement

 

Auto design 
  

 
 

 Manual design 
  

 
 

 Cracked-section analysis 
  

 
 

 

 Punching 

reinforcement

 

Auto design 
 

  
 

 Manual design 
 

  
 

 Cracked-section analysis 
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No. Global RC design Element-based RC design Combined RC design 

1  Design calculation parameters  Global Analysis  Design calculation parameters 

2  Design group  Design calculation parameters  Design group 

3  Auto design > Parameters  Design group  Auto design > Parameters 

4  Global Auto design  Auto design > Parameters  Global Auto design 

5  Manual design by elements  Auto design by elements  Auto design > Parameters 

6  Apply design changes  Manual design by elements  Auto design by elements 

7  Global Check  Apply design changes  Manual design by elements 

8  Cracked-section analysis  Global Check  Apply design changes 

9  Documentation  Cracked-section analysis  Global Check 

10   Documentation  Cracked-section analysis 

11    Documentation 

 

Table: Recommended steps by design alternatives 

Bar Reinforcement 
Bar reinforcement design needs internal forces from Analysis calculations applied for Load combinations 

or Load-groups,  Buckling length and initial design settings defined by  Design calculation 

parameters and 2nd order calculation method by Configuration. 

 

 

Figure: Design calculation parameters 
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Figure: Design calculation parameters 

The maximal section distance defines the approximate position of the design sections and so the 

available sections for detailed results. 

Auto Design 
Global Auto design gives utilization results and suitable reinforcement distribution for all concrete 

bars of the current project. 

 The applied design parameters can be displayed on screen by showing the “RC bar, design 

parameters” object layer, or click  Design tool of the Auto design to show the parameters 

together with a detailed utilization table. Utilization as colored figure (color palette) can be 

displayed by selecting New result > RC bar > Utilization, and clicking the Numeric value tool 

summarizes the list of maximum utilizations by elements in a dialog. 

 

Figure: Global Auto design and utilization results 

Element-based Auto design finds the most suitable position and distribution of longitudinal bars 

and stirrups for selected unique or grouped members only according to their user-defined design 

parameters. Initial reinforcement (steel quality, diameter, profile, concrete cover) and design 
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(aggregate, vibration) settings can be set for the concrete members/groups with the  

Parameters tool of Auto design. 

 

Figure: Design parameters 

To run element-based design for the load combinations or the maximum of load groups, select the 

required members and/or group with the Auto design command and click  Design tool. The quick 

process results applied reinforcement and their checked utilization. Check the Display table box to have 

a look at the overall design results. 

 

Figure: Quick summary of Auto design results 

The upper table shows the design efficiency and the maximal utilization of the designed single members 

and groups based on the given design parameters. The bottom table (“Show details”) displays the 

utilization details of the bar or the members of the group selected in the upper table. 
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 Meaning Note 

 Suitable reinforcement is available  

 Suitable reinforcement is not 

available 

Modify bar profile, material or RC 

design parameters 

Group ID of a single bar or a group name  

Design parameters Applied design parameters  

Total weight Total weight of applied reinforcement  

Max Max. utilization of a single bar or the 

significant member of a group 

 

Min Max. utilization of the less significant 

group member 

 

Bar ID of a single bar or a group member  

SEC Section utilization According to Eurocode 2: 6.1  

ST Stirrup utilization According to Eurocode 2: 6.2 and 6.3  

C Concrete utilization According to Eurocode 2: 6.2 and 6.3  

T Utilization of torsional reinforcement According to Eurocode 2: 6.3  

CW Utilization for crack width According to Eurocode 2: 7.3  

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a bar or a design group in the upper table. 

2 Modify the design parameters of the select element under Parameters. 

3 Click Design. 

Applied reinforcement generated by Auto design can be displayed with: 

- Detailed result applied for the displayed utilization result (New result > RC bar > Utilization) of a 
single bar or a group member. 

- Manual design applied for a single bar or a group member to edit the design reinforcement and/or 
add further longitudinal bars and stirrups. 

Manual Design 

Manual design opens a new window in the current project and gives tools to define new (applied) 

reinforcement in concrete beams, columns and bars, or to modify/edit the reinforcement 

generated by Auto design. The drawing area is divided into two view windows: 
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- Cross-section 

It shows the cross-section of the current concrete bar. The definition of new longitudinal bars 

(sectional position) and stirrups (shape) starts in this window. The position of the cross-

section (section view) can be set by moving the section marker  in 3D view. 

- 3D view 
It shows the side view of the concrete bar by default. But, any 2D and 3D view can be set with 

the View menu commands (e.g. general 3D view with View > Space view). The start and end 

pont (and so the length) of longitudinal bars and the position (the distribution) of the stirrups 

can be defined here. 

 

Figure: Working windows of Manual design 

You can choose the required window by clicking inside it or its title. 

The Longitudinal bar tool defines new bars in given insertion points. Set the main properties of the 

new bar on the tool palette or all properties under Default settings. 

 

Figure: Definition tools and settings of Longitudinal bar 
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Use one of the following tools to place the new bar in the Cross-section view: 

Clicking in Cross-section, the new bar will be placed with its center point. 

Align the new bar to a line/edge by select one in Cross-section. Move the mouse to set the bar’s 

relative position to the selected line/edge: the center point/upper/bottom/left/right surface will 

be on the line/edge. 

 

 

Figure: Placement of a bar aligned to an inner edge of a stirrup 

Align the new bar to a corner defined by two lines/edges. The bar will be tangent for the first and 

then the second given line. 

  

 

Figure: Placement of a bar aligned to a corner of a stirrup 

1. Define the group of longitudinal bars by set the number of the horizontal (nc), vertical 
(nr) bar numbers and the distance between the rows (c) 

 

Figure: Placement of bar group 

The steel bar length can be defined manually by giving the bar’s start and end point in 3D view. 
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Figure: Steel bar length definition 

The Stirrup tool defines new stirrups with given shapes. Set the main properties of the new stirrup 

bars on the tool palette or all properties under Default settings. 

 

Figure: Definition tools and settings of Stirrup 

Choose the contour geometry of the new bar and define the bar’s relative position to the contour 

with Alignment, which also defines the final stirrup shape with the Cover value in the Cross-section 

view. In the final step, the distribution of the stirrups based on the Distance value is defined with 

a start and an end point in the 3D view. 

 

Figure: Stirrup geometries 

 

Figure: Placement of stirrups 
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 The contour defines the stirrup shape, if the Cover value is set to 0. 

You can modify the properties (quality, diameter, profile etc.) of previously defined bar/stirrup 

reinforcement(s) with the Properties tool of Longitudinal bar and Stirrup. 

To exit from Manual design with validating the new and modified reinforcement bars and stirrups, 

click OK. 

To exit from Manual design without accepting the defined and modified reinforcement, click 

Cancel. 

Detailed Result 
Utilization of RC bars can be displayed in the following cases: 

- After global Auto design, you can display utilization of all concrete bars calculated from the 
suggested applied reinforcement. 

- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected elements. 
- After global Check done for all bar elements having final applied reinforcement. 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result>RC 

bar 

 New result>RC bar  Check  Apply changes 

3    New result>RC bar  Calculate>Design 

calculation>Auto 

design all structural 

elements 

4     New result>RC bar 

Table: Steps of displaying RC bar utilization by different design cases 

Utilization displayed with New result appears for all designed bars. The utilization components 

for a bar/design group can be displayed with Detailed result. 

Detailed result opens a new windows in the current project after selecting a bar/group member, which 

display: 

- Applied reinforcement 
The figure gives the distribution of the applied reinforcement. 
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Figure: Longitudinal bar and stirrups data 

- Cross-section data 

The figure gives the cross-section datas: height, width, area, moment of inertias. 

 

Longitudinal bar dimensions 
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Figure: Cross-section datas 

 

- Material properties 

In Materials section, the program shows the material properties of the applied concrete’s and 
reinforcement, e.g. compression strength (fck), the mean tensile strength (fctm), mean Young 
modulus (Ecm). 

 

Figure: Material properties 

 

- Calculation formulas 

This contains the EC-3 formulas for checking RC bar elements, the substitutions in the formulas 
and the calculation table for each cross section. In the table, the amount of cross-section 
calculations can be set in the Display options. 

 

 

Figure: Formulae 

- Detailed calculation tables  
Calculation details and final values are collected in tables sorted by checking types and under 

utilization graphs by default. Column number depends on the number of calculation sections 

or the table settings defined with Display options. 
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Figure: Detailed calculation table 

- Stress-strain graphs 
Different colors display the strain (red) and the concrete stress (cyan) curves grouped by Section 

utilization (ultimate limit states) and Crack width( serviceability limit states). Also the 

compressed concrete zones are shown with cyan fills in the calculation sections. The number of 

displayed sections can be set with Display options.  

 

Figure: Stress-strain graphs by sections 

- Utilization graphs 
Section (Eurocode2: 6.1), Stirrup (6.2, 6.3), Concrete (6.2, 6.3), Torsional reinforcement (6.3) and 

Crack width (7.3) utilization graphs together with a Summary graph are displayed with legends 

by default. Numeric values can be inquired in the calculation sections (Design calculation 

parameters sets the maximum distance of sections). 
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Figure: Utilization graph 

Tabmenu contains the following tools and settings: 

- Selection of element to display 
You can choose a unique or a design group member from the drop-down lists to display its 

detailed results mentioned before. Each row displays the ID and the maximum utilization of a 

member. In case of a design group, “Maximum” means the significant member having the 

maximum utilization. 

 

Figure: Selection of a unique or a group member 

- Selection of design load 
Depending on RC design was done for load combinations or load groups, a load combination 

or the maximum or a significant component of load groups can be selected for detailed results. 

Each row displays the name of the load combination/load group component and its utilization 

effect. “Maximum” means the significant load combination or component of load groups. 

 

Figure: Selection from design loads 

- Auto design 
Quick Auto design can be done for the currently displayed unique/group member. Its 

design parameters can be set/modified in the appearing dialog, and then clicking OK 

starts RC design that updates all detailed result figures and tables. 
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- Manual design 
Manual design can be launched directly for the currently displayed unique/group 

member. Returning from reinforcement editing updates all detailed result figures and 

tables. 

- Display options 
The content and the appearance of the detailed result can be set with Display options. For 

tables or stress-strain graphs, you can choose all, maximum and characteristic calculation 

sections to display. 

 
Figure: Display options of Detailed result 

- Go to 
Navigate in the RC bar detailed result window by selecting the required design type in the 

drop-down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all figures and tables or specified details only into 

Documentation. 

 Export RC bar reinforcement into *.dwg or *.dxf file format by clicking File/Export to/Export 

to AutoCAD… 

 

Surface Reinforcement 
Surface reinforcement design needs internal forces from Analysis calculations applied for Load 

combinations or Load-groups and initial reinforcement properties (direction, shape, steel quality, diameter 

and concrete cover) defined by  Design calculation parameters. 
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Figure: Initial reinforcement settings 

  The reinforcement shape (Straight/Centric) and the bar directions (x’/y’/r/t) set by Design 

calculation parameters will be fixed parameters in Auto and Manual design, so only they can be 

edited/modified only with Design calculation parameters. 

Although all design results can be calculated for all reinforcement types, Auto design does not work 

for the Centric reinforcement! Only Manual design can be used to define and edit the required 

centric reinforcement area. 

A Plate or Wall can be specified as single layer reinforced by defining “Single layer reinforcement” 

Calculation parameter for it. 

 

Figure: Single layer reinforcement definition 

In the Calculation parameters dialog the User can define the followings: 

- the quality and diameter of the reinforcement for both directions, 

- the direction of the bottom layer, 
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- the distance of the reinforcement from the centreline, 

- the allowed crack width on the bottom and on the top of the structure. 

 

Figure: Calculation parameters for single layer reinfrocement 
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Crack width values that exceed the specified limit are displayed with a different colour. The 

maximum allowed value of crack width can be set at the Calculation parameters ( ). At the Display 

options ( ), the weight, scale and colour of the crack lines can be defined. 

 

If a shell has “Single layer reinforcement” Calculation parameter, its Design parameter can be modified 

only if “Single layer reinforcement” option is selected in Auto design/Parameters. 
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Figure: Auto design parameters of single layer reinforcement 

In case of Manual design, single layer reinforcement can be placed only on „Mid, x’/r” and „Mid, 

y’/t” layers. 

 

Single and double layer reinforcements cannot be used in the same Plate or Wall element. 

Auto Design 

Global Auto design gives design force and required reinforcement results and suitable applied 

reinforcement for all concrete surfaces of the current project. Furthermore, Auto design calculates 

missing reinforcement and crack width based on the determined applied reinforcement. 

 

 

Figure: Global Auto design and its result 
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Element-based Auto design finds the most suitable top and bottom (or mid) reinforcement for 

selected concrete plate, wall and shell elements or element groups only according to their internal 

forces and design parameters. Initial settings of the base net and additional reinforcement by 

positions (Bottom face/Top face/Mid face) and directions (x’/y’/r/t) can be set with the  

Parameters tool of Auto design. 

 

 

Figure: Design parameters 

  The minimum concrete cover together with bar directions is derived from Design calculation 

parameters settings. 
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To run element-based design for the load combinations or the maximum of load groups, select the 

required members and/or group with the Auto design command and click  Design tool. The quick 

process finds the suitable bar diameter for the additional reinforcement from the defined diameter 

range, calculates the bars’ utilization and distributes top and bottom reinforcement where required. 

The placed bars can be displayed by their directions and positions with the navigator icons 

of the Reinforcement layer tool palette. 

The generated applied reinforcement is also visible in Manual design, where additional 

reinforcement can be defined or the current state can be edited. 

  In case of design groups, the applied reinforcement appears only at the Master group member. 

Check the tool palette’s Display table box to have a look at the overall utilization results given for the 

designed surface elements or design groups. 

 

Figure: Quick summary of Auto design results 

The upper table shows the design efficiency and the maximal utilization of the designed single elements 

and groups based on the given design parameters. The bottom table displays the utilization details of 

the surface element or the elements of the group selected in the upper table. 

 Meaning 

 Suitable reinforcement is available 

 Suitable reinforcement is not available 

Note: Modify the element thickness, material or RC design parameters. 

Group ID of a single element or a group name 

Design parameters Main applied design parameters 

 
 

 

 



447 

 

Total weight Total weight of applied reinforcement 

Max Max. utilization of a single element or the significant member of a group 

Min Max. utilization of the less significant group member 

Shell ID of a single element or a group member 

RBX Utilization of bottom x’/r reinforcement 

RBY Utilization of bottom y’/t reinforcement 

RTX Utilization of top x’/r reinforcement 

RTY Utilization of top y’/t reinforcement 

CWB Utilization for crack width on the bottom face 

CWT Utilization for crack width on the top face 

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a surface element or a design group in the upper table. 

2 Modify the design parameters of the current elements under Parameters. 

3 If the selected surface elements already contain applied reinforcement defined by Manual design 

or earlier Auto design, you can delete it by activating  on the Auto design tool palette. 

4 Click Design. 

Manual Design 

 

Manual design gives tools to define new (applied) reinforcement in concrete plates, walls and 

shells, or to modify/redefine the reinforcement generated by Auto design. 
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Figure: Manual design tools 

 If needed, applied reinforcement defined earlier by Auto design or earlier Manual design can be 

deleted with Edit > Erase. The geometry of the applied reinforcement regions can be edited with 

the region-related Edit commands such as Region operations. 

To define new reinforcement in a surface element, first choose the same reinforcement shape 

(Straight/Centric) set earlier for the surface element with Design calculation parameters. 

Choose the geometry of the new surface reinforcement. 

Choose the reinforcement layer with  

 

Set the position (Bottom face/Top face/Mid face) of the new surface reinforcement. 

Set the direction (x’/r/y’/t) of the new surface reinforcement. 

All parameter of the new reinforcement bars can be set under Default settings or the main parameters on 

the Manual design tool palette. 

According to the geometry place the surface reinforcement with its required points. The new surface 

reinforcement will be situated parallel with the plane of the host element with the defined concrete 

cover thickness. 

 

Figure: Additional reinforcement defined with Manual design 

  In case of design groups, the applied reinforcement of the group Master is editable only. 

The active layer will automatically follow the result displayed: e.g., when showing stresses ont he 

top surface of a slab, the top layer of reinforcement will be activated. 
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You can modify the properties (quality, diameter, spacing, cover) of previously defined surface 

reinforcement(s) with the Properties tool of Manual design. 

Running global (Calculate > Design calculations > Check) or element-based Check the program gives 

Applied reinforcement result, so the applied area of surface elements can be displayed with Color 

palette, Contour lines, Graph or Sections mode. 

 

Figure: Applied reinforcement area displayed with Graph, Color palette, Contour lines, Sections and Bi-direction mode 

Shear capacity 
FD calculates RC shells (3D Plate, Wall) shear capacity and their results can be seen from New result / 

RC Design / Shear capacity. These results can be displayed in Graph, Contour Line, Color palette and 

Section format. 

 

Shell buckling 

The buckling problem of the shell is transformed to the buckling of equivalent columns made from the 

shell, on which the second order resistance and utilization is calculated. 

 
Only RC Plane plates and Plane walls with straight reinforcement and uniform 

thickness are suitable for shell buckling calculation. 

The calculation process is based on so-called buckling regions, which can be defined at RC 

design/Surface reinforcement/Buckling length. 
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Each buckling region on the shell has a corresponding buckling factor (beta) and a direction vector in 

the plane of the shell. The former will be used to calculate the buckling length of the equivalent 

column, while the latter one specifies the x’ longitudinal axis of this column. By default, FEM-Design 

generates one buckling region on each RC wall and plate. Default buckling direction is vertical on 

walls, and parallel with the local x axis on plates.  Buckling factor is set to 0.0 on all shells in order to 

let the User decide whether this calculation is needed or not, since it is quite time consuming . 

 

Shells with zero buckling factor will not be considered for shell buckling calculation, 

but zero utilization is set for them. 

The default buckling regions can be modified by adding new regions to the shell. One shell may have 

more buckling regions with different beta factor and direction vector, but the shell must be completely 

covered by these regions. 

 

During the checking process, the program generates equivalent bar(s) from the shell based on its 

material, thickness and reinforcement. This bar is checked as an RC bar: Its utilization is calculated by 

determining its second order internal forces and resistance.  

The calculation process consists of the following steps: 

1. As other shell design calculations, the shell buckling is also calculated in every node of the shell 

(only where there is a buckling region with non-zero beta value). 

 

2. An equivalent bar is generated for the examined node as follows. The edges of the shell are 

intersected by the ray determined by the node and the direction vector of the corresponding 
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buckling region. The two intersection points are taken as the start and the end point of the 

equivalent bars. 

 
Note that this intersection is always made with the edges of the shell and not with the 

edges of the buckling region corresponding to the node! If a node is on the border of 

two or more buckling regions, it is calculated with both different beta values and 

direction vectors, and the higher utilization will be used. 

 

 

 

 

 

 

3. The cross section of the equivalent bar is 1 m wide and its height equals to the thickness of the 

shell. Along the bar, the applied reinforcement of the shell is transformed into the direction of 

the bar and placed into it.  

 

The checking process is executed section by section along the bar. The distance between these 

sections is given by Division length of substitute column parameter in Calculation parameter 

dialog (see the lower figure). Internal forces acting at these sections are calculated by 

transforming shell internal forces at the section point into the coordinate system of the 

column. As the buckling direction of shells is perpendicular to its plane, we need the 

equivalent bar’s normal force and moment vector in the plane of the shell for the calculation. 

β=2 

β=2 

β=1 
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4. Once the first order internal forces are obtained in every section, the second order internal forces 

are calculated based on the nominal stiffness or nominal curvature method, according to the 

configuration settings. The only difference in the checking process of a real bar and this 

equivalent bar is that now the eccentricity coming from the second order effects are applied 

only perpendicularly to the plane of the shell. In other words, the out-of-plane normal force has 

eccentricity only along the z’ axis of the shell. This modification is in harmony with the fact that 

the buckling direction of the shell is perpendicular to the plane. 

 

 

 

 

 

 

5. Finally, based on the second order internal forces, the utilization is calculated for every cross 

section of the equivalent bar (based on the interaction curve), and the highest section utilization 

is assigned to the node. 

Shell buckling calculations are available for Load combinations, Maximum of load combinations and 

Maximum of load groups. The utilization results can be displayed in the New result/RC shell/Shell 

buckling/Utilization  

0.5 m 

0.5 m 

0.5 m 

0.5 m 

0.5 m 

0.5 m 

1.0 m 

NEd 
MEd,I 

NEd 
MEd,II 
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Some details of the calculation can be obtained by listing RC design/Load combinations/Shell, buckling 

table. Also, wall buckling utilization appears in the Shell, Utilization list.  

 

 

Every plate and wall has one result, containing the coordinates of the dominant section, the 

corresponding reinforcement, first and second order internal forces together with the capacity and 

buckling factor. 
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Punching Reinforcement 

Punching check and design can be done according to Eurocode 2 both in FEM-Design  Plate and  

3D Structure modules. It is recommended to perform after Surface reinforcement design, because 

surface reinforcement influences punching calculations. 

The punching regions are automatically defined by the program at the plate – coumn intersections and 

you can define them manually. 

 Punching design/check can be done at any point where a punching region is exists. Design and 
check can be done by these punching zones or by their design groups. 

 The program does not generate punching objects for columns that are connected to more than one 

slab at the same level. 

Initial properties are needed to be set for punching zones. Use  Calculation parameters to define the 

followings: 

 

 

Figure:Setting β values for punching objects 

- Beta (β) 
According to Eurocode 2, β coefficient is taken into account as the effect of any eccentricity of 

loading. Its value depends on column position. The program offers default standard values for 

column positions: for corner (β=1.5), for edge (β=1.4) and inside columns (β=1.15). These 

standard values have to de added manually by selected punching zones or by their groups. If 

you neglect β values, choosing Calculate automatically defines them during design/check process 

and gives accurate results for β coefficients (see Detailed results). 

- Distance of calculated perimeters (d) 
This value is used in slightly different ways in checking and design process: 

Checking: perimeters to check between u1 and uout(,ef) are generated with d 

distance from each other. 
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Design: searching for uout(,ef) perimeter starts from u1 and distance of checked 

perimeters from the column is increased by the d distance until uout(,ef) 

is found. 

 Calculation parameters are displayed on the model view by the Punching, calculation parameters 

object layer. 

Auto Design 
Global Auto design gives utilization results for punching. Auto design applies the initial 

punching reinforcement settings. 

 Punching design always deletes the existing reinforcement and generates new one. 

Defining punching regions 

When clicking on the , the dialog appears: 

 
Figure: Punching region toolwindow 

First the origin of the local system should be specified, which is also the calculation point for punching. 

The punching force is taken from the finite element corner node closest to the local system’s origin.  

Before analysis, the user should place a fixed point in Finite element tab, where a punching 

calculation is planned to be performed, because in this way it will be surely a corner node, leading 

to higher precision in punching calculation. 
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Figure: Punching region example 

If you pick a punching force calculation point away from the region the following appears: 

 

Punching utilization results can be displayed for the entire model with New result > RC punching > 

Utilization. Maximum utilization in table format can be also shown with Numeric value. Detailed 

utilization results can be asked by unique or grouped punching zones with  (see later). Different 

colors display the adequacy of the checked punching zones. 
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Figure: Global Auto design and its result 

Element-based Auto design checks the utilizations against punching and finds required 

reinforcement for selected zones and/or design groups of zones. Initial settings can be set for 

required reinforcement by bended bar, circularly placed stirrup and open stirrup types with the 

 Parameters tool of Auto design. 

 

Figure: Design parameters by punching reinforcement type 

The symbols of the design parameters are stored on the Punching, design parameters object layer. 
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To run element-based design for the load combinations or the maximum of load groups, select the 

required zones and/or groups with the Auto design command and click  Design tool. The quick 

process runs detailed utilization and finds the suitable bar diameters for the additional reinforcement. 

Check the tool palette’s Display table box to have a look at the overall utilization results. 

 

Figure: Quick summary of Auto design results 

 The ID of design groups can be shown with the Punching, design groups object layer. 

The upper table shows the design efficiency and the maximal utilization of the designed punching zones 

based on the given design parameters. The bottom table displays the utilization details of elements or 

design members. 

 Meaning 

 RC column is suitable for punching without or with shear reinforcement 

 

Suitable shear reinforcement is not available 

Note: Modify the slabs’ surface reinforcement or the design parameters. 

Group ID of a unique punching zone or design group 

Design parameters The suitable bar diameter and other design parameters as the reinforcement type 

Total weight - The “-“ symbol displays that no shear reinforcement is applied 
- Total weight of applied punching reinforcement 

Max Max. utilization of a unique zone or the significant zone of a group 

Min Max. utilization of the less significant group member 

Punching ID of a unique column or a design group member 
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CC Utilization for concrete compress 

CS Utilization for concrete shear 

RS Utilization for reinforcement shear 

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a punching zone or a design group in the upper table. 

2 Modify the design parameters of the current elements under Parameters. 

3 Click Design. 

 Detailed result summarizes the applied formulas by the design modes and display the applied 

shear reinforcement (if needed) drawing too. 

Manual Design 

Manual design gives tools to define new (applied) punching reinforcement in concrete plates, or 

to modify/redefine the reinforcement generated by Auto design. 

The rules of new reinforcement definition, if predefined reinforcement already exists from Auto design: 

- new same-type reinforcement will be added to applied reinforcement, 
- new different type reinforcement always overwrites the previously defined one, and 
- new “open stirrup”-type reinforcement always overwrites the previously defined 

reinforcement even if it was “open stirrup”. 
 First choose the type of the new reinforcement. If you would like to modify/refine a previously 

defined (generated by Auto design or defined by Manual design in an earlier phase) reinforcement, 

you also need to set the required type from the drop-down list of Manual design. The  Properties 

tool of Manual design can be used for modifying actions. 

The tools of Manual design depends on the selected reinforcement type. 

Bended bar 

First set the reinforcement properties under Default settings, and choose the bar direction according to 

the local system directions of the related column. Then select the punching zone you would like to be 

reinforced (with totally new or additional reinforcement) and place the new bars. 
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Figure: New bended bar 

Stirrup, circular 

First set the reinforcement properties under Default settings, then select the punching zone you would 

like to be reinforced, and finally define the circular form with its inner radius. 

 

Figure: New stirrups in circular shape 

Stirrup, open 

First set the reinforcement properties under Default settings, then select a geometrical shape (e.g. 

rectangular, circular, polygonal) for the stirrup position. Select the punching zone you would like to be 

reinforced, and finally define the shape in the model view. 
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Figure: New open stirrups 

  In case of design groups, the applied reinforcement of the group Master is editable only. Other 

group members have symbolic reinforcement figure. 

Running global (Calculate > Design calculations > Check) or element-based Check the program gives 

utilization result for the applied punching reinforcement. 

Detailed Result 
Utilization of punching reinforcement can be displayed in the following cases: 

- After global Auto design, you can display utilization calculated from the suggested applied 
reinforcement. 

- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected zones. 
- Global Check done for final applied reinforcement. 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result > 

RC punching 

 New result > 

RC punching 

 Check  Apply changes 

3    New result > 

RC punching 

 Calculate>Design 

calculation>Check all 

structural elements 

4     New result > 
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RC punching 

Table: Steps of displaying punching utilization by different design cases 

Utilization displayed with New result appears for all designed punching zones. The utilization 

components with calculation formulas and the applied reinforcement (if needed) can be 

displayed with Detailed result. 

Detailed result opens a new window in the current project after selecting a unique zone or a member 

zone of a design group, which display: 

- Design parameters and applied reinforcement 
The figure displays the calculation perimeters, the design parameters and the applied 

reinforcement calculated by Auto design (if required) or defined in Manual design. 

 

Figure: Calculation perimeters, design parameters and applied reinforcement 

- Detailed calculation formulas 
Calculation details and final values are collected by checking types: Concrete compression 

resistance (Eurocode2: Part 1.1: 6.4.3), Shear reinforcement resistance (Part 1.1: 6.4.3) and Concrete 

shear resistance (Part 1.1: 6.4.3). The proper results are displayed in green, while the red result 

warnings you to repeat design. The content of the utilization checks depends on Display 

options. Not relevant checks can also be hidden. 
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Figure: Utilization formulas and tables 

- Summary graph 
Summary graph is displayed with legend by default. 

 

Figure: Utilization summary 

 Tabmenu contains the following tools and settings: 

- Selection of zones checked for punching  
You can choose a unique zone or a design group zone member from the drop-down lists to 

display its detailed results mentioned before. Each row displays the ID and the maximum 

utilization of a member. In case of a design group, “Maximum” means the significant member 

having the maximum utilization. 

- Selection of design load 
Depending on punching design was done for load combinations or load groups, a load 

combination or the maximum or a significant component of load groups can be selected for 

detailed results. Each row displays the name of the load combination/load group component 

and its utilization effect. “Maximum” means the significant load combination or component of 

load groups. 
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Figure: Selection from checked elements and design loads 

- Auto design 
Quick Auto design can be done for the currently displayed unique/grouped zone. Its 

design parameters can be set/modified in the appearing dialog, and then clicking OK 

starts punching design that updates all detailed result figures and tables. 

- Display options 
The content and the appearance of the detailed result can be set with Display options. 

 

Figure: Display options of Detailed result 

- Go to 
Navigate in the Detailed result window by selecting the required design type in the drop-

down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all figures and tables or specified details only into 

Documentation. 
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STEEL DESIGN 
 

Fast auto design and check are available to find the most suitable steel bar profiles. All section shapes 

and classes - including class 4 profiles (slender sections) - can be checked for utilization. When modeling 

steel bars with 3D steel shell components, an auto design finds the proper thickness of the shell 

elements. 

The table summarizes the available steel design features by FEM-Design module. 

 

Table: Steel design features by FEM-Design module 

Steel Bar 
Global Auto (steel bar) design (Calculate > Design calculations > Auto design all structural elements) finds the 

most suitable cross-section (from the profile range set at Auto design > Parameters) for all steel bars 

(columns, beams and truss members) based on their buckling length, stiffeners, calculation parameters, 

internal forces and detailed utilization calculations. With Manual design you can run quick utilization 

check for given profiles by bar elements and/or design groups. You can also do quick Auto design by 

elements and design groups only instead of global design. Of course, any number of design cycles is 

executable, so the global Auto design can be combined with both previous and additional element-based 

Auto designs. 

No. Global steel bar design Element-based steel design Combined steel design 

1  Calculation 

parameters 

 Global Analysis  Calculation 

parameters 

2  Design group  Calculation 

parameters 

 Design group 

3  Auto design > Parameters  Design group  Auto design > Parameters 

4  Global Auto design  Auto design > Parameters  Global Auto design 

5  Documentation  Auto design by elements  Auto design > Parameters 

Design element type Design feature 

   

 Steel Bar 
Auto design 

   

 Manual design 
   

 Shell Model 
Auto design   

 

 Manual design   
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6   Manual design by elements  Auto design by elements 

7   Apply design changes  Manual design by elements 

8   Global Check  Apply design changes 

9   Documentation  Global Check 

10    Documentation 

Table: Recommended steps by design alternatives 

Initial Calculation and Design Parameters 

All bar design calculations needs internal forces from Analysis calculations applied for Load combinations 

or Load-groups,  Buckling length and initial design settings defined by  Design calculation 

parameters. 

 

Figure: Design calculation parameters 

The flexural buckling curves (EC3-1-1: 6.3.1.2) can be specified for each steel bar in Calculation parameters 

dialog or the user can let the program to calculate it as in the previous versions by selecting “Auto” 

option.  
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Figure: Setting calculation parameters 

For steel bars with varying section the “Auto” option cannot display the automatically calculated 

curve, since it is determined during the design calculation. 

When the section of a steel bar is modified, buckling curve options of the calculation parameter is 

reset to “Auto” 

When buckling curve is calculated automatically, applied section is considered, if it exist. 

Convergence criteria and the maximum number of iteration steps can be set for effective cross-section 

calculation of Class 4 steel bar section in Calculation parameters dialog. 

In some cases the iteration for effective cross-section fails because of the too strong convergence 

criteria. In this case reducing its factor or increasing the number of the iteration steps may solve the 

problem. 
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Lateral torsional buckling can be calculated using the formulas to general case instead of using 

the simplified method.When the general method is used for lateral torsional buckling calculation, the 

position of the load needs to be specified as well. Calculation method of the kij interaction factors can 

be specified by selecting the design configuration option from the ribbon. 

 

Stiffeners can be added manually to steel bars at any time during design (e.g. before Auto design, 

or between Auto design and final Check). Stiffeners can be defined element by element, but they 

can be copied among bar elements. Stiffener definition tools are: 

-  creates given number of evenly distributed stiffeners on a defined length section, 

-  creates stiffeners by given distance on a defined length section (in case the multiple of the 
distance does not fit in the section, the program distributes stiffeners with equal parts at the ends), 

-  defines stiffeners one by one in given position, 

-  copies stiffeners of a selected bar to other bars with the same length. 

You can increase the number of stiffeners in more steps, if you inactivate  (Do not delete the original). 
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Figure: Stiffeners 

Auto Design 

Global Auto design gives utilization results and suitable profiles for all steel bars of the current 

project. 

 

Figure: Global Auto design and utilization result 
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 The recommended profile names can be displayed on screen by showing the “Steel bar, applied 

quantity” object layer, or click  Design tool of the Auto design and the parameters together with 

utilization results are available in table format. Utilization as colored figure (color palette) can be 

displayed by selecting New result > Steel bar > Utilization. 

  Variable cross-section steel bars can’t be designed, just checked. 

Applied profiles are displayed in blue in the Utilization table, if they are assigned to the steel bars during 

design, otherwise black color represents the original/initial profiles. 

Element-based Auto design finds the most suitable profile of steel columns, beams and bars for 

selected unique or grouped members only from a range of available profiles defined by  

Parameters. The design utilization can be limited between 10% and 100% with Limit utilization. 

 

Figure: Range of available profiles for design 

To run element-based design for the load combinations or the maximum of load groups, select the 

required members and/or group with the Auto design command and click  Design tool. The quick 

process results recommended profiles and their utilization. Check the Display table box to have a look at 

the overall design results (see the figure before). 

The upper table shows the design efficiency and the maximal utilization of the designed single members 

and groups based on the given design parameters. The bottom table displays the utilization details of 

the bar or the members of the group selected in the upper table. 

 

 Meaning Note 

 Suitable profile is available  

 Suitable profile is not available Modify the range of available 

profiles or steel materials 

 Suitable profile is available, but the 

utilization is over the Limit utilization 

 

Group ID of a single bar or a group name  
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Design parameters The defined range of available profiles  

Applied profile Profile currently assigned to the bar  

Max Max. utilization of a single bar or the 

significant member of a group 

 

Min Max. utilization of the less significant 

group member 

 

Bar ID of a single bar or a group member  

RCS Resistance of cross-section: the 

maximum utilization from all strength 

calculations 

According to Eurocode 3: 

6.2.3 - 6.2.10 

FB Utilization for flexural buckling According to Eurocode 3: 6.3.1 

TFB Utilization for torsional-flexural 

buckling 

According to Eurocode 3: 6.3.1 

LTB Utilization for lateral torsional buckling According to Eurocode 3: 6.3.2.4 

SB Utilization for shear buckling According to Eurocode 3: 1-5: 5 

IA Interaction 

(between normal force and bending) 

According to Eurocode 3: 6.3.3 

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a bar or a design group in the upper table. 

2 Modify the range of available profiles for the select element under Parameters. 

3 Click Design. 

Save /load default sections 
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For each section type (e.g. IPE, HEA, CHS, etc.) a set of sections can be saved/loaded as default. 

This will only work with one type cross-section (e.g. only HEA, or only KKR) selected. Otherwise, with 

Save command, the user can save a set of arbitrary sections into a file, and use them later for another 

model by Load command. 

 

Manual Design 

With Manual design quick utilization check can be done for given steel profile and for selected 

steel beam, column, bar or design group only. Just, choose the load type (load combination or 

load group) and a profile name from the drop-down lists and select a bar, bars or group, and 

program displays detailed utilization results in table format. 

  The meaning of the utilization components, the table content and features are the same as written 

before at Auto design. The program use the chosen profile for all selected bar elements. 
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Figure: Quick check by Manual design 

Detailed Result 

Utilization of steel bars can be displayed in the following cases: 

- After global Auto design, you can display utilization of all steel bars checked for the 
recommended profiles. 

- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected elements. 
- After global Check done for all bar elements having final cross-section. 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result> 

Steel bar 

 New result>Steel bar  Check  Apply changes 

3    New result>Steel bar  Calculate>Design 

calculation>Auto 

design all structural 

elements 

4     New result> 

Steel bar 

Table: Steps of displaying steel bar utilization by different design cases 
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Utilization displayed with New result appears for all designed bars. The utilization components 

for a bar/design group can be displayed with Detailed result. 

Detailed result opens a new window in the current project after selecting a bar/group member, which 

displays: 

- Input data 
The figure displays the applied steel cross-section with its main calculation and material 

parameters. 

 

Figure: Applied cross-section 

- Detailed calculation formulas 
Calculation details and final values are collected by checking types: Shear resistance (Eurocode3: 

1-1: 6.2.6, 6.2.8), Torsional resistance (1-1: 6.2.7), Shear stress (1-1: 6.2.6), Normal stress (1-1: 6.2.1), 

Normal capacity (1-1: 6.2.1), Flexural buckling (1-1: 6.3.1), Torsional-flexural buckling (1-1: 6.3.1), 

Lateral-torsional buckling (1-1: 6.3.2.4), Interaction between normal force and bending (1-1: 6.3.3.) and 

Shear buckling (1-5: 5). The proper results are displayed in green, while the red result warnings 

you to repeat design with new bar properties. The content of the utilization checks depends on 

Display options. Not relevant checks can also be hidden. 

 

Figure: Utilization checks and formulas 
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- Summary graph 
Summary graph is displayed with legend by default. Numeric values can be inquired in the 

calculation sections (set by Design calculation parameters). 

 

Figure: Utilization summary 

 Tabmenu contains the following tools and settings: 

- Selection of element to display 
You can choose a unique or a design group member from the drop-down lists to display its 

detailed results mentioned before. Each row displays the ID and the maximum utilization of a 

member. In case of a design group, “Maximum” means each check is displayed for the 

significant member having the maximum utilization for that check. 

 

Figure: Selection of a unique or a group member 

- Selection of design load 
Depending on steel design was done for load combinations or load groups, a load combination 

or the maximum or a significant component of load groups can be selected for detailed results. 

Each row displays the name of the load combination/load group component and its utilization 

effect. “Maximum” means each check is displayed for the significant load combination or 

component of load groups having the maximum utilization for that check. 

 

Figure: Selection from design loads 

- Auto design 
Quick Auto design can be done for the currently displayed unique/group member. Its 

design parameters can be set/modified in the appearing dialog, and then clicking OK 

starts steel design that updates all detailed result figures and formulas. 
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- Manual design 
Manual design can be launched directly for the currently displayed unique member 

/group. 

- Display options 
The content and the appearance of the detailed result can be set with Display options. You 

can show only the final equation without details of the different checks (Hide details). 

 

Figure: Display options of Detailed result 

- Go to 
Navigate in the detailed result window by selecting the required design type in the drop-

down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all figures, fomulas and summary table or specified 

details only into Documentation. 

Fire design for steel bars 

Fire design gives the opportunity to check and design steel bars for fire effects according to EN 1993-1-

2. 

Launch Steel design/ Steel bar, fire design . To start Fire design it needs some new input data of the 

bars, and a special load combination and/or load group must be defined. 

- A „+Fire” type load case has to be defined in the Load cases dialog. 

-  
- For maximum of load groups calculations, an accidental load group must be defined that 

contains the „+Fire” type load case. 
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-  
- For maximum of load combinations calculations, accidental load combinations must be defined 

that contains the „+Fire” type load case. 

-  
- The effects (internal forces) are calculated from accidental load combinations, where fire is the 

accidental effect. Resistance of bar is calculated by using reduced yield strength and elasticity 

modulus for steel at the elevated temperature. 

Fire design contains Calculation parameter, Check, Design group, Auto design and Manual design 

commands. 

Calculation parameter 

  Explanation of data in calculation parameters are in EN 1993-1-2:3, 4 and EN 1992-1-2:3. 

„Deflection criterion is essential” option is available for Danish national annex only.  

 

Check 

It works in exactly the same way as in case of steel bar design. 

Design group 

It works in exactly the same way as in case of normal steel bar design, except that fire design 

parameter and fire design calculation parameter of two bars must match to be placed into the same 

design group. 
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Auto design 

There are two design options:  

- Design for fire protection material  

The design parameter contains the fire protection material, which can be selected from a 
library (see later). Its minimal and maximal thickness and an increment value, which is used by 
the automatic design procedure to find the minimal necessary thickness of the protection 
material, can be given by the User 

 

- Calculate maximum temperature   

The Temperature step for maximum temperature calculation can be defined by the User. 

Limit utilization can also be set in the Steel bar - fire design parameter dialog 

 

Manual design 

Fire protection material (from a library, see later), its thickness, or the Maximum member temperature 

can be selected in Steel bar, fire protection dialog for Manual Design.. 

 

Fire protection material library 

It is available by clicking on „Edit library…” item in the material list of fire protection parameter in 

Auto and  Manual design dialogs. 
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Results 

Utilization results are available to display on the model and to list.  

A new result “Max. of combinations/Bar, Combined utilization summary” is available, where the 

maximum utilization of steel bars for both normal and fire check is displayed 
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Shell Model 
In FEM-Design, a steel bar can be modeled as a real 3D element defined from steel plates. 

 To convert a bar element to 3D shells apply the Steel bar, shell model tool of the  Tabmenu. 

Global Auto (Shell model) design (Calculate > Design calculations > Auto design all structural elements) finds 

the most suitable thickness (from a thickness range set at Auto design > Parameters) for all steel plates of 

the shell model based on internal forces, stability check and detailed utilization calculations. With 

Manual design you can run quick utilization check of given thickness values for selected shell models or 

their design groups. You can also do quick Auto design by shell elements and design groups only instead 

of global design. Of course, any number of design cycles is executable, so the global Auto design can be 

combined with both previous and additional element-based Auto designs. 
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No. Global steel bar design Element-based steel design Combined steel design 

1  Structure>Steel bar,shell 

model 

 Structure>Steel bar,shell 

model 

 Structure>Steel bar,shell model 

2  Design group  Global Stability analysis  Design group 

3  Auto design > Parameters  Design group  Design Parameters 

4  Global Auto design  Auto design > Parameters  Global Auto design 

5  Documentation  Auto design by elements  Auto design > Parameters 

6   Manual design by elements  Auto design by elements 

7   Apply design changes  Manual design by elements 

8   Global Check  Apply design changes 

9   Documentation  Global Check 

10    Documentation 

Table: Recommended steps by design alternatives 

  Stability analysis is required to get utilization check of steel bar-shell models. Global Auto design 

automatically runs stability analysis for the entire structure. 

Auto Design 
Global Auto design gives utilization results and suitable thickness for all steel plates of shell models. 
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Figure: Global Auto design and utilization result 

 The recommended thickness values can be displayed on screen by showing the “Steel bar, shell 

model, applied quantity” object layer, or click  Design tool of the Auto design and the thickness 

values together with utilization results are available in table format. Utilization as colored figure 

(color palette) can be displayed by selecting New result > Steel bar, shell model > Utilization. 

Applied thickness values are displayed in blue in the Utilization table, if they are assigned to the steel 

shell parts during design, otherwise black color represents the original/initial thickness. 

Element-based Auto design finds the most suitable thickness of steel plates for selected unique or 

grouped shell models only from a range of available thicknesses defined by Parameters. 

 

Figure: Range of available thickness values for design 
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To run element-based design for the load combinations, select the required shell element and/or 

element group with the Auto design command and click  Design tool. The quick process results 

recommended thickness values and the utilization of the shell model elements. Check the Display table 

box to have a look at the overall design results (see before). 

The upper table shows the design efficiency and the maximal utilization of the designed single element 

and groups based on the found thickness values. The bottom table displays the utilization details of the 

shell model element or the members of a group selected in the upper table. 

 Meaning 

 Suitable thickness is available 

 Suitable thickness is not available 

(Modify the range of available thicknesses or steel materials.) 

Group ID of a single element or a group name 

Design parameters The defined range of available thicknesses 

Applied thicknesses Thickness currently assigned to the shells 

Max Max. utilization of a model element or the significant 

member of a group 

Min Max. utilization of the less significant group member 

Bar ID of the designed single bar or a group member 

Stress Stress utilization 

FBS Utilization for flexural buckling around the stiff axis 

FBW Utilization for flexural buckling around the weak axis 

TB Utilization for torsional buckling 

LTB Utilization for lateral torsional buckling 

LB Utilization for local buckling 

Table: The meaning of symbols and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a bar or a design group in the upper table. 

2 Modify the range of available plate thicknesses for the select element under Parameters. 

3 Click Design. 

Manual Design 

With Manual design quick utilization check can be done for custom (also different) thickness 

values of selected steel plates (or their groups). Just select steel plate(s) and set a thickness value 
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in the appeared dialog. Run Check calculation to run and display utilization check for the modified 

plates according to their new thickness values. 

  The meaning of the utilization components, the table content and features are the same as written 

before at Auto design. 

 

Figure: Quick check by Manual design 

Detailed Result 

Utilization of steel bar-shell models can be displayed in the following cases: 

- After global Auto design, you can display utilization of all steel shell models. 
- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected elements. 
- After global Check done for all bar-shell elements having final plate thicknesses. 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result> 

Steel bar, shell model 

 New result> 

Steel bar, shell model 

 Check  Apply changes 

3    New result> 

Steel bar, shell model 

 Calculate>Design 

calculation>Auto 

design all structural 

elements 

4     New result> 

Steel bar, shell model 

Table: Steps of displaying steel bar-shell model utilization by different design cases 

Utilization displayed with New result appears for all designed bar-shell models. The utilization 

components for an element/design group can be displayed with Detailed result. 
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Detailed result opens two new windows in the current project after selecting a shell model or group 

member, which display: 

- Applied shell thicknesses (Detailed result window) 
A list displays the applied thicknesses by the steel plate components. 

- Detailed calculation formulas (Detailed result window) 
Calculation details and final values are collected by checking types: Stresses, Flexural buckling, 

stiff/weak direction, Torsional buckling, Lateral torsional buckling and Local buckling. The proper 

results are displayed in green, while the red result warnings you to repeat design with new 

thickness values. The content of the utilization checks depends on Display options and Buckling 

mode (see later). Not relevant checks can also be hidden. 

 

Figure: Utilization checks and formulas 

- Summary graph (Detailed result window) 
Summary graph is displayed with legend by default. 

 

Figure: Utilization summary 
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- Buckling mode (Buckling mode window) 
Based on stability analysis, the calculated shapes of the bar-shell model can be displayed in 3D 

view. Just select the required shape from the Shape drop-down list of the navigator panel and 

the program automatically shows the deformed shape in the current display mode. Buckling mode 

can be also chosen for the selected shape that affects on the design check content of the Detailed 

result window. You can add numeric values to the deformed shape or run buckling animation. 

 

Figure: Buckling shape 

 Tabmenu contains the following tools and settings for the Detailed result window: 

- Selection of element to display 
You can choose a unique or a design group member from the drop-down lists to display its 

detailed results mentioned before. Each row displays the ID and the maximum utilization of a 

member. In case of a design group, “Maximum” means the significant member having the 

maximum utilization. 

- Selection of design load 
A load combination can be selected for detailed results. Each row displays the name of the 

available load combination and its utilization effect. “Maximum” means the significant load 

combination. 

- Auto design 
Quick Auto design can be done for the currently displayed unique/group member. Set the 

thickness of the steel plate components, and then click OK to start design that updates all 

detailed result figures and tables. 
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- Display options 
The content and the appearance of the detailed result can be set with Display options. 

- Go to 
Navigate in the Detailed result window by selecting the required design type in the drop-

down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all calculation and check formulas into Documentation. 
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TIMBER DESIGN 
 

Fast auto design and check are available to find the most suitable timber bar cross-sections and panel 

types. 

The table summarizes the available timber design features by FEM-Design module. 

 

Table: Timber design features by FEM-Design module 

Load-Duration Classes 
Based on Eurocode 5 (EN 1995-1-1:2004), load-duration classes can be taken into account in the Timber 

design. 

The load-duration classes are characterized by the effect of constant load acting for a certain period of 

time in the life of the structure. For a variable action the appropriate class shall be determined on the 

basis of an estimate of the typical variation of the load with time. 

Actions shall be assigned to one of the load-duration classes given for strength and stiffness calculations. 

Load-duration class Order of accumulated duration 

of characteristic load 

Examples of loading 

Permanent More than 10 years Dead load 

Long-term 6 months – 10 years Storage 

Medium-term 1 week – 6 months Imposed floor load, snow 

Short-term less than one week Snow, wind 

Instantaneous  Wind, accidental load 

Table: Load-duration classes and examples of load-duration assignment (EN 1995-1-1:2004) 

  Since climatic loads (snow, wind) vary between countries, the assignment of load-duration 

classes may be specified in the National annex. 

Design element type Design feature 

   

 Timber Bar 
Auto design 

   

 Manual design 
   

 Timber Panel 
Auto design   

 

 Manual design   
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Loads can be assigned to load-duration classes with the Load cases command in the  

Tabmenu. 

 

Figure: Load cases and load-duration classes 

Timber Bar 
Global Auto (timber bar) design (Calculate > Design calculations > Auto design all structural elements) finds 

the most suitable cross-section (from the profile range set at Auto design > Parameters) for all timber bars 

(columns, beams and truss members) based on their initial calculation parameters, internal forces and 

detailed utilization calculations. With Manual design you can run quick utilization check for given 

profiles by bar elements and/or design groups. You can also do quick Auto design by elements and 

design groups only instead of global design. Of course, any number of design cycles is executable, so 

the global Auto design can be combined with both previous and additional element-based Auto designs. 

No. Global timber bar design Element-based timber design Combined timber design 

1  Calculation parameters  Global Analysis  Calculation parameters 

2  Design group  Calculation parameters  Design group 

3  Auto design > Parameters  Design group  Design Parameters 

4  Global Auto design  Auto design > Parameters  Global Auto design 

5  Documentation  Auto design by elements  Auto design > Parameters 

6   Manual design by elements  Auto design by elements 

7   Apply design changes  Manual design by elements 

8   Global Check  Apply design changes 

9   Documentation  Global Check 

10    Documentation 

Table: Recommended steps by design alternatives 

Initial Calculation and Design Parameters 
All bar design calculations needs internal forces from Analysis calculations applied for Load combinations 

or Load-groups,  Buckling length and initial design settings defined by  Design calculation 

parameters. 
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Figure: Design calculation parameters 

Auto Design 

Global Auto design gives utilization results and suitable profiles for all timber bars of the current 

project from a defined range of cross-sections. 

 

Figure: Global Auto design and utilization result 

 The recommended profile names can be displayed on screen by showing the “Timber bar, applied 

quantity” object layer, or click  Design tool of the Auto design and the parameters together with 

utilization results are available in table format. Utilization as colored figure (color palette) can be 

displayed by selecting New result > Timber bar > Utilization. 

Applied profiles are displayed in blue in the Utilization table, if they are assigned to the timber bars 

during design, otherwise black color represents the original/initial profiles. 
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Element-based Auto design finds the most suitable profile of timber columns, beams and bars for 

selected unique or grouped members only from a range of available profiles defined by  

Parameters. The design utilization can be limited between 10% and 100% with Limit utilization. 

 

Figure: Range of available profiles for design 

To run element-based design for the load combinations or the maximum of load groups, select the 

required members and/or group with the Auto design command and click  Design tool. The quick 

process results recommended profiles and their utilization. Check the Display table box to have a look at 

the overall design results (see the figure before). 

The upper table shows the design efficiency and the maximal utilization of the designed single members 

and groups based on the given design parameters. The bottom table displays the utilization details of 

the bar or the members of the group selected in the upper table. 

 Meaning Note 

 Suitable profile is available  

 Suitable profile is not available Modify the range of available 

profiles or timber materials 

Group ID of a single bar or a group name  

Design parameters The defined range of available profiles  

Applied profile Profile currently assigned to the bar  

Max Max. utilization of a single bar or the 

significant member of a group 

 

Min Max. utilization of the less significant 

group member 

 

Bar ID of a single bar or a group member  

T Utilization for combined bending and 

axial tension 

According to Eurocode 5: 6.2.3 
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C Utilization for combined bending and 

axial compression 

According to Eurocode 5: 6.1.4, 

6.2.4 

S Utilization for combined shear and 

torsion 

According to Eurocode 5: 6.1.7, 

6.1.8 

FB1 Utilization for flexural buckling around 

axis 1 

According to Eurocode 5: 6.3.2 

FB2 Utilization for flexural buckling around 

axis 2 

According to Eurocode 5: 6.3.2 

LTB Utilization for lateral torsional buckling According to Eurocode 5: 6.3.3 

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a bar or a design group in the upper table. 

2 Modify the range of available profiles for the select element under Parameters. 

3 Click Design. 

Save /load default sections 

For each section type (e.g. Dressed lumber, Glulam, etc.) a set of sections can be saved/loaded as default. 

This will only work with one type cross-section (e.g. only Glulam, or only Sawn lumber) selected. 

Otherwise, with Save command, the user can save a set of arbitrary sections into a file, and use them 

later for another model by Load command. 
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Manual Design 
With Manual design quick utilization check can be done for given timber profile and for selected 

timber beam, column, bar or design group only. Just, choose the load type (load combination or 

load group) and a profile name from the drop-down lists and select a bar, bars or group, and 

program displays detailed utilization results in table format. 

 

Figure: Quick check by Manual design 

  The meaning of the utilization components, the table content and features are the same as written 

before at Auto design. The program use the chosen profile for all selected bar elements. 
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Detailed Result 

Utilization of timber bars can be displayed in the following cases: 

- After global Auto design, you can display utilization of all timber bars checked for the 
recommended profiles. 

- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected elements. 
- After global Check done for all bar elements having final cross-section. 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result> 

Timber bar 

 New result>Timber bar  Check  Apply changes 

3    New result> 

Timber bar 

 Calculate>Design 

calculation>Auto 

design all structural 

elements 

4     New result> 

Timber bar 

Table: Steps of displaying timber bar utilization by different design cases 

Utilization displayed with New result appears for all designed bars. The utilization components 

for a bar/design group can be displayed with Detailed result. 

Detailed result opens a new window in the current project after selecting a bar/group member, which 

displays: 

- Applied cross-section 
The figure displays the applied timber cross-section with its main calculation parameters. 

 

Figure: Applied cross-section 

- Detailed calculation formulas 
Calculation details and final values are collected by checking types: Combined bending and axial 

tension (Eurocode5: 6.2.3), Combined bending and axial compression (6.1.4, 6.2.4), Combined shear 

and torsion (6.1.7, 6.1.8), Flexural buckling around axis 1 and 2 (6.3.2) and Lateral torsional buckling 

(6.3.3). The proper results are displayed in green, while the red result warnings you to repeat 
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design with new bar properties. The content of the utilization checks depends on Display options. 

Not relevant checks can also be hidden. 

- Summary graph 
Summary graph is displayed with legend by default. Numeric values can be inquired in the 

calculation sections (set by Design calculation parameters). 

 

Figure: Utilization checks, formulas and summary 

 Tabmenu contains the following tools and settings: 

- Selection of element to display 
You can choose a unique or a design group member from the drop-down lists to display its 

detailed results mentioned before. Each row displays the ID and the maximum utilization of a 

member. In case of a design group, “Maximum” means the significant member having the 

maximum utilization. 

- Selection of design load 
Depending on timber design was done for load combinations or load groups, a load 

combination or the maximum or a significant component of load groups can be selected for 

detailed results. Each row displays the name of the load combination/load group component 

and its utilization effect. “Maximum” means the significant load combination or component of 

load groups. 
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- Auto design 
Quick Auto design can be done for the currently displayed unique/group member. Its 

design parameters can be set/modified in the appearing dialog, and then clicking OK 

starts timber design that updates all detailed result figures and formulas. 

- Manual design 
Manual design can be launched directly for the currently displayed unique/group 

member. 

- Display options 
The content and the appearance of the detailed result can be set with Display options. You 

can show only the final equation without details of the different checks (Hide details). 

 

Figure: Display options of Detailed result 

- Go to 
Navigate in the detailed result window by selecting the required design type in the drop-

down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all figures, fomulas and summary table or specified 

details only into Documentation. 

Timber Panel 
Global Auto (timber panel) design (Calculate > Design calculations > Auto design all structural elements) finds 

the most suitable type (from panel type range set at Auto design > Parameters) for all timber panels (plates 

and walls) based on internal forces and detailed utilization calculations. With Manual design you can 

run quick utilization check for given panel types by elements and/or design groups. You can also do 

quick Auto design by elements and design groups only instead of global design. Of course, any number 

of design cycles is executable, so the global Auto design can be combined with both previous and 

additional element-based Auto designs. 

  To define a timber panel (slab or wall) read more at Timber Panel Element. 
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No. Global timber panel design Element-based timber design Combined timber design 

1  Design group  Global Analysis  Design group 

2  Auto design > Parameters  Design group  Design Parameters 

3  Global Auto design  Auto design > Parameters  Global Auto design 

4  Documentation  Auto design by elements  Auto design > Parameters 

5   Manual design by elements  Auto design by elements 

6   Apply design changes  Manual design by elements 

7   Global Check  Apply design changes 

8   Documentation  Global Check 

9    Documentation 

 

Table: Recommended steps by design alternatives 

Auto Design 

Global Auto design gives utilization results and suitable panel type for all timber panels of the 

current project from a defined range of panel types. 

 

Figure: Global Auto design and utilization result 

 The recommended panel type names can be displayed on screen by showing the “Timber panel, 

applied quantity” object layer, or click  Design tool of the Auto design and the parameters 
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together with utilization results are available in table format. Utilization as colored figure (color 

palette) can be displayed by selecting New result > Timber panel > Utilization. 

Applied panel types are displayed in blue in the Utilization table, if they are assigned to the timber 

panels during design, otherwise black color represents the original/initial types. 

Element-based Auto design finds the most suitable type of timber panels for selected unique or 

grouped members only from a range of available types defined by  Parameters. 

 

Figure: Range of available timber panels for design 

To run element-based design for the load combinations or the maximum of load groups, select the 

required members and/or group with the Auto design command and click  Design tool. The quick 

process results recommended panel types and their utilization. Check the Display table box to have a 

look at the overall design results (see before). 

The upper table shows the design efficiency and the maximal utilization of the designed single panel 

element and groups based on internal forces. The bottom table displays the utilization details of the 

panel or the panel members of the group selected in the upper table. 

 Meaning Note 

 Suitable panel is available  

 Suitable panel is not available Modify the range of available 

panels or timber materials 

Group ID of a single panel or a group name  

Design 

parameters 

The defined range of available panels  

Applied type Panel type currently assigned to the 

panel 

 

Max Max. utilization of a single panel or the 

significant member of a group 

 

Min Max. utilization of the less significant 

group member 

 

Panel ID of a single panel or a group member  
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Sx+ / Sy+ Utilization for x/y-directional tension  According to Eurocode 5: 6.2.3 

Sx- / Sy- Utilization for x/y-directional 

compression  

According to Eurocode 5: 6.1.4, 

6.2.4 

Txy Utilization for shear, xy According to Eurocode 5: 6.1.7 

Tx / Ty Utilization for shear, xz /yz According to Eurocode 5: 6.1.7 

Table: The meaning of symbols, design parameters and utilization results 

Quick redesign can be done inside the Utilization table: 

1 Select a panel or a design group in the upper table. 

2 Modify the range of available panel types for the select element under Parameters. 

3 Click Design. 

Manual Design 

With Manual design quick utilization check can be done for given types of selected timber panels 

or their design groups only. Just, choose the load type (load combination or load group) and a 

type name from the drop-down lists and select a panel or panel group, and program displays 

detailed utilization results in table format. 

  The meaning of the utilization components, the table content and features are the same as written 

before at Auto design. The program use the chosen type for all selected panels. 

 

Figure: Quick check by Manual design 

Detailed Result 

Utilization of timber panels can be displayed in the following cases: 

- After global Auto design, you can display utilization of all timber panels checked for the 
recommended panel types. 

- When running element-based Auto design, utilization can be displayed by designed elements. 
- After Manual design, element-based Check displays utilization for selected elements. 
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- After global Check done for all panel elements having final thickness (type). 
 

No. Global Auto design Element-based Auto des. Element-based Check Global Check 

1  Calculate>Design 

calculation>Auto 

design all structural 

elements 

 Auto design  Auto design and/or 

 Manual design 

 Auto design 

and/or 

 Manual design 

2  New result> 

Timber panel 

 New result> 

Timber panel 

 Check  Apply changes 

3    New result> 

Timber panel 

 Calculate>Design 

calculation>Auto 

design all structural 

elements 

4     New result> 

Timber panel 

Table: Steps of displaying timber panel utilization by different design cases 

Utilization displayed with New result appears for all designed panels. The utilization components 

for a panel/design group can be displayed with Detailed result. 

Detailed result opens a new window in the current project after selecting a panel/group member, which 

displays: 

- Applied panel type 
A list displays the applied timber panel type with its main calculation parameters. 

 

Figure: Applied timber panel type 

- Detailed calculation formulas 
Calculation details and final values are collected by checking types: Tension and bending 

(Eurocode5: 6.2.3), Compression and bending (6.1.4, 6.2.4), Shear, xy (6.1.7) and Shear, xz and yz 

(6.1.7). The proper results are displayed in green, while the red result warnings you to repeat 

design with new panel types. The content of the utilization checks depends on Display options. 

Not relevant checks can also be hidden. 

- Summary graph 
Summary graph is displayed with legend by default. 
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Figure: Utilization checks, formulas and summary 

 Tabmenu contains the following tools and settings: 

- Selection of element to display 
You can choose a unique or a design group member from the drop-down lists to display its 

detailed results mentioned before. Each row displays the ID and the maximum utilization of a 

member. In case of a design group, “Maximum” means the significant member having the 

maximum utilization. 

- Selection of design load 
Depending on timber design was done for load combinations or load groups, a load 

combination or the maximum or a significant component of load groups can be selected for 

detailed results. Each row displays the name of the load combination/load group component 

and its utilization effect. “Maximum” means the significant load combination or component of 

load groups. 

- Auto design 
Quick Auto design can be done for the currently displayed unique/group member. Its 

design parameters can be set/modified in the appearing dialog, and then clicking OK 

starts timber design that updates all detailed result figures and formulas. 

- Manual design 
Manual design can be launched directly for the currently displayed unique/group 

member. 
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- Display options 
The content and the appearance of the detailed result can be set with Display options. You 

can show only the final equation without details of the different checks (Hide details). 

 

Figure: Display options of Detailed result 

- Go to 
Navigate in the detailed result window by selecting the required design type in the drop-

down list. It is useful when you are in zoomed view. 

Click Tools > Add view to document to place all figures, fomulas and summary table or specified details 

only into Documentation. 

  

 

 

 



503 

 

 

FOUNDATION DESIGN 
 

Fast check are available to find the most suitable foundation.  

 

In Configuration dialog, the user can set design options, like Design Approach, soil’s Safety Factors, the 

load combination’s Limit state and Settlements parameters. 

 

In Foundation design only Check is available, Manual design or Auto design not. 

In Design approach tab, the user can select the design approach which influences the combination of 

effects. For more details, see Eurocode 1997-1:2006 Chapter 2.4.7.3.4. 

In Safety factor tab, the user can set the safety factors of soil properties, resistance and permanent actions. 

In the Load combination tab, the user can set the limit states for each load combinations according to the 

selected Design approach. 

In the Settlements tab, the user can set for which types of load combinations (quasi-permanent, frequent, 

characteristic) he wants the settlement check to be performed and define the limit values of the relative 

displacements and rotations. For more details, see Eurocode 1997 H Annex. 

Design approaches 

Soil’s safety factors 

Limit state 

definition 

Settlement parameters 
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By  Design calculation parameter command the foundation’s calculation parameters can be set:  
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1. Isolated foundation:  
o settlement limit value 
o preparation method (Cast in-situ or Precast)  

 

2. Wall foundation:   
o settlement limit value 
o maximum distance of calculated sections 

 

3. Foundation slab 
o settlement limit value 

 

o Put additional check points for settlement calculation. These points automatically 
generated at the slab region’s vertices and at the joint of columns and foundation slab. 
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Design calculations can be done by Check command or in Calculation dialog. Under Check command the 

user can check either the objects or display the relative settlements. 

 

For foundation slabs only relative settlements can be calculated with SLS combination. Due to this 

the design calculations for foundation slabs will not run the ULS combinations. 

After displaying the Foundation utilization results, foundation design calculations can be seen by Detailed 

results command. 
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When choosing Display options   the following dialog appears. 

Go to…   command helps the user to navigate in detailed results. 
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PERFORMANCE BASED DESIGN 

Model definition and calculation 

Performance Based Design is implemented in FD 13 according to Turkish code. This way the 

performance level of existing RC buildings can be calculated from linear analysis. To calculate 

Performance level of an existing reinforced concrete building, follow these steps: 

1. Set the code to “Eurocode (Seismic code: Turkish)”. 

2. Build the model in Structure tab. 

 The columns and walls have to be defined from storey to storey. 

3. Add the loads in Loads tab. 

a. Define Gravity load combination. 

b. Define masses from loads in Load case – mass conversion dialog. 

c. Define the Seismic Load properties: 

i. Set the Structure type to Existing building, and also the Information level in 

Structure information tab. 

ii. Define the design spectra in Spectra tab. 

 There are Standard and Unique spectra. Standard spectra are calculated 

according to the current seismic code. In order to define non-standard spectra 

the use the Unique option. 

4. Run analysis in Analysis tab 

a. Calculate Load combinations in Calculation dialog. 

b. Calculate Eigenfrequencies in Calculation dialog. 

c. Calculate Seismic analysis (Equivalent seismic load) in Calculation dialog. 

5. Define reinforcement for RC elements in RC Design tab. 

6. In Performance based design tab 

a. Set the Calculation parameters for beams, columns and walls: 

 

Figure: Setting the calculation parameters 
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• Beams: both ends are Confined and/or Shear strengthened and/or Secondary 

beams 

 
Figure: Calculation parameters for beams 

• Columns / Walls: both ends are Confined and/or Shear strengthened 

 
Figure: Calculation parameters for columns and walls 

b. Start the Performance based design calculation by selecting the Design calculations 

under Calculations dialog. 

 

Figure: Design calculations 

Results 

For Performance based design the following results are available to display and list: 

Results for display: 

▪ Damage mode/zone: 

- By member 

- By member and joints 

- By member and storey drift 
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- By all 

▪ Damage factor 

▪ Relative storey drift ratio 

▪ Performance level 

 

Figure: Display results 

Results to list: 

▪ Input data 

- Beam longitudinal reinforcement 

- Column longitudinal reinforcement 

- Wall longitudinal  reinforcement 

- Beam strirrup reinforcement 

- Column stirrup reinforcement 

- Wall stirrup reinforcement 

▪ Results 

- Beams, fracture mode 

- Beams, damage zone by member 

- Beams, damage zone, summary 

- Strong column check 

- Columns, fracture mode 

- Columns, damage zone by damage factor 

- Columns, damage zone by drift 

- Column-beam joint shear check 

- Columns, damage zone 

- Wall fracture mode 

- Walls, damage zone 
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- Building performance (Fx +Mx, Fx – Mx, -Fx + Mx, -Fx - Mx, Fy+My, Fy-My, -

Fy+My, -Fy-My, summary) 

 

Figure: List results 
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DISPLAY RESULT 
 

Different modes can be used for displaying Analysis and Design results. This chapter summarizes the 

skills and settings of display results on the screen. Of course the result figures can be printed out or can 

be inserted to documents (see Documentation). 

Display Techniques 

Finishing analysis and design calculations, the results are available in the list of the  New result 

command. Just click the command icon and browse from the results available from previously done 

calculations. 

 

Figure: Quick way for displaying results 

Select a result data, then a display technique (Display options) for it, and finally, clicking OK displays the 

result figure based on the default or last-used settings of the applied display technique.  

 Available for 

Display option Bar elements Planar elements 

Graph 
  

Contour Lines  
 

Color Palette 
  

Sections  
 

Table: General display options 
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If display options are not available for the selected result data, it will be displayed in one way. Some 

result types have special display modes. 

 Available for 

Display option Bar elements Planar elements 

Reactions/Connections All type of supports and connections 

Bi-directional results  Principal internal forces, required 

reinforcement shown 

simultaneously in all directions 

Principal directions  Directions of principal internal 

forces  

Crack width  Result of crack width calculation 

(RC Design) 

Punching results  Punching check results (RC Design) 

Table: Special display options 

For bar elements, the currently displayed result (e.g. displacement, internal forces, utilization for 

RC/steel/timber design etc.) can be detailed by selected bar with the  Detailed result command. 

 The scale / color distribution of the current figure can be modified fast with Quick editing tools 

or with the  Display option. 

Graph 
By choosing Graph display option, the result values (e.g. displacement, internal forces etc.) will 

measured and displayed in their calculation point (finite element nodes). 

 

Figure: Displacement of a slab in different views and display modes 
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Figure: Moment and shear diagrams of beam elements 

The settings of the currently displayed graph can be modified with the  Display options tool. 

 

Figure: Display settings of graphs (planar and linear) 

The following options can be modified and set for a graph: 

- Scale factor 

It sets the display scale of the graph (enlarge (>1) or reduce (<1)). Scaling value, which is the 

absolute or relative maximum of the current result type, helps you in setting the scale factor. 

- Reset absolute vs. Reset relative  

Pressing the buttons fits the Scale factor to the absolute or relative maximum of the same type 

results on the current structure. 

- Graph color 

The color of the result and the positive/negative values (available for bar elements only) can be 
set by clicking the “colored line” button and by browsing requested colors from a palette. The 
button shows the actual color set for the displayed graph. 

- Step (available for bar elements only) 

It is the distances between the points in which you can ask and display numeric values. 

 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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Contour Lines 

Contour lines are a set of color lines. Each line connects points having the same result value and displays 

them with one color. It is similar to the contours of a topographical map which connect contiguous 

points of the same altitude. 

 

Figure: Contour lines 

Contour lines display technique is developed to display results of plates, walls, shells etc. Two types of 

contour lines are available: “Continuous” and “Discrete”. 

“Continuous”-type contour lines contain colored line by equal step, while lines can be defined in 

arbitrary distribution with the “Discrete”. You can define as many colors as you want for the contour 

lines. 

 

Figure: Continuous and discrete contour lines 

The distribution and color settings of the currently displayed contour lines can be modified with the 

 Display options tool: 

- “Palette” settings 

 Choose the required contour palette type: continuous or discrete. 
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 The active option displays the meanings of the color (palette symbol) on the screen next 

to the result. Size (%) defined the size of the palette symbol, if it is displayed on screen. 

In case of “Continuous” palette, Step sets the distance between the neighboring contour lines 

and so the color distribution. 

Pen width sets the thickness of the contour lines on the screen. 

- “Value” settings 

 Defining a color and a value in the available numeric field, the Insert option 
inserts a new line into the palette with the given color line and at the given 
value. This option is mainly developed to define the “Discrete” palette. 

 Delete option can be used to remove the unnecessary color line and its value currently 

selected in the palette with its ◄ symbol. It is equivalent with the “drag and drop out” 

of the line with its ◄ symbol. 

 Modify option moves the contour line, which is currently selected in the palette, to the 

given value and/or changes its color with a color set under the option. 

- “View” settings 

 Zoom functions to enlarge or reduce the range of the palette. The last status will 

be used for the palette symbol, if it is displayed by . 

- Reset absolute vs. Reset relative  

Pressing the buttons fits the top and bottom limits of the palette adjust to the absolute or relative 

maximum of the current result. 

Color Palette 
Color palette is a set of colored regions. Each colored regions are represent values in a given interval. It 

is similar to Contour line, but not only the region borders but their inner areas are colored. 

 

Figure: Color palette used for displaying results for planar and bar elements 

 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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Color palette display technique is developed to display results of both planar and bar elements. Two 

types of color palettes are available: “Continuous” and “Discrete”. 

“Continuous”-type contains colored zones by equal step, while the interval of the colored regions can be 

defined in arbitrary distribution with the “Discrete”. You can define as many colors as you want for the 

color palettes. 

 

 

Figure: Continuous and discrete color palette for planar objects 

The distribution and color settings of the currently displayed color palette can be modified with the 

 Display options tool:  

- “Palette” settings 

 Choose the required color palette type: continuous or discrete. 

 The active option displays the meanings of the color (palette symbol) on the screen next 

to the result. Size (%) defined the size of the palette symbol, if it is displayed on screen. 

In case of “Continuous” palette, Step sets the interval of the colored zones and so the color 

distribution. 

- “Value” settings 

 Defining a color and a value in the available numeric field, the Insert option 

inserts a new colored zone into the palette with the given color line and at 

the given bottom value. This option is mainly developed to define the 

“Discrete” palette. 

 Delete option can be used to remove the unnecessary colored zone and its value 

currently selected in the palette with its ◄ symbol of the bottom value. It is equivalent 

with the “drag and drop out” of the zone with the ◄ symbol. 
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 Modify option moves the colored zone, which is currently selected in the palette, to the 

position defined by the given bottom value and/or changes its color with a color set 

under the option. 

- “View” settings 

 Zoom functions to enlarge or reduce the range of the palette. The last status will 

be used for the palette symbol, if it is displayed by . 

 With Scale to view option turned ON, if User hides part of the structure, the 

palette will be rescaled automatically: 

 

 
If the result to be displayed needs wider scaling than the customized has, the program 

overwrites the scaling to the view. 

- Reset absolute vs. Reset relative  

Pressing the buttons fits the top and bottom limits of the palette adjust to the absolute or relative 

maximum of the current result. 

Color palette display mode also gives the possibility to show displacement (=deformed shape) of 

surface/bar elements simultaneously the displayed result shown by color palette. 

 Apply Deformed shape for the color palette of Mx' plate result (Analysis/ Plate internal forces). First 

display Mx' with Color palette, and then open the palette's setting with the  Display options 

tool. Open the Others tab of the color palette dialog, and mark the Display with the deformed shape 

checkbox.  

 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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Figure: Color palette result displayed with deformed shape (planar elements) 

Deformed shape can be also shown together with a color palette result (My’) of bars. 

 

Figure: Color palette result displayed with deformed shape (bar elements) 

 Option to hide finite elements for colour palette results 

To hide the finite elements from the result, click on the  icon. In the pop-up window, Surface, colour 

palette click the Others tab and uncheck the box next to Show finite elements, then click ’OK’. 
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Picture No. 3. shows the result without the finite elements grids. 

  

1. 

2. 

3. 
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Sections 

Results of planar objects, which are able to be shown with Graph mode, can be displayed in given section 

lines. 

 

Figure: Result displayed in sections 

Use the  Define tool to the position of a section line. Just give the start and end point of the new 

section. You can continuously define next points with  for further sections, such as you define a 

polyline; or stop the definition with the mouse button or the  key. 

After defining sections, the program fixes the section positions, so the next result - selected for 

displaying with Sections - will be displayed in the same section lines. For example, you can easily and 

fast check the same parts of a slab, wall etc. for different internal forces, loads or load combinations. 

 Display an analysis result (e.g. Mx’) and one of its derivatives in design (e.g. Required 

reinforcement, bottom, x') in the same section positions. Select the first result type with “Sections” 

display option, and define sections with their start and end points. Choosing the next result (e.g. 

Rqd. Reinforcement, bottom, x’) with  will be displayed in the same positions. 
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Figure: Section positions are stored for next results 

To modify the color and hatch settings of the displayed sections, click  Display options and open the 

settings dialog with the  tool of the Section option.  

Additional sections with the current settings can be added to the view with the  Define tool. 

Unnecessary sections can be removed with the  Delete section tool by just their selection. 

- Scale factor 

It sets the display scale of the sections (enlarge (>1) or reduce (<1)). Scaling value, which is the 

absolute or relative maximum of the current result type, helps you in setting the scale factor. 

- Reset absolute vs. Reset relative  

Pressing the buttons fits the Scale factor to the absolute or relative maximum of the same type 

results on the current structure. 

- Positive/Negative values 

The color of the positive/negative values can be set by clicking the “colored line” button and 

by browsing requested colors from a palette. The buttons show the actual color. 

- Step 

It is the distances between the points in which you can ask and display numeric values and the 

displayed hatch lines. 

- Distribution 

The distribution of the displayed section results can be chosen. Besides the calculated 

distribution it can be linear or constant. 

 This function can be useful at checking the average in-plane shear force between profiled 

panels. 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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Figure: Section settings 

Display displacements 
Displacements can be displayed as graph, contour lines, colour palette or sections. 

1. Select the type of displacement result (translational, rotational) you wish to be displayed. 

2. Select the load case type and the load case. 

3. Click in the display-style of the result under Display options. 

 

The two result types: 
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Display Reaction and Connection Forces 

Reaction and connection forces can be displayed in supports and connection objects by type, by 

component, with group resultants, with the combination of them or the resultants at the middle of the 

support/connection. 

 

Figure: Reaction forces and moments in a Wall and Column support (Plate module) 

 

 

Figure: Reultants of the line support group 
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The color of a reaction/connection force component is represented by the proper direction component 

(x’, y’ or z’) of the support’s/connection’s local coordinate system. The color of the local system axes 

(directions) can be set at Settings > All > Display > Local systems. 

To check and modify the settings of the displayed reaction/connection results, click  Display options. 

 

Figure: Display options of reactions and connection forces 
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Support/Connection types 

First, choose from the available support/connection types (point/line/ surface) you would like to 

display. Of course, the results of all types can be displayed simultaneously. 

Component 

Choose component(s) (force/moment and directions) you would like to display in case of single/group 

support or connection. 

Resultant 

The force (F) and/or moment (M) resultant of group support reactions or connection forces can be 

displayed. Resultants appear with dashed lines on the screen 

 Quick selection buttons let you hide all or show selected components on the 

screen. 

Scale 

It sets the display scale of the result diagrams (enlarge (>1) or reduce (<1)). The scaling value (shown in 

the grey fields), which is the absolute or relative maximum of the current result type, helps you in setting 

the scale factor. Pressing the Reset absolute or Reset relative buttons fits the Scale factor to the absolute or 

relative maximum of the same type results on the current project. 

Distribution  

Different displaying modes can be chosen for line reactions/connection forces: 

- Original 

It displays the calculated result values. 

- Linear 

It displays linear mean value of the result by support/connection element, which is calculated 

by the area-weight method. 

- Constant 

It displays constant mean value of the result by support/connection element, which is 
calculated by the area-weight method. 

- Constant by element 

To solve singularity peaks at line reactions and connections, the program calculates the average 

value (constant mean value) of the reaction and connection forces by element. 

 In this case, you can easily insert numeric values by the constant section (Numeric value 

> Find all local maximum/minimum). 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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Figure: Line reactions displayed with “Constant by element” 

 

Figure: The theory of the average calculation by element (Constant by element) 

 The “uplifted” part of the support/connection is taken into account by displaying the 

distribution of line support reactions and connection forces. 

 

Figure: Reaction distribution on ”Uplifted” connection  
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Bi-Directional Results 

In some cases (e.g. initial forces, reinforcement results etc.) two result components can be displayed 

together, in one diagram. At these results, numerical values are also displayed besides the directions. 

 

 

Figure: Required bottom reinforcement displayed with directions and numeric values 

The color and text settings of the currently displayed bi-directional result can be modified with the  

Display options tool. 

 

Figure: Display settings of bi-directional results 

Principal Directions 

The direction of principal internal forces and stresses can be displayed in two ways: 

- “One size” 

The symbols of the principal directions are shown with uniform-length lines. The symbol line 

of the first principal direction is longer than the second ones. 
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- “Proportional – scale” 

The length of a symbol line represents the size of the principal force/stress. The display scale 

factor can be customized according to the absolute/relative maximum of the result. 

The algebraically larger value will be the first principal value, by default indicated with green 

colour. The algebraically smaller value will be the second principal value, by default indicated 

with red colour. 

 

 

Figure: One-sized or proportional-scaled principal results 

The display type and the colors of the principal directions can be set and modified with the  Display 

options tool. 

Arrows at the ends of the lines are indicating whether the principal stresses are tension (positive) or 

compression (negative). 
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Crack Width 

Crack width results of RC slabs and bars can be displayed with crack lines. The lines represent the 

direction of the cracks, their pen width the size of the crack width and the color represents if the crack 

width exceeds the allowed crack width. 

 

Figure: Crack width of RC slab 

The length, width and color of the crack lines can be modified with the  Display options tool and the 

allowed crack width limit can be set in the Calculation parameters under RC design tab.  
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Figure: Display settings of crack width result 

Design Utilization Results 

Global Auto design and Check calculations give utilization results for planar and bar elements by the 

applied design type. 

Utilization results are colored figures (color palette), and summarize the list of maximum utilizations 

by elements in a table dialog with the help of the Numeric value tool. 

Read more about the utilization results by design type: RC design, Steel design and Timber design. 

 

Figure: RC bar design and utilization result 
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Figure: RC punching design and utilization result 

Detailed 1D Object Result 
Detailed analytical results are available for one-dimensional analytical objects (e.g. bars, line support 

groups and connections) after clicking on  Detailed result tool and by selecting the object.  

 

Figure: Detailed results on a line support and line connection 

In Detailed result window the User can manage the results by selecting the object, the calculation and 

other  calculation dependent  options. 
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Figure: Detailed result window 

The display type, colors and distribution mode of the detailed results can be set and modified with the 

 Display options tool. 

 

Figure: Display result – display options 

- Diagram type 

Common scale displays the same-type result diagrams (e.g. My, Mz and Mt are moment 

diagrams) in common scale. The program automatically sets the scale value to the absolute 

maximum of the current result. 

Scale by figures displays diagrams in their best scale. The scale values, the upper and bottom 

limits will be set by figure according to its own absolute maximum value (e.g. the scales of My 

and Mz differ from each other). 

file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
file://///officesrv/strushare/Ricsi/new%20features/Absolute%23_
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- Positive/Negative values 

The color of the positive/negative values can be set by clicking the “colored line” button and 

by browsing requested colors from a palette. The buttons show the actual color. 

 

- Distribution 

The distribution of the selected result functions can be chosen (calculated, linear, constant or 

constant by element) for line support groups and connections. 

The hatch line dense by the figures is the same with the “display steps” of the original bar result, on 

which the Detailed result tool was used. 

Utilization results with detailed background calculation formulas (together with Eurocode references), 

figures and tables can be displayed by single elements or by design groups. Quick navigation is 

powered with zooming details. Read more about Detailed results by design type: RC design, Steel design, 

Timber design and Foundation design. 

 

Figure: Detailed design result (RC bar design) 

“Absolute” vs. “Relative” Maximum Value 
The Absolute maximum and Relative maximum options of the display settings search the maximum values 

of a result component in all diagrams independently the negative and positive signs. Relative maximum 

finds the maximum value of the current diagram with its absolute value for the current load 

case/combination/group. Absolute maximum finds the maximum value of the same type results (e.g. 

shear force diagrams) with its absolute value for all load cases/combinations/groups. 

Let’s see an example to understand the meaning of “absolute” and “relative” maximum values. 

file:///E:/GTT_munkák/StruSoft%20Kft/2015%20január/UM%20darabok%20Isti/UM_13/foundation%20design.docx
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 Let’s display the Tz shear force diagram of a frame structure in case of two different load 

combinations. The next table summarizes the positive and negative maximum values of both 

diagrams. 

 Maximum values 

Display option Positive  Negative  Relative Absolute 

Load combination 01 9.37 -9.42 9.42 10.20 

Load combination 02 10.20 -8.67 10.20 10.20 

Table: Maximum values of the same-type result diagrams (Tz) 

 

Figure: The values found by Reset absolute/relative 

Automatic minimum and maximum numeric value display 
The program is capable to show automatically the local or 

global minimum and/or maximum values of the 

displayed result. Automatically displayed values will be 

shown in blue, while values displayed by manual query 

remain black. It can be set to show the minimum and/or 

maximum values of all results across all visible objects, or 

local extreme values for visible each object. 
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 Let’s display the my’ moment results of a 3 storey building. The next figures shows the difference 

between showing the automatic results (minumum and maximum) for all visible objects and values 

by object. On the right figure the „by object” option choosed so the the program shows the results 

of the minimum and maximum values of each plates. On the left figure the „for all visible 

objects” option choosed, the displayed results will be the extreme maximum and extreme 

minimum values of all 6 plates. 

  

 When in storey view, ‘All visible objects’ means the objects on that storey 

This is also available for each result (even for analysis detailed results, as shown below) where 

minimum/maximum can be displayed by the Numeric value function. 

The last selected display settings for display automatic values are applied for all the new results, until 

they are modified by the user. 

These settings are kept for the results when 

- they are added to the documentation,  

Minimum/maximum values for 

all visible objects 

Minimum/maximum values by 

object 
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- they are hidden then shown again,  

- the model is recalculated (naturally, only the display settings stay the same – the actual 

numerical values will be refreshed according to the new results). 

 

 

 

Style Templates 
Display settings (scale, colors, steps etc.) can be stored in files (so-called styles) by display technique or 

by figure. The saving and the loading facilities can be reached at the  Display options tool. The styles 

are stored in files with different file extensions by display technique. The files can be swapped between 

users, so companies can create standard display setting for their own documentation style. 

- Save as default 

It saves the current display settings as the default (without 

file name!) settings of the applied display technique. If you 

do not use a style (see later), the program always offer the 

last saved default settings when you apply the same 

technique inside one example or in further ones. 

- Load default 

It restores the default display settings after any change. 

- Save 

The color settings of the current dialog can be saved as a 

style in a template file. The file extension depends on the 

current display technique. 

- Save with scale 

All display settings (scale, steps, colors etc.) of the current 

dialog can be saved as a named style in a template file. 

- Load 

User-defined styles can be loaded from a file browser. 

 The following example helps in understanding the difference between Save and Save with scale 

after loading styles created by them. The color palette settings of an Mx internal force diagram 

was saved with Save and Save with scale. The figure shows the settings of My also displayed with 

color palette after loading (Load) the two saved styles. After loading “Save”-style, the palette 

contains the same colors but the scale is optimized for My values. Loading “Save with scale”-style 

results the same scale together with the same color information with Mx. 
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Figure: Save vs. Save with scale 

Numeric Values 
Tool Tip 

Rolling your mouse over a result picture will display the numeric value in the current position and in 

the proper metrical unit as a tool tip. Tool tip works for all types of display techniques. 

 

 

Figure: Numeric value displayed by tool tip 

Value Labeling 

Result diagrams can be completed by displaying the calculated numeric values. Use the  Numeric 

value tool to add labels to the currently displayed result figure. 
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Figure: Tool palettes of Numeric value 

Depending on the currently displayed result figure and the object type – you would like to ask numeric 

values – the tool palette of Numeric value contains different definition tools. With the  Define tool, 

new value labels can be placed on the current figure. 

The color of the numeric values can be set with the “Current color” button of the Status bar. Of course, 

you can place values with different colors on a result figure. For example the maximum values can be 

displayed in red while the others with black. 

Set the text settings of the numeric values at  Default settings. 

 

Figure: Numeric value settings 

 

The next figures give examples for the tools of Numeric value. 

Use  Select to place numeric values in clicking points of the displayed result. With  tool, result 

maximum, minimum and absolute maximum/minimum can be found for selected object(s). With  

tool, all result limits (maximum and/or minimum) can be displayed for selected object(s). 
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Figure: Arbitrary and maximum values (bar displacement) 

 

Figure: Arbitrary and maximum values (plate internal forces) 
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Figure: Display numeric values (with Select) on a Contour palette result 

In case of bar displacement, points can be selected for displaying numeric values on bars (Original shape) 

or on the deformed shape of the bars. 

 

Figure: Numeric values displayed on the original and deformed shapes 
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Bar displacement can be asked with its real size (Vector size) or by its component (parallel with the 

global/local x’/y’ or a given direction). 

 

Figure: Numeric values by displacement component 

The display settings of predefined numeric values can be modified by the  Properties tool. 

The position of the text labels can be modified independently from their insertion (clicking) point with 

Move (Edit menu). 

Editing Results 

 The settings of the currently displayed result can be modified with the Display options tool any 

time. The content of the setting possibilities (colors, scale, palettes etc.) depends on the display 

technique used for the visible result. 

Above Display options, quick change tools give fast and real-time modification in 

scale/color distribution (step) of the current result figure and in size and decimal 

numbers of displayed numeric values. Quick change tools work for all type of 

display techniques. The next figures show some examples. 

 

Figure: Modifying diagram scale 
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Scale increases/decreases the scale (e.g. graph, section) or the step distribution (e.g. contour lines, color 

palette) of the currently displayed result figure with 10% percent. Use the “+” or “–“ key of the 

keyboard’s numeric pad as the fast key of Increase scale or Reduce scale. 

The numeric values are refreshed automatically when the display options of a result are modified. 

 

Figure: Modifying the text size of numeric values 

Font size modifies the font size of the numeric values with 10% of the initial size. 

 

Figure: Modifying the decimal numbers of numeric values 

Browsing Results 
A one-click browser (Quick selection) is developed for changing between result figures displayed earlier 

on the screen. By clicking on “▼” symbol next to  Select result, a list appears with titles of results 

displayed so far. Just click on the result you wish to display again. The content of the list can be 

organized with Select result: hide current figure or delete items. 
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Figure: Quick or dialog browsing among previously displayed results 

Animation 

 The currently displayed results can be animated with the Animate result tool. Not only for bar 

results (such as dynamic and stability results, displacement, internal force/stress diagrams etc.), 

but all result display types of planar elements (such as displacement, internal forces, RC results, 

utilizations etc.) can be animated. That means graph points are moving, the colors and color 

intervals are pulsing etc. Clicking Animate result starts the animation after some seconds 

(depending on the model size) by continuously displaying the linear interpolation statuses 

between the initial and the final states of the current result figure. Press any key or click by mouse 

the stop animation. 

 

Figure: Animation of a frame displacement 
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Moving load results 
Special results can be displayed for Moving loads, described below. 

Moving load maximum 

Moving load maximum is similar to Maximum of load combinations. It shows the maximum values of 

the selected result in all points of the model, under the effects of a Moving Load. User can change the 

Load combination and the Moving load of which results he or she wants to display. 
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Moving load influence line 

The Moving load influence line shows how the value of the selected result changes in a user-defined 

point of an object, while the Vehicle moves along the path. 

User can define it with the following steps: 
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The results are displayed similarly to the one in the figure below: 

 

 Since Moving loads are based on singular load cases, these result values are exact only in the 
Vehicle positions. The other points of the curve show approximate values. Accuracy can be increased 
by defining more Vehicle positions, however, it increases calculation time, too. 

Moving load’s cases 

Although Moving loads are based on singular load cases, they are managed differently than regular 
load cases. It is possible to create an animated result for a Moving load. The figure below shows the 
method: 
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The animation displays the changing of the selected result while the Vehicle moves along the path. 

The next figure describes the new Moving load’s cases dialog: 

 

Animate result button in the Moving load’s cases dialog has a different effect than the regular 
Animate result button in the Analysis and the Design tabs. 
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DOCUMENTATION 
 

This chapter summarizes the documentation possibilities of FEM-Design projects, models and results. 

It introduces the printing and listing (summary tables) functions and the automatic documentation 

based on templates (Documentation module). 

Printing 

 The full content or a selection part of the screen (Drawing area) can be printed out with the Plot 

command (File menu). Just click with  to send the entire screen to print preview, or define a 

selection box with  to set it content as the plotting input. 

 

Figure: Plotting screen (entire or selected part) 

The printing settings are the following: 

- Settings dialog style 

With Dialog and Preview buttons you can switch between the dialog box and the full screen 
mode of the plotting settings. 

- Printer setup 

The goal printer can be chosen from the available (installed or network) printers and plotters. 

PDF creator (not included by default) can be also set here to save the screen content as PDF. The 

printer or PDF settings are available at Properties. 

- Page setup 
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The size of the paper and the margins together with the paper orientation can be set here in a 

separate dialog. Title label can be added to the print area. Check the box “Info label” to add title 

label to the bottom right corner of the print area. Set the page number and set the text size and 

the width of the label at Setup. The label contains custom text set by Settings > Title and autotext 

such as the file name and date modified. 

 

Figure: Title label as header 

 If you would like to print out only the content of the Title, place it on the drawing area 

with Draw > Title information table, add it to the print area selection and inactivate the 

Info label option at Page setup. 
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Figure: Title label as drawing element 

- Color print 

Switch between grayscale and color (seen on screen) printing. 

- Pen simulation 

Different pen width values can be assigned to colors at Setup. 

- Print border 

Rectangle border fit to paper margins (Page setup) can be shown and set for printing out. 

- Print only selected area 

If this check box is active, only the selected area (in case of selection) will be printed otherwise 

the its environment (the whole content of the drawing area). 
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Figure: Printing selection 

- Scale 

Set the printing scale manually or select one from the list. Dashed border marks objects 

(selection size) to print and helps in setting the scale. Fit scale to margins option sets the biggest 

scale of the selected print area according to the paper size, margins and the origin (see later). Fit 

text size to scale option sets the scale of the texts according to the drawing scale (1:?) or keeps the 

original size of the text in case of its inactive status. 



553 

 

 

Figure: Printing text size 

- Origin 

The position of the selected printing area can be set with its distance from the origin. Horizontal 

defines the distance of the bottom-left corner of the printing area from the left margin and 

Vertical sets the distance of the bottom-left of the printing area from the bottom margin. Center 

buttons fit the printing area to the middle of the page area bordered by the margins. The 

printing area can be dragged by the mouse also on the symbolic white page. 
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Figure: Printing area position 

- Simple preview 

It is generally a problem to plot big models; setting the final position of drawings on the paper 

takes time. By activating Simple preview, the program shows only the frame of the selected 

printing area to reduce the generation time of the drawing when setting its position (Origin) 

and Scale. 

 

Figure: Simple preview of the printing area 

- Save as default 
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It saves the paper and color printing settings as the default plotting settings for later use and 

next projects. 

Click Print to start printing. A small dialog appears, in which you may cancel/stop printing. 

Quantity Estimation 

 Just one click on Quantity estimation (Tools menu), and a fast process collects all structural elements 

of the current project and lists their materials, identifiers, main geometric parameters (e.g. 

profiles/thickness), quantities, reinforcement diameter etc. 

 

Figure: Quantity estimation 

  Reinforcement quantities are displayed after RC design only. 

Categorization by priorities and summary by certain properties are also available in the quantity 

estimation tables (Options). 
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Figure: Categorization and summary features 

The currently displayed table can be attached to  Documentation by clicking Add to documentation. 

The results of quantity estimation can be printed out directly as tables with the List option. (Other 

summary tables such as structural, load, finite element input and analysis/design result outputs of the 

current project can be also listed here. You may also use the  List command of the Tools menu any 

time.) 

 

Figure: Listing quantity estimation results 
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Listing 
All tables of input and output data can be collected and printed out. 

After launching the List   command, the User can select the required objects – using Filter and/or 

common graphical selection methods - before the List tables dialog appears. The whole database can be 

listed by pressing  button. Selection can be carried out in the List tables dialog as well using the 

drop-down menu in the top right corner. The User can choose the followings: 

• All (all objects of the model), 

• Current selection (objects selected before List tables appeared; this option is not available when 

all objects were selected (by pressing Enter) after launching the List command), 

• Visible objects (objects visible in the Application window), 

• User defined filter (objects belonging to pre-defined filters). 

Listed data depend on the selected objects. By ticking ‘Hide irrelevant tables’ check box those tables 

which are irrelevant by the current selection disappear (otherwise they are shown in grey). 

 

Figure: List tables dialog 

Further options are available in List tables dialog: 
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- Format table…: The table settings can be set for all export modes at Format Table...: 

 

 

Figure: Customizable table settings 

The following properties can be set: 

- a common text style (font type and size) for table titles, text and values; 

- the unit of the values by element type (Length, Force, Displacement etc.); 

- the column width that can be defined by the Width option or by stretching the right side of the 

selected column with mouse; 
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- decimal number of numeric data; and 

- scientific form of numeric data. 

 

• At Options (depending on the data type), the calculation points (nodes) can be set where you 

would like to ask and list (result) values. 

• Settings> stores the current list settings as the default settings for later use and next projects or 

previously saved defaults can be loaded. 

• With Add to batch option the selected data can be added to Batch list (see later). 

 

In ‘Send to…’ drop-down menu the destination of the listed tables can be set. These are the followings: 

 

Figure: Listing procedure and modes 

- Clipboard 

Clicking List data sends the table of the selected item to the Microsoft Office Clipboard, which 

allows you to copy the table and text items from FEM-Design and paste them into another 

document such as Microsoft Excel, Word etc. 
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- Printer 

List data sends the selected data table directly to the printer according to Page 

and Printer setup. Page setup offers the same possibilities mentioned at Printing. 

 

 

 

- Documentation (listed tables appear in the documentation), 

- Excel file (listed tables can be exported to an Excel file) 

 

In List to Excel dialog besides the File path also a Template path can be set if the User has a pre-defined 

Excel-template (with .xltx, .xlt, or .xltm extension). The created Excel file can be opened 

immediately by ticking ‘Open file in Excel’ checkbox. 

 Listing without a template file: creates an Excel file in which all the tables are located 

on separate spreadsheets. 

 Listing with a template file: the User can create a template in which the locations of the 

required tables in the spreadsheet are marked with ‘$$’ followed by the exact title of 

the table. Using a template allows the User to gain exactly the required data. 
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Template file: 

 

Template-based exported file: 

 

After listing to Excel without any template and examining the number of columns belonging to a 

table, it is easier to create a template. 

2 batch files + 2 templates are delivered with the program (FDSteelFrame, FDRCStruct). 

To avoid the time-consuming procedure of selecting the tables for listing one by one Batch is 

implemented for the tables which can be saved and reloaded, even in different models. This way 

all the required tables can be listed by a few click. Tables can be added to the Batch by selecting 

the tables in the “Data” window and clicking on Add to batch button.  
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The following options can be done with the batch: 

• Delete tables (selected data will be deleted), 

• Save batch (the batch can be saved to a batch script file with .bsc extension), 

• Load batch (the saved batches can be loaded and used in other models; those tables which are 

not relevant in other models are displayed in grey), 

• List batch (all tables in batch window will be listed in accordance with the settings of ‘List 

objects…’ and ‘Send to…’ drop-down menus. 

The batch window and options can be hidden by clicking on <Hide batch button.  

In batch window more data can be selected by holding  pressed or with the help of  and 

buttons.  

In a listed batch the order of the tables is the same as in the batch window. The order of the tables 

in batch window can be rearranged with  pressed and using . 

A saved batch file with load cases (or load combinations, stability analysis etc.) can be used in other 

models when the names of the load cases (or load combinations, stability analysis etc.) are the 

same due to that the identification is based on the name. If all load cases (or load combinations, 
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stability analysis etc.) are selected in the batch window and the batch file is loaded in another 

model, all the load cases (or load combinations, stability analysis etc.) of the other model will be 

taken into account. 

Documentation Module 
Although the Plot and List commands give quick report data possibilities, you can create multi-page 

documentation with the Documentation module. Titles, figures, texts, tables, images, headers, footers, 

table of content etc. can be placed in custom style into the complete documentation. Documentation 

module can be run in all FEM-Design modules (depending on your license). 

Click  to enter Documentation mode. 

 

Figure: Starting Document module 

The next chapters introduce the possibilities and the proposed steps for defining complete set of design 

documentation. 

Main Commands 

The commands and their functions: 

 

Figure: Documentation tools 

- Section 

 Section defines documentation parts having different properties (=“sections”) such as page size, 

orientation, margin sizes and associated printer. 
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 Define a section for the cover page with a color image as A4 page size and with a color 

associated printer, and another section for the other pages as A3 size and with grey-scale 

printer for texts and figures with black lines. 

- Title block 

This is a command for creating and registering new labels, headers, footers and frames, and for 

inserting stored title templates into the document from the built-in or user-defined title block library. 

You can apply drawing and auto text tools to design your private label, title and frame style and 

then register it with  Title block command for current and future use. 

- Table of contents 

It inserts a table of contents into the current document. It contains the list of chapters (see the next 

command) and their page numbers. If you define a new chapter or make modifications, the program 

refreshes this list. 

- Chapter 

Titles of main and sub-chapters can be inserted into the document with item numbers and names. 

- Page break 

Defining a page break generates a new page with the same properties of the current section. 

- Graphical window 

The command lets you to insert (working) windows in which you can display different figures 

(geometry, loads, mesh, analysis and design results, etc.) into the current document. 

 A window object defined by  Graphical window is not a static figure with constant and 

fixed content. It is a working window, where you can use the layer systems, display settings 

and view commands (zoom and rotate operations, plane, side and space views, shade and 

wireframe display modes, etc.) to set the required appearance of the model, the loads, the 

supports, the results, etc. 

- Table 

It inserts tables of input and output data (e.g. list of load cases and load combinations). The function 

and the table settings are similar with the possibilities of the List command. 

- Draw box 

The tool inserts a working window into the document where you can create your own drawing with 

the commands of the Draw and Edit menus. Drawing layer-system is also available in a  Draw 

box. 

- Text box 

It is a simple word processor for creating texts, notes into the document. The size of the text box, the 

font styles and text alignment can be set manually. 

- Image 
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Image files (e.g. jpg, bmp etc.) can be inserted to the document with this command. 

Control Panel 
The control panel enables you to easy move between different parts of the current document, to set the 

properties of the inserted objects, and to print and create templates for further documentation. 

 

- (Documentation map) 

The list contains the defined title boxes, sections, graphic boxes, images, 

drawings and texts (hereafter called “objects”). You can activate the 

selected list object by double clicking on its name. 

In order to speed up work in Documentation, Sections can be 

hidden/shown by clicking the checkbox next to the section’s name. 

The hidden sections are not locked thus, they can be cut, copied, pasted, 

moved, dropped or modified. If an active section is moved into a hidden 

one, both sections will be hidden and vice versa. 

 

It is possible to select more sections to hide at one go. Uncheck 

an active checkbox, all the selected sections will turn off. Check 

an inactive one, they will all be shown. 

 

- Navigation 

You can navigate between pages by  Page up,  Page down,  

Home and  End buttons. Clicking  Go to switches to the object 

selected in the list (the same as double clicking the selected object in the 

List).  

 

Titles added to documentation elements provide easy navigation through 

defined text boxes and figures (Graphical window, Image and Draw box). 

- Items 

With Cut, Copy and Paste tools you can modify the position of selected list 

items (multi-selection also works by using the mouse together with  

and/or  keys). You can move a selected list object into a new position 

by holding down the  key and moving the mouse into the required row 

of the list. To erase one or more selected objects click on Delete. With 

Properties the settings (sizes, styles, contents, etc.) of the selected object can 

be modified. The variability of objects depends on the type of object 

(drawing, text, image, section, etc.). 

- Document 

With Reset, you can delete all contents of the current documentation and 

“open” a new, empty document with the default settings. At Templates you 
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can save the current document structure and settings under a name as a 

template. You can also load a predefined one to create fast documentation 

of your current project (see later Templates). The Print command lets you 

print out the whole document or a part of it. With Save as .docx button the 

whole documentation can be exported to an Office OpenXML (.docx) file. 

Steps to Create Your Own Documentation 

This chapter shows the proposed steps of document creation via an easy example (in Plate module). 

 For a faster documentation process, we recommend that you start documentation after finishing 

model generation and calculations and not before them. 

1. Document title 

Set the main properties of the document by selecting Untitled in the list and click on Properties at 

Items. Give a name for your document (in Title) and set the font settings by chapter orders (levels). 

Under Utilities you can save the settings as default or as a named style, so you can then load styles 

for future projects. 

 

Figure: Document title 

2. Cover page (Text box and Image - Section 1.) 

Set the properties of Section 1. by activating it in the list and by clicking on Properties. 
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Figure: Cover page 

- Set the paper size and orientation (e.g. A4 and portrait). 

- Choose a printer for the current section. You can set different printers, plotters and PDF creators 
per sections. It is very typical that the text parts are wanted to print as A4 and the figures etc. 
as A3, etc. 

- Set the margin, from which the texts, figures, images, etc. will start. For example, the main title 
will start 60mm from the top of the page.  

Write the title of the document on the first page with  Text box. The text will start from the upper 

margin. 
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Figure: Cover page with title 

 

Also a subtitle can be created by re-running  Text box. 

 Empty rows and new lines can be defined with the  +  key-combination. 

Place an image file (e.g. a picture about the model) with the  Image command. To open an image 

file, browse for it at > option of File name. Set the position of the picture from the side margins at 

Alignment. At Size you can define arbitrary size or special size (Page width/ Full page) by choosing 

from the list under > symbol. Apply Preserve ratio to avoid figures from distortion during size 

definition. 
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Figure: Cover image 

 The settings for an inserted object (text box, image, etc.) may be modified by selecting it in the 

list and by pressing on the Properties option. It works the same as with the initial dialog of the 

object. 

3. Table of contents (Section 2.) 

Create a new section (leave your selection on the last item (here the image)) with  Section and 

set the value of the top margin, which the table of content will start from (e.g. 30mm). Click on  

Table of contents command and an empty “table” appears on the Section 2 page. The table will be 

refilled automatically when defining chapters. 

 

Figure: Inserted (empty) table of contents 

4. Header and footer (Title block - Section 3.) 

Create a new section (leave your selection on the last item (here “Table of contents”)) with  

Section and set top and bottom margin values that define the available area for further text, figures 

and tables (30mm in this example). Use the commands from the Draw menu to prepare the 

appearance (frames and texts) of headers and footers. Apply e.g. Line and Field commands (Auto-

text). 
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Figure: Header/footer defined by Line and Field commands 

 Where you see “?” symbol at an auto-text, the content can be defined at Settings > Title. 

After finishing drawing, use the Register tool of  Title block to save your “header and footer” as 

built-in label parts. Type an identifier (“header&footer” in this example) for the title in Name field, 

select the lines and texts by window selection and give an insertion point (bottom left corner of the 

page in this example). 

 

Figure: Header/footer defined by Line and Field commands 

After registration, delete the drawings and text from the document by Erase (Edit menu)! 
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Insert the defined and registered title block into the document with the Insert tool of  Title block. 

Choose the saved “header&footer” from the Name list, and then place the insertion point of the 

selected title block on the bottom left corner of the page. As result, the “header&footer” will be 

repeated on every page in the current section (Section 3.). 

 

Figure: Insertion of title block (header & footer) 

5. Chapters (Section 3.) 

Place your first chapter with the  Chapter command. Give a name in Title field for the current 

chapter (“Geometry” in this example). 

 

Figure: Insertion of chapter 

For further chapters the program offers alternative numbering systems for the next main chapter 

(“2”) or subchapter (“1.1”). It depends on which button is active:  Increase indent or  

Decrease indent. 

6. Figures (Graphical window - Section 3.) 

In a chapter you may insert text (see Text box), images (see Image) and figures of the model geometry, 

loads, results, etc. In this example, first place a figure about the model geometry (plates and 

supports). Click  Graphical window, choose Structure-type and set the display parameters of the 

image in the appeared dialogue box. You may give a name to the figure for displaying it (Display 

title, “Plane view”). A “1m scale bar” can be displayed inside the figure with Display scale. The size 

of the window can be set with a width and a height value or by choosing predefined sizes under > 

(Page width/Full page). The required figure position can be defined by activating one of the buttons 

for Alignment (“centre” in this example). The position of the title is the same as the activated 

Alignment of the window. Clicking OK inserts the new figure into the document. 
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Figure: Insertion of figure 

Other graphical windows can be defined by repeating the previous step. For example, place a side 

view of the structure, etc. 

Clicking the window area activates it as a working window, so you can modify the view and position 

of the window content. Black thick frame shows what graphical window is the active. 

 For example, clicking the Structure-type graphical window, the display settings (Settings 

menu), the view commands (View menu) and the layer system (Current layer) may be used; but 

at an Analysis (result)-type graphical window, you can browse from results (New result and 

Select result), displaying numeric values (Numeric value). 

 

Figure: Available tools depend on the graphical window type 

 Each graphical window has its own layer system, main and display settings. FEM-Design 

also gives the possibility to define different units for displaying geometry and various 

results. 

Click the white paper (outside from the active graphical window) to return back documentation. 
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Repeat the previous steps to define more chapters (2. Supports, 3. Loads, 3.1 Load cases, 3.2 Load 

combinations, etc.), and to place new figures (such as loads with a Loads-type graphical window). 

 There is no facility to set distances between texts, chapter title rows and figures, but with 

 Text box command you can insert empty lines between objects into the document. 

Another way to insert figures is, that the current model view can be placed onto the last page 

of documentation with the  Add view to document command (Tool menu). Of course, the 

settings of the new graphical window can be modified later with the Properties tool of 

Documentation. 

 

Figure: Quick export of current view as a figure into documentation 

7. Tables (Section 3.) 

Input and output data as tables can be added to the document with the  Table command. The 

functions and tools of Table are same as described at List. Choose data to print out as a table from 

the available Tables, Data and Result lists. In this example, place a summarization table of load 

combinations (under chapter 3.2: Load combinations). First select Load combinations in Data list 

(Tables/ Loads), second set the table settings at Table and Options, and finally click on List data. As a 

result the selected table appears after the current documentation object. 
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Figure: Insert table to documentation 

8. Result figures (Graphical window - Section 3.) 

To document result figures, use  Graphical window and select Analysis-, RC design- , Steel design- 

or Timber design (depending on the available calculation type and what result you would like to 

display). After insertion, click inside the graphical window and choose result types with New result 

and/or Select result. 

Templates and Automatic Documentation 

The documentation structure (cover, chapters, text and window positions) defined in Documentation 

module can be saved under a file name (.DSC) as a template for further projects. Click Control Panel’s 

Templates > Save as tool. 

The program automatically generates your complete documentation, if you apply a previously defined 

or built-in template. Use Templates > Apply when entering to Documentation mode after modeling and 

calculate a new project, and the program automatically generates complete documentation by 

refreshing based on the applied template (it updates the title label, table of content, page numbers, 

figures and tables etc. of the template).  

 A pictures inserted by Image are deleted in a new template! 

If you load a template into a document having no calculated results, the Analysis, RC design or 

Steel design-type graphical windows contain only the structure, but they will be refreshed any 

time you have calculations. 

The Templates can be appended into the Documentation by Templates >/Append… command. Items of 

the appended templates will be inserted after the last existing document item.  



575 

 

 

If an applied template generates documentation with tables having no valid values, the empty tables can 

be hidden. Select the title of the document (first row) in the Control panel, then click Properties and 

inactivate the “Display empty tables” option in the dialogue that pops up. 

 

 

Figure: Empty tables hidden by Properties 

The documentation can be exported to Office OpenXML (docx). For further information check the 

following link: http://download.strusoft.com/FEM-Design/inst150x/savetodocxfaq.pdf 

Printing 

The completed document or only some parts of it can be printed out with Control Panel’s Print tool or 

File > Print document.  

 

 

Figure: Printing setup 

http://download.strusoft.com/FEM-Design/inst150x/savetodocxfaq.pdf
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Set the Page rage as: 

- All 

The whole document (all pages from start to end) will be printed out. 

- Selection 

The objects selected in the Control panel (multi-selection also works) and their pages will be 

printed out. 

- Pages 

This provides the possibility for printing by defined page. Enter page number and/or page 

ranges by separating with commas and by using “-“ (an example: 1,10,15-20,25, etc.). 

 The printing process requires associated printer(s) by the sections of the current documentation. 

If a section has not got a defined printer (Undefined), you can add one by selecting the section 

name in the document list and by using the Properties tool (Change option). 

 

 

Figure: Printer assigned to Section 

 If you assign a PDF creator program to all sections, you can save your documentation as a PDF 

file. 

Export to .docx format 

It  is possible to export the Documentation and any Detailed result to Office OpenXML (.docx) file. 

In the Documentation module this feature can be accessed by the “Save as .docx” button at the bottom 

right corner of the Control panel. 
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To export data from the Detailed result window use the File > Export to > Export to Office OpenXML 

(.docx) document command or directly the File > Export to Office OpenXML (.docx) document command 

where it is available. 

 

In both cases the “Save as Office open XML (docx) document” dialog appears, where User can decide 

the followings: 

• where to save the result file 

• which MS Office Word template file to use for the convention (optional) 

• whether to mark the Documentation Sections in comments or not (only in Documentation 
module) 

The used template files must be based on the original template file My Documents\FEM-Design 

document templates\template for fem-design document templates.dotx, as this file contains the style required 

for the exportation. 

 

MS Office Word 2007 or newer is required for opening files with .docx distribution 
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It is highly recommended to mark the documentation sections in the exported file, since the page 

rendering in MS Word and in FEM-Design are different. Furthermore, the exported document has A4 

format pages. Therefore, if there are pages in the FD Documentation with different size, it is easier to 

find them and change their size in the result .docx file with section marks. 

Using own Word templates is useful when the FD Documentation contains Title block, since it is not 

possible to export it to .docx. As an alternative, User can create a Word template with custom headers 

and footers, and use it for the exportation. 

Since MS Word has more sophisticated solutions for creating the table of contents, FEM-Design 

does not export it to the .docx document. However, chapters are exported, therefore table of contents 

can be created in MS Word easily. 

An example of the exported Detailed result can be seen in the following figure: 

 

More information and useful hint can be found in the Docx FAQ. 
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Export to Mathcad and to XHTML 

User can export Detailed results to .xmcd (Mathcad 15) and to .html (XHTML with MathML). This 

opportunities can be accessed in the Detailed Result window’s File > Export to menu. The .html 

exportation is available for the detailed results of all Designs, while the .xmcd is for Steel and Timber 

design. 

 

The exported .html file can be displayed properly only in web browsers supporting MathML. 

Currently: Firefox 38 or higher, Safari 8 and 9, iOS Safari 8.4 or higher. 
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The result of the XHTML exportation is a .html file and also a folder, which contains elements of the 

html page. 

 

The result of the exportation to Mathcad is a single .xmcd file, which is fully editable in Matchcad 15. 

 

Mathcad 15 M20 version is required to open the .xmcd file. 
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DRAWING AND EDITING TOOLS 
 

Although FEM-Design is an analysis and design application, CAD drawing can be also done with its 

built-in drawing tools. Editing tools also available to edit, modify and multiply both structural and 

drawing elements. Drawings can be the draft of the later design model, but you may also export them 

in the popular DWG and DXF formats. 

Drawing tools are grouped in the Draw menu, but they are directly available from the list appears when 

clicking  key together with . 

Editing tools are grouped in the Edit menu, but they are directly available from the list appears when 

clicking . 

 

Figure: Drawing and editing tools 

Draw Menu Commands 
The following rules are valid for the drawing commands and elements: 

- Drawing elements are placed and stored in Drawing layers. 

- The color of the current drawing layer is the default drawing color. Under “Current color” 
button of Status bar, you can customize the drawing color independently from the host layer’s 
color. 

- The style of the drawing lines and edges can be set with “Current style”. 

- Drawing and text styles together with display settings of drawing elements are available at 
Settings.  
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- Although, you may draw in 3D, in most cases, it is recommended to set the user coordinate-
system in the drawing plane. 

- To define drawing points, type coordinate and angle values in the Command line and/or Co-

ordinate box or use the Object snap tools to pick requested special points. 

- Command line guides you with the steps of drawing element definition. 

The next table summarizes the available drawing tools, their functions and definition steps. 

Command Description Definition modes 

 Point 
Defines a point based on the 

current drawing settings. 

- 

 Line 
Defines a line or connected lines 

(open, closed and/or polyline) 

based on the current drawing 

settings. 

Definition of start- and endpoints 

 Rectangle 
Defines a rectangle (closed 

contour) based on the current 

drawing settings. 

Definition of two opposite corners 

 Arc 
Defines a circular arc based on the 

current drawing settings. 
 Arc by center, radius and angle 

 Arc by 3 points 

 Arc by start, end point and tangent 

 Circle 
Defines a circle arc based on the 

current drawing settings. 
 Circle by center and radius 

 Circle by diameter 

 Circle by 3 points 

 Region 
Defines a drawing region with 

arbitrary shape. Also holes can be 

added to the region. 

 Rectangular 

 Circular 

 Polygonal 

Pick lines (close contour) 

 Solid 
Defines prismatic, centric, sphere, 

regular and general 3D solid 

surface. Generic solid can be 

generated with the help of 

arbitrary shapes and directrix. 

Solids can be also cutted in their 

heights. 

 Prismatic 

-  Rectangular base (brick/cube) 

-  Circular base (cylinder) 

-  Polygonal base (prism) 

-  Pick lines (arbitrary base) 

-  Pick existing region (arbitrary base) 
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Centric 

-  Rectangular base (pyramid) 

-  Circular base (cone) 

-  Polygonal base 

-  Pick lines (arbitrary base) 

-  Pick existing region (arbitrary base) 

 Sphere 

-  Sphere 

-  Segment of sphere 

 Regular 

-  Tetrahedron 

-  Cube 

-  Octahedron 

-  Dodecahedron 

-  Icosahedron 

 General (arbitrary shape with directrix) 

 Text 
Defines arbitrary text in custom 

style and any direction. 

-  

 Field 
Places autotext in custom style 

and any direction. 

- 

 Dimension 
Defines length, angle and level 

dimensions in custom style. 
 Linear (Length) 

 Arc 

 Diameter 

 Radius 

 Angle 

 Level dimension 

 Title information table 
Places a table that displays title 

Information of the current project. 

The content of the table can be set 

by Settings > Title. The width of 

the information table is defined by 

- 
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the text size and style (Settings> 

Text). Table is placed in the Title 

information object layer. Layer 

color defines the table color too. 

Table: Draw menu tools 

The following chapters give more details for some drawing items. 

Solids 
This chapter shows some example for available solid geometries and introduces how general solids can 

be defined with the help of shape contour and directrix. 

  There are no real curved surfaces in 3D modeling, so the program approximates the curved 

surfaces with polygonal planes. The value of approximation can be set by the Refracting angle 

option (Primary/Secondary). The next figure shows the meaning of refracting angle values for a 

double-curved surface (defined by  General). 

 

Figure: Curved surface approximation 
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Figure: Some examples for prismatic solids with definition steps 

 

Figure: Full or truncated pyramid (Centric solid) 
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Figure: Some examples for centric solids with definition steps 

 

Figure: Spheres defined in different coordinate-systems 
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Figure: Half and truncated spheres 

 

Figure: Octa-, dodeca- and icosahedron 

With General tool, general 3D solids can be defined with a directrix and a generation line (builds up the 

surface of the solid). Both of them can be a closed contour line or an arbitrary line (it can be also closed), 

but one by one. The only rule is that they must touch each other. Five tools can be used for defining the 

contour geometry and other five ones for defining the line geometry. The function of the contour line 

or the arbitrary line can be set with the Directrix is contour line (and the generation line is the arbitrary 

line) or the Directrix is line (and the generation line is the contour line) tools. The final shape of the solid 

depends on the Perpendicular and Constant options that define how (in what angle) the generation line 

will be transformed around the directrix: 

- Perpendicular: the solid sections having the same shape with the generation line will be 
perpendicular to the directrix in its all points. 

- Constant: the solid sections (inner surfaces) will be parallel with the generation line along the 
directrix. 
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Figure: Different combinations of directrix and generation line 

 

 

Figure: Both directrix and generation line are closed contours 

Text and Field 

Custom (  Text command) and automatic (  Field command) texts can be placed on the drawing area 

in arbitrary position. They can also be edited any time. 
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Figure: Text and Field commands with their settings 

At Text, the custom text can be defined in the Text field. At Field, the content of autotext can be set at 

Type. Some autotext types (such as Project title, Description, Designer’s name, Signature and Comments) 

are defined by the user at Settings > Title, and the other ones automatically set by the current project 

settings (such as File name, File date, Code name etc.). Field is especially useful in Documentation, as you 

can see it from the range of autotext types. 

The following text properties can be set for both text and field items: 

- Font 

Choose the required font type from available MS Windows offered types. 

- Script 

Script solves the character problems at different languages. An example for the Times New 
Roman font: character “ő” appears as “õ” in Western, but as correct “ő” in Central European 
script. 

- Size 

It is the height of the font in millimeters. 

- Width 

It is the width of the font. Its value that is lower than 1 defines narrower letters. Its value that is 

bigger than 1 results thicker letters. 

- Slant 

You can set the slant of the letters in degrees that closes angle with the vertical direction. The 

angle is measured clockwise. The standard italic font has about 10-15 degree slant. 

- Alignment 

In the Alignment figure you can set the position of the text insertion point. The hatched rectangle 

is the border of the text and the insertion point is in the intersection of the two black lines. 

Moving the black lines with the mouse offers nine possible positions for the insertion point. 
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To place the text/field on the drawing area, give the coordinates of the insertion point, and then define 

its direction. The  mouse button sets the direction parallel (“horizontal”) with the X direction of 

UCS. 

 

 

Figure: Text position 

Special characters can be defined in Text field by typing “%” before letters and numbers. These are the 

followings: 

-  %g = ° (degree symbol) 

-  %d = ∅ (diameter symbol) 

-  %p = ± (plus/minus symbol) 

-  %% = % 

-  %2 = 2 (square sign) 

-  %3 = 3 (cube sign) 

Dimension 

With  Dimension, length, angle and level dimensions can be defined in custom style. The style of 

dimensions can be set by  Default settings. 
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Figure: Dimension settings 

- Dimension line extension 

Dimension line can be extended with a value. 

- Level 

The size of the  Level dimension symbol can be set with Size value. 

- Color and Pen width 

You can choose a color (black by default) for all dimension items, and set a pen width for the 

lines. 

- Layer 

Drawing layer (“DIM” by default) can be chosen for the new dimension items. Of course, you 

can define and use different layers by position (external/internal), by direction 

(horizontal/vertical), by type (length/level dimension) for example. 

- Extension line 

Sizes, positions and display settings can be set for extension lines. 

- Arrowheads 

The style, the size and the pen width of the arrowheads can be set here. 

- Text display properties 
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The text style, the decimal numbers and the measurement unit type (independently from the 

project unit settings) of the numeric values can be set here. Additional text can be inserted before 

and after the measured values with Prefix and Suffix. Also special characters can be used as 

dimension text. 

- Horizontal / Vertical alignment 

The alignment of text to dimension lines can be set by direction. 

Dimension types 

From the Dimension tool palette chose the required type of the new dimension. 

 

Figure: Dimension types 

Different directions can be set for  Linear type dimensions: 

- Predefined direction 

The direction of dimension lines can be set parallel with one of the axis directions of the UCS 
or the global system. 

 

Figure: Dimensions parallel with global axes 
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- Parallel with line 

The direction of dimension lines can be set parallel with a line defined by two points. 

 

Figure: Dimensions parallel with a given line 

- Perpendicular to plane 

The direction of dimension lines can be set perpendicular to a given plane (e.g. the plane of a 
wall). 

 

Figure: Dimensions perpendicular to a given plane 
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Figure: Dimensions of arcs and circles 

 

Figure: Dimensions of angles 



596 

 

 

Figure: Level dimension 

Modification in dimension 

- Modify line dimension 

With this tool you can add new (reference) points to a selected predefined linear dimension 

line. First select the required dimension line, and then place the new point. 

 

Figure: New points added to dimension line 

- Add dimension to base line 

New dimension lines can be added to a baseline of an existing linear dimension line. This 

means, that the starting point of the new lines is at the selected baseline of the dimension line. 

First select the dimension line, then choose the side or baseline, and finally add the new points. 

The new lines will inherit all properties from the selected one. The location of the selected 

dimension line determines that the new lines will be above it or below it. 
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Figure: New dimension line assigned to a base line of an existing one 

- Dimension line position 

The position of a predefined dimension lines can be modified easily. Just select the required 

dimension line, and then define its new position. 

 

Figure: Modification in dimension line positions 

- Text content 

The real measured values can be substitute with any custom text. Not only numbers but letters 

can be added as text content. Do not forget to hide unit system, if you want to display only the 

new text. First select the text value, and then type the required text in the Text content dialog. 

Clicking the Original button restores the measured dimension value and overwrites the custom, 

the user-modified text. 
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Edit and Modify Menu Commands 
The Edit menu contains tools for editing and modifying drawing elements, structural elements, loads, 

reinforcement objects, result data, etc. The following table summarizes the editing tools, their function 

and examples. 

Edit Command Function Example 

 Repeat command Reruns the last used command.  

 Undo 
Undoes the last operation such 

as the editing operations 

summarized in this list. 

The maximum numbers of 

undoable operations can be set 

at Settings > Environment > 

General > System > Undo steps. 

Calculation operations and 

previous commands cannot be 

undone. 

Undo command does not close 

the current action window only 

resets it. 

 

 Redo 
Executes the previously undone 

command. 

Redo command does not close 

the current action window only 

resets it. 
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 Cut 
Erases selected elements of the 

project and places it onto the 

Clipboard in order to Paste them 

later to the drawing area. An 

insertion point is required for 

the later insertion (paste). 

 

 Copy 
Places selected items on the 

Clipboard. It does not delete the 

original objects. An insertion 

point is required for the later 

insertion (paste). 

 

 Paste 
Inserts the FEM-Design-type 

drawing contents of the 

Clipboard into the current 

project’s drawing area. The 

elements are placed with the 

coordinates of the insertion 

point defined by Cut and Copy. 

Paste together with Cut and 

Copy is working between more 

than one opened projects too. 

 

 Erase 
Deletes selected objects from the 

current project and so from the 

drawing area. 

Some special objects can be 

deleted with their own eraser 

tool: 

- Holes of planar regional 
elements (plates, walls etc.) 
can be deleted with the 
Remove hole tool of Modify 

region command. 

- Finite elements of a mesh can 
be deleted with the Delete tool 
of the Finite elements tabmenu. 

 

 Copy bitmap It exports the selected part of the 

drawing area to the Clipboard as 

an image, and it can be inserted 

to other programs such as photo 

editors, MS Word, MS Excel, etc. 

 

 Paste file Inserts the whole geometrical 

content (drawing and structural 

elements, loads, finite element 

mesh) of a FEM-Design file into 

the current project. The insertion 

point of the copied content is the 

global system origin of the 

pasted file.  

- 
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The loaded file must be 

compatible with the current 

FEM-Design module. 

External reference It imports DWG/DXF drawings 

as an image in the background 

 

Modify commands Function  Example 

 Move 
Moves objects or their copies 

with a given distance 

(displacement vector) in the 

drawing area. 

 

 Copy 
Makes more than one copies of 

selected objects. Each copies can 

be moved with different 

distances. The base point of each 

copies are the same point of the 

selected elements. 

 

 Mirror 
Mirrors selected objects or make 

a mirrored copy of them. 

Elements or their copies can be 

mirrored to a given line or 

plane. 

 

 Rotate 
Rotates selected objects or make 

a rotated copy of them. 

Elements or their copies can be 

rotated around a given point or 

line with an accurate angle or a 

defined new position. 

 

 Array > 

Rectangular 

Multiplies selected objects as 

row (UCS y direction) and 

column (UCS x direction) 

distribution. The number of 

copies and the distance between 

the copies by direction are 

required. 
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 Array > Polar 
Multiplies selected objects by 

rotating them around a centre 

point. 

Required data: direction of 

rotation (Clockwise/Counter-

clockwise), the origin of the 

rotation, the rotation angle and 

the number of copies. 

 

 Offset 
Makes a copy of line-type 

objects (line, arc, region contour, 

beam, column etc.) that will be 

placed parallel with the original 

object with a given distance and 

on the defined side. 

 

 Stretch 
Stretches line-type elements or 

the selected corners of closed 

polygons and region-type 

elements. 

 

 Curve 
Curve a line-type element or an 

edge of region-type elements.  

Clicking  on a curved 

line straigntens that. 

 

 Elbow 
Breaks a selected line or region 

edge, or in other word, it adds 

new point to lines and edges in 

new position. 
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 Scale 
Scales objects, blocks, even the 

entire structure. A base point 

(will be the only point that will 

remain in its original place after 

scaling) and the scale factor are 

required for scaling 
 

 Split 
Automatically splits selected 

line-type elements in their 

common intersections.  

 

 Trim 
Cuts line-type objects along an 

edge defined by another object. 

The cutting edge may have a 

real or virtual intersetion with 

the selected line wanted to be 

trimmed. 

 

 Extend 
Extends line-type objects to an 

edge defined by another object. 

The boundary edge may have a 

real or virtual intersetion with 

the selected line wanted to be 

extended. 
 

 Break 
Cuts a section from line-type 

object and breaks it into two 

independent object. 

Break can be used to cut a line 

into two parts by double clicking 

in the same line point (zero 

section length).  

 Chamfer 1. Cuts the corner of a closed 
polygon and region. 

2. Connects two line-type 
objects with a skew line 
defined by the chamfer 
distances.  
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 Fillet 1. Rounds the corner of a 
closed polygon and region. 

2. Connects two line-type 
objects with an arc defined 
by the fillet radius. 

 

  Modify region 1. Removes hole from region-
type object. 

2. Splits region by cutting 
edge defined manually or 
by the intersection of 
another region. 

3. Reduces/increases region 
area with parallel offset of 
region edges. 

4. Swaps faces of wall/plate 
regions (mirrors local 
system). 

5. Does logical operations 
(union, substarct, 
intercection and excluded 
“OR”) between regions. 

  

 Modify solid 1. Removes hole from 
drawing solid. 

2. Splits solid by cutting 
region/plane defined 
manually or by the 
intersection of another 
solid. 

3. Does logical operations 
(union, substarct, 
intercection and excluded 
“OR”) between solids. 

  

 Change direction 
Modifies the direction of the 

following object types: 

- column and beam section 
position, 

- support, 

- load, 

- parametric reinforcement, 

- applied reinforcement bar. 

 

 Change 

appearance 

1. Changes display properties 
of drawing and structural 
objects such as color, line 
type, pen width, text style 
etc. 

2. Matches properties of an 
object with others. 

 

Table: Edit menu tools 
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Quick modifications 
By clicking right mouse button the quick menu appears. After clicking on an arbitrary element all the 

commands of quick menu are visible but those that are not available for the chosen element(s) are 

disabled. 

 

 

Click 

LB 

(default) 

Click + hold 

LB 

CTRL + Hold 

LB 

Line’s end 

point 

Node on 

surface edge  

 

Stretch Stretch Drag a copy 

Along point 

along line 

 

Curve Move Drag a copy 

Any point 

inside Surface  

 

Move  Move Drag a copy 

Any point on 

screen, where 

there is nothing 

Box selection 
 

 
 

 

• At    user can select another command in the Modify menu which is also available by . 

•   on line’s end point or node on surface edge starts ‘Stretch’ command or the last used 
command selected by the user for this case 
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•   on any point along the line starts ‘Curve’ command or the last command 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.       on node 2.        

1.       on node 

2.        
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•  on any point inside on surface starts ‘Move’ command 

 

• and holding at line’s end point or surface edge’s end node starts ‘Stretch’ command 

 

   

  

3. Move and         1.         on surface 

2.        to 

select the base 

point 

1.       on node 2. Move mouse while 

holding mouse button 

3. Release mouse 

button 
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•  and holding at any point along line or any point inside surface starts ‘Move’ command 

 

•  +holding          at any point in a structural or drawing element starts to drag a copy of the 
object. 

 

  

1.        on line or 

inside surface 

2. Drag while 

holding mouse 

3. Release mouse 

button 

1.         +           on line 

2. Drag while 

holding mouse 

button 
3. Release mouse 

button 
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•   none of the objects starts ‘Box selection’ 

 

•  none of the objects hit pops up ‘Modify’ commands. 

 

Guide lines and Tracker 

The Guide lines and Tracker appears when any commands started and assist the user in modeling and 

modifying elements in a much more effective way. Guide lines are displayed temporarily during 

modification or drawing to assist user to find desired point in a fast and easy way. There are two kinds 

of Guide lines Straight and Circular. The Color and Angle step can be set in the 

Settings/Environment/Guide line and Tracker. All features of Guide lines can be turned OFF/ON in its 

Setting dialog. There are three colors of Guide lines in FEM-Desig. Dark green line will be drawn if the 

Guide line is parallel with the X axis of UCS, orange line will be drawn if it is parallel with the Y axis of 

UCS and light green (as default color) line will be drawn for any other guide line. 

 

out of elements 

1st 
2nd 

Box selection area 
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 Stand Click RB 

Along line or 

arc 

 

Parallel guide 

line 

Parallel guide 

line 

Line’s middle 

or end point 

 

Perpendicular 

guide line 

Perpendicular 

guide line 

 

Guide line 

 

- 
Remove that 

guide line 

Guide lines can be defined on the following ways: 

• It appears automatically after 1 second, if mouse stands over a line 

 This function can be turned off in its Settings by unchecking „Pop up guide line automatically if the 

mouse stays over a line for more than 1 second” 

1. Guide line parallel with 
                   UCS Y direction 

2. Guide line parallel with UCS  

Guide line and Tracker  

are orange 

Guide line and Tracker  

are dark green 
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•  on a line (straight, arc, circle or any object having these kind of geometry) 

 Virtual intersections can be found easily with Guide lines 

 

•   and drag mouse to define arbitrary guide line. If  is pressed, the line is created with finite 

length (from start point to end point), otherwise it will have infinite length. 

 Middle point of a rectangle can be found easily with Guide lines 

 

 

Guide lines are drawn in 3D, but Master Line (thick line) from which angle is measured, can only be 

placed in UCS or in a plane parallel to UCS. 

• Perpendicular guide line appears if mouse cursor stands over the end or middle point of a line, 

otherwise Parallel guide line appears. 

1. Right click on line or 

standing the cursor 

1. Right click on line or 

standing the cursor 

2. Drag mouse and release 

button 

1. Hold CTRL + Click 

Guide line with 

finite length 

Snapping middle 

point of guide line 
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•  over guide line will remove that guide line.  

 

• By  over snap-free places, guide line settings will pop up.  

• Snapping on a Guide line +  will stick the pointer to that guide line. 

Right click 
Guide line  

removed! 

Standing at the middle of 

bar or Right click 
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The Tracker tooltip shows Angle, Distance, dx, dy and dz from the last point. It pop up next to the 

cursor while drawing and the tracker will be the same color as the Guide line. 

 

Modify region 
Modify region command includes editing functions of drawing regions and region-type structural objects 

(plate, wall, surface load, surface support, surface reinforcement etc.). 

- Remove hole 

- Split region 

It divides regions into several pieces by cutting edge that can be defined manually as custom 

polyline or by selecting predefined lines or by selecting a region intersects the original one. 

Stand here and  

Hold Shift 

Right click 
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Figure: Splitting region 

- Perpendicular region offset 

It increases or decreases region area parallel with region edges. Offset can be done for all region 

edges, for all external contour, or for the hole edges. 

 

Figure: Perpendicular region offset 

- Direction region offset 

It increases or decreases region area along a defined direction. Offset can be done for all region 
edges, for all external contour, or for the hole edges. 
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Figure: Direction region offset 

- Swap top and bottom faces 

It exchanges the upper and lower surface of plates and the front and back sides of walls. It also 

mirrors objects with variable thicknesses. 

 

Figure: Swap plate region surface (variable thickness) 

- Logical operation: Union 

It adds user-defined area to a selected region or unifies two predefined regions. The result 

region always inherits the properties of the goal region selected first. 

 

Figure: Custom drawn part added to a (plate) region 
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Figure: Unifying two regions into one 

- Logical operation: Substract 

It cuts out a part of a region, which will be determined by another region intersects the original 

one. The result region always inherits the properties of the goal region selected first. 

 

Figure: Substract of two intersected regions 

- Logical operation: Intersection 

It creates a new region from the intersection of two regions. The result region always inherits 

the properties of the goal region selected first. 

 

Figure: Intersection of two regions 
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- Logical operation: Excluded “OR” (XOR) 

It performs an algebral XOR operation on an existing region and a shape drawn to intersect it 

or two regions having common part. The common part will be deleted. The result region always 

inherits the properties of the goal region selected first. 

 

Figure: Deleted intersection part of two regions 

Modify solid 
Solid operations command includes editing functions of drawing solids. 

- Remove hole 

- Split solid 

It divides solids into several pieces by cutting plane that can be defined manually as custom 

plane or by selecting existing regions or by selecting a solid intersects the original one. 

 

Figure: Splitting solid with predefined region and custom defined plane 

- Logical operation: Union 

It unifies one solid with another one(s). The result solid always inherits the properties of the 

goal solid selected first. 
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Figure: Unifying three solids into one 

- Logical operation: Substract 

It cuts out a part of a solid, which will be determined by another solid intersects the original 

one. The result solid always inherits the properties of the goal solid selected first. 

 

Figure: Substract of solids 

- Logical operation: Intersection 

It creates a new solid from the common part of two solids. The result solid always inherits the 

properties of the goal solid selected first. 
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Figure: Intersection of two solids 

- Logical operation: Excluded “OR” (XOR) 

It performs an algebral XOR operation on two selected solids. The common part will be deleted. 

The result solid always inherits the properties of the goal solid selected first. 

 

Figure: Deleted intersection part of two solids 

Change appearance 
The Change appearance command changes several properties of objects according to user modifications. 

- Change properties 

The display properties of objects can be modified in one settings dialog: 
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- layer of drawing objects, 

- line type of lines, edges and axes, 

- text style of texts, tables, dimensions etc. 

- color of selected objects (different color can be set from the color of the layer assigned to 
the object), 

- pen width of objects. 

 

Figure: Appearance modification 
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ACCESSORIES 
Correct model tool 

Correct model tool is a revolutionary function to fix the models having geometrical errors, in semi-

automatic way, with supervision of the user. This tool helps to fix the following types of errors in the 

model: 

- object multiplication and overlap 

- geometrically incorrect objects (very small region parts, very small angles, divided region 

edges, etc.) 

- incorrectly positioned objects 

Correct model tool is a semi-automatic system which necessarily needs user-interaction. It draws 

attention to the possible errors of the model and in most cases also offers solution(s), but you have to 

decide whether it is really an error or not and if it is, how to fix it.  

Pick Correct model from Tools/Correct model or from the toolbar ( ). 

Select the elements to be checked. 

Then in the pop-up dialog, select the task(s) to be run. 

 

 

All correction tasks can be selected or cleared in one click. Use the Select all and Clear all buttons for it. 
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Press Start to start the correcting process. It runs row by row and the current step turns green. The 

view is focused on the incorrect object (part).  

 

The table below contains the meaning of the flashing red object depending on the current correction 

task: 

Correction task (type) What is flashing? 

Delete identical copies object to be deleted 

Fix overlap current object and its modified version 
are both flashing 

Chamfer sharp angles the part of the region to be removed 
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Fix small areas and lines the part of the line/region to be 
removed 

Merge region lines the region line to be merged 

Fixing geometrically incorrect objects the object to be fixed 

Fit objects to storeys, axes and reference planes 
the suggested new position of the 
incorrectly placed object 

Fit objects to each other 

 

You can choose from the following choices: 

- Ignore: the object is not modified 

- Mark: the object is marked according to the colour and text set in the Marker dialog 

- Fix: the object is deleted/modified according to the program’s suggestion. The number in 

the table in Fixed cell of the current correction task’s row is increased by one. The fixed 

object turns into green 

Ignore all, Mark all, Fix all acts on all further incorrect objects found by the current correction task 

(highlighted by green in the table). 

After one of the abovementioned button is pressed, the next incorrect object – if exists – gets into focus 

and highlighted   

Show again focuses on the current objects. It can be useful at a large model. 

Break cancels the correction process but the previously performed modifications are kept. 

Once the correction process is finished (or cancelled) the modifications can be applied on the model by 

pressing either Apply or OK. In case of OK the dialog closes. All modifications can be discarded by 

pressing Reset if they were not yet applied on the model. 

 

Settings commands let the user save/load the selected correction tasks and their tolerances. 
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Using Auto button and applying its modification on the model is not recommended, 

because in practice in most cases there is no exact solution: 

- fixing an error may generate or eliminate other problems 

- fixing the same error in different ways may generate/eliminate different 

problems 

- consequently, the correcting process can be iterative.   

However, Auto is useful to get an estimation of errors and type of them in the model. 

 

 

See detailed description of each correcction task as follows. 

Delete identical copies 

If more identical element exist in the same position, it deletes all 

multiplication, and counts as one correction in the Fixed column on 

the Correct model dialog. 

 
This is not working for intermediate sections, post-tensioned cables and corbels. 

 

Fix overlaps 

It fixes the overlapping regions and lines. The existing objects can 

be shrunk or erased, but function will not generate new objects (e.g. 

a region can not fall apart).. 

Overlapping is allowed for the Loads. 

 
This is not working for isolated and wall foundations’region and corbels. 

 

Sharp angles 

Sharp corners under 10° will be fixed according to the given tolerance. 

The highlighted part of object will be removed. If the element has 

smaller dimension than the given tolerance, the whole element will be 

removed. 

 

Fix small areas and lines 

Objects within the tolerance range will be removed. It will fix small 

holes, long narrow areas etc.  
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Merge region lines 

Merge region lines function merges two lines/curves of a region into one 

line/curve if they are in the range of tolerance. Too flat curves may be 

replaced by line. The figure below shows examples how the tolerance is 

measured. 

 

Align to structural grid 

This function aligns objects to the structural grids (axes, storeys or reference planes). Alignment is done 

by orthogonal projection of object’s checkpoints to the structural grid within the tolerance. The check-

points are shown below for line, arc and circle: 

 

 
Once an object is placed on a grid by Correct model tool, it will not be detached from it 

by any next correction step.  

 
Correct model tool does not check structural grid for possible errors, like axes too close to 

each other or not perfectly parallel.  

 

Stretch to structural grid 

This function will stretch the regions and lines to the intersection of 

axis within given tolerance.  

 
If the geometry of the object is incorrect (e.g. shell is not laying in plane) this function 

cannot be performed. 

Align regions 

It aligns the regions (projection) to an other region’s plane which is 

within the given tolerance both in direction perpendicular to and 

parallel with  the region’s plane. 
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Stretch to crossing regions 

This function will stretch the objects to the crossing regions within 

given tolerance. 

 

Stretch regions in plane 

Regions laying in same plane will be stretched to each other within 

given tolerance. 

 

Stretch regions in plane 

Lines laying within given tolerance to other objects will be stretched. 

 

Align points 

Points (objects) will be aligned to closest object within tolerance. 

 

Restrictions 

 
- Correct model cannot handle: 

• peak smoothing regions 

• connections (point, line, surface) 

• bar, shell components 

• building cover and 

• doesn’t work in Analysis and Design tabs 

- only the visible objects can be modified 

- columns and walls need to be vertical and will stay vertical after the 

modifications as well 

- isolated, shell foundation and foundation slab need to be and remain horizontal 

- pile can be placed in any direction, but cannot be horizontal 
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- corbel is not handled by Correct model and cannot be used as an object to fit other 

objects to 

 

 

Correct model works in multiple-window mode as well. 

 

Example 

The following example shows the process of fixing geometrical errors of a small model with different 

types of errors: 

 

Query 

Starting   in Tools menu helps to get geometrical informations in the model.  You can get the point 

coordinates, length between two point, angle, region and solid parameters. 

Point coordinates 

Choosing a point with   shows the point coordinates in orthogonal and cylindrical Global co-ordinate 

system. 
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Figure: Point coordinate 

Length 

Choosing two points with  shows distance between the selected points and their projection to the  

co-ordinate axes. 

Angle 

Choosing two lines with  shows the angle between the lines. 

Region 

Choosing or drawing a region with  shows area, perimeter, center of gravity (co-ordinates). 

Solid 

Choosing a solid with  shows volume, perimeter, area and center of gravity (co-ordinates). 

Block 

Blocks can contain only drawing elements (point, line, arc, circle, region, solid and text) for editing these 

elements in one step. 

 
Figure: Block toolwindow 

Similarly to filter, for definition, you have to type the name first, then select the desired objects. If 

required, members can be added with the “+”, and removed with the “-“ buttons, and exploded with 
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the explosion symbol at the right hand side. With properties “?”, you can also change the name of the 

block. 

For grouping structural elements or loads User defined filter function can be used. 

Archive 

This command deletes the result files for save free space in the hard drive. To see the result, you have 

to run calculation again.  

External reference 

With this command User can display a drawing of dwg or dxf format as an image in the background. 

The main advantage of external reference is that  modifcations made in the source file will be executed 

in the FEM-Design file each time it is reopened, or Refresh function called. 

 
Figure: External reference toolwindow 

After Clicking on Define you can specify the insertion coordinate system: 

 
Figure: Insertion coordinate system of DWG/DXF drawing 

With the third click, you specify the coordinate system’s second axis. The second axis can define reverse 

polarity compared to the polarity of the referenced image and thus you can get a reverse image (with 

wrongly directed texts, etc.). 



630 

 

 If the origin in the dxf or dwg file is far away from the drawing, you may not find the image in 

FD’s workspace. Click on „Zoom margin” in this case:  

 
Figure: Inserted DWG drawing 

In the import window, you can set the conversion scale, select the desired layers, with different colour 

representations: 

 
Figure: Import dialog 

With the display option in the red box, you can turn the picture on and off.  



631 

 

 
Figure: Turning on the Display option 

In “off” state, the file path is printed at the insertion point, and you can set its font parameters in the 

window below, which opens in default settings during definition , or when clicking on an existing 

external reference with  active: 

 

If the source file has changed, you can refresh  it, or refresh it with different parameters . 

Statistics 

Starting  in Tools menu opens the Statistics dialog, where User can find information about the 

quantities of different objects in the model. 
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Get GUID 

The Get GUID function enables the query of the GUID of elements. This can be useful for identification 

of structural objects imported/exported via Struxml. 

Picking  in Tools menu launches Get GUID. You needs to select teűhe elements, of which GUID you 

wish to know. 

The pop-up window shows the General Unique IDs which can be sent to the clipboard by clicking on 

“Send to clipboard” button. GUIDs for analytical and physical model of a bar are different. 

Analytical view: 

 

 

Physical view: 

 

If the bar is saved in struxml format, these GUIDs can be found there as well. 
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Feedback mail 

In Help/FEM-Design Support you are able to reach the support easily and get answers for specific 

model dependant questions. 

 

  

In the dialog you can decide how to receive answer, via email or phone and/or Teamviewer (remote 

desktop). The Help button links to a guide, how to write a request. 

Local support button opens StruSoft’s support website, where the local contacts are listed. 

If the Attach current model is active, the last saved model will be send to the support. If the model 

includes linked DWG files, those files will be attached as well.  
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There is an option to add more files (e.g. pictures) to the report. 

Company settings 

It is a very fast way to export all FEM-Design settings and libraries to any other computer. You are 

able to deliver your company preferences from one computer to another very easy and quickly.  

 

Pick export  or import  settings in the FEM-Design Center and select the items, which wanted to 

be forwarded. The company settings file has *.fdcs format. 

The following items can be exported: 

- settings 

- libraries 

- doc templates 

- list batches 

- title blocks 

- list templates 

- Office OpenXML templates 

Export Import 
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